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Chapter 1

Learning about ArchiCAD

This introductory chapter presents the ArchiCAD User Guide. It also explains the relationship between the printed
documentation and the on-line Help available with the program and reviews additional information sources.

ArchiCAD User Guide and
ArchiCAD Help

The printed ArchiCAD User Guide provides concise
information about all ArchiCAD features and functions. It is
made up of two volumes containing Chapters 1-4 and 5-13,
respectively.

The ArchiCAD Help, from ArchiCAD's Help menu, contains
the electronic version of the printed manual. In each chapter,
the More Information item, not included in the printed
manual, points the user to additional information aimed at
users of very specific functions or expert tools. ArchiCAD
Help also includes the entire Graphisoft GDL Reference
Manual, which provides a comprehensive description,
including extensive examples, of the programming language
used to create library items.

Note: Some of the expert programming materials are
available only in English.

Structure of the User Guide

In both its printed and electronic formats, the ArchiCAD User
Guide is divided into the following chapters:

Chapter 1: Learning about ArchiCAD is the section you
are reading now and helps you locate the information you
need.

Chapter 2: The ArchiCAD User Interface introduces the
visible elements of the ArchiCAD working environment. It

helps you find your way around the ArchiCAD workplace and
understand the role each component plays in using ArchiCAD.

Chapter 3: Project Organization and Navigation presents
the ways ArchiCAD simulates and improves on the traditional
environment needed to develop an architectural project and
produce presentation and construction documents. This chapter
describes how to implement some basic architectural concepts
using special automation tools to speed up daily work.
Chapter 4: Element Creation concentrates on the creation
of ArchiCAD elements of different types. It also covers the
tools and settings available for constructing Virtual Building
elements. Special techniques for the duplication of existing
elements and the creation of elements by using the contours
of other elements are discussed, as are the semi-automatic
tools that add structural elements and finishes, such as
StairMaker, RoofMaker and Interior Wizard.

Chapter 5: Drafting and Editing Techniques concentrates
how to fit elements to each other and to special points of the
worksheet, and how to modify placed elements by moving or
transforming them.

Chapter 6: Project and Program Customization tells you
how, in your everyday use of ArchiCAD, you can tailor the
program to your specific needs, define standard options for all
projects in your office, or use special settings for different
projects. ArchiCAD provides a large amount of freedom in
customizing the program, the workplace, and your own
personal preferences. This chapter presents those options that
can be changed by the user, from custom symbol line types
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Chapter 1: Learning about ArchiCAD

and shortcut keys to library usage and the precision of
decimal display.

Chapter 7: Library Management describes how to manage
the Library folders that contain the external files used by
ArchiCAD, and which are referred to by construction
elements.

Chapter 8: Working with GDL Objects deals with the
creation and editing of GDL Objects stored in outside files,
including Doors, Windows, Lamps and general Objects, as
well as calculation database components such as Zone Stamps
and Property Objects.

Chapter 9: Collaboration and Connectivity includes the
data exchange tools that you need in your architectural
practice to collaborate with colleagues and other
professionals. In addition, documents created with ArchiCAD
can be reviewed in the special mark-up mode or even
through the Internet.

Chapter 10: Project Data Calculation sums up the
calculation process based on ArchiCAD's integrated database
of construction elements, which can display in list format the
number, quantities and components of elements in a project
or the elements' spatial disposition (zones), using the features
of the Calculate menu.

Chapter 11: Menu Command Reference reviews the
commands available through the ArchiCAD menubar. It
provides a short description of each command and refers you
back to the sections that detail these functions. Features that
are not presented in detail in any other chapter are discussed
at more length here.

Chapter 12: Using PlotMaker discusses PlotMaker, a
standalone layouting application that is part of the ArchiCAD
package. PlotMaker is optimized for preparing an architectural
documentation set based on the views, drawings and images
created with ArchiCAD, with the possible addition of data from
additional, external sources such as other CAD and image files,
word-processing documents and spreadsheets.

Chapter 13: Printing and Plotting reviews the possibilities
offered by ArchiCAD and PlotMaker for printing and plotting
the various aspects of the Virtual Building. It also sums up the
output options available for different element types and
points out further output possibilities.

Additional Quick Help Features

In addition to the ArchiCAD Help menu item, ArchiCAD offers
a number of help features inside the program.

- If you enable Tool Tips (Windows) or Help Tags (MacOS),
you will see short descriptions over interface elements. On
Windows, you may need to right-click and choose the
What's This? item in the appearing context menu.
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- In its expanded state, the Control Box (located by default
at the bottom of the ArchiCAD screen) includes a Prompt
Box that provides step-by-step instructions about the next
editing operation expected from you.

//‘“\ﬁ
iﬁlil@l'

Enter Naxt Mode of Polyiitall.

- On Windows only, the Status Bar at the bottom of the main
ArchiCAD window displays information on the selected
menu command or the editing operation underway.
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Bl ArchiCAD 8.0.0 B7.0 INT (3582) for TeamWork
File Edit Tools Options Image Calculske | Teamwork Display  Window Extre
[osEs RLIF oo Bonn
a Send & Receive Changes, .
! Receive Changes

! Sign @uk..
Shepg This Project...
Show My Workspace Only

Change [y WarkSpace. .

Teamywork Hotes
Add|Comments. .

Saves the current project as 5 shared Team Project.

Structure of the Help Menu

In addition to the ArchiCAD Help item, the Help Menu of
ArchiCAD includes program information (About ArchiCAD)
and links to Graphisoft and ArchiCAD websites.

ArchiCAD Help contains the Getting Started manual (also
available in printed format) with information on the ArchiCAD
package, system requirements, components, installation and
troubleshooting. The ArchiCAD Shortcuts item is a quick
reference guide to frequently used keyboard combinations.

The Graphisoft Website

You can connect directly to the Graphisoft website from the
ArchiCAD Help menu or type http://www.graphisoft.com into
your browser . The Graphisoft website contains up-to-date
information about product availability, support, user community
news, events and the latest news about related products that
allow you to take the Virtual Building concept further within the
architectural and building profession and connect to other
professional fields such as facility management and HVAC.

In different sections of the website, you can access
information about:

- Products that allow you to connect to other professional
fields, for example Graphisoft's ArchiFM product family
including ArchiFM WebServer and ArchiFM Maintenance,
or GDL Technology's intelligent object tools for the

creation of manufacturer libraries that can be used in both
ArchiCAD and other CAD programs.

TECHNOLOGY

- Utilities related to ArchiCAD with which you can design
library items, add elements that correspond to a particular
usage in a specific area or export data from the project for
further processing.

ArchiRuler
2 ArchiRuler adds a palette of dedicated 2D
‘ - designing took te ArchiCAD.
N 4

ArchiTzrra
The first ArchiCAD plug-in for terrain
modelling

HES Palette
The intemational language for colour
Gommunication

PlanZModel i

Convertyour2D floar plan drawings into a 30

(. AchiCAD model from DXF and DG files o ’
¥ imported sketches and drawings

GOLToclbox
J The interactive GDL sditor weoking wihin
ArchiCAD

Artlantis
The easiest and fastest way to photo-
realistic pres entations.

HYAC for ArchiCAD f
Took for ArchiCAD users to model duchuar
without an in-depth knomledge of HUAL f

J§  AschiDesigner Dpenings
] Profeszional parametric window and doar
design taol.

Z00M G0L
Standalone object modeler,

fuchiF orma
The fitst ArchiGAD plug-in for sreating
objects

- Special libraries that can be added to the default ArchiCAD
Library.

Auchite ctural Access aries
Allthe detait you need

N MAD, Design
For Kitchen and Interior Design

Office and Business Librany
interior Elements for Business Envionment

Street and Traffic Library
Common r0ad signs including waming senvice and
parametric destination signs

The furniture design of Gerrt Thomas Ristveld

Cl .= object ibrary for ArchiCAD

Lamplorld
Wl The Art of [llumination

The fumiture design of Abwar Aatts
Sitting i an active occupation and resting should be
done in bed

Contact your ArchiCAD dealer for more information about the
availability and pricing of these products.
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Further Reading

In addition to the printed ArchiCAD User Guide and the
electronic ArchiCAD Help, the following books are
recommended for mastering ArchiCAD or immersing yourself
in specific fields:

- The ArchiCAD Step by Step Tutorial is a self-teaching
book that allows you to learn the basics of ArchiCAD in a
few short lessons, while the ArchiCAD Training Guide,
also a general handbook, is more suited for classroom
situations.

- Project Framework presents recommended
implementations of ArchiCAD in your office.

- ArchiCAD for AutoCAD Users is recommended reading
for those who need to use both programs in the same
office.

- Object Making in ArchiCAD will teach you the basics of
creating your own library parts without or with GDL
scripting. The GDL Cookbook is a comprehensive book
on GDL including guidelines and expert options.

- Illustration with ArchiCAD deals with basic,
intermediate and expert visualization options both inside
ArchiCAD and on exported files in software that further
process images and animations for presentation purposes.

All these books are presented on the Graphisoft website.
Consult your ArchiCAD dealer for more information about
their availability. You can also purchase them directly from
Amazon.com.

[y -
lllustration in

AFchiCAD

Gl DA 8 b
. .

lor Ao CAD sers

Note that the list of books is subject to change. Some of these
books may not yet have been updated to the latest versions of
ArchiCAD. Many ArchiCAD dealers also offer their own
training courses and materials.
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Chapter 2
The ArchiCAD User Interface

This chapter introduces the visible elements of the ArchiCAD working environment. It will belp you find your way around the
ArchiCAD workplace and understand the role each component plays in ArchiCAD.
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1) Menubar
2) Toolbar

3) Info Box
4) Toolbox

5) Floor Plan
worksheet

6) Section/Elevation
window

7) Status Report
window

8) Detail Drawing
window

9) Navigator
10) 3D Window

11) Project Preview
window

12) Listing Window
13) Navigator Preview

14) 3D Navigation
Palette

15) Control Box
16) Coordinate Box
17) Status Bar
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Chapter 2: The ArchiCAD User Interface

ArchiCAD Windows

There are three basic types of windows in ArchiCAD:

- Construction windows, in which you build your model.
These are the Floor Plan window and the 3D window.
Both of these windows are available at any time you work
in the project, although the 3D Window can be hidden by
closing it without closing the project.

- Additional windows that show specific views of the
model or allow you to elaborate on it. These windows are
generated from elements of the Construction windows.
They include any number of interactive Section/
Elevation windows and Detail Drawing windows as
well as 3D Picture windows showing PhotoRendered still
images and Listing windows that display text data about
the project.

- Auxiliary windows that display information about the
project, such as the Project Notes, the Project Preview
and the Report window.

All window types are resizable in all directions.
Most of the windows include a number of shortcut icons next
to their bottom scrollbar. They represent shortcut commands
as described later in this chapter.
Note: GDL Objects (or Library parts) open for editing also
have a number of windows. These are described in detail
in Chapter 8: Working with GDL Objects.

Construction Windows

Floor Plan Window

The Floor Plan Window is the basic construction area where
most editing operations take place. It shows a representation
of the current Project as a traditional architectural drawing.

& Example / Ground Floor =101

H

Fallk_ oo | ssw |v |QH &1Q]&le«Qioe]«] | o

- The Floor Plan worksheet represents a window into an
arbitrarily large drawing space.

- You can pan and zoom the window within the full
drawing space to obtain the best view of the work you are
currently doing by using the shortcut icons next to the
bottom scrollbar or the commands of the Display and
Window menus.

- It is a starting point for exporting drawings into various file
formats.

When working in the Floor Plan window, you can use all or
most of the functions offered by the floating palettes and
other interface component.

The 3D Window

The 3D window gives you instant feedback on the
construction operations performed in other views and at the
same time allows you to directly edit your model in either
perspective or axonometric view. New elements can also be

12
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created in this window. In the production phase of your
project, you can also generate here accurate 3D images
optimized for plotter output.

@ Example 30 / all

Mation Mode

(3% @

Lookto Reset

x| Editing-Motion

BRI

i st Bla| ol n
oo MR & & & @ cel e | _’I_J

The 3D Window is directly linked to the Floor Plan and to
the Section/Elevation windows: any changes made on the
Floor Plan or in any of the Section/Elevation windows will
be visible in the 3D window and vice versa.

- Either the complete project or just the parts you select can
be displayed in the 3D.

- Block, Wireframe, Hidden Line or Shaded views are
available in all types of parallel and perspective
projections.

- The 3D model can be post-processed by the
PhotoRendering feature, or exported in a variety of 2D
or 3D file formats for other applications.

Most construction aids are available in the 3D window.

Additional Windows

Section/Elevation Windows

The Section/Elevation tool in the Toolbox allows you to
generate any number of sections or elevations of your Project
in separate Section/Elevation windows linked to named and
numbered Section markers.

There are two modes for sections/elevations:

- In Model mode, the window consists of construction
elements and any changes made in will automatically be
updated in the Floor Plan window, as well as in the 3D
window and other Section/Elevation windows when
activated.

[ 09 Modelling 01 ;/ Model 10l =l

[

a2 | v |Cdn e e & eqloe] 4] | LIJJ

- In Drawing mode, construction elements are
decomposed into 2D Fills, Arcs and Lines. Changes made
in this type of window are not updated in other windows.

Graphisoft ArchiCAD User Guide
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You can, however, update the Drawing to reflect recent

changes made to the model.

[l C Section / Drawing =10l x|

Training Foom

Atriunn

Crache

ss % | v |G| @ e e e leny el | _|JJ

Drawings are obtained by choosing the Unlink from Model
command from the Display menu's Sections/Elevations
hierarchical menu. In the caption of the window, the word

Model changes to Drawing. This command is NOT
undoable.
In both modes, you can add 2D graphics, annotation and

dimensioning. See Sections in Chapter 4. Element Creation for

details.

Detail Drawing Window

The Detail tool in the Toolbox allows you to generate Detail
Drawings from Floor Plans, Sections/Elevations, models or

plan drawings, which can be opened in separate Detail
Drawing windows.
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Detail Drawing windows are linked to Detail Markers
placed on Floor Plans or Section/Elevations by using the
Detail tool. They are numbered and named according to the
settings of the Detail Marker they are linked to.

See also Detail Drawings in Chapter 4: Element Creation.

3D Picture Windows

Any number of photorealistic images of the model in the 3D
window can be generated using the PhotoRendering feature
as a snapshot of the current state of the Project. 3D Pictures
are not editable. You can save them as separate files,
independent from the model.
- PhotoRendered images can be exported to image-
processing applications for retouching.
- You can copy a part of the picture with the Marquee tool
and paste it as a Figure into the Floor Plan or a Section/
Elevation window.

14

Graphisoft ArchiCAD User Guide



Chapter 2: The ArchiCAD User Interface

GETETE 4 2 4

- 3D Pictures are listed in a hierarchical menu of the
Window menu, together with picture files opened with
the File/Open command.

Note: Neither 3D Pictures generated by ArchiCAD nor
external files opened with File/Open are kept as part of
the project when saving it. You will have to save the
individual windows as separate files if you wish to keep
them.
See also the PhotoRendering feature in Chapter 11: Menu
Commandes.

Listing Windows

ArchiCAD provides different options for viewing on screen
the quantity calculations for the whole Project, selected sets of
elements or Zones.

Example / Elements / General Element List o =] ]
al nt list -
Element | |I.a\rer Name Pser i) | | Width
Thiel
MALL
First Floor Walls Extarnal. N all-453 033m
First Floor Malls Extornal. N Wall-453 0.35m
Firsl Flaor Walls Exlernal N ftall-453 038 m
First Floor Walls Extarnal. N all-453 n.35m
First Floor Malls Extornal. M Wall-453 0.35m
Firsl Floor Wialls Exlernal N pAall-AE3 .35 m
First Floor Walls External M all-454 035 m
First Floor Malls Extornal. M- ivall-454 0.35m
Firat Fluor Wi'alls External. N fiball-454 0.3 m
First Flonr Walls Extarnal. N all-45d naim
First Floor Malls Extarnal. M Wall-454 035m  —
First Fluor Wialls External N phall-456G .38 m -
Tk 100w | v | @ &y @ leq] S el < | 3

Element and Component List windows will display a
detailed list of quantities of either the whole project or any
desired part or subset of it. ArchiCAD combines the building
components of the Project with the Properties descriptions
residing in the Object Library to provide a detailed list of the
elements and their user-defined components.

Zone List windows display a detailed list of quantities of
either all the zones of a Project or selected ones. Zones are
floor plan spatial units including rooms, groups of rooms or
even larger parts of the Project defined with the Zone tool.

The lists displayed in these windows can be exported into a
variety of file formats for further processing.

See also Chapter 10: Project Data Calculation.

Auxiliary Windows

A number of secondary Windows are available at any time for
displaying information about the current state of the Project.
These include the Project Notes, the Project Preview and
the imaging and listing Report windows.
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The Project Notes Window

You can access this window by choosing the Window/
Project Notes command. Whenever you open it, the date
and time will be updated and a blinking insertion point
marker will appear next to the current date and time.
It works like a note pad, where you can:

- enter written notes about the Project or comments for

fellow designers,
- keep track of the time spent on a particular job.

=
|

Wednesday, July 17, 2002 11:07 AM

_>l_/i

Any text entered here is saved with your Project.

The Project Preview Window

You can paste a PhotoRendered image of your Project into
this window. This preview is shown in the Open file dialog
box in order to make the identification of files easier.

=]

M7s 4|

The Report Window

The Report window displays information about the imaging
and listing process, provided that you have checked the
Write Report option in Options/Preferences/Imaging &
Calculation menu command.

It also lists input/output operations, as well as the name and
version number of the Add-Ons that have been loaded either
at startup or by choosing the Tools/Add-On Manager
command.

B Report =10l x|
ArchiCAD Rendering Engine ¥5.T
Inage size 1113 77 (34

PhotoRendering :
Start time  7ALTAE002 11:17:
Elapsed time & seconds

Displaying and Refreshing Views

ArchiCAD provides a number of options that affect the view
of the current ArchiCAD window. These commands give you
complete control over your views: you can enlarge and
reduce them, move around freely in your windows or go to
previous or predefined views and refresh and clean up the
screen. These commands can be accessed from the Display
and Window menus and most of them are available in the
form of shortcuts from the bottom scrollbar of the windows.
Special zooming commands can also be accessed by using a
wheel-mouse.

Zooming

You can zoom in on details or use zoom out to encompass
more elements by using a number of techniques.

In any view:

- Choose Zoom In or Zoom Out from the Display menu.
Draw a rectangle around the detail you intend to enlarge
with the Zoom In cursor. The area surrounded by the
rectangle is enlarged to the size of the current window.
With Zoom out, the entire current view is squeezed into
the rectangle that you have defined. The operation is
optimized, no distortion will result.

- Clicking the Zoom In | &] or Zoom Out [ €] button on
the bottom scrollbar of the active window activates the
corresponding shortcut. The process is the same as above.
You can also double-click the appropriate icon to double
the current magnification or reduction level.

16
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In any view:

- If you have a mouse with a scrolling wheel, you can use it
for zooming in and out around the mouse pointer by
scrolling the wheel ahead and back.

Note: You can even use this feature in the Navigator
Preview palette.

- Click the Special Zoom button Ci#| on the bottom
scrollbar to emulate the operation of a wheel-mouse
controlled zoom: to zoom in, click the button and move
the cursor upwards in the window. To zoom out, click the
button and move the cursor downwards. The next click
will activate the chosen zoom.

- Use the numeric keypad by pressing the ‘+’ key for
zooming in and the ‘-’ key for zooming out.

- Use the Navigator Preview palette as detailed in that
feature's description in Chapter 3: Project Organization
and Navigation.

In addition, you can optimize the view to show the selected
elements only by choosing the Zoom to Selection command
in the Display menu.

Fit in Window

You can size your Project to accommodate all the currently
visible construction elements. This provides a good way of
checking to see if you have placed something in the far
corners of your drawing by mistake during numeric input or a
multiply operation.

Choose the Fit in Window command in the Display menu
or click the corresponding shortcut button | €| on the bottom
scrollbar of the active window.

For Listing windows you have an additional shortcut in their
bottom scrollbar allowing you to Fit the Width [l of the
generated list to the current size of window.

Pan

You can also move in a worksheet to display design elements
or details that do not fit in the current view. You have the
following options:

- Choose the Pan command from the Display menu to pan
the entire virtual worksheet by moving the Hand cursor
over it with your mouse. The whole on—screen area will
move, while the current zoom level is preserved.

Click the Pan button /&% on the bottom scrollbar of the
active window as a shortcut to the previous option.

If you have a three-button mouse, you can use it for
panning by pressing down the middle button while
moving the Hand cursor over the worksheet. This feature
is not available in 3D views.

- If you have a mouse with a scrolling wheel, you can use it
for panning by pressing the wheel continuously while
moving the Hand cursor over the worksheet. This feature
is not available in 3D views.

- You can use the numeric keypad by pressing the

following keys: 4 (pan left), 2 (pan downwards), 6 (pan

right), 8 (pan upwards).

Use the Navigator Preview palette as detailed in that

feature's description in Chapter 3: Project Organization

and Navigation.

Note: The Pan command can be used with the numeric
input and Mouse Constraints to pan in specific directions
relative to element or Project geometry.

Preset Zooms

You may need to get a zoom level where your drawing
elements appear at the same size they would assume on
paper if represented at the current scale (the one set in
Options/Floor Plan Scale...), for example before pasting
elements that should appear in real paper size on the
worksheet, such as a scanned site plan.
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You can access this zoom level by either choosing the Actual
Size command from the Display menu or clicking the Zoom
Level button on the bottom scrollbar of the active window
102 % _| (this button displays the current zoom level in
percent of the Actual Size).
Note: Since scale does not affect 3D views, this option is
not applicable in the 3D Window.

If you need to return frequently to a part of your project, you
can define it as the Home Zoom by choosing the Set Home
Zoom command in the Display menu. You can return easily
to this view by choosing the Home Zoom command in the
Display menu. This zoom is saved with the Project.

You can save different zooms for further use by clicking the
arrow pop-up button in the bottom scrollbar of the active
window. The pop-up menu commands allows you to access,
rename and delete predefined zooms.

v Save Curent Zoom...
Rename %s..
Delete %z

1000
S00%
200%

Ek 100%

S0%

20%

10%
If you wish move one step back from your previous Zoom
In, Zoom Out, Pan, Home Zoom or Fit in Window
operations, you can either choose the Previous Zoom
command in the Display menu or click its shortcut button
[#Cl in the bottom scrollbar of the active window. Up to 20
previous steps are stored. To return forward, use the Next

Zoom command or shortcut button |C/.

Redrawing or Rebuilding a View

Operations such as transformations and deletions may leave your
screen strewn with unwanted artifacts. This is just a temporary
screen display problem (your prints and plots will be fine) and can

be corrected by choosing the Redraw command in the Display
menu, which cleans up your screen.

If you need to get a more thorough refreshment of your
windows, you can choose the Rebuild command, also in the
Display menu.
- When you Rebuild the 3D Model, the program will replace
your outdated 3D view with an updated one.

Note: The 3D Window is automatically rebuilt every time
you activate it. By default, rebuilding also occurs every
time you change the 3D settings. You can disable this in
the Options/Preferences/Imaging and Calculation
dialog box.

When working on a dynamic Model Section, the name of
the Rebuild command changes to Rebuild Model S/E. If
you modify elements in this window, some complex
changes (e.g., modifying a Library Part) do not appear
automatically in this Window and you have to use the
Rebuild Model command to see them properly.

When working on a static Drawing Section or a Detail
Drawing window composed of 2D drawing elements
only, the name of the Rebuild command changes to
Rebuild Drawing S/E or Rebuild Detail Drawing.
These commands refresh the view as a 2D drawing, fixing
any potential temporary display errors.

For a complete refreshing of static Drawing Section or
Detail Drawing windows, choose Section-Elevations/
Rebuild from Model or Detail Drawings/Rebuild
from Source View. This will refresh the contents of these
windows to fully reflect the current state of the Virtual
Building model. In the process, all 2D elements originating
from the model will be removed and an up-to-date view
will be generated. This means that any previous manual
editing of this artwork will be lost. 2D artwork added to
the the drawing manually will be kept intact.

Note: In both Section/Elevation modes, ArchiCAD
recreates the view without removing the drawing elements
that you added to it in.

18
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Additional options are available for rebuilding Section/
Elevation and Detail Drawing Windows from the appropriate
hierarchical menus of the Display menu. You can rebuild all
the windows at the same time or select some section markers
or detail markers on the Floor Plan and then choose the
Rebuild Selected command.

ArchiCAD Palettes

ArchiCAD's floating palettes help you construct, modify and
locate elements. Each palette can be shown or hidden
separately using the Floating Palettes hierarchical menu in the
Window menu. The four main palettes (Toolbox, Info Box,
Coordinate Box, Control Box) can be enabled or disabled
together using the Show Main Palettes Only command.

The shapes of the main palettes can be customized with
Options/Customize.

21
Tool Box: [~ Show " Estended o E o E
Coordinate Box: ™ Show " Estended o o E
Contral Box ™ Show " Extended Lo o g
Info Bok: [ Show [ o E

[~ Shaw Tool Tips on Floating Palsttes

Cancel |

The Coordinate Box

The Coordinate Box is available when working in any
construction window. By default, it appears in the bottom of
the screen. The Coordinate Box:

= ; x: 0512 r:E.007 z-0.000
» y:2963 azgoise to Projest 2ero[F]

- shows you the precise location of the ArchiCAD cursor
within both the Cartesian and polar coordinate system for
your drawing;

- enables you to enter numeric drawing coordinates for
greater precision;

- houses the Origin, Grid and Gravity control icons.

See also Chapter 3: Project Organization and Navigation for
the detailed description of these features.

The Control Box

The Control Box contains a number of drawing aids in the
form of icons. The Control Box is only available when you
are working in any of the Construction Windows. By
default, it appears at the bottom of the screen, on the top of
the Coordinate Box.

i ililgl ; hlgalf ] 0K | Cancel | Ell

The palette's controls, from left to right:

- Relative Construction Methods constrain the cursor to a
defined angle or distance during drafting or editing. They
are linked to the Mouse Constraints feature which helps
you place the endpoints of linear elements at predefined
angles.

- Cursor Snap Variants control the way the current
position of the cursor is projected.

- The Suspend Groups switch allows you to choose
between editing grouped elements together or on their
own.

- The Magic Wand traces the contours of existing elements
in order to create new elements of other types.

- The Special Snap Point definition controls automatically
generate temporary snap points on different parts of edges
and help you position elements at exact points or
distances along lines and edges.
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- In the palette's maximized state (shown below), the
Prompt Box provides point-by-point instructions during
drafting or editing.

TR IPAIE NP Yo e 3T

Entter First Corner of Rectangle Wall

0K Cancel | 5

See also Chapter 5: Editing and Drafting Techniques for the
detailed description of these features. The use of the Magic
Wand is described in Chapter 4: Element Creation.

The Toolbox

The Toolbox located by default on the left edge of the Floor
Plan Window shows a variety of tools for selection, 3D
construction, 2D drawing and visualization.

=

% [ & |2
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In its default shape, Toolbox does not display every single
tool icon; some tools are grouped into pop-up menus that
open from a related icon.

and the available Add-Ons. The location of these tools in
the Toolbox cannot be set by the user.

The Info Box

The Info Box is located by default on the right edge of the
screen and is only available when working in any of the
Construction Windows.

£

Se\ecﬁ[:r} f]e’dings
= =]
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71 o215
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B, [-=-000

Solid Line v |

9 am

l:‘ concrete block 4 |
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g’l |— CedarB... g 4
Eaws =

Log Details.. |

Wil Trirmn med 2
Custom Texture Drigin s

10: IWaH—dSD

l_ L=bel Elements

- The Info Box displays either the default parameters of the
Note: Besides the standard set of tools, additional tools active tool or those of the most recently selected element.

can appear in the Toolbox depending on the installation
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- The Info Box provides a condensed view of the
corresponding tool's settings dialog box with direct access
to the displayed attributes and parameters.

- Input or Geometry Methods specific to the tool are also
shown in the Info Box. Most of these are not available in
the corresponding tool's settings dialog box.

- Unlike the tool settings dialog boxes (see below), the Info
Box shows no panel titles and as little text as possible. Use
the Tool Tips from the Help menu to learn about each of
the controls.

You can customize the amount and order of the Info Box

panels with the Options/Customize menu command. See

Chapter 6: Program and Project Customization for details.
Note: When several elements are selected, the displayed
information refers to the most recently selected element. If
several elements overlap, successive clicking with the
Checkmark cursor (in Arrow tool mode) will cycle
through the selection markers of the available elements.

Tool Settings Dialog Boxes

Tool settings dialog boxes are not palettes, but they can be
accessed from either the Toolbox or the Info Box palette
and are best discussed here. They contain the group of
settings that define the appearance and parameters of the
elements each tool draws.
There are several ways to open a tool's settings dialog box:

- Double-click the tool icon in the Toolbox.

- Click the tool icon in the Info Box.

- Press the left arrow key on the keyboard.

- Choose Edit/(Tool) Settings.

- Click an element with the right mouse button (Windows)

or hold down the Control key (MacOS), and choose the

(Tool) Settings command from the appearing Context
menu.

1l wall Selection Settings x|
F averites

~ @4 Geometry and Positioning
=

L B =

Selected: 1 Editable: 1

ta Project :
Zero o ) I'3 aaa
- % Floor Plan and Section
Solid Line 3
— | ] |
7////% D concrete block ’| “EW Jee _’_I
%
L ACTRR
= Use Line & Fill Colors of Composite
= Use Backaround Colors of Composits
- & HModel
[ Cedar Board EER l! oa ||
f) 1 CedarBoad =R E
ﬁ* [ whitewash [ Lag Details.. |
wiallistimmed by one or more roofs Urda Foof Tiim:
Custom Texture Grigin defined in the 30 Window. Heset Texrture rigin
»  =p Listing and Labeling
£ @ walk Extenall g Cancel | o |

The settings for each tool are organized into several panels
that can be opened or closed individually by clicking the
caption of the panel.

[l wall Selection Settings x|
Favorites.. Selected: 1 Editable: 1
» @ G y and Pasitioni N
» P, Floor Plan and Section a3
> A Model

» — Listing and Labeling

£% @ Wals EdtemnalN v

Cancel | oK I

The title bar of the dialog box displays the type of the element
and whether you are viewing Default settings or those of
Selected elements.

To prevent crowding of dialogs when opening new panels,
use the checkboxes in Options/Preferences/Dialog Boxes
& Palettes to have the program automatically close the
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previously opened panels and/or move the dialog box
upward on the screen.

You can customize the number and order of the tool settings
box panels with the Options/Customize menu command. See
Chapter 6: Program and Project Customization for details.

Navigator and Navigator Preview

The Navigator and Navigator Preview are two separate
palettes that facilitate navigation inside the project. Both of
them appear on the left side of the screen by ArchiCAD
default.

F 5
fb.| IE [ 0. ¢round Floor Go |
Froject bap | View Sets |

Lo 3 (0. Ground AI

B
gl ._J_ _I 102 % _.I

Plan: 0. Ground Floor
- Wiew Settings:

= Layercomb.  Custom L4 I
@ Scale 1:100 » I

The Navigator palette has three modes: Navigator, View
Editor and Publisher. You can change modes by clicking the
house icon in the top left corner of the palette.

- In Navigator mode , you get an overview of the
project structure and can instantly access stories, sections,
elevations, detail drawings, 3D views, lists and other text
windows;

- In View Editor mode IEE, you can manage view options
for easy access to typical drawing types like architectural,
HVAC, or office furniture setup and define a set of
construction documents that can be exported to PlotMaker;

- In Publisher mode @, you can publish view sets by
saving, uploading, printing and plotting them.
The Navigator Preview palette:
- Shows a preview of the selected item in Navigator. If no
item is selected, a small view of the front window is shown;
- Allows you to zoom to different parts of the contents of
the front window;
- Sets up 3D projections.
The visibility of the Navigator and Navigator Preview
palettes can also be controlled by clicking the corresponding
buttons JE&[& on the bottom scrollbar of the Floor Plan,
3D and Listing windows.
The Navigator disappears from the screen when you click on
the work space. To keep it permanently visible on the screen
during your work, you can fix it by clicking the Pin [@ icon
in the top right corner of it.

See Chapter 3: Project Organization and Navigation and the
Publisher function in Chapter 9: Collaboration and
Connectivity.

The 3D Navigation Palette

This palette is only available when working in the 3D
window. It lets you:

- navigate in 3D space in real time;
- switch among projection and navigation modes;
- place and edit Cameras and animation paths.

x| Editing-Maticn Maticn Mads

il o] [ @l

Look ta Reset

B HE plal =

See also 3D Image Setup in Chapter 3: Project Organization
and Navigation.
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Additional Palettes

In addition to the main palettes presented above, there are a
number of additional palettes used by specific ArchiCAD tools
and functions. None of these palettes is displayed by default;
they can be shown or hidden with the appropriate commands
of the Window menu.

- The Favorites Palette contains the list of preset combinations
of tools and their settings that can be recalled at any time.
Favorites are presented in Chapter 4: Element Creation.

- The Mark-Up Palette contains the Entries that mark
elements of your project with a color highlight for correcting
mistakes or managing design suggestions. Project Mark-Up is
presented in Chapter 9: Collaboration and Connectivity.

- The Status Report floating palette shows you the names
of the Library Part files that present problems and the
download status of web objects. The palette automatically
appears when you open a project whose library set is not
fully loaded. See also Chapter 7: Library Management.

- The Selections palette allows you to store and recall any
selection, rename and delete a selection or sort added
selections. See Selection in Chapter 5: Drafting and
Editing Techniques for details.

- The Quick Layers palette houses controls for setting the
states of layers without having to open the Layer Settings
dialog box. See Layers in Chapter 3: Project Organization
and Navigation.

- The Element Information palette displays information
about the dimensions of element(s) selected on the Floor
Plan. See Chapter 10: Project Data Calculation.

Pet Palettes

Pet Palettes are displayed automatically during drafting and
editing operations. The palette can either continuously follow
the cursor's movement, or always jump to the last used
position (you can set this feature in the Options/

Preferences/Dialog Boxes & Palettes dialog box). The
palette is automatically closed when the operation is finished.
The actual contents of the pet palette depends on the type of
the selected element, the current window, and whether you
have clicked an edge or a node of the element.

&= lessky

- PR

For example, you can use the pet palette to:

- draft or edit polygonal element contours;

- drag entire elements or element nodes;

- stretch elements horizontally and vertically (in 3D only);
- rotate, mirror, elevate and multiply elements.

Clicking the last icon of the palette, representing a slab and an
arrow, allows you to alternate between transformation and
modification methods.

The operations that can be performed by using the pet palette
are detailed in Chapter 4: Element Creation and Chapter 5:
Drafting and Editing Techniques.

Menubar and Context Menus

The Menubar is displayed on top of the screen. All menus
are visible at all times, but the contents of individual menus
can change according to the currently viewed window and
the availability of Add-Ons. Commands that are not available
in certain situations are grayed out in the list.

Context menus can be displayed by clicking a selected
element or in empty space in construction windows, Section/
Elevation and Detail Drawing windows or a selected item in
the Navigator palette with the right mouse button (Windows)
or while holding down the Ctrl key (MacOS).

Context menus always contain commands that are relevant
to the given element or situation.
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Line Selection Settings

Select & Activate Tool
% cut

) Copy

27 1g 2 Clear

), Zoom to Selection

¥ i Drag

&+ Rotate

{p Mirror

i Mukiply. ..
Display Order

§ Lovers

{# Trim to Racf...

Trim Zore. ..

30 Window

mEcale 1100 3

£
[EE [@

Prajact Map |View sete|

Rebuid Al Model 5/E's From Madel
Rebuid Al Drawing S/E's from Model
Rebuid Selected From Mode!

In the Windows environment, a Toolbar can also be
displayed under the Menubar, including a wide range of
shortcuts for frequently used commands and actions.

Fle Edit Tools Options Image Calculate Teamwork Display window Extras Help

IpEEgBr ®loc|ieBlaa|irTreFEkE i tenpndaa D

Section settings. .

I — |
Flan: Sections/Elevations
- View Settings:

S Layercomb. Custom  F

Note: Both the shortcuts assigned to the menu commands
and the Toolbar can be customized to your current needs
as detailed in Chapter 6: Program and Project
Customization.
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Chapter 3

Project Organization and Navigation

ArchiCAD is optimized to simulate and improve on the traditional environment needed for the development of an architectural
project and the production of presentation and construction documents. This chapter describes the implementation of some
basic architectural concepts and the special automation tools that speed up daily work.

The following concepts are covered bere: Scale, Origins, Coordinates, Construction Grids, Elevation Values and
Reference Levels, Layers, Stories, 3D Image Setup and Project Navigation .

Scale

Traditional concepts of architectural scale (for example
1:1000, or 1/4" =1") do not apply to ArchiCAD, because you
are building a real size digital building. If you rescale your
document, only the relative size of fixed (or paper) size
elements like text or vector hatch patterns changes, as
compared to the construction elements, which have been
defined in world coordinates. See details later.

After setting a scale, what you see will be a preview of the
Project if printed or plotted at that scale. To see a REAL
preview, not a zoomed one, choose Display/Actual Size
after setting the scale. Alternatively, you can click the button
displaying the current zoom level next to the one showing the
current scale at bottom left of the worksheet. Actual Size is the
equivalent of the 100% value.

ﬁlchenme * 1240 m2
0.3
A s 08 m2 / /
| I
,4;\{ 7

T T oo || qwns [ |Q+| & (Fraleiosid 1|
To set the scale factor for the Project, choose the Floor Plan
Scale command (Options menu) or click the shortcut at
bottom left of the worksheet.

lll Scale (Floor Pla 51 B3| [ LLL Scale (Floor Pla 2]x
40 = 10" = Custom =
' Custom
1: 11

ot | [5] | =3, H

1.50

You can select either a standard scale from the pop—up menu
or you can type a special, nonstandard scale into the text
input field.

Standard scales are shown according to either metric or US
standards, depending on the Length Unit setting made in the
Options/Preferences/Working Units & Levels dialog box.

Wl preferences 2lxl
IWolkmg Units & Levels j << Freyious I MNest »» |
£2  Length Unit: I meter
Decimals:
centimeter |
. millimeter
e Angle Unit:
Decimals: feet & fractional inches
feet & decimal inches |
P ey decimal feet
fractional inches [
decimal inches
Reference Levels

When choosing the menu item in a Section/Elevation or
Drawing Detail window, its name changes to Section Scale
or Detail Scale. You can change the scale separately for every

Graphisoft ArchiCAD User Guide

25



Chapter 3: Project Organization and Navigation

window. The name of the given window is displayed in the
caption of the dialog box.

Il 5cale {D Sectiol 2 Bl 5cale (D01 ) 2

15 - |1 100 -
1. |E 1. |
Cancel | Cancel |

Note: If you change the drawing scale, the current view
will change accordingly, and the current magnification will
remain constant, i.e., fixed size elements will appear
unchanged on screen. To return to the previous view of
the window, choose Display/Previous Zoom.

According to their behavior at different scales, there are two
types of elements in ArchiCAD.

Scaled elements are rescaled according to their real size
whenever you change the Project scale. Scaled elements
include all construction elements such as walls, objects, slabs,
etc.

Fixed Size elements are printed or displayed on the screen
at the size you specify regardless of the scale selected for the
Project. For elements that do not have any real size such as
text blocks, dimensions and arrowheads, you can specify a
fixed size defined in either points or millimeters.

;o '-W—Uﬂc
— W-01 f—W-03 He—W-01 t— =03
g o yW-02
i ST 2 I [ A RN e R T L S (e A L= N e R L [

The ArchiCAD Print and Plot dialog boxes allow you to
specify an output scale each time you print or plot your work.
You can also choose whether or not you want the program to
reduce or enlarge fixed size elements as the drawing is
reduced or enlarged according to the ratio of drawing scale

and printing scale. In most cases, scaling is the recommended
choice. See Chapter 13: Printing and Plotting.
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Drawing Scale: 1. 100 Sheet Lapout:

Plotting Scale: 1. |50

Dashed and symbol line types as well as vectorial and symbol
fill types can be defined as either fixed or scaled. You can set
this characteristic for each line type or fill pattern in the Line
Types and Fill Types dialog boxes (Options menu). These
settings are valid for the whole Project and cannot be changed
for individual construction elements.
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The 2D Symbol of GDL Objects can be sensitive to the current

scale. See in particular Windows, Doors and Stairs in Chapter
4. Element Creation.
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Origins
All ArchiCAD drawing is performed in an invisible two-

dimensional coordinate system. Like in any coordinate
system, all measurements are made in reference to an origin.

ArchiCAD defines three coordinate system origins:

- The Project Origin is a constant location which remains
fixed for the life of your Project.

- The User Origin is an aid to drafting and measurements.
The User Origin can be moved to any location, allowing
you to “reset the zero point” to any location. This is often
helpful when you need to draw elements with respect to
existing walls, slabs or other components.

- The Edit Origin appears only during drafting and editing
operations and is used to display the distance and angle of
a rubberband line from the starting point of a drawing
operation.
In Floor Plan and other 2D views, the origin is always marked
by a bold X called the Origin Indicator, while in 3D, the User
Origin and the X, Y and Z axes are displayed with bold black
lines. The lines are 1 meter (approx. 3 ft.) long.

When you move the origin by specifying a User Origin or by
drawing a new element, the Origin Indicator is relocated to
show the new origin.
Note: When a User or Edit Origin appears, the Project
Origin remains visible in the same color as the
construction grid.

T,

AR

By default, the Project Origin of the coordinate system is close
to the lower left corner of the startup screen.
There are two ways to create a User Origin:

- At any construction node by using the keyboard. Hold
down both the Alt and Shift keys while moving the cursor
to the construction node where you want the origin
located.

w

rrr o Y

MY,
(i

- At any location by using the User Origin button from the
Coordinate Box. This method allows you to move the
origin where nothing is currently drawn.

= -6000
¥: 12000

i

Click the User Origin button, then click at any point in
the worksheet. The origin is instantly relocated there.

In 3D, you can place the User Origin at a different elevation
by clicking on an element surface (this is only possible in
Hidden Line or Shading mode). Clicking in blank space
moves the Origin without changing its elevation.

Graphisoft ArchiCAD User Guide
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Note: The User Origin cannot be moved to preceding
nodes of an element presently being constructed.

To return the origin to the Project Origin, double-click the
User Origin button. Alternatively, in a 2D window, you can
also select the current User Origin with the Arrow tool (or
by shift-clicking it when any other tool is active) and press the
Delete key.
In 3D, the User Origin is more significant than on the Floor
Plan:

- If Gravity is Off, its elevation determines the elevation of

new elements.

- In the Coordinate Box, Z values can be measured from
the User Origin.

- In the tool settings dialog boxes, elevation values refer to
the User Origin rather than the current story.

1l Beam Default Settings
x Z: 895 I
| to Project Zero IV« Project Zem
1st Reference Lavel
2nd Reference Level

Favorites..

~ @@ Geomely and Positioning
-
==y (400
User Qrigin <y 1 0

to Praject i
EE N Sha
» 1 Floor Plan

i Section

b
» @ Model
» {5 Hole

» = Listing and Labeling

The Coordinate System

The ArchiCAD coordinate system is defined by the Origin (as
seen in the previous section) and the coordinate values
displayed in the Coordinate Box. The Origin is always
interpreted as (0, 0).

x: 0 IKAI:U
¥: 0 a: 0.00°

The Coordinate Box provides you with information about
your location in the current worksheet window. It displays the
Cartesian and Polar coordinates of the current cursor position.
You can toggle between Absolute and Relative coordinate
value display during drafting or editing by clicking its Delta
(A) icons.

"

x: 6104 E Lr: 7294 x| = 0
¥: 5005 a: 39.35° *| to Project Zera i}

[
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- Absolute values show the horizontal, vertical, radial and
angular distance of the cursor from the Project Origin or a
User Origin but never from an Edit Origin.

x x: S07E ;5172
x| ] [ 4 5 e —

- Relative values show the horizontal, vertical, radial and
angular position of the cursor relative either to the Project
Origin, to a User Origin before any element is begun, or to
an Edit Origin once a drafting or editing process is under
way.

x s fix: 0 Arz o
i | e +, F ty: 0 |F a: 336.56° |

In general, viewing Absolute Cartesian and Relative Polar
coordinates provides the most information, and is the most
useful under normal circumstances.

x o | x: 4801 Ar: 0
' & : +’ ﬂ ¥ 543 |E a- g .9z" ‘

With a well chosen User Origin, Absolute Cartesian displays
your position relative to important locations in your Project,
while Relative Polar values show the direction and length of
elements as you draw them.

The Grid System

Two grid systems are provided to help you put ArchiCAD’s
accuracy to work: the Construction Grid and the Snap
Grid.

Like the printed grids on traditional graph paper, these
ArchiCAD grids add a visual orientation and sense of scale to
the Floor Plan worksheet and the Section/Elevation and Detail
Drawing windows. Grids are not available in the 3D Window.

- The grids can be set up to reflect the layout and level of
precision that is meaningful to your Project. You can also
add a rotated or skewed grid for special alignments.

- The grids can be used for attracting the cursor (snapping).
This allows you to create a precise graphic alignment of
elements at consistent lengths and distances.

- The grids can easily be turned on and off as you draw, so
you can use them as the situation requires.

Note: You can also create, place and use custom local
structural grids of different sizes and shapes using the Grid
Tool command from the Tools menu. These grids are not just
drafting aids; they are an integral part of the documentation.

Defining the Grids

To define the Snap and Construction Grids, choose the
Grids & Background command in the Options menu.

W Grids & Background x|
i~ Constiuction Grid
i hain Grid Au Brid
" Spacing: Steps: Spacing: Steps:
E29 Coo lo lo
B [am § a0 [o

—Skewed Grid Snap Grid
s Local Origin I Spacing:

% o N En

E [FE

Fiotation Angle

i 4500
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Note: All the values in this dialog box are based on the
current measurement units defined in Options/
Preferences/Working Units & Levels.

The Construction Grid is used to reflect any characteristic
spacing of your Project. The Construction Grid could also be
used to define the foundation footings or the column grid of a
building.

The Construction Grid can be enhanced with an Auxiliary
Grid, which is also visible on the screen. The Auxiliary Grid is
often used to indicate the thickness of concrete walls or
foundation footings.

The Construction Grid is normally visible on the Floor Plan
Worksheet, but you can turn it off with the Grid Display
toggle command in the Options menu. Note that in this case,
it will also disappear from the Grids & Background dialog
box.

The Construction Grid can be printed or plotted with the
Floor Plan (see Chapter 13: Printing and Plotting).

2=
Platter: CalComp 55436 4.07
Copies:
Destination: = Plotter " File ~ Spool Folder
Plat with... ! Calor ! Graysoale ¥ Black & White
Text & Markers: " Fix Size (" Resize to Plotting Scale
Plot Giid & No © Yes AT | |

The Snap Grid, on the other hand, is an invisible grid that
can be used to define the smallest unit of measurement
relevant to your Project. You can set the horizontal and
vertical Snap Grid increments independently, allowing you to
reflect the unique geometry of your Project.

The Grids can be defined separately for the Floor Plan
worksheet and any individual Section/Elevation or Detail
Drawing window. Note that, in Floor Plan view, the same
Grid settings will be used for all Stories.

I E|

T
5% | v QY @& @leq)ield | AP

Defining the Construction Grid

Horizontal and vertical spacing can be independently defined
for the construction grid in the Spacing and Steps edit boxes.
The Construction parameters are used as follows:

- Spacing values determine the distance between grid lines.

- Steps indicates the number of repetitions for the spacing
pattern. If you enter 0 in any of the Steps field, you disable
the corresponding grid line.

- The Main Grid Step value is followed by the Auxiliary
Grid Steps, then the pattern is repeated. The auxiliary grid
spacing can be used to create periodic or stepped grids.

The sample window on the right displays a preview of the
grid. Below this area, the percentage box and the Zoom In-
Zoom Out icons work the same way as the zoom controls at
the bottom of the worksheet. The only difference is that while
you need to double-click the Zoom In/Out icons of the
worksheet to get a double magnification/reduction, a single
click will do the same here.
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To define the grid, enter values for Main Grid and Auxiliary
Grid Spacing and the number of Steps. Click the preview
window to update the sample grid.

(N

Defining a Skewed Grid

Two controls appear at the bottom of the dialog box to help
you set up and use a Rotated or Skewed Grid. They also
have their equivalents in the Coordinate Box.

To set up the Skewed Grid in the Grids & Background dialog
box, use the controls in the bottom left area. You can specify
here a Local Origin that is different from the Project Origin, as
well as a Rotation Angle.

Skewed Grid
s Local Origie

@
N —

Fiotation Angle

4500

You can also define the Skewed Grid's angle graphically.
Close the Grids & Background dialog box and activate the
Coordinate Box. Click the second button from the left to
enable the feature.

I ]
You can now draw a vector on the Floor Plan that will serve
to define the angle of the Skewed Grid relative to the
horizontal axis. You can use all construction aids to do this,
including coordinate constraint, as below.

x: 4861 ||§I 4584 HE
y: 0464 a: 5687

yiize e x|
The control that actually enables the Skewed Grid is located
below the Snap Grid area in the Grids & Background dialog

box. Clicking the second button from the left activates it. The
same control appears in the Coordinate Box.

ved Grid Shap Grid |

! Lacal Origin; + Spacing:
[ L g
Backgraund:
Jo = ——

station Angle:

26,00

'X,% fPat Cancel iil .p" ﬂ :

Note: When using a transformed grid, Mouse Constraints
and coordinate values are calculated according to this
coordinate system. See also Mouse Constraints in Chapter

5: Editing and Drafting Techniques.

Defining the Background

Below the preview area of the Grids & Background dialog
box, the Background button controls the color of the
worksheet. It shows a sample of the current color. Double—
clicking the button will open the Edit Color dialog box in
which you can select a color.

The Grid Lines button works the same. Note that the color
you select here will also be used for the dimmed Project
Origin when it is temporarily displaced.

Graphisoft ArchiCAD User Guide
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Controlling the Grids

The Grid Snap function allows precise graphic alignment of
elements at consistent lengths and distances. When the grids
are active, the cursor can only draw from one grid intersection
to another. This allows you to position the cursor accurately,
even at low zoom levels.

To activate Grid Snap, you can choose the Grid Snap
command from the Options menu or select the Snap On icon
in the Coordinate Box or in the Grids and Background
dialog box. When grid snap is active, it restricts the movement
of the cursor to Construction or Snap Grid nodes. A small dot
jumping from grid-point to grid-point indicates the current
cursor position.

FRIEE

The Grid Snap command acts as a toggle between the last
grid type used (Construction or Snap) and no grid snap.
When the command is checked, Grid Snap is active. When the
command is unchecked, Grid Snap is disabled.

You can suspend or activate the grid snap feature by pressing
the S key.

When either Grid System is activated, the cursor moves from
one grid intersection to another. Since there are times when
you need to disable this feature (for example, to position a
piece of furniture at a non-grid location), it is easily turned
On or Off.

Displaying the Grids

You can show or hide the Construction Grid lines by clicking
the X icon at the bottom of the Grids & Background dialog
box. The grid instantly disappears from the preview and,
when you click OK, from the active worksheet, too.

Background Giid Lines

I
' Cancel

You can also achieve the same effect with the Grid Display
toggle command in the Options menu.

Note: The grid is automatically hidden if it would be too
dense on the screen, that is, if the smallest distance
between two adjacent grid lines would be smaller than 3
pixels.

Elevation

ArchiCAD offers several ways to determine the elevation of
elements and to set the height at which the new elements
should be created.

- In the Coordinate Box, you can choose whether to display
elevation values from the Project Zero, the current Story (or
in 3D, the User Origin) or one of the two optional
Reference Levels defined in Options/Preferences/Working
Units & Levels.

PRI

x: 10381 E Ar: 10EBL x| =0 |
¥: 2525 a- 1267 *| to Current Story l% Project Zero

+ Curtent Story
13t Reference Level
2nd Reference Level

b4

- While dragging the pointer over a slab, roof or mesh
surface (provided that the corresponding Gravity icon is
active, see below), you can monitor the changes in
elevation (Z) values in the Coordinate Box. When several
slabs, roofs or meshes overlap, the highest elevation value
is displayed.
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z: 0
to Current Story

i z: 200
| ‘ [—‘5| to Current Story ]

+

- In 3D, the Z field of the Coordinate Box also displays the
elevation of any element hotspot the cursor currently
touches.

3| = 000
S| =z H| to st Reference ]
*| to Project zera i)

L2

L7

- The elevation of the element to be placed is displayed in
the Info Box. If you define an offset in the Info Box, the
elevation is automatically calculated, and the element will
be placed at the displayed elevation.

Gravity

Gravity helps you place Wall, Column, Beam and Object type
elements relative to the elevation of a Slab, Roof or Mesh. The
corresponding icons are located in the Coordinate Box.

+

.

SRS R e ey
- With the first icon, newly created elements will be placed
relative to the current Story’s 0 level (Floor Plan) or the

current User Origin (3D Window).

to Ctfent Story

- With the next icons, newly created elements will be placed
relative to the Slab, Roof or Mesh beneath them.
Notes: Gravity only affects newly created elements and
cannot be used for editing existing ones. To measure
elevation values, activate the Slab, Roof or Mesh tool and
switch Gravity on.

Reference Levels

You can define two optional Reference Levels that will help
you position elements. This is done in the bottom section of
the Options/Preferences/Working Units & Levels dialog box.

I ‘whorking Units & Levels j << Previous I Mext»> |

22 Length Linie [[milimetar =l
Decimals: o -

25 Angle Unit: I decimal degrees j
Decimals: 2 -

Angle & Text Size Decimals in Dialog Boxes: 2 -

FReference Levels Elevation Relative to

[2nd Reference Level 2000

1t Reference Lewel 1000

Project Zera il h 4

Select a level’s name and modify it as you like, then type the
value you need in the Elevation field. The elevation marker
symbol always shows the zero value inside this dialog box
only. You may find it easier to calculate levels by switching
the zero value to another level than Project Zero. You can do
so by simply clicking in the Relative to field next to the
level's name.

Fielative to

e

Note that Reference Levels are display and input aids only.
Changing their value has no effect on placed elements, as
their actual elevation is always calculated from Project Zero.

Feference Levels Elevation

2nd Reference Level 1000
15t Reterznce Level | [
Project Zero -1000
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Elevation Control in 3D

Before you start drawing an element in 3D, set the controls
and settings to make sure that the element will be inserted at
the right elevation.

With Gravity On, Walls, Columns, Beams and Objects will be
positioned on top of the Slab, Roof or Mesh surface you click.
Elements of other types will have a “transparent” behavior,
i.e., the click will poke through Walls or Objects and find the
first Slab, Roof or Mesh surface.

The Z field in the Coordinate Box is locked to the elevation of
the Slab, Roof or Mesh, and so is the bottom elevation value
field in the Info Box.

e .

10815 dr: 12241 i | =200
5204 |F a: 30 54° ‘ S| 1o Project zere b |

With Gravity Off, the elevation of the User Origin is the
principal factor. Move the User Origin at the desired height,
and in the Settings dialog box of the Tools, set the elevation
values as desired.

The Z field in the Coordinate Box will display the elevation
of the User Origin, while the Info Box displays the top and
bottom elevation values of the element you are about to
create. You can specify an offset from the User Origin by
defining the value for the Z coordinate.

Note: The elevation of wall openings is strictly determined
by the current values in the Door and Window Settings
dialog boxes, and is always measured from the bottom of
the clicked Wall.

Elevation and Stories in the 3D Window

The 3D Window always displays the range of Stories defined
in Image/Elements to Show in 3D, and there is no visual clue
as to which elements belong to which story.

New elements are always added to the story within the range
that best matches their elevation. This means that:

- If the contents of the 3D Window was defined either by
explicit selection (in most cases, the Arrow tool) or a
single-story Marquee area, then all new elements will be
added to the current story regardless of elevation.

- If multiple stories are displayed, then new elements within
the range of a displayed story will be added to that story,
while elements placed very high or very low will be added
to the top or bottom story of the displayed range.

Note that this only applies to new elements. Existing elements
will always keep their story, regardless of the vertical
adjustments made in the 3D Window. To move them to
another story, you need to activate the Floor Plan Window,
cut them from one story and paste them to another.

Stories

Stories provide a physical separation for elements according
to the vertical level to which they belong. Each Story has its
own Floor Plan in which you place elements.

Stories are typically used for drawing each Floor Plan of
multistory structures separately. They can also be used for
separating site plans, roof plans, etc., that have vertical 3D
relationships.

- Only the current Story’s Floor Plan view is displayed for
editing, printing or saving to an external file format.

- In 3D view, all Stories are projected by default, but you
can limit the projection with the Elements to Show in 3D
command (Image menu).

- In Section/Elevation views, you can define a vertical
range that can include entire Stories or only parts of them.
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All Story functions are controlled through the Stories
hierarchical menu in the Options menu. The currently defined
Stories are displayed at the bottom of the submenu with their
elevation value. The current Story is indicated by a checkmark
in the list and its name appears in the title bar of the Floor
Plan Window.

|Optmns Image Calculate Teamwork Display Window Extras Help

ECI A N | A

Floor Plan Scale...

Display Options. ..

8 Grids & Background..,

3% Grid Snap Chrl+f
@ Grid Display
@ Clean Wall & Beam Intersections ChrH7
Layers » [k GoUp a Story CtrHe
¥ Go Down a Stary ChrHS
¥ Pens & Colors,., It ot st ot
s G0 o Story. .. th-
23 Line Types... = i
EZ. Eill Types... Show Ghost Stary
= Composites. ..
o - v 1, Story (2900
B Materials. . |— ¥ (2300)
0. Stary (0)
[E4 Zone Categories...

3 Mark-Up Styles. .,
ﬁ Attribute Manager ...

Preferences 3

Customize »

The commands of the Stories hierarchical menu allow you to:

- Define the Stories that make up the vertical structure of
your design;

- Determine which Story is currently displayed in the Floor
Plan worksheet;

- Display as a "Ghost Story" the elements of another Story in
Floor Plan view.

Defining Stories

The Story Settings... command displays the Stories dialog
box. This is where you will define the vertical structure of
your Project.

Il Story Settings 2=
Mo. Mame Elewation Height to Mext
* 3 Roof 10,125 3375 =
. 2 Second Floor 6,750 2375
. 1 First Floar 3,375 3375
round Floor Jo.ooo | EIE ]
. -1 Foundations -3,000 3,000
[
Inzert Above | Inzert Below | Delete Stary |
[~ Show Ghost Story I Below Current Stary - Options..
—Edit Elements of Selected Stopy———————————————— Event List
Cut &1l | &l Types - ﬂ
Copy Al | wall Tool
£ Column Toal
Clear Al | =] Betam Tool
% Object Toal
Affects all @ Larrp Toal
layers, even Slab Taal
hidden and 9‘ Ha fTDDI
¢ Roof Tool
s | Pl @ &
Paste Selected Tupes
i | Cancel | Ok I
"

The upper section of the dialog box offers a scrollable list of
the current stories in your design. When starting a new project
from scratch, you only have a single story, but if you are using
a template, the file may already contain a predefined story
structure.

- To add a new story, click the Insert Above or Insert
Below button;

- To clear a story, clicking the Delete Story button.
Warning: Deleting a Story also clears all the elements that
are placed on it.

The new story appears above or below the selected story. The
numbering is automatically updated. There is no limit to the
number of stories.
Note: The ground floor is Story number 1 (US version) or
0 (International version).

To activate a story, select it in the list and click OK. The Floor
Plan sheet will show this selected story.
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When the name of a Story is selected, you can edit its Name,
Elevation (to Project Zero) and its Height to the Story above.
The Number field is not editable manually.

Changes to story height and elevation are interpreted
differently:

- If you modify the height of a story, this will affect the
elevation of all stories above (if the story number is
positive) or below (f the story number is negative). In
practical terms, you stretch or shrink the whole building
by making the height of a story larger or smaller. The
height of all other stories remain as they were.

- If you modify the elevation of a story, this will affect the
beights of the stories immediately above and below. In
practical terms, you move the level of a single story while
keeping the rest of the building static. The elevation of all
other stories remain as they were.

When creating a new Story, you may wish to copy to it
elements that already exist on another Story. In addition to the
standard Cut, Copy, and Paste commands of the Edit menu,
you can move all elements belonging to a given type in one
step with a special function inside the Story Settings dialog
box.

—Edit Elements of Selected Stary
Cut &ll | All Types O =
Capy All Dl wiall Tool O
8 Column Tool O
Clear &1 | @ Beam Tool O
Jle  Object Tool
Affects all #Z Lamp Tool
layers, ewven
ey, l:‘-/! Slab Tool O
losked anes. izl FRoof Todl O =l
PV —
Faste Selected Tupes |

The elements or items to be pasted (placed) are selected by
checking the box in front of the name of the tool that created
this type of element. To select all elements, check the All

Types box.

- Clicking the Cut All button removes all the selected
elements from the story that is selected in the list.

- Clicking the Copy All button creates copies of the
selected elements of the story that is selected in the list.

- Clicking the Paste Selected Types button pastes all the
cut or copied elements on the story that is selected in the
list (do not forget to switch stories before this operation).

- If there are already some elements on the target story and
you wish to remove them first, select that story, check the
appropriate element type box and click the Clear All
button, then paste the new ones.

These operations are not actually performed until you confirm
them and exit the dialog box. The Event List next to this area
shows you the story editing steps you have taken. When you
click OK, a final prompt will ask you to confirm that you want
to proceed with the operation.

Defining a Ghost Story

The Ghost Story option allows you to display the elements of
another story on your Floor Plan Worksheet behind the story
that you are currently working on. This function is accessible
from the Story Settings dialog box.

s I [ — I e |

v Show Ghost Story Eelow Current Story - Options.. |

X [ &bove Curent Story -
Edit Elements of Selected Stary t List

cwal | AT -
3. Story
Capy Al | sl = Story
@ Calu 10 gtow
| atory
Cesal || Eeal LT
Wy Dbl -

You can only show one Ghost Story at a time. The pop-up
menu lists all the stories available in your current Project. You
can either choose a given story or the story right above or
right below the current one.

Clicking the Options button opens a subdialog box with the
element types available to show or hide on the Ghost Story.
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You can also choose here the uniform color that will be used
to display all ghost elements.

0.000 3375 1. [ e =
2,000 2,000 Il Ghost Story Options 2lx|
= Ghost Story Color: I
gt Below | Delete Stoy | Show Elements:
-
All Types O =| F
Ewent List ‘wal Tool O I
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O " Radial Dimension Taol O \
O LI o | Level Dimension Tool O
= = | omet Angle Dimension Tool O
+ T | -
VpES Cancel | ok A TewtTool O _I o
Cancel | oK I y
A

Once the Ghost Story has been defined, you can also switch
its display on and off with a toggle command in the Stories
hierarchical menu.

The elements of the Ghost Story can be seen and snapped to.

If you click on such an element, a message will appear to
inform you that this element is inactive in the current view.

Thiz elerment is inactive in this
[view.

*

You can print the elements that are currently visible on the
Ghost Story by checking the appropriate radio button in the
Print dialog box.

Print: " Entire Drawing (% Current View Only

Text & Markers: ' Fix Size * Resize to Printing Scale
Print Grid: & Mo © Yes

Print Ghost Stary: = Mo * es

Drawino Scale:  1:100 Sheets ta Print: 1

Ghost Story elements cannot be:

- selected or edited
- plotted

- saved in any 2D format

Note: You can also show single elements of some types
(Beams, Objects, Lamps, Stairs, Slabs, Roofs, Meshes) on
more than one Story by activating the appropriate control
in the given element's settings dialog box or the Info Box.

Bl slab Default Settings x| k|
Favorites... | Default Default Settings @
¥ (@3 Geometry and Positioning

=i = @
ftiyis o200 ¢[00

o Story 0 —Fp 2,700
<o d oo

to Project Zera |

Pe— |u,uuu Show an:

Current Story Only

- B Floor Plan

E Solid Ling

One Story Up
One Stary Dawn
One Story Up & Down

Al Stories

Current Stary Only

One Stoy Up
Ore Story Diawn
Ore Story Up & Down

Each Stay

Activating Stories

In addition to selecting a Story from the Story Settings dialog
box, you can use the Navigator palette (see later in this
section) and commands from the Stories hierarchical menu.
The Go Up a Story command activates the next Story above
the current one on the Floor Plan, while Go Down a Story
takes you to the Story below the current one. If Autosave is
On in the Preferences, this command triggers an Autosave.
If you attempt to go to a story that does not exist, an alert is
displayed asking you whether you wish to create a new story.
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Il Attention! [ %]

& This Stary does not exist yet.

Cance|| {Creaie Siory:

The Go To Story... command opens a dialog box allowing
you to jump directly to an existing Story and provides you
with a range indicator of how many Stories currently exist. If
you enter a Story number outside the existing range, the field
will revert to the top or bottom Story of the valid range.

Il Input an Integer [ 2] x]

n
Cancel |

Goto story: [1...8]

Each story defined in the Stories dialog box is displayed in
the story list at the bottom of the hierarchical menu with its
Name (or serial Number, if no Name has been defined for it),
as well as its Elevation to Project Zero. From this list, choose a
Story to display in the Floor Plan window.

Layers

While plans are drawn on Stories, each element of the plan is
placed in a particular Layer. Layers are global, which means
that the same layers are available on all stories and in all
worksheet windows.

Layers are analogous to pin-registered overlay drafting and
provide a “logical” separation of elements. Related groups of
elements, such as dimensions, furniture, electrical symbols
and so on, are placed on common Layers. Since each tool has
a default Layer assignment, elements are automatically placed
on separate Layers when using the tool.

You can also show or hide each Layer depending on what
you want displayed, saved to an external file format, printed
or projected in 3D. In 3D only, elements on certain layers can

appear in wireframe form. It is also possible to lock Layers in
order to prevent certain elements from being selected or
modified.

To automate the process of displaying and locking layers, you
can store various setups in Layer Combinations and then
choose any of these by name from the Options/Layers
hierarchical menu.

All Layer functions are controlled through the Layers
hierarchical menu in the Options menu. The currently defined
Layer Combinations are displayed at the bottom of the
submenu. The current Layer Combinations is indicated by a
checkmark in the list. Some of the commands are also
accessible from a floating palette (QuickLayers) shown at the
bottom of the illustration below.
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Note: Layers and Layer Combinations are handled by
ArchiCAD as attributes. See Attribute Management in
Chapter 6: Program and Project Customization for more
details.
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Layer Settings and States

Choosing the Layer Settings... command in the Layers
hierarchical menu displays the Layer Settings dialog box
which has two panels: Layer Combinations and Layers.
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The dialog box uses a number of icons to indicate the
different states of Layers.

- The open fp or closed @ lock icons indicate that a Layer
has been protected to prevent its contents from accidental
modification. If a Layer is locked, the elements on it
cannot be edited or deleted and no new elements can be
placed on it.

- The open @ or closed «» eye icons indicate that a layer
(and the elements assigned to it) are currently visible or
invisible.

- The solid model [ or wireframe (@& icons indicate that the
elements placed on that layer are fully visible in 3D views
or with their contours only, independently of the current
3D mode set in the Image menu. This can be useful, for
example, for storing the operator elements of Solid
Operations on wireframe layers and target elements on
solid layers. See Solid Operations in Chapter 5: Drafting
and Editing Techniques.

- The numbers under the intersection [= icon in the Layers
panel indicate the number of the intersection group the
elements on that layer belong to. Only elements on the
same intersection level will cut or connect to each other in
3D view.

Layer Definition

Layers are created, edited and managed in the Layers panel.

To create a Layer, click the New button on the right and give it

a unique name.
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Note: Newly created Layers are not included in any Layer
Combination.

The Layer that you select in the list appears in the edit boxes
below the list field. You can:

- Modify a selected layer's name;
- Set an intersection group number in the first edit box;
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- Add an extension to the layer's name. This can act as an
additional sorting control if you have many layers.

You can sort Layers by Name and Extension by clicking the
captions on top of the list field.
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The first item on the list, the ArchiCAD Layer, cannot be
deleted, hidden or locked. This layer collects all those
elements that may have lost their layer definitions.

The icons inside the list field and the buttons on the right of
the Layers panel help you manage layer states. With the
Select All and Deselect All buttons you can select and
deselect all layers, respectively. Multiple selection through
keyboard shortcuts is also possible. All the management tools
detailed below act on selected Layers.
- Clicking the lock, eye and model icons in the list field
toggles the state of the corresponding Layer(s).
- The Lock/Unlock and Show/Hide buttons also change
the state of selected Layers.
With the Delete button, you can remove selected layers.
Deleting a layer clears all the elements on it and is not
undoable. To help avoid clearing by mistake, ArchiCAD
displays a warning prior to actually deleting the layers.

Setting Up Layer Combinations
In the Layer Combinations panel of the Layer Settings
dialog box you can define and save sets of layers.

A Layer Combination is a “snapshot” of the state of all Layers
in the Project and can be recalled at any time by selecting its

name from either this dialog box or the Layers hierarchical
menu, where they are listed by name.

If you select a Layer Combination in the list and deploy the
Layers panel, you will see that the layer state icons on the left
change accordingly.
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By selecting a name in the Layers list, you can check its state
in the various defined Layer Combinations.
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To define a new layer combination, your best choice is to start
by setting the state (locked/unlocked, shown/hidden, solid/
wireframe) of the individual layers. Use the sorting and
selection controls to set several layer's state at the same time.
You may want to first activate an existing combination that
needs only minor refining.
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When you are finished, click the New button in the Layer
Combinations panel and give the new set a unique name in
the appearing dialog box.
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To modify an existing layer combination, for example by
adding a newly created Layer or by changing the state of
some of its Layers, select it, make the necessary adjustments
and click the Update button.

The currently active Layer Combination is indicated by a
checkmark in the Layers menu. If there is no checkmark, this
means that the current layer state was achieved through
manual changes and does not correspond to any of the
predefined Layer Combinations. If you wish to save this state,
2o to Layer Settings and create a new Layer Combination
without changing the current states of the Layers.

Using a Single Layer

You can choose to place all your elements on a single layer to
simulate AutoCAD-like work. Instead of changing the default
settings made for each tool individually, choose the Active
Layer command from the Layers hierarchical menu. This will
set the default layer of all element types to the same layer. All
Tool Settings dialog boxes will use the same default Layer
definition and successive elements will all be placed on that
layer, regardless of type. You can, of course, override this
setting manually for selected elements.

|x| _hndividually set Layers
One Active Layer for all Berment types

If you wish to return to the previous layer state, choose the
Individually Set Layers option from the command's
dialog box. The last set of manually defined layers will be
used.

The Quick Layers Menu and Palette

The Quick Layers command accessible from the Layers
hierarchical menu opens another submenu with a number of
commands that help you quickly change the state of the
Layers in your Project.

- The Show/Hide Layers Toggle inverts the visibility of all
layers.

- The Lock/Unlock Toggle inverts the state of all protected
and unprotected layers.

- The Active Layer command to switch to single-layer
mode and back (see above).

- The Hide/Lock/Unlock Selections' Layers commands
invert the state of the Layers belonging to the currently
selected elements, while Hide/Lock Others' Layers does
the same for the elements that are not selected. Both
explicit selection and Marquee areas are taken into
consideration.

- The Show Quick Layers palette command displays a
palette housing all of the commands described above in
the form of buttons.

=%
3D Image Setup

In the 3D Window, you can view and edit the model under
various angles and in various modes. You will change views
and settings according to your current needs, by adding
Cameras and using the commands of the Image menu.

Selection's Layer Cthers' | ﬁl||
=

JEN " e == | |
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This short introduction presents some of the basic concepts
that are specific to the 3D Window only and do not apply by
their nature to the Floor Plan worksheet or the other views of
the Project.

Note that the 3D Window also acts as the source of the
photorealistic still images and animations that you can create
with ArchiCAD. Some of the features described below apply
explicitly to PhotoRenderings.

Projections

ArchiCAD can display parallel (axonometric) projections and
perspectives. By default, when first starting the program and
activating the 3D Window, you get a Dimetric axonometry of
the model.

Parallel projections automatically include the entire model,
while perspectives are defined by a viewpoint and a specific
target.

The 3D Projection Settings command from the Image menu
opens a dialog box that contains all the controls you need to
define the 3D view. The name and contents of the dialog box
depend on the projection type: Parallel Projection Settings
or Perspective Settings. You can easily switch from one to
the other with the button at the top right corner.

The projections that you define in the 3D Projection Settings
dialog box remain valid only until the next time you open the
dialog box and modify them. To store projections that you set
up in the 3D Window, you can:
- Save the Current View with the Navigator palette as
described in the next section;

- Place a Camera on the Floor Plan if viewing a perspective
(see Animation Controls at the end of this section);

- Add the current projection to the series of Pre-Set views if
viewing a parallel projection.

Perspectives

In the Perspective Settings dialog box, you can easily set all
the relevant parameters, such as viewpoint location and
elevation, target location and elevation, width of the viewing
cone, and sun position.
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The preview area on the left side of the dialog box shows
your Floor Plan as it currently appears in the worksheet. To
see another part of the Project, leave the dialog box, choose
another detail using the Navigator or zooming and panning
operations, then open it again.

The solid line in the preview area represents the line of vision
between the viewpoint and the target point. You can click and
drag both the target point and the viewpoint independently of
one another. Click anywhere in the preview area and the line
of vision will be rotated around the target point to your click
position.

The angle defining the View Cone is displayed in the
preview area and provides reliable information if the line of
vision is horizontal. If the line of vision is looking up or
down, the angle can be used only for estimating the resulting
view.

After zooms, pans, or numeric distance settings, the viewpoint
and/or target point may occasionally disappear from the
preview area. To retrieve them, simply Shift-click where you
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want the viewpoint and Alt-click where you want the target
point to be in the Window. They will immediately move to
the points where you clicked.

You can also numerically specify the location of the viewpoint
with respect to the target in the Distance and Azimuth edit
boxes on the right side of the dialog box, and their effects will
be displayed graphically in the preview area. (In this case, the
position of the target will remain unchanged.) The elevation
of the viewpoint and the target point, as well as the View
Cone and Roll Angle of the Camera must be set numerically
by using the remaining edit boxes.

1) For a one-point perspective, set the viewpoint and target
point elevation to the same value. Set the viewpoint
Azimuth parallel to the principal axis of the Project.

2) For a two-point perspective, set the viewpoint and target
point elevation to the same value. The other settings can
have any value.

3) For a three-point perspective, set the viewpoint and target
point elevation to different values.

4) To get a top view in perspective, set the viewpoint
elevation higher than that of the target point elevation,
drag the target to the desired location on the plan, then set
the distance to zero by dragging the viewpoint until the
numeric field displays zero. (You cannot type zero in the
Distance field.)

5) For a fast preview of projections, use the Block 3D
modeling option described below. You can check the
general look of the projections very quickly in the 3D
Window this way.

In the projection preview area, the dashed line from the
center of the area with a sun icon at its end shows the
direction of light for shaded and rendered representations.
The sun icon can be dragged around the perimeter of the
plan, but it cannot be positioned closer. Its distance is
regarded as infinite. Both its Altitude and Azimuth can be set

numerically in the edit boxes below the viewpoint and target
settings. See also Sun and Light Effects later.

Note: Cameras placed in the Floor Plan worksheet also
define perspective views, but they are configured in the
Camera Settings dialog box, not in this dialog box. You can
copy a camera’s settings here by selecting a single camera
on the Floor Plan and choosing 3D Projection Settings.
See also Cameras in Chapter 4: Element Creation.

You can also use the Navigator and Navigator Preview
palettes described in the next section to set up the 3D view.

Parallel Projections

In the Parallel Projection Settings dialog box, the
selections of the projection type pop-up palette offer a wealth
of projection options, while the preview area and viewpoint
control let you easily fine-tune a desired view.

Il parallel Projection Settings llll
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You can choose from 12 Projection types to make a view of
your Project, including predefined axonometrics, side, top and
bottom views, and your own custom-defined axonometrics.

PreSets... | More Sun... |

You can check the view given by the chosen projection type
and any additional settings you have made by referring to the
simple house in the Preview Window in the left part of the
dialog box.
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For each Projection type, the edit boxes at the top of the
dialog box show the defining angles and scaling ratios of the
X, y and z coordinate axes.
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You can create your own customized axonometry, either by

entering values for the angles and ratios of the three coordinate
axes or by manipulating the house icon in the preview area:

- To rotate an axis about the origin, click on or near it and
drag it to the desired orientation.

- To rescale and rotate an axis, click within the circle at its
endpoint and drag it to the desired position. (If you only
want to rescale, it is easier to enter a value in the edit box.)

The adjustments you make here are continuously reflected
both by the values displayed in the edit boxes, and by the
distortion of the house icon itself.

You can set the direction of your view and the position of the
sun with the controls and edit boxes to the right of the
preview area. Just as for perspective projections, the distance
of the sun from the target is considered to be infinite, and for
parallel projections the viewpoint distance is infinite as well.
Simply click the Sun or Camera icon and drag it to the
desired location. The effect of your changes is shown by the
rotation of the house in the preview area and by the values in
the edit boxes to the right of the control.
- To move the camera or the sun in 45° increments, click
once near the desired direction on either of the gray circles.
- To move them in 5° increments, drag the camera or sun icon.
- To move to any in-between position, type the desired
numeric value into the edit fields.

The Azimuth of the camera and the sun can be set either
graphically or numerically, but the sun Altitude angle can
only be set numerically.

Hint: Unless you are an experienced ArchiCAD user, it is
generally best to begin with a predefined projection from
the palette, then rotate the view with the camera angle
control, and finally make minor adjustments with the
rescaling features.

The Pre-Sets button opens a subdialog box where you can
store and retrieve settings. You can also use this sequence of
axonometric views for a future animation. Animations based
on axonometric views are not fly-throughs in the same sense
as perspectives, even though they are created with the same
command. Using in-between frames, you will get an animated
metamorphosis from one projection to the other.

Il Pre-set Projections i
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Add Current Projection... |

Set ta Curent Prajection |

Clear Cancel |

- The Add Current Projection button places the current
view on the list. The views on the list will be keyframes in
the Fly-Through. You can also name each keyframe in the
dialog box that appears after pushing this button.

- If no projection is selected, New will be added to the
bottom of the list. If a projection is selected, the new
projection will be inserted before the selected one.

- The Set to Current Projection button changes the
highlighted keyframe in the list to the one you set prior to
opening the Pre-Sets dialog box.
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- The Clear button clears a keyframe from the list.

Under Options for Fly-Through in the right section of the
dialog box you can also set the number of in-between
frames that ArchiCAD will create by interpolating between
every parameter (e.g., axis scaling ratio, camera angle,
etc.) of consecutive keyframes.

- The Open and Close radio buttons control whether the
animation will loop continuously from the last defined
keyframe back to the first keyframe during the Fly-Through.

- Wait frames have the same effect as described for the
Camera Tool in Chapter 4.

You can also use the Navigator and Navigator Preview
palettes described in the next section to choose a parallel
projection type and set up the 3D view.

Sun Direction and Light Effects

Clicking the More Sun... button in either the Perspective
Settings or Parallel Projection Settings dialog box gives access
to the Sun subdialog box for a series of more sophisticated
sunlight settings, which can be used for PhotoRenderings.
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Characteristics of light can be set in the upper part of the Sun
dialog box.
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Double-click the color box to go to the Edit Color subdialog
box. The color of directional light (with a color intensity
between 0 and 100%) can be set here.

- You can decide how much of the directional light is
represented in nondirectional, ambient light.

- Both the color and intensity of directional light can affect
the ambient light, according to the percentage specified in
the Contribution to Ambient (%) field.

As opposed to directional light (e.g., the sun), ambient light is
nondirectional and can stand as a substitute for the rich
reflected and inter-reflected light experienced in a real
environment. It can brighten otherwise overshadowed
surfaces.

Ambient light may have its own color (in a pink room for
instance) and its intensity may have to vary to obtain special
effects in renderings.
- Its color is set through the Edit Color subdialog box.
Double-click the sample color to open it.

- Its intensity can be set between 0 and 100%.

To further enhance the realism of your renderings, the
atmospheric Fog effect alters light in proportion to the distance
from your viewpoint. You can set the color of the fog by
double-clicking its sample box to access the Edit Color dialog
box. You can also set one of four levels of intensity for the
effect with the radio buttons.

(To achieve a typical misting effect, set the color to white, and
this will fade the more distant objects. To use light decay, set
the fog color to black, and this will darken the more distant
objects.)
Note: To apply this effect, make sure that Fog is activated
in the PhotoRendering Settings dialog box.

Click the Apply button to test the sunlight, ambient light and
fog settings you have made on a neutral white material.
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Click the Set City... button to specify a geographical location
by latitude and longitude, or by specifying a major city close
to your site from the scrollable list.
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- To add a new location, type into the appropriate edit
boxes its name, the exact global coordinates and the time
zone of the site, then click the Add button. The new
location now appears in its alphabetical position in the list.

- To delete a location, select the city name by clicking on it,

then click the Clear button to remove the city from the list.

In the Sun subdialog box, you can specify the date and time
of day (just below the Set City button). The +1h correction
(summer time) checkbox lets you adjust for Daylight Savings.
As a result of all these specifications, you can get the exact
direction readings of the sun, with an icon indicating if it is day
or night.

The orientation of your Floor Plan is defined by setting the
North direction relative to the floor plan’s orientation on
screen. You can drag the compass needle or type in the angle
numerically, relative to the X axis of your sheet.

If you define the sun position by defining a location with date
and time, its azimuth settings will be calculated with respect
to this orientation (where East is at 0.00 degrees).

Note: When using surveyor’s units (in Preferences/
Working Units), the North of the Coordinate Box will
be the same as the one set here.

3D Window Contents

The actual contents of the 3D Window depend on a variety of
settings and criteria.

Explicit selection made on the Floor Plan (that is, with the
Arrow tool or a selection command, but NOT the Marquee
tool) is the first priority. If some elements are selected, only
these will be displayed in the 3D Window and the caption of
the window will include the "Selection" mention as well as the
name of the active Story.
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Note: If you create new elements in the 3D Window in a
view based on explicit Floor Plan selection, these new
elements will disappear from the current 3D view after you
complete them.

If there are no explicitly selected elements on the Floor Plan,
the next priority is the state of the Elements to Show in 3D
dialog box opened from the Image menu.

In this dialog box you can select which stories and element
types should be included in the 3D Window.
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- In the Stories to Show in 3D area, you can either choose
All Stories or a continuous range of stories.

- The Element Types to Show in 3D checkboxes allow you
to turn construction elements on and off. With Doors and
Windows switched off, openings are interpreted as empty
holes. It is possible to select all element types (with the
exception of Zones) by checking a single box. Zones can
also be selected separately to appear in the 3D Window.

- If you use the Marquee tool to create a selection rectangle
prior to modeling, it can be used directly or inversely
through a third set of options. With the inverse option, you
can exclude internal elements of a house when you need
only external views of the 3D model. The Marquee can
affect multiple stories, not just the current story.

- If the Trim Elements to Marquee checkbox is checked,
the model will be clipped at the Marquee’s boundaries.
Otherwise the model will not be clipped, but all those

elements that have at least one hotspot inside the Marquee
will be displayed.

If there is a Marquee selection made in the Floor Plan, the
settings of the Elements to Show in 3D dialog box are
observed, but the caption of the 3D window includes the
Marquee mention and the range of included stories.

@ Example 3D / Marque

=1oi x|

See also the Marquee tool's description under Selection in
Chapter 5: Drafting and Editing Techniques.

3D Modes

When using the ArchiCAD's internal rendering engine, four
3D viewing modes are offered. They can be chosen from the
3D Window Settings dialog box in the Image menu or
directly as the commands of the 3D Engine and Mode
hierarchical menu, also in the Image menu.
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Elerments ta Shaw in 3D... Chel+alk+a ‘
=

3D Cutting Planes. ., ChrShiFt+¥
X 30 Cutaway ChrHY

30 Window Settings. ..

3D Engine and Mode i/ internal 30 Engine

PhatoRendering Settings > Ol
[ FhotoRender Projection Fio @
o‘? Create Fly-Through. .. F11  (f Wireframe Ctrl+Shift+HF9
A Create Sun Study... F12 [T Hidden Line ChrF9
I i e, |6 shadng Fe

If you choose Block mode, the 3D Window will show only
the blocked volume of each element without placing any
holes into them. Block is the fastest 3D display format
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available. It can only be used for information about the
placement of the elements in the Project, but it gives you a
quick way to check, for example, whether the angle of your
view is appropriate.

Choosing Wireframe mode creates a view showing all the
edges and lines of your Project. This shows much more detail
than the previous. Note that if you have many elements one
behind the other, this type of view can be hard to interpret.

In Hidden Line mode, those lines which are blocked from
view by solid objects are removed. This type of view is the
best choice for easy interpretation, if you do not want a
shaded view. It is also suitable for hard copy output on a
printer. Hidden Lines can be saved in many file formats, either
as 2D or 3D files.
Choosing the Shading method causes your 3D model to
appear with all of its visible surfaces shaded according to the
light direction set in the 3D Projection Settings dialog box.
The colors of the surfaces are determined by the material
attributes of the construction elements (regardless of the color
of light set in the Sun dialog box).
Shading is good for:

- Fast on-screen feedback,

- Easy checking of surface colors, and

- In any presentation for which photorealistic quality is not a

requirement.

The same object in Block, Wireframe, Hidden Lines and
Shading modes
Note: When using the OpenGL engine, only the
Wireframe and Shading modes are available.

The 3D Navigation Palette

The 3D Navigation Palette is only available when the 3D
Window is active. It has tools and controls to:
- change a 3D projection interactively;
- explore 3D spaces in real time (if model size and computer
performance allow);
- edit the keyframes of animation paths.
Perspective and Parallel views have specific controls.
x| Editing:-Motion Motion Mode x|

Editing- Motion Maotion Mode

Bkl afa] [+ 2| o <) Bl il || [BH @
EA0 | Sl adeal o WEA B Ble] o

[@] The Projection Mode switch in the top right part of the
Palette toggles between view types, like the similar control
button in the 3D Projection Settings dialog box.

The Editing-Motion controls include:

The Edit Mode icon represented by an Arrow-Wall-Slab
combination; with this mode on, 3D construction Tools
can be used and the elements edited.

- The Motion Tools that allow you to move around in the
3D window by changing the 3D projection.

5[]

“?‘k oggf‘.'.;:\

These Tools are different for perspective and axonometric
views and are also modified by the Motion Mode chosen
(Camera or Locked target). See details below.
The Undo button, bottom right, for undoing the last
single view change.
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Navigation Basics

Navigation is controlled by Motion Tools and Motion
Modes. There are different options for perspective and
axonometric views. Each combination of Tools and Modes
results in a different kind of movement.

Regardless of Tools and Modes, you need to click in the 3D
Window to begin moving. Click first in the center of the
image. A simplified image of the model will be displayed.
ArchiCAD will ignore contours at first, then switch to rough
Shading, Wireframe or Block modes. (Smaller models on fast
computers produce the best results for movement.)

In the middle of the image, a rectangle will appear. This is the
“neutral area”.

If you click anywhere between the rectangle and the window
border, you will begin moving. Click at the top or bottom for
one kind of movement, to the left or right for another, and in
the corner areas for a combination of the two.

Click close to the rectangle to move slowly, close to the
window’s border to move fast. To move at a constant speed,
keep the mouse pressed. Drag the pointer around to increase
or decrease speed and change directions. For extreme speed,
drag the cursor out of the 3D Window as far as your screen
Size permits.

Mowve Fast
% i '
Move Slowly
eu ~4—MHNeutral Area—W [
o By
Y

If there are individually selected elements in the 3D Window
when you start navigating, only these elements will be
displayed as you move. This feature can be extremely helpful
with large projects. It also allows you to analyze one or
several elements on their own, without their environment.
When you stop moving, the simplified image will be
displayed until you click inside the rectangle (the neutral
area) or use any of the Look To, Reset, Undo or Edit Mode
buttons. Then it will rebuild the image with the current 3D
Window Settings. In Axonometric views, it will also fit the
new view of the model to the Window.

With the Motion Tools, you can double-click the Zoom
controls at the bottom of the 3D Window and use the Fit in
Window, Next and Previous View buttons.

Clicking a Tool icon in the Toolbox while in Navigation
Mode will automatically switch you back to Editing Mode.

Navigation in Perspective
Navigation in perspective view is defined by the combination
of Motion Tools and Modes.
There are three Motion Tools in perspective views.
1) Walk
- Top-Bottom: moves forward and backward horizontally.
- Left-Right: turns around.
2) Lateral Move
- Top-Bottom: moves up and down.
- Left-Right: moves laterally to the left or right.
3) Turn

- Top-Bottom: looks or turns up and down. Range is +90
degrees; cannot turn upside down.

- Left-Right: turns around.
The two perspective Motion Modes are as follows:

[s#| Camera: Keeps the physical distance between camera
and target constant.
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Target Lock: Keeps the current target at the center of
the image. (See also the Look to buttons later.)

The following Motion Tool/Mode combinations exist in
perspective views (note that the Tool icon changes in the
Edit-Motion area according to the Mode chosen):

Walk - Camera: Walk within a building, look around in
rooms.

Walk - Target Lock: Move around in external views,
move closer and farther away.

Lateral Move - Camera: Go up, down and sideways
but keep looking in the same direction (like an elevator or
subway ride).

Lateral Move - Target Lock: Go up, down and
sideways but keep looking at the same spot of the
building.

Turn - Camera: Stand in one place and look in all
directions as if in the centerpoint of a globe.

Turn - Target Lock: Move on the surface of a “glass
dome” up, down and sideways but keep looking at the
center.

Shortcuts and Tricks

With the Walk or Lateral Move Tools, press Shift to switch
temporarily to the opposite Tool.

When using the Turn Tool, press Shift and click to the left or
right to change the Roll Angle.

Click the Look to buttons, then click a surface in the 3D
Window to interactively set the target point.

L
+

- With the left button, you will actually “face” the clicked
surface as the axis of the camera will become
perpendicular to it and point to the clicked location. The
current distance between camera and target will remain
constant.

- With the right button, the clicked point will become the
target while your standpoint remains constant.

It is recommended that before using the Target Lock mode,
you set a proper target using either these buttons or the 3D
Projection Settings dialog box for reliable movement.
Please note that you can only move the target point to visible
surfaces in the 3D Window. To place the target in blank space
or into a place hidden inside the building, use the graphic and
numeric controls of the 3D Projection Settings dialog box.
Click the Reset buttons to quickly normalize strange views if
you get lost.

ol

- The left button will reset the Roll Angle to zero, i.e., to
make the horizon horizontal again.

- The right button will bring your viewpoint to the same
elevation as that of the target point, i.e., to look in a
horizontal direction again, returning to “2-point” or
“architectural” perspective.

The View Cone sliding switch is the only view control that
can also be used in 3D Editing Mode. Drag the sliding switch
to change the view from wide-angle to telephoto.

Navigation in Parallel Views
In axonometric views, the number of options is somewhat
smaller.

It is Turn Tool the only motion tool in Axonometric
views. Clicking anywhere will commence rotation.

There are two Motion modes in axonometric views.
Model
- Rotates the model around the Project X, Y and Z axes.
- Top-Bottom: rotation around X.
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- Left-Right: rotation around Z. This kind of motion keeps
vertical edges vertical. Press Shift to rotate around Y.

Image

- Rotates the model around the Screen X, Y and Z axes.

- Top-Bottom: rotates the model around a horizontal axis.
This kind of motion also keeps vertical edges vertical.

- Left-Right: rotates the model around a vertical axis. Press
Shift to rotate around an axis which is perpendicular to the
screen.

Click the left Look to button to “face” the clicked surface as
the axis of the camera will become perpendicular to it. This
affords undistorted views of roof planes or other skewed
element surfaces.

=

Click one of the Reset buttons to quickly normalize strange
views if you get lost.

w6

- The left button will make vertical edges vertical again.

- The right button will generate a standard side view,
keeping the current azimuth constant.

Animation Controls

To fine tune the keyframes of fly-through animations, use the
small pop-up button at the top right of the palette.

With no or several cameras selected on the Floor Plan, you
get the following menu:

Fut a carmera into the path

Choosing this single command will place a camera on the
Floor Plan that matches your current viewpoint in the 3D
Window. If you have cameras on the Floor Plan already that

define an animation path, the new camera will be added after
the active camera, which is marked by its view cone on the
Floor Plan.

With a single camera selected, you get this menu:

Go to the previous

Go to the next

FModify the selected

Revert wiew to the selected one

Insert a new camera after the selected one

- Go to the previous: steps one keyframe back on the
animation path and selects the corresponding camera on
the plan.

- Go to the next: steps one keyframe forward on the
animation path and selects the corresponding camera on
the plan.

- Modify the selected: updates selected camera to match
the current projection. Use this when you have changed
the view in the 3D Window.

- Revert view to the selected one: discards all changes
you made manually and shows the 3D model as the
selected camera sees it.

- Insert a new camera after the selected one: in
addition to inserting the new camera, this will also select
the new camera on the plan.

See also Cameras in Chapter 4: Element Creation.

In axonometric views, you get this menu:

Edit pre-zet projections...

Add current projection...

- Edit pre-set projections: opens the same dialog box as
available from the 3D Projection Settings dialog box.

- Add current projection: saves the current axonometric
view in the list of pre-set projections.
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Navigator

The Navigator feature helps you navigate in the ArchiCAD
Project. It also integrates the Publisher function that allows
you to create batch output from the project.

The feature includes two palettes: the Navigator palette itself

and the Navigator Preview palette. By default, both of them
appear on the left edge of the screen.

= |
s, ® ooy | oo
Froject bap |View Sets|
Em Untitled

=] [E] Stories

ez % D]

Source:

- “Wiew S ettings:
ZLayer comb. Custam 4 I
mScale 1:100 4 I

The Navigator palette displays in three possible modes the
structure of your Virtual Building. You can change views with
the button at top left of the palette.

k|

[@

Froject bap | View Sets |

- In Navigator mode, you can view the structure of the
project according to a plain Project Map organized into the

Stories, Sections/Elevations, Details, 3D views and Lists
generated from the Virtual Building file or in a number of
customizable View Sets defined for various purposes.

- In View Editor mode, you can build and customize View
Sets based on the Project Map or another View Set. The
View Sets are also the source used when adding ArchiCAD
views to a PlotMaker Layout.

Project Map 3 la Wiew Set: 02 Appraval 3 |

| |G| =l x|

Drag and drop items into the View Set on the
right to store them with the current Settings.

E-fB Untitled E|D 000 Sirte/Context
E-[E] Stories E-[E] Stories
B T e 1 I T = [ 0. Story

----- [&] Sections/Elevations . [&] Sections/Elevations
= 100 G Plans

EIEl Staries

D
-G Generic Perspective
i@ Generic Axonometry
gl 00 Urititled Path

~[@&] Sections/Elevations
=1 900 30 Views
£ Generic Perspective
- g Generic Axonametry
-] Design Intent

[Z] Elements
12l Components
-IfBy Zones

Source: Wiew:

Wiew Settings & Storing Options: Wiew Content:

ZLayer comb. Custam F || SLayer comb.
mScale 1:100 b || mSeale
QZooming Current Zoom F || AZooming

@ Generate in | 30 Window b || & Generate in

[El Dizplay Options, All image menu Settings

- In Publisher mode, you define sets of views to print, save
or upload to the Internet as described in Chapter 9:
Collaboration and Connectivity.
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[@ | viewset: 02 Approval »
Drag and drop items into the View Set on the Viem Set Publishing Properties |
right to store them with the current Settings.
Save st
=B Untitled
B[] Stories
o a0 Stoy @l @l @l E‘l *x
[&] Sections/Elevations .
Details = 100 GA Plans -l
B D [=-[E] Stories
& Generic Perspective : @ 0. Stery

=[] 200 Ga Section/Elevation

\..[@] Seclions/Elevations
[ 90030 Views

: b Generic Perspective

b Generic Axanarnetry

B+ Design Intent

----- @ Project Motes

i@ Generic Axonometry
HR 00 Untitled Path

View Cantant  Publisning |

I j‘

Source: Sections/Elevations

Wiew Settings & Storing Options: Format:

S Layer comb. Custom 14
mScale 1400 3 Options. .
QAZooming Current Zoom 4

»

[~ Crop image to Zoom

@ Generate im 30 Window

Publish thiz set 'l

The shape and visibility controls of both palettes are
presented in Chapter 2: The ArchiCAD User Interface.

Navigator Mode

In Navigator mode, the Project Map is shown by default. The
Project Map is automatically created in the course of your
work. It displays the structure of the project in a hierarchy of
folders.

On the top level, next to the house icon, you can see the
name of the project. At the same level, a Help folder gives you
quick access to the help system and to application and vendor
information.

Below, the Stories, Sections/Elevations, Details, 3D, Lists and
Info folders store the available views of the project. You can

display the contents of each folder by clicking the plus sign in
front of it or by double-clicking the item icon or name.

|
Bfi=h [@

Froject Map |View Fets |

-[@] Help

The Stories folder contains all the Stories defined for the
project. When first starting a project from scratch, it contains a
single item (0. Story or 1. Story, depending on the national
version of ArchiCAD being used.)

Froject Map |View Sets |

E-f% Untitled -
i =& Stories

B[ 5y

[&] Sections/E levations
Details

a0

The Sections/Elevations and Details folders contain the list
of corresponding windows. If there is no plus sign in front of
either folder, this means that no such view has been defined
yet for the project.

The 3D folder contains five types of elements for the various
projection and camera types. By default, three items are
present on starting the project: Generic Perspective, Generic
Axonometry and an Untitled Path for perspective type
Cameras.

- When you place Cameras in the Project, their names
appear under the Path. The Path can be renamed in the
Camera Settings dialog box, and more Paths can be added.
All these additions and changes are updated in the Project
Map.
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- Creating a VR Object-type Camera automatically adds its
name to the Project Map. All the created VR Object type
Cameras are listed one by one.

- Creating a new VR Scene automatically adds its name to
the Project Map. Placed panoramic Cameras' names appear
below the name of the VR Scene, and more Scenes can be
added. All changes are updated in the Project Map.

Froject Map |View Setsl

-8 Untitled
[B-[E] Stories
~[@] Sections/Elevations

-G (Generic Perspective
- g Generic Axonometry
-85 00 Noth-South
-l 03 EastwWest
L@ Camera 1

B Camera 3

/3 04'R Object 1
-6 05%R Object 2
=M 01 Scene 1
-8, Panorama-1
53 02 SceneZ
[ Lieke

=

The Lists folder contains three items: Elements, Components
and Zones. When opened, all three show the list of
predefined list schemes available for the project. All these
items also appear in the List Elements/Components/Zones
hierarchical menus in the Calculate menu.

Projct Map | View Sets |

E-fEy Untiled

[E] Sections/Elevations
Details

]... an

--[@] Lists

gL Elements

2] Basic

[E] Default

] General Element List

[E] Window scheduls Type 1
[E] window schedule Type 2
{5 Companents

Iy Zones

Project ap |\/iaw snsl

[

roject Map |V\ew Setsl

E-fB Untitled

B
Elements
{3, Components

] Basic

[E| Default

[E| Component/Keys

E] Descriptor/Keps
Iy Zores

E

=) {8 Untitled
B i
[@) Sections/Elevations
] Details

(5% Elements
+ Components
E-I[# Zones

(2] Basic
] Detault
] Rasms/Staries
&

Rooms/Zone Categories

The Info folder contains two items: Project Notes and Report.
They represent the corresponding windows also available
from the Window menu.

Using the Project Map

- When you select an item in the Project Map, you can see
its preview in the Navigator Preview palette, if
applicable.

- Double-clicking an item opens or brings to front the
corresponding window.

- Clicking an item with the right mouse button (Windows)
or with the Cmd key pressed (MacOS), opens a context
menu with some basic commands that are relevant to the

type of the item.
il #F‘
3D projection sektings...

=By Uniitled
| E-[E Stories

&S ectlnnsE Open

Details
in)

Froject Map | Wiewn Setsl

- 0 Stary -
[&] Sections/Elevations J

Create new story,..
Renarne story

Delete this stary

Show this story as ghost

Elements ko show in 30...

Fource:

i Story Settings...

_ 30 Cubaway
Seee 3D cutting planes
- Wiew 5 ) )
3D window settings...
£ Laver comb. 1 SUM...

E&eale T FTT I

Note: For the house icon representing the Project, the
context menu contains general project-related commands.

Froject Map |View Setsl

Preferences

Library Manager. ..

Below the Project Map, the View Settings controls show the
current Layer combination and the Scale of the selected view.
You can change both with the pop-up menus.

hd Wiews Settings: |
= Layer comb. | Custom ¥ Show 20 Elements Only
@ Scale 1100 %I Show 3D Elements Only
Show All. Lock 30 Elements
- - Shaow and Lock All
=l Show and Unlock Al
[ 0. Sterr G | Shove " alls Only
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< Vewseiings CrrEE—— 5
Slavercomb. Cugtom S5y Project Map >| Iﬁ Miew Set 01 Preliminary bI
@Seale [:100 11

1:2
. 1:5 Drag items into the View Set to store
7 - T o A T ] | ] 1] <
5 | = =4 Uniilled =1 D00 Site/Cortert
1100 o E-[E] Stories o =-[E] Stories
1:200 P[0, Ston i [ 0. Story

[&] Sections/E levations

£ 100 G Plans

. @3] Stories

] 200 G4 Section/Elevation
L.[&] Sections/Elevations

] 900 30 Views

EM Generic Perzspective

Lo f Generic Axonometry

Using View Sets

Clicking the View Sets tab of the palette in Navigator mode
gives access to predefined views defined by scale, layering,
display options and view type. Accessing views is performed
as from the Project Map. Custom views are defined in View
Editor Mode detailed below.

= Saurce: 0. Story Wiemn
lﬁ ‘fiew Settings & Storing Options: Wiew Content
Z Layercomb.  Custom k|| = Layer comb.
Project Map Viewseﬁl mScale ﬁ @ Soale
01 Preliminary 3 _PI AZoaming Current Zoom F| | QZoaming
i Generate in | 30 Window || @ Generate in

(=1 000 Sirte/Context Bl Display Options, image Settings
i E-[E] Stories

-3 0. Storp

-[@] Sections/Elevations

[ 100 GA Plans View Set Controls

200 A Section/Elevation The View Set definition and management controls are in the
-[@] Sections/Elevations

£ 31 900 9D Views top right corner of the View Editor.
-EM Generic Perspective . 3 . . .
B Genetc Asoromeny The View Set field shows the name of the active View Set.
Clicking it opens a pop-up menu allowing you to manage and
Source: 0. Story choose from currently defined View Sets.
& Vs iew editor Ay e
b:o
S Layercomb.  Custom bI 5, | Project Map » l_ viem St | 02 Appraval » Newr Set.
mSeale 1:100 '| g::::eta
e B @] =] x| ek
; “- [ 0. Story -] B[] Stories B 01 Preliminary
L] .o . H
[E] Sections/Eleval [ 1. Sl
VleW Edltor MOde E__Peef;ifsns et 7@: 0. Stz:i | 03 Conknilction

The second mode of the palette allows you to organize both
the default views of the Project Map and additional,
customized ones into any number of hierarchical groups. For
example, all HVAC drawings including plans, sections and
details can be arranged into one logical group.

Note: ArchiCAD includes by default three custom view
sets (Preliminary, Approval and Construction). You can
use these as the starting point for your own view sets,
modify, rename or even delete them.
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The Duplicate, Rename and Delete commands act on the
selected View Set, that is, the one whose name is shown in
the View Set field. These operations are not undoable, caution
is recommended.

To create a new set from scratch, choose the New Set command
in the pop-up menu. You will then be prompted to name it.

=k

© | viewset | 01 Preliminary v
] 3 5 x|
E E ll[reate Custom ¥Yiew Sek x|

Yiew Set name;

IMy “iew Set

E

E

The new, empty Set immediately appears in the list and
becomes active. You can then start building up the Set.
You have several options:
- Activate the Project Map in the pop-up menu on top of the
left section of the View Editor and drag and drop items in

the field on the right. Entire folders or single items can
both be added.

rewedrar =
ﬂj’[l.” Project Map [%l v Froject Map My View Set bl
01 Preliminary

Drag items into the Wiew Set to store

e wi e sunart v el B =] = = |
BBy Previews My Wiew Set
i B-[@E Stories
H M 1. Stow

- Activate another View Set in the same pop-up menu on
the left and drag and drop items from there.

view Editor A
54| | 01 Preliminary 3 Froject Map | by View Set » |
Drag items into the View Setto store w
them with the current Settings. 02 Approval @gaﬂ

03 Construction
My View Set

- Use the buttons below the View Set pop-up to build up
from scratch a custom hierarchy and save custom views.

| 2
Wiew Set: Iy Wiew Set b |
s EEEE

All these options can be combined to create the new set.

Saving Views

Before including a view in the set, you can set a number of
options for it. This is true both for items dragged and dropped
from the Project Map or another view set and for those saved
directly from the active worksheet window.

If you choose to include in the set a view from the Project
Map, select it and look at the bottom of the View Editor
palette. Depending on the type of the view, some or all of the
options in the View Settings and Storing Options area will
become active.

- For Stories (Floor Plan) and other 2D views (Sections/
Elevations and Details), you can choose a Layer
Combination and a Scale. You can also decide whether to
include the current zoom rectangle in the view, or save it
independently of the zooming.

B8 Previews -
-[E] Stories
- Ba[f 5y
[ 0. Stary

-[@] Sections/Flevations

Details

H‘ ool

o-[@] 20 LI

Source: 0. Story

View Settings & Storing Optiens:

S Layer comb.  Custom 4
= Soale 1:100 D
Q Zooming Curient Zoom L4
& Generate in | 30 Windaw Y
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- For 3D views, you can decide whether the view should be
generated in the 3D Window or the PhotoRendering
window.

BT S
= 0. Story

; =]
[&] Sections/Elevations
Dretails

J= DO

an

&1 Generic Perspective

@ Generic Axonometry LI

Source: Generic Pespective Wi

Wiew Settings & Staring Options: Wiew Content:

ZLayercomb.  Custom * || & Layercomb.
@ Seale 1:100 M| | =5cale
QZeoming Current Zoom M A Zoaming

t# Generate in | 30 Window v v 20 window
% Photarendering ‘Window

- For Lists, only the Layer Combination control will be
applied.
When you have finished setting up the view, simply drag it to
the right.

E|ﬁj Freviews -
i E-[E] Stories
T malso

-3 0. Stay
i [&] Sections/Elevations
-3 Details
L= DM
{oE-fElEn

[P 1. Sty

If you wish to save a view directly from the active worksheet
window, you first need to set it up and make sure that it is the
front window. Then click the Save Current view button
below the View Set name. The Save Current View dialog box
opens. You can name your new view here.

Wiew Set My View Set 4 .
View Set My View Set 4
Ei=ks
L=k ] 5] x|
BT 5. curventview 2| e [ T— 21

Source: 1. Stoy

-l

Source:  Generic

Save Ly i
ave Cument View as: Save Cument View as:

Interior perspective]

WienSettings and Storing O ptions: ViewSettings and Storing Options:

Wiew: 1. Stary S Layer Combination:  Custem ‘View: 1. Story S Layer Combination:  Custom
@ Soale 1:100 — @ Scale: 1400

View Content View Gontent

= layarsomt Q Zooming Current Zoom hd = Layer somp  BEnea N 30 Window -
@ Seale @seale

Qzsoming  There is no Wiew Settings awailable for this view QZooming  There is ne Yiew Seftings available for this view.

= Generate in e Generate in

O bisplay Opt Cancel E0isplay Opt Cancel

The Layer Combination and the Scale cannot be modified
here, current values will be applied. You can choose to store
the zoom level with the view and, for 3D views, the source of
the view (3D Window or PhotoRendering).

The current Display Options are always saved with the view.

Redefining Views

At any moment, you can select a view in the list and click the
Redefine button [#| (second from the left) to change the
definition of the selected item, using a dialog box whose
content is identical to the Save Current View dialog box. You
can also rename the view here.
Note: You can rename any of the items of the View Set by
clicking in the name field and typing the new name.

Organizing the View Set

View Sets can be organized by folders. You can replicate the
structure of the source set (Project Map or another View Set)
by dragging entire folders into the editing area of the new
View Set and then modifying their contents.

You can also add new folders by clicking the New folder

button ﬂ The New folder immediately appears. Click its
name to rename it.
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You can define the hierarchy of the new set manually by
dragging items into folders, create subfolders and drag items
from folder to folder, and so on. New folders are always
created at your current location in the hierarchy.

[ 1. Story
[l Near View

= Interic :
e[ Aviterior perspective

&

Cloning Folders

You can create an exact duplicate of a folder of the Project
Map. This Clone Folder will be automatically updated when
the original changes, which means that you will not have to
edit its contents manually. A clone of the Stories folder, for
example, will always show all Stories of the Project.

Click the Clone a Folder button [g@]. A dialog box appears,
listing the possible folders.

Choose Falder:

E-{B Previews
--[&] SectionstElevations
Details
-[&] 30
E-[E] Lists
Info

Clane Hame:
ISthes

Current ViewSettings and Storing Dptions:

£ Layer Combination:  Work
@ Seale: 1:100

30 Window -

Note: Display Options will be stored with the view.

@ Generate in

v

Select a folder (the entire Project, Stories, Section/Elevations,

Detalils, 3D, Lists, Info) and type in the Clone Name in the

corresponding field, then click the Create button at bottom
left. The new items will immediately appear in the View Set.
The icon displayed on the new folder shows that it is a clone,
as distinguished from other, manually created folders.

You can move the entire cloned folder inside the hierarchy of
the View Set, but you cannot drag new items into it. If you
wish to delete an item from a cloned folder, you will be
warned that the entire link structure will be removed from the
View Set.

You can delete any other view or manually created folder by
clicking the last button (X) below the View Set pop-up.

Redefining All Views in a Folder

You can change all views in either a normal or a clone folder
by selecting it and clicking the Redefine button to apply the
current settings of the Source side. You can then select
individual views and fine-tune them.

Note: In View Editor mode, both sides of the palette can be
used for navigation to check the contents of the views you are
editing.

Navigator Preview Functions

The Navigator Preview palette has three uses:
- It shows a small preview of the view selected in the
Navigator palette.
- It can be updated to show the view currently defined in
the active window.
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- With zoom and pan operations inside the palette, you can
update the view displayed in the active worksheet
window.

When previewing a 2D window, you have the following
zooming and panning options in the 2D preview:

- To change the location of the frame, drag its enclosed area
with the Small Hand Cursor.

- To change the size of the frame, drag its sides or corners.

MNavigator preview |
[ -1.Foundations Go |

Mavigator preview |
[ -1. Foundations Go |

o =

g_J_g?o% _.I gI_J_gIM% _.I

- At the bottom of the palette, the plus and minus buttons
and a sliding switch allow you to zoom the current view in
and out. Clicking the buttons increases or decreases the
zoom level in about 10% increments.

Navigator preview S|l Navigator preview k|
[y O. Story Go | [ 0. Story Go |

<@

gl._[j\?_lmn% _.I

For Perspective 3D views, you can change the view cone,
using the sliding switch or the small icons, at its ends in 5
degree increments.

g_hgmn% _;I

Mavigator preview |
G Generic Pemspective (X} I

MNavigator preview |
G4 Generic Perspective Go

._J_ welpoom _.I 5 ._J. 110.0" j

The Navigator Preview palette includes a small arrow icon in
the bottom right corner. It opens a menu whose commands
control the updating of the preview. Some of the options are
available for both 2D and 3D views, but there are specific
commands for 3D views only.

Navigator preview | Navigator preview =l
[ 0. Stery Go G Generic Parspactive Go
| + Realtime zoom
Auto 200m
O Double-click ta zoom

glj_glmn% l_r\

I [
 Reakime z00m
Auto zoom
Double-click to zoom

Redraw Praview

H Sec 1 20z

Tat 258t Ln 43 Col 25 REG

The common features are:

L

Show from Top
Show from Side
Show Actual Preview

| ﬁ ._J_ wefrs0"

Rechaw Freview
[T Rechas 8l Previens

——

- Real-time Zoom: If you choose this option, the zooming
and panning operations made in the preview are

continuously shown in the worksheet.

- Auto Zoom: With this option, the zooming and panning
operations made in the preview do not affect the
worksheet until you release the mouse button.

- Double-Click to Zoom: With this option, the worksheet
does not reflect the display changes made in the preview.
To update it, you need to either double-click inside the
preview or click the Go button in the top right corner of

the palette.

- Redraw Preview: This command updates the preview
window when you have edited the contents of the active

worksheet.

Graphisoft ArchiCAD User Guide

59



Chapter 3: Project Organization and Navigation

The other options are only available for 3D views and are
different for Perspectives and Parallel Projections
(Axonometrics).
- Choosing Show from Top allows you to manipulate a
perspective camera directly: move it around, fix the target
point or the viewpoints.

Navigator preview =
G Generic Ferspeotive G0

Navigator preview =
G Generio Perspestive o

Navigator preview =
G Generio Farspestive so

o

e

ﬁ ._J_ gau' _;I 5 ._J_ ga.u“ _.I

- Choosing Show from Side displays only the perspective
camera and story elevation marks; you can control the
vertical position and tilt of the camera by moving it
upward. The story signs start to move in the opposite
direction, simulating the effect of camera motion on the
view. The arrows pointing downwards and upwards
indicate the total height of the model.

Cument Story

ﬁ ._J_ ,:_(IQS.D’ :I_.I ﬁ _J_ ,_(lgs.u" :I_>|

- For axonometric views, only the small house representing
the model is displayed when showing the Top view. The
controls resemble those of the Parallel Projection Settings
dialog box.

Mavigator preview
@ Generic Axonometny Ga I

F|

I

Navigator preview

An additional pop-up menu lists the same view type
possibilities as those offered in Parallel Projection Settings.

{2 Geneiic Axonometny Go |

. : v

0

=

T

Cugtom Axonometric Model View
Top Maodel Yiew

|zometric Axonometic Model Yisw
Frontal Axonometiic Model Yiew
Monometric: Model Yiew

Dimnetric Model View

Side Model View

Eottom todel iew

Izometric Bottom M odel Yiew
Frontal Battorn Maodel Wiew
Monometric Bottom Model Yiew
Dimetric Botom Model Yisw

- Choosing Show Actual Preview displays the current
content of the 3D Window. In this case, all zooming
controls are disabled. To refresh the preview, double-click
it or choose Redraw Preview.

Navigator preview
@ Generic Axonomety Go |

k|
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Chapter 4

Element Creation

This chapter concentrates on the creation of ArchiCAD elements of different types. It also covers the tools and settings available

Sfor constructing Virtual Building elements.

Introduction

ArchiCAD elements belong to four basic types: construction
elements, drawing elements, annotation elements and
visualization elements.

Construction elements are the virtual equivalents of actual
three-dimensional building components such as Walls, Slabs,
Roofs, Doors, Windows, Objects and so on.

|4 Untitled / 0. Story

AT
BmE

(]

ype | Fill Neme
|

| masonry block |
| Solid Fill |
| Solid Fill |

They are displayed as drawing symbols in the Floor Plan, as
solid building components in the 3D Window and their cut or
elevated view can be projected in Section/Elevations
windows. Their appearance can be enhanced to simulate
realistic effects in PhotoRendering, and their properties
including descriptions and components can be listed in text
windows.

Drawing elements are strictly two-dimensional. They have
many uses: they can serve as drawing aids that help you
position construction elements, represent larger shapes in 2D
views only, enhance details, and so on. With the exception of
Fills, they do not appear in list views.

Annotation elements are associative Dimensions, Text
blocks and smart Labels. Dimensions and Labels display
numeric or textual data in 2D views either about the elements
they refer to or as standalone informative elements. A special
case is Zones, which also carry 3D information.

Visualization elements indicate the location and direction
of special views of the project on the Floor Plan. They
include Section and Detail markers as well as different
Camera types and their paths.

The Toolbox plays the key role in the creation of all these
types of elements. Its icons represent different element types;
you can always create new elements belonging to the type
represented by the active Toolbox icon. Double-clicking an
icon opens a settings dialog box containing a large number of
options for the given element type.
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Using Construction Tools

You can create the following types of elements in both the
Floor Plan worksheet and the 3D Window: Walls,
Columns, Beams, Slabs, Roofs and Meshes.

The creation, display and behavior of the elements obeys
some common rules, but the specifics will be discussed in the
sections dedicated to the different element types.

Creation Steps

The typical steps in creating construction element are the
following:

1) Select the corresponding tool in the Toolbox and open its
settings dialog box by double-clicking the tool's icon. (If
the desired tool is active, you can also use the Info Box to
reach its most important settings and open the settings
dialog box by single-clicking the tool's icon.)

2) Adjust the settings offered by default to suit your particular
situation or purpose, or click the Favorites button on top
of the dialog box to select a predefined element
configuration. Click OK to confirm the settings.

3) Choose a Geometry Method in the Info Box allowing you
to create plain, curved, chained, rotated or polygonal
variations of the elements, where applicable.

4) In the Floor Plan or 3D Window, define the location, the
length or the shape of the construction element. In 3D,
you can graphically override the height value typed in the
settings dialog box.

Element Display

The Floor Plan, Section/Elevation and 3D display of
construction elements depends on the attribute choices made
for them in their dialog boxes. Attribute sets are managed by a
number of commands in the Options menu. For faster display
or output, the 2D appearance of some of the attributes can be
optionally modified in the Display Options dialog box
opened from the Options menu.
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You can change the attribute settings of the elements by
clicking the pop-up controls in the appropriate panels of the
element settings boxes and dragging the cursor to your new
choice.

Attributes include:

- Pen Colors for the color and line width of the elements'
outlines and fill patterns.

a9 am |

[10 018 mm s 051 Rt

Log Details.
i

- Line Types for the outline of the elements in the Floor
Plan and the Section/Elevation windows. All Line types are
available for any of the elements. Note that Line types can
be scale-dependent, which means that their display may
change according to the active window's scale factor.
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- Fill Types for the hatches of the Wall bodies and Columns

in the Floor Plan and the cut surfaces of all construction
element types in the Section/Elevation windows. The
availability of fill patterns for construction elements is a
general setting made in the Fill Types dialog box. Whether
Construction Fills appear as bitmap patterns or vectorial
hatches depends on the general setting made in Display
Options. Note that vectorial Fill Types can be scale-
dependent, which means that their display may change
according to the active window's scale factor.

| masonry block

- & Model
a [ Suface-whitewash >| |_ ! W — =TT

Fill Types can also be applied in the 3D Window as part of
the Material definitions in the form of 3D Hatchings. This
definition has no relation with the 2D Fill Type definition
of the element, and all simple Fill Types are available.
Composites are complex structures including several
predefined Fill Types. Only Walls, Slabs and Roofs can use
Composites. The availability of each Composite is set
individually for these three element types in the
Composite Settings. Their display obeys the same rules as
simple Fill Types.

Materials provide the look and feel of construction
element surfaces in both 3D and PhotoRendering. All
Materials are available for any of the elements. Material
definitions can be quite complex, including a Color, a
bitmap Texture and a simple Fill Type in the form of a 3D
Hatching, as well as Reflection, Transparency and
Emission values.
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Element Identification, Listing and Labeling

The last panel of the settings dialog box of all construction
element-type tools is called Listing and Labeling and
controls the handling of the elements in calculations.

Note: The Fill and Zone tools also include this panel, as
the elements they create can also be listed in calculations.

il wall Default Settings x|
Favorites.. | Default
L L] y and Positioni

4. Floor Plan and Section

@, Model

7 :E Listing and Labeling

1D: IWaIIVDDQ Link. Properties:

I™ By Criteria

»
4

™ Labelwall on Creation i :
Matching Properties:

Label Settings... ;I
FRelation to Zones: ;I
I Zone Boundary - Chaoss...
fwratFoq
£ D Exleiionals v Cancal | | y
4

The ID field serves to identify and group elements in list
views. The text string within this field cannot exceed 15
characters. Any character can be used.

If a number is included anywhere in the 15 characters,
drawing successive elements will add one to this number for
each new element, provided that the Auto ID Increase
checkbox is enabled in the Options/Preferences/
Miscellaneous dialog box. Each new element will have a
unique ID.

- If elements are duplicated or multiplied, the IDs of the

replicas will remain the same as those of the originals.

- If you paste elements into a Project, you may have
elements with conflicting IDs. ArchiCAD does not
automatically exclude ID conflicts. It is up to the user to
designate different IDs for elements that may be in
conflict.

IDs can be customized both before creating elements and
after selecting a number of existing ones, by using the
Element ID Manager... command in the Calculate
menu. See Chapter 10: Project Data Calculation.

Note: All construction elements also have a unique,
automatically generated, internal ID which is conserved
throughout the life of the Project. You can also use this
identifier for labeling or in lists.

Checking the Label Walls (Columns, Beams, etc.) box allows
you to automatically generate Labels next to the new
elements. The Label Settings... button then becomes active
and you can adjust them directly from here, without having to
exit the settings dialog box. See the Labels' description later
Sfor details about labeling.

The Link Properties section allows you to link a Property
Object to the element for calculations. See Chapter 10: Project
Data Calculation and the More Information section of
Chapter 10: Project Data Calculation in ArchiCAD Help.
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Walls

Definition

The Wall is a fundamental element in the practice of
architecture. When you create a Wall in ArchiCAD, you create
the outline and hatching of a Wall in 2D and a solid Wall body
in 3D.

Walls can be straight, curved, trapezoidal and polygonal. The
steps for creating each type are detailed later in this section.

Each Wall possesses a reference line and a direction. It serves
the precise connection of Walls for clean intersections. It also
establishes hotspots and edges for selecting, moving and
transforming Walls.

The reference line is a heavy black line that always appears
when drawing the Wall. Depending on the chosen

Construction Method, the wall body protrudes on either or
both sides of the reference line. The direction of the wall is

defined by the order in which you define the wall's endpoints.

The reference line (including the arrow that shows the Wall's
direction) is only visible on the Floor Plan, provided that the
Clean Wall & Beam Intersections feature is switched off.
Otherwise, all Walls look alike in this respect.

The hatching inside the Wall body shows the Fill pattern
chosen to represent it in on the Floor Plan and in Sections.
Multiple hatches represent Composite Structures.

7777777777777
 E—

I

In 3D views and PhotoRendering, the look of the wall's
surfaces is provided by the Materials assigned to them.

Note that the display of the Wall depends on the current
settings in Options/Display Options.
- Clean Wall intersections can be set on and off.
- It is possible to show only the reference lines of walls
without the contour lines.
- Fill patterns can be shown as uniform, bitmaps or vectorial
lines.

See also the interaction between Wall type elements and other
elements at the end of this section.

Wall Tool and Settings

The Wall tool is located near the top of the Toolbox,
preceded only by the two selection tools. Its settings dialog
box contains four panels: Geometry and Positioning, Floor
Plan and Section, Model and Listing and Labeling. At the
bottom of the dialog box, as for all tools, the current layer
choice is displayed in a pop-up menu.
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-
L

I} wall Default Settings x|

Favarites, Default

@i G ry and Positioni
4. Floor Plan and Section
., Model

=p, Listing and Labeling

v v v |¥w

£ @ Exterion walls ’I

Cancel

(3 [s]e 1]])

The Geometry and Positioning settings include the Wall's
height and elevation, the position and offset of the Wall's
reference line, the basic type of the Wall (simple, trapezoidal,
polygonal), and the total thickness of the Wall.

Il wall Default Settings x|
Favarites... Default

& i% Geometry and Positioning

ﬁl 2700 Iaw = %:lﬂ
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P @ Model
P =& Listing and Labeling
£5 3 Exteiionwalls » I Cancel

- The elevation values are interdependent. One value is
measured from the level of the current story and the other
from either the project's zero level or a special reference
plane defined in Options/Preferences.
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- Walls with an offset can be used to trace the outline of a
Slab with one of the internal contours of composite Wall
skins. An offset can also help keep the reference line at
either the center or border of a wall structure skin.

- When drawing an axial wall, that is, when the reference
line is right in the middle of the wall's body, the offset
value is grayed out.
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- Since the reference line is always parallel to one of the
wall's edges, the axial wall method is not available for
trapezoidal walls.

- If you have chosen a composite structure for the wall in
the Floor Plan and Section settings, you cannot edit the
thickness of plain walls, as the value is dependent on the
added value of the individual skins as set in Options/
Composites.
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- The thickness of trapezoidal walls changes continuously
along their length. You define here the thickness value of
the two endpoints. When using a composite structure for a
trapezoidal wall, neither of the two endpoint thickness
values can be set to less than the default setting made in
Options/Composites. The thickness variation will be
applied to the innermost core skin of the composite.

) |12 [125
271 [0

- Thickness does not apply to polygonal walls, the field
cannot be edited.

z|E: 7] |125

- The PolyWall Corners Can Change checkbox is only
active when drawing a Polygonal Wall. It controls the
display of wall contours when connecting such a wall to
other, plain walls. See details later.

The second panel controls the Floor Plan and Section
attributes of the Wall.

Il wall Default Settings x|
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These settings affect the outlines and hatching of all Walls on
the Floor Plan and of cut Walls in Section/Elevation
windows. Uncut Wall edges do not display the hatching in
Section/Elevation views, and their contour lines are displayed
as set in the Model panel.

A
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- Polygonal walls cannot have composite structures, only
plain fill patterns.

- You can choose different colors for the wall body hatch
and its background. In the case of composites, you can
either use the composite structure's own line, fill color and
background color definition or override it with manual
choices. The corresponding controls are consequently
disabled.
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™ Use Background Colors of Compasite:

The third panel is called Model and controls the 3D display of
the wall.
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The most important control of this panel concerns the
surfaces of the wall's two sides and all four edges. Clicking
the chain icon will assign the last material chosen to all
surfaces. Deselecting the chain icon will restore the materials
that you originally set for each separate wall surface.

g, [ Sufacewhitewash
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ﬁ‘ [ wood-Deck

y

- The Log Details... button opens a dialog box for defining
the display of walls constructed from logs. See the Log
Walls section for detailed explanation.

- The Undo Roof Trim... button is never active when
drawing new Walls. It serves to restore the original height
of selected Walls trimmed to Roofs. See the Roof section for
details.

- The Reset Texture buttons are never active when
drawing new Walls. They serve to restore the origin and

direction of the Texture if it was modified in the 3D
Window. See Aligning Textures in 3D in Chapter 5:
Drafting and Editing Techniques.
The fourth panel is called Listing and Labeling and controls
the handling of the Wall in calculations.
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Most of the controls of this panel are described in the Element
Identification, Listing and Labeling section earlier in this
chapter.

The Relation to Zones pop-up defines whether the new
Wall is a Zone delimiter, an element to subtract from the
Zone's area or to be ignored when calculating Zones. See the
Zomes' description for more details.

Drawing Walls

When you are satisfied with the choices you made in the Wall
Settings dialog box, you can start drawing Walls. New Walls
can be created in either the Floor Plan or the 3D Window.

Geometry

There are ten Geometry Methods available for drawing simple
and special Wall configurations. They can be activated by

68

Graphisoft ArchiCAD User Guide



Chapter 4: Element Creation

choosing the appropriate option in the Info Box before
initiating the creation of the wall. You can also switch methods
on the fly after you have already started drawing a Wall.

E|

Default Settings oo

Drawing a Straight Wall Segment

The Single Wall method produces one straight wall element at
a time.

A

Oefault Settings 1'
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In the Floor Plan, you define the location of Wall segments,
that is, their length, by clicking at their endpoints.

)

The moment you start drawing the Wall, a ghost contour
appears and it follows the cursor until you click at the second
endpoint.

In 3D view, in addition to defining the length of the wall, you
can also graphically override the height value typed in the
Wall Settings dialog box.

As on the Floor Plan, a ghost contour of the Wall follows the
cursor showing the originally set height.
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- To accept the original height of the Wall, double-click at
the second endpoint.

- To override the height setting, move the Pencil cursor up
or down along the vertical line projected from the second
endpoint and click at the desired height.

- Hitting the Enter key validates the height of the Wall at the
current location of the cursor.

Drawing a Curved Wall

The Wall Geometry Methods available in the Info Box provide
three different options for drawing Curved Walls in circular
arc shapes. They differ in the basic points they define.
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- The first option defines the curved wall by the arc's or
circle's centerpoint and radius. Your first click defines
the centerpoint. A ghost contour of the circular wall
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follows your cursor until you click a second to time to
define the radius. After that, only a partial ghost curved
segment is shown, until you click a third time to define the
length of the arc wall's circumference. If you need a full
circular wall, double-click when defining its radius. When
all three points are defined, the ghost contour is replaced \\
by the fully displayed wall contours and hatches. =

N\

o ’ When the arc length is defined, the ghost arc is replaced
- by the fully displayed wall contours and hatches.

- The second option defines the curved wall by three points A
on the arc's circumference. The first two clicks define h
two points that you will probably locate on points
connecting other elements, grid intersections or special
snap points. After that, a ghost circle follows the cursor
until you click a third time to define the third point.

- The third option only defines full circular shapes based on
three tangential edges or points. In this process, you select
three initial points: these can be a tangent edge (indicated by
the Mercedes cursor), a node (indicated by the Checkmark
cursor), or a free-floating point (indicated by the Crosshair
cursor.) An endpoint cannot qualify as a tangent edge when
using this method, so a maximum of two endpoints are
allowed. If more than two are selected, the process will
revert to the first method described above. Only linear
tangency is allowed: all tangent points must be on the
straight edges of Slabs, Lines, Walls, etc. If you click a radial
edge with the Mercedes cursor, the resulting Circle will pass

A fourth click is needed to define the length of the arc through that point rather than being a tangent to the curve.
segment. Double-click the third point to define a full

circular wall. Note that the second and the third points do
not need to be actually part of the arc wall.

The next step depends on the geometric situation.

If there is only one solution, the circular Wall is
automatically drawn.

If there are two or four solutions, the Eyeball cursor
appears and the ghost contour of the Wall flips from one
position to the other as you move the cursor around. Click
when it is at the right place to complete the circular wall.
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- If there is no solution, (for example, if you define three
parallel edges for tangency), no circle will be made.

Notes: Since Walls need to have two endpoints, the fully
closed circular Wall that you draw will in fact consist of
two half-circles.

Walls in the forms of full ellipses, elliptic arcs or splines
cannot be created directly, but you can trace the shapes of
plain drawing elements with the Magic Wand. See
description later.

Drawing a Chain of Walls

The PolyWall method produces a sequence of connected
straight or curved wall elements with automatically coincident
reference line endpoints that will share the same
characteristics.

In the Info Box, choose the Geometry Method that represents
a chain of Walls.

E

Default Settings

As soon as you start drawing the first Wall, a pet palette
appears, offering you geometry options for drawing a straight
or a curved segment.

= Al Fsdls

—

The options are:
- A straight wall segment;
- A curved segment tangential to the previous one (cannot
be used for the first wall segment);
- A curved segment tangential to a line you define before
actually drawing the segment;

= i s s

- A curved segment passing through two points;

- A curved segment defined by its centerpoint, radius and
length.

Place the cursor on the option that suits you best and define
the endpoint of the first segment using the methods described
above for single Wall segments. This endpoint automatically
becomes the starting point of the next Wall segment. When
you want to finish drawing Wall chain segments, double-click
the endpoint of the last segment.

Throughout the process, a ghost contour of the Wall segments

is shown. The full Walls are only displayed when you are
finished.

- Clicking the Cancel button in the Control Box or hitting
the Delete key at any time during drafting will abort the
process, and no elements will be created.

- Choosing the Undo command in the Edit menu will remove
the entire new chain of Walls, not just the last segment.
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- Hitting the Backspace key allows you to undo the previous
segment and continue the creation of the Wall chain.

- If you change the Wall's attributes in the Info Box during
the creation process, all created Wall segments will have
the modified attributes (reference line position, line type,
fill color, material, etc.).

- If necessary, you can switch methods on the fly in the pet
palette.

- If the Autogroup function (Tools menu) is switched on, the
chained Wall segments will be created as part of a group.

Drawing a Rectangle of Walls

The Rectangle Wall method produces four Wall elements with
coincident nodes by defining the diagonal line of a rectangle.
Its four sides are always aligned orthogonally with the Normal
Grid and are not affected by the use of a Skewed Grid.

7, |

Default Settings

The Rotated Rectangle Wall method produces four wall
elements as with the previous method, except that you first
define a rotation vector for the rectangle’s base reference line.

|

Default Settings

Drawing a Trapezoid Wall

The Trapezoid or Non-Parallel method allows you to draw
straight Walls whose thickness is not constant. You draw this
type of Wall as a straight Wall, except that you will first enter
the thickness of the Wall at its two endpoints.

E|

Default Settings 1'
! [= =
=] [« =]

e
£ ':22—

e

Drawing a Wall Polygon

To define a polygonal wall block of free shape, choose the
Wall Polygon Geometry Method in the Info Box or the Wall
Settings dialog box. Note that this type of Wall cannot contain
Doors or Windows and that only simple fills are allowed for
their structure. The definition of the contour of the Wall
Polygon is quite similar to the PolyWall method. Both straight
and curved edges are allowed.

The edges of the polygon are defined the same way as for the
chain of Walls described above. Wall Polygons must have at
least four sides.

E

Default Settings
| =
e |G| g I &
=

—_— 400

zd
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Default Settings

- If you define a polygon whose edges intersect themselves,

ArchiCAD will warn you about this, but it will still be
drawn.

- You cannot place any doors or windows into them;

- They cannot have composite structures.
When completed, the polygon edges will be divided into
groups of reference line edges and plain edges, separated by
"real" edges. Materials will be assigned accordingly.
To edit polygonal Walls, click the nodes and edges or the
selected Walls and use the pet palette. At the endpoints of the
reference edge range, the pet palette will contain a special
icon that lets you redefine this range by moving the range
endpoints to other nodes of the Wall polygon.

Drawing a Log Wall

You can create straight walls constructed from logs. Log
details appear in both the 3D Window and Section/Elevation
Windows.

Clicking the Log Details... button in the Model Attributes
section of the Wall Settings dialog box opens a dialog box
with a number of geometry and texture options.

M Log Details 2=

31 Logheight |EEN [~ Startwith half log
Note: Setzero log height for no logs

Log Shape:

r@ r§ s &
=

Log Radius:
& ] c

Material of Horizontal Edges:

(% Asin Wall Settings
{~ Override with Reference Side Material
£ Owenide with Opposite Side Material

I Align Texture to Wall Edges

Cancel | oK |

- Log Height: In this edit field, you can enter the height of a
log. If the value is 0, no logs will be displayed.

- Start with half log: If this checkbox is active, the wall
will start with a half-height log at the bottom.

- Log Shape: You can choose from four shapes by clicking
the radio buttons.
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- Log Radius: You can choose from two options by clicking
the radio buttons - the wall can be built from round logs or
from slightly chamfered square logs.

- Material of Horizontal Edges: You can choose from
three options by clicking the radio buttons.

- Align Texture to Wall Edges: By enabling this checkbox,
wall texture mapping will be aligned to the wall in order to
avoid having a fragmented log texture.

Notes: Log construction is only available for simple
straight walls.

When determining the log’s height, remember that if you
enter a value that is larger than the wall’s width parameter,
the logs will not rest on each other.

Drawing a Gable Wall

When you need walls to fit a Roof or you want Walls with
cutoff corners, you can obtain them by cutting regular
Rectangular Walls with appropriate roof pitches as shown
below. The full procedure is described under Roofs.

Wall Intersections in 2D

Clean Wall intersections can only be created between walls
that are correctly joined. The reference line is the focal point
when you join walls, and the reference lines of the walls to be
joined must fit precisely. Simple X crossings of these lines are

not enough: your lines should either join by their endpoints
or create precise T or L junctions.

When drawing a new Wall or stretching an existing one by its
endpoint, it is sufficient to click any edge or inside the
hatching of the target Wall. The reference line of the new (or
edited) Wall will be adjusted for proper connection. This
construction aid is not effective with other editing operations.

When you are faced with a complex joining situation, it may
help to switch Off Clean Wall & Beam Intersections in the
Options menu. With Clean Wall Intersections Off, the
reference lines will be clearly visible, helping you to construct
your walls precisely.

Note: Wall intersections are effective even if some of the
intersecting elements are on currently hidden Layers.
Connection of Walls with Different Fill Patterns
If different walls are connected, in the case of L intersections,
the wall patterns will be separated by the diagonal of the
intersection (see figure below). In the case of T intersections,
the outline of the running wall will remain continuous.

If you need a more elaborate drawing detail at wall
intersections, you can create a patch or a detail drawing. You
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can also retouch the drawing in PlotMaker before plotting or
printing.

Priorities at Triple Wall Connections

Triple wall connections are based on priorities, and generated
in two steps. First, the two thickest walls are connected.
Second, the third wall will be fitted to the above two. If all
walls are of identical thickness, Composite Walls will be
prioritized over homogeneous ones.

If a triple intersection does not look as you expect, move a
wall endpoint by a very small distance away so that you get
two double intersections instead of a triple.

Intersections of Walls with a Vertical Displacement

If two walls are connected by their horizontal position but do
not connect vertically or just touch each other, they will not
intersect in either the Floor Plan or in 3D.

Smart Connection of Composite Walls

Connecting walls are automatically matched and the fill
compositions are analyzed. The connection is set up
accordingly.

ERTRRT,
R
R

Corner (L) joints of Composite Walls with wall skins of
identical Fill Patterns are automatically cleaned even if the

layers of identical Fill Patterns have a different thickness value.

e
SOOI

>
5

B i

R
ToToTeleTe

[y,
T TeTeTeTeTeToToTes

The core skins of Composite Walls are never cut through by
other skins.
Creating Intersections from Wall Crossings
To transform a wall crossing into a proper intersection:
1) Draw two walls that cross each other.

2) Select one of the walls.

3) With the Wall tool active, Ctrl-click (Windows) or Cmd-
click (MacOS) the reference line of the other wall. The
selected wall will be split

Notes: This technique also works on several walls selected
at the same time. Alternatively, you can also use the Split
command from the Edit menu.

PolyWall Corners

When connected to other, plain walls, wall polygons keep
their original contour by default.

If you wish to override this setting, check the PolyWall
Corners Can Change box in the General Settings section of
the Wall Settings dialog box.
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In the following example, a Single Wall is connected to a Wall
Polygon. The first illustration shows you the situation with
Clean Intersections Off.

Turning Clean Intersections On (Options menu) will give
a different result with PolyWall Corners Can Change active
(left) and inactive (right).

Modifying Wall Geometry

With the commands of the Modify Wall hierarchical menu of
the Tools menu, you can modify the thickness, the Reference
Line position and the direction of selected wall type elements.

With the Structure... command, you can change the hatching
of the selected Walls, and still keep the position of a desired
part of the Wall.

At the top of the dialog box, you can set the fill. If the chosen
fill is not a composite, you can set its thickness, otherwise the
thickness of the core layer is displayed.

Click the radio button at the bottom to choose which part of
the wall should keep its position after the modification. (If
possible, this will be done by adding an offset to the reference
line. If not, the reference line will be moved.)

I Modify Wall Structure

Selected: 1

r~ Floor Plan & Section Attributes

7////Z masonry block

21x

Editable: 1

b|

Thicken W all fram

& Reference Line
" Iriner side of Core
" Center of Core

" Outer side of Core
O Duter side of Wall

e

+

Cancel |

With the Reference Line command, you can move the
reference line of the selected walls without changing the
walls' position on the Floor Plan.

Il Modify Wall Reference Line

Modify Reference Line of Selected Walls

2=

Selacted: 1 Editable: 1

—Feference Line Side

{+ No change

© Left LEB3
" Right 2
" Invert all sides CER

— Diffset

¥ No change

" None

" Tainner side of Core
" To center of Core

" To outer side of Core

™ To ouler side of 'wal

" By distance:

Cancel
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On the left side of the dialog box, you can change the reference
line side of walls. On the right you can add an offset to the
reference line to position it to the desired part of the wall.

With the Invert Direction command, you can change the
direction of the reference line. (This is visible when the Clean
Wall & Beam Intersections toggle command is Off.)

Walls and Other Elements

- Colummns: Automatic Wall-Column connections, optional
Wall wrapping around columns. Walls and Columns must
belong to Layers that have the same intersection group
number. See the Columms section for examples and details.

- Beams: When a Beam crosses a Wall, the element of lower
priority is cut in 3D. Wall priorities are defined globally in
Options/Preferences/Construction Elements while Beam
priorities are defined individually. Walls and Beams must
belong to Layers that have the same intersection group
number. See the Beams section for examples and details.

- Doors and Windows: A Wall is the only placeholder of
these elements. They become part of the Wall. See the
Doors and Windows section for details.

- Slabs: Overlapping Wall and Slab edges are eliminated in
3D: facades will be clean on elevations and other 3D
views. See the Slabs section for details.

- Roofs: The top or the bottom surface of Walls can be
trimmed to Roofs. See the Roofs section for examples and
details.

- Zones: Walls are typically used to define the boundaries of
Zones. See the Zones section for details.

Note: Solid Operations performed on Walls are always
effective, regardless of any Layer settings.

Columns

Definition

Columns in ArchiCAD are made up of two components: the
load-bearing core and the optional veneer used to simulate
fire proofing or any kind of sheathing around the core. The
Column's base can be either rectangular or circular. Columns
can stand free, or they can be smartly connected to walls.

In 2D, Columns are represented by their external and internal
contour, an optional crossing symbol and two different fill
patterns for the core and the veneer. In 3D, a single material is
used to display all their surfaces. In Section view, the core fill
pattern is shown, while in Elevations the Column is displayed
with its contour only.
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Column Tool and Settings

The Column tool is located below the Wall tool in Toolbox.
Its settings dialog box contains four panels: Geometry and
Positioning, Floor Plan and Section, Model and Listing
Attributes. At the bottom of the dialog box, as for all tools,

the current layer choice is displayed in a pop-up menu.

’ £l 10l columin Default Settings - x|
L Favorites. . | Default
» @t Geometry and Positioning
- » gzl Floor Plan and Section

B » iy Model

@ » o Listing and Labeling
= £% @ Columns bI Cancel | oK I

=

The Geometry and Positioning controls include the
Column's height and elevation, the dimensions of the core
and veneer and the location of the anchor point of the core.

Wl Column Default Settings x|

Fawarites... | Detfault

M g% Geomebry and Positioning
N EE ESP””—
R [l — o |

b P';i:z_,l f— l ID— ¥ Weneer ﬁ“* |25—
Anchor Point of Core: ﬁ I ﬁ@
» g Floor Plan and Section
b iy Model
» = Listing and Labeling
£% @ Columns >| Cancel | Ok I

You can also choose between a circular and a rectangular
Column and decide whether the Column should be
freestanding or wrapped by Walls. See the Columns and Other
Elements section later.

ErEE

- The horizontal and vertical dimensions of rectangular
Columns can be different. Use the chain icon next to them
to constrain them to the same value.

- Veneer thickness is uniform around the core.

The second panel controls the Floor Plan and Section
appearance of Columns.

Il Column Default Settings x|
Favorites... Default
» @t Geometry and Positioning
A= Floor Plan and Section
[ St >| mCAE T |
O I &
C°;: 7] structural concrete ’| ' 3 AECH -I
]
” L AP l_l
V;L‘f:[ |:| Fire: Proafing '| 7N |= I_I
7%
e A ]
P iu Model
P =i Listing and Labeling
£2 @ Colmnz DI Cancel | oK I

These settings affect the Column's symbol (plain, slash or X),
hatching and outlines of all columns on the Floor Plan and
of cut columns in Sections/Elevations.
- The Line type choice affects both the Column's outline and
the optional symbol.
- You can choose different colors for the Column's hatches
and their backgrounds.

- Composites cannot be chosen as Column fills.
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The third panel controls the Model attributes, that is, the
display of the Column in the 3D Window, and of uncut
Columns in Section/Elevation windows.

Il Column Default Sektings x|

Fawvorites... | Default

} (@)t Geometry and Positioning

» g Floor Plan and Section

- Q Model

B [ Sufacewhitewash b |

Gy = am

Undo Roof Tirim |

Columm is trimmed by one on more roofs.

Custom Tesxture defined in the 200indow, Reset Origin |

» o Listing and Labeling

&% <@ Columns 3 |

Cancel | 0K I

The most important control of this panel concerns the surface
of the Column.

- For Columns placed with the Wrapped method, the
Material choice you make here is overridden by the
surface Materials of the Walls that they intersect.

- The Undo Roof Trim... button is never active when
drawing new Columns. It serves to restore the original
height of selected Columns trimmed to Roofs. See the Roof
section for details.

- The Reset Texture button is never active when drawing
new Columns. It serves to restore the origin of the Texture
if it was modified in the 3D Window. See Aligning
Textures in 3D in Chapter 5: Drafting and Editing
Techniques.

The fourth panel is called Listing and Labeling and controls
the handling of the Column in calculations.

Il column Default Settings |
Favorites. . I Default

» (@t Geometry and Positioning
» g Floor Plan and Section
P iy Model
- :g Listing and Labeling

D ICD\-DD‘I Link Properties:

V¥ By Criteria

™ Label Column on Creation B )
Matching Properties:

Labe! Settings... | ;I
Relation to Zones: _I
I Zone Boundary j [~ Individually Choose.. |

f

£%F @ Columns 3 I

Cancel | oK I

Z

Most of the controls of this panel are described in the Element
Identification, Listing and Labeling section earlier in this
chapter.

The Relation to Zones pop-up defines whether the new
Column is a Zone delimiter, an element to subtract from the
Zone's area or to be ignored when calculating Zones. See the
Zomes' description for more details.

Drawing Columns

When you are satisfied with the choices you made in the
Column Settings dialog box, you can start drawing
Columns. New Columns can be created in either the Floor
Plan or the 3D Window.

Geometry

There are three Geometry Methods available for placing
Columns. They can be activated by choosing the appropriate
option in the Info Box before placing the Column.
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E|
et seires @ |
@
- The Circular method allows you to place a Column with a
circular base.
- The Right-Angle method produces a Column whose sides
are aligned with the normal grid.
- The Rotated method produces a Column that can be
freely rotated before placement.

Placing the Column

The ghost outline of the defined Column follows the cursor
until you click to place it. If the dimensions of the Column are
rather small, it is not visible at lower zoom levels on the Floor
Plan.

Click to place the Column at the anchor point of its core
defined in the Column Settings dialog box.

When placing a Column with the Rotated method, your first
click defines the anchor point location. A ghost contour of the
Column appears while you rotate it to find its final location.
Click again to set the Column's angle and place it.

B
: &

Columns and Other Elements

Similarly to Walls, Columns can be trimmed to the upper or
lower surface of a Roof. See Roofs section for details.

When a Beam crosses a Column, the element of lower priority
is cut in 3D. Column priorities are defined globally in
Options/Preferences/Construction Elements while Beam
priorities are defined individually. See the Beams section for
examples and details.

Columns can be included in Solid Operations with all other
types of construction elements.

Columns and Walls have a special relationship as detailed
below.

Unwrapped Columns on the Floor Plan

Unwrapped Columns do not modify the shape of the wall, just
cut out a place for themselves, breaking through all wall skins.
The connection line between wall skins and the Column are
removed where their fill patterns match. The contour of
Column cores with a slash or an X is always fully drawn,
regardless of any other factors.

Below, the same Column variations are shown in three
different situations:

1) The Column stands free of any walls.
2) The Column is placed in a composite Wall.
3) The Column is placed in a plain wall.
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Wiall and Weneer Fills are different
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Wall and Yeneer Fills are identical
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Wiall and Core Fills are identical, ¥ in Care

N

LTI
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Wall and Core Fills are differert, plain Core

SRR

wall and Core Fills are identical, plain Core

Y

Wrapped Columns on the Floor Plan

Wrapped Columns can only break through the core skins of
composite Walls. The other wall skins wrap around the
column, retaining their thickness.

Wrapping will only occur if:

- the Column was placed using the Wrapped Method;

- it intersects a composite Wall;

- the composite Wall type has wrapping skins;

- the Column touches or intersects the core skin(s) of the

composite Wall.

In the illustration below, you can see that the core of the wall
works as with unwrapped Columns, and the intersection lines

are cleaned as in the previous illustration. However, the other
skins of the composite Wall go around the column.

Wall and Veneer Fills are different

Wall and Veneer Fills are identical

Wall and Core Fills are identical, ¥ in Core
Wall and Core Fills are different, plain Core

Wall and Core Fills are identical, plain Core

Note: Wrapping is not available for curved or polygonal
Walls.

Columns in 3D Views

Columns placed with the Wrapped Construction Method will
inherit the Surface Material of the connecting Walls, even if
there are no wall skins configured to actually wrap around the
Columns.

If Column surfaces are connected to wall or slab surfaces or
other Column surfaces within the same 3D plane, the
connection lines are eliminated in 3D view.
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Beams

Definition

ArchiCAD Beams are straight horizontal construction elements
with vertical end faces. They are best used when designing
support building elements whose axis length is significantly
larger than either their width or their height, for example
rectangular concrete or timber beams.

When you create a beam, ArchiCAD generates the contour
and the reference axis of the beam on the Floor Plan, a
contour in Elevation with a section hatch when cut in Section,
and a solid body in 3D.

il Beam Default Settings x|

Faworites... Detault

P @ G iy and Positionil
= Floor Plan

—— Dashed 3

= = 7| 9 am
T Bl
b 1 Section

¥ 9 Model

» [ Hole

4

=g, Listing and Labeling

£F @ Beams 3

. I

All types of Beams can include Holes. Holes are defined after
the Beam has been placed. The geometry of the Holes is
defined in the Model panel of the selected Beam's settings
dialog box. Holes can be circular or rectangular, and Holes of
different shape and size can appear in the same Beam.

Each Beam possesses a reference axis and a direction. The
reference axis serves the precise connection of Beams for
clean intersections and establishes hotspots and edges for
selecting, moving and transforming Beams.

The reference axis is a heavy black line that always appears
when drawing the Beam. The direction of the wall is defined
by the order in which you define the wall's endpoints.

The reference axis (including the arrow that shows the Wall's
direction) is only visible on the Floor Plan, provided that the
Clean Wall & Beam Intersections feature is switched off.
Otherwise, all Beams look alike in this respect.

R T
= ==—==3

Note that the display of the Beam depends on the current
settings made in Options/Display Options.
- Clean Wall & Beam intersections can be set on and off.
- Tt is possible to show only the reference lines or only the
contour lines of the Beams.
- Fill patterns can be shown as uniform, bitmaps or vectorial
lines.

Beam Tool and Settings

The Beam tool is located below the Column tool in Toolbox.
Its settings dialog box contains six panels: Geometry and
Positioning, Floor Plan, Section, Model, Holes and Listing
and Labeling. At the bottom of the dialog box, as for all tools,
the current layer choice is displayed in a pop-up menu.
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| E 1l Beam Default Settings x|
L Favorites. | Default
_» @l G y and Positioni

— 4 Floor Plan

2 P Ti Section

@ » .2 Model

==, » & Hole

%. » = Listing and Labeling

= £ @ Beams Pl Cancel |
(]

The Geometry and Positioning controls include the Beam's
height and elevation, its thickness, an optional offset from the

reference axis, and the option to show the Beam on its own
story only, on all stories or on the stories right above and

below.

il Beam Default Settings

F avarites

|

Default

hd i% Geometry and Positioning
.
=== (400
to Stoy0 gy, | (2700

to Projest

Zaro | <, | |2700

Shov on, Current Starm Only -

;1 Floor Plan

Tt Section

i[# Hole

3
3
¥ 3 Model
3
3

- Listing and Labeling

@ <> Beams bI

Cancesl | 0K I

A

- By default, the reference axis runs in the middle of the
Beam's upper face. However, you can define an offset for
special purposes, and the reference axis can even be
located outside the Beam's contour.

F-"———===—-
E - — = = — ]
e

The second panel includes controls for the Floor Plan
display. Different line types and pen colors can be chosen for
the outline and the reference axis of the Beam. The same
choices will be used to indicate the location and axis of the
optional Holes.

Il Beam Default Settings : 1'

Default

Favorites...

» i'; Geometry and Positioning
- Floor Plan

——  Dashed 3
— _as_e ______________ _| _ W I-l
il Eo.ti[)fhe_d._._._._ e _:| ¥ 1w
» i1 Section
b 23 Model
P & Hole
P - Listing and Labeling
£F @ Beams bI Cancel | oK I

The third panel lists the possible attribute choices (fill patterns
and pen colors) for the Section view. Different colors can be
used for the outline, the cut Beam's internal hatch and the
background of that hatch.

Il Beam Default Sektings x|

Default

Favaorites...

» @t Geometry and Positioning

4 Floor Plan

~ i Section
O 1m|
structural concrete L4 %u IZ_ |-|
A ETR
P 3 Model
P & Hole
P =p Listing and Labeling
£ @ Beams » Cancel | ’TI
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- Composites are not available for the Beam's hatch.

- Only exposed surfaces will use the fill pattern; in Elevation
view, Beams appear with their outline only.

The Model attributes appear on the fourth panel. In addition
to the Material choices available for all five surfaces of the
Beam, this is also where you define the intersection priority of
the Beam in 3D. Clicking the chain icon next to the Material
names will assign the last material chosen to all surfaces of the
Beam. Deselecting the chain icon will restore the materials
that you originally set for each separate surface.

Wl Beam Default Settings x|

Faworites... | Default

i 6 ry and Posgitioni
Floor Plan

»
3
» Tt Section
-

ﬁ Model

ﬂ [ Surfacewhitewash b
|ﬂ [ Suface whitewash L

E |— Surface-wWhitewash b @

@ |— Surface-Whitewash b

3D Intersection
Priarity:

g |— Surface-whitewash > 1 15

Beam istimmed by one or more roofs. Undao Boof Trim |

Custom Tesxture defined in the 200indow, Reset Origin |

» & Hole
» o Listing and Labeling

£F @ Beams 3 |

Cancel | 0K I

- 3D Intersection Priority is discussed below in the Beam
Connections section.

- The Undo Roof Trim... button is never active when
drawing new Beams. It serves to restore the original height
of selected Beams trimmed to Roofs. See the Roof section
Jfor details.

- The Reset Texture button is never active when drawing
new Beams. It serves to restore the origin of the Texture if
it was modified in the 3D Window. See Aligning Textures
in 3D in Chapter 5: Drafting and Editing Techniques.

The fifth panel is used for the definition of Holes.

Il Beam Default Settings - x|

Favorites... Default

[t Geometry and Positioning

1 Floor Plan

o Model

E Hole
Shape: IE @l Size: 'E':::I 200

el aE) Ee

»
»
P T Section
»
e

Contours on Plan:

Position: -IT;!--:: 200

P  =p Listing and Labeling

£F @ Beams }I

Cancel | oK I

Rectangular and circular Hole shapes are allowed. The
Position field sets the distance of the Hole from the top
surface of the Beam. With the Contours on Plan control, you
can decide to show the outline of the Hole inside the Beam or
the axis only.

- You can modify the default settings made for Holes by
selecting them inside the Beam. The same Beam can
accommodate Holes of different shapes and sizes. See the
Defining Holes section below for more details.

The sixth panel is called Listing and Labeling and controls
the handling of the Beam in calculations.
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il Beam Default Settings x|

Favorites... I Default

fll+ Geometry and Positioning

Floor Plan

T Section
o Model

i['# Hole
:@ Ligting and Labeling

v |v|v|v |+

D:  |Beam-a0i| Link Propeties:

¥ By Criteria

¥ Label Beam on Craation ) ~
Matching Properties:

Label Settings... |

=
-]

¥ Individually

Choose...

[Properties

£F D> Beams 3 |

Cancel | 0K I
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The controls of this panel are described in the Element
Identification, Listing and Labeling section earlier in this
chapter.

Drawing Beams

When you are satisfied with the choices you made in the
Beam Settings dialog box, you can start drawing Beams.
New Beams can be created in either the Floor Plan or the 3D
Window.

Geometry

There are four Geometry Methods available for drawing
Beams. They can be activated by choosing the appropriate
option in the Info Box before initiating the creation of the
beam.

A

Default Settings ﬁl
[= FlE|e

- The Single Beam method produces a beam element by
clicking twice in the worksheet at its axis' starting point
and endpoint.

- The PolyBeam method creates a sequence of connected
beam elements with automatically coincident axis
endpoints. The process for drawing chained Beams is the
same as for Walls (see detailed description in the Drawing
Walls section.) Since, unlike for Walls, only straight
segments can be drawn manually, the pet palette does not
appear when you draw Beam chains. When you click to
end the definition of the first Beam, you automatically start
drawing the second one, and so on, until you double-click
to finish drawing the chained Beams.

The Rectangle Beam produces four beam elements with
coincident nodes, the sides of the rectangle being parallel
with the x and y directions, respectively. Define the
rectangle by clicking the starting point and the endpoint of
one of its diagonal lines.

The Rotated Rectangle Beam method produces four
beam elements with coincident nodes, the first side of the
rectangle being defined by the first two mouse clicks at
their endpoints and the perpendicular side defined by the
third mouse click.

Note that although only straight Beams can be created
directly, you can trace the contours of circular drawing or
constructions elements with the Magic Wand to reproduce
their shape by short straight Beam segments. See description
in the Using the Magic Wand section.

Defining Holes in Beams

You can define Holes only after the Beam has been drawn.
Select the desired Beam and make sure that the Beam icon is
highlighted in the Toolbox.

On the Floor Plan, holes can be created by clicking on the
Beam's reference axis. The pet palette appears with the
possible editing choices. Click the Hole icon. The Hole will
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immediately appear in the Beam with the options chosen in
the Holes panel of the Beam Settings dialog box.

In the 3D Window, you can create holes by clicking the
Mercedes cursor on either the Beam's reference axis or a top
edge of the selected Beam element.

1 BE==——

Selecting and Modifying Holes

If you need a number of Holes in the Beam whose settings
are dissimilar, you may wish to first create the series of Holes
by multiplying them and then fine-tune some of the Holes'
shapes, sizes or positions.

You can select a hole with the Beam tool active by Shift-
clicking its center with the Checkmark cursor or by using the
Arrow tool. Note that only one selected hole can be edited at
a time, but if you select the Beam itself, you can modify the
values of all holes simultaneously.

You can modify the Holes' shape and size in the Beam Settings
dialog box or the Info Box. The position of the Hole can also
be changed graphically. Selected Holes can be moved along
the Beam in Floor Plan view. In 3D, the pet palette offers you
the possibility of also moving the Holes up and down.

Joining Beams

ArchiCAD automatically cleans crossings, T and L junctions of
Beams if the Clean Wall & Beam Intersections feature is
turned On in the Options menu.

When drawing Beam junctions with Clean Intersections Off
and On, respectively, the results look like the figures below.

7

Note that unlike for walls, there is no need to split Beams for
clean X crossings.

When joining Beams with Clean Intersections turned On,
it’s irrelevant whether the two reference axes meet or not. If
one end of the joining Beam falls within the contour of the
other Beam, the end of the joining Beam will automatically
adjust to the reference axis. If the Clean Intersections
option is Off, Beams end at the mouse clicks.

In 3D, intersections depend on the priority settings made for
the individual Beams in the Model panel of the Beam Settings

dialog box. For perfect X crossing in 3D, set different
priorities.

Y Ve

Beam junctions are also cleaned up if the crossing or joining
Beams run at different elevations. If Beams pass each other in
space, the junction is not cleaned up in the Floor Plan view.

[
UL

+_

== —]
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Beam end faces are always perpendicular to the sides of the
Beam. For end faces at free angles, use the following trick:

1) Draw your Beam.

2) Set Beam thickness to zero in the Beam Settings dialog
box in order to draw a second (virtual) Beam.

3) Draw the zero thickness Beam starting from the end of the
reference axis of the first Beam at the desired angle as
shown in the figure below. Use the horizontal snap variant
in the Control Box.

»
- _\ - -~ -

4) Rebuild your view. You should see a similar configuration
in your Floor Plan view and 3D view, respectively.

I . . ~

5) Touch up the floor plan symbol by adding a line segment
to complete the gap.

| . . N
[ ~

Beams and Other Elements

When Beams cross Walls or Columns, the element of lower
priority will be cut in 3D, which means that the intersection
part will be removed. The element of higher priority will
remain intact. This applies to volume calculations as well.

- Wall and Column priority numbers are always even and
can only be defined as a general setting in Options/
Preferences/Construction Elements.

- Beam priority numbers are always odd and can be defined
individually for every Beam in the element’s settings dialog
box.

In the example below, the Column's priority number has been
set to 8 in Preferences. The upper Beam’s priority number is
3, and the lower Beam’s priority number is 11. The Hidden
Line and Wireframe views show you how the cut is effected.

iy

Beams always cut Slabs when the two elements join in space
(provided that their Layers belong to the same intersection
priority group). This applies to both the 3D Window and
volume calculations.

Beams can be trimmed to Roofs. See the Roofs section later.

In addition, Beams can participate in all types of Solid
Operations with other construction elements.

Slabs

Definition

Slabs are the basic horizontal building blocks in ArchiCAD.
They are typically used for modeling floors or split levels.
Slabs can be drawn either on the Floor Plan or in the 3D
Window.
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On the Floor Plan, Slabs are represented by their outline. In
3D view, three different materials can be used to display their
surfaces. In Section view, the cut Slab body's fill pattern is
shown, while in Elevations the Slab is displayed with its
contour only.

!
N

The Geometry and Positioning panel contains the Slab's
thickness and elevation values as well as the option to show it
on multiple stories.

Wl slab Default Settings x|

Faworites... Default
- gs Geometry and Positioning
Qo+ [0
to Stere@ <y l ID Shaw on:

= szj:,c:_q S l IU ICurrent Story Only j

I, Floor Plan

== Section

= Model

Slab Tool and Settings

The Slab tool is located in the lower part of the construction
tools section of the Toolbox. Its settings dialog box contains
five panels: Geometry and Positioning, Floor Plan,
Section, Model and Listing and Labeling. At the bottom of
the dialog box, as for all tools, the current layer choice is
displayed in a pop-up menu.

l | Il slab Default Settings x|
L3

I F avarites. Default
= » @t Geometry and Positioning

= » 1, Floor Plan
& 5 =

— == Seclion

= » 5 Model

=E=E, P =g Listing and Labeling

& £2 D Floos L4 Cancel | oK I
=

I ]

v |w (v (v

=, Listing and Labeling

£F @ Floors 3 I

Cancel | oK I

Z

Note that by default, the Slab is set to coincide with the zero
level of the story (or project), which means that the elevation
of the bottom surface of the slab is obtained by subtracting
the thickness from the value shown in the elevation field.

In the Floor Plan panel you can set the line type and pen

color that will be used to represent the Slab's outline in the
Floor Plan.

Il slab Default Settings x|
Favorites... Default
» §t G vy and Positioni

hd B Floor Plan

E Solid Line >| le_ .
» = Section
P 5 Model
P  =p Listing and Labeling

£ @D Floos DI Cancel | oK I

The Section panel defines the fill pattern used to represent
cut Slab surfaces in Section/Elevation windows. Different pen

8
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colors can be chosen for the Slab's outline, its body hatch and
the background of the hatch.

Il Slab Default Settings x|

Fawvorites | Default

» @)t Geometry and Positioning

» 1, Floor Plan

T B Section
G tiuctural concrete 4 . |1 1.
=T E] |
I Use Line & Fill Colors of Composite ) |Q1 [

™| e Backaround Colors of. Composite

b o Model

» o Listing and Labeling

£ @ Floors Dl Cancel | Ok I

- Composites are available for Slabs. If you choose a
composite structure as the Slab's body hatch, the two
checkboxes below the pop-up control become active. You
can use them to override the line type and color setting
made here for the Section display and use the Composite's
own attributes as defined in Options/Composites.

The Model panel's most important controls define the Materials
used for displaying the different surfaces of the Slab in 3D view.

Wl Slab Default Settings x|

Detfault

Favarites... |

i Geometry and Positioning

r,_ Floor Plan

4
4
} = Section
-

<3 Model
== [ woodPine, shiry =r’

= | Sufacewhitzwash b @
) [ sufaceswhitswash s

Custom Texture defined in the S00ind o, Reset Origin

b = Listing and Labeling

£ <@ Floos Dl Cancel | ()4 I

- You can use three different materials for the Slab's different
surfaces or click the chain icon to use the last selected
material for all surfaces. Deselecting the chain icon will
restore the originally set materials to the slab's surfaces.

- The Reset Texture button is never active when drawing
new Slabs. It serves to restore the origin of the Texture if it
was modified in the 3D Window. See Aligning Textures in
3D in Chapter 5: Drafting and Editing Techniques.

The fifth panel is called Listing and Labeling and controls
the handling of the Slab in calculations.

1l slab Default Settings 1'
Favorites... I Default
» (@t Geometry and Positioning
» 1, Floor Plan
} = Section
b = Model
- :g Listing and Labeling

1D- IS\ab-DU‘I Link Properties:
I By Ciiteria
[ Label Siak ) :
a Matching Properties:
LLabel Settings... | ;I
[ Individually Choose.. |
£
£F @ Floors bI Cancel | 0K I
2

The controls of this panel are described in the Element
Identification, Listing and Labeling section earlier in this
chapter.

Drawing Slabs

When you are satisfied with the choices you made in the Slab
Settings dialog box, you can start drawing Slabs by applying
one of the Geometry Methods in the Info Box. New Slabs can
be created in either the Floor Plan or the 3D Window.
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Geometry

There are three Geometry Methods available for Slabs from
the Info Box.

A

Default Settings EI
Tlalol

- With the first icon on the left, you can create a Polygonal
Slab. Just like for Walls, the pet palette appears and allows
you to draw straight and curved segments for the Slab's
outline. See the Geometry section under Walls for details
about the use of the different tools.

If the Slab's polygon intersects itself, a warning appears,
but the Slab will still be drawn.

- The second and the third icon allow you to create a
Rectangular or a Rotated Rectangular Slab. The rectangle is
defined by placing two opposing corner nodes. A
rectangle Slab is always aligned orthogonally with the grid.
The Rotated Rectangular method requires that you first
define a rotation vector.

Placing Holes in Slabs

You may need to make holes in Slabs to accommodate objects
such as staircases, or for an open atrium space.
Select a Slab and activate the Slab tool, then draw a new

contour within the Slab's boundaries. This new contour will
be interpreted as a hole in the Slab.

- If you forgot to select a Slab before starting to create a hole
in it, the new contour will be interpreted as a new Slab,
even if it lies inside another Slab. To check for this, select
the Slab in the Floor Plan view. If you have made a hole,
selection dots will be displayed around both the external
and internal contours of the Slab. You can then select and
delete the accidentally created Slab.

- If you create a hole whose outline intersects the host Slab’s
contour or the outline of other holes in the same polygon,
ArchiCAD will display a warning message, but the outline
of the hole will still be created. A self-intersecting Slab
polygon will be fixed automatically if you edit the polygon
later using any of the pet palette's editing methods.

Slabs and Other Elements

If you build a Wall on top of a Slab and an edge of the Wall
coincides with any part of the contour of the Slab, the
coinciding line between them will be automatically omitted in
3D visualizations. This feature ensures correct hidden-line
exterior views.
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Slabs can participate in all types of Solid Element Operations.
Slabs, like other construction elements, can be trimmed to
Roofs. There is, however, an important difference for Slabs:
unlike for Walls, Columns and Beams, the trim is definitive
and cannot be undone in the Slab Settings dialog box. See
Roofs later in this chapter for details.

Roofs

Definition

ArchiCAD Roofs have very flexible characteristics. They can
be used to create abstract 3D shapes meeting a wide variety of
needs.

In Floor Plan view, the outline of the Roofs is shown together
with their pivot lines. This horizontal non-printing element is
part of the lower surface of the roof.

The roof pitch is interpreted as a pivoting angle around this
line and the elevation of the roof’s bottom edge is defined by
the elevation of the pivot line.

)

EpARRGnt
i 5%
N

Note: You can hide all pivot lines with the appropriate
control in Options/Display Options.
In 3D view, Roofs are displayed as solid bodies. In Section/
Elevations, the exposed cut surfaces display the internal fill

patterns. Roof panes that are not affected by the cut are
displayed with their outlines only.

Roof Tool and Settings

The Roof tool is located in the lower part of the construction
tools section of the Toolbox. Its settings dialog box contains
five panels: Geometry and Positioning, Floor Plan,
Section, Model and Listing and Labeling. At the bottom of
the dialog box, as for all tools, the current layer choice is
displayed in a pop-up menu.

Il Roof Default Settings x|

Favorites... | Crefault

+ Geometry and Positioning

Section

[ 3
= _Floor Plan
B
Va N

Model

oo |6 | (1 ||

v v (v v |w

=, Listing and Labeling

=y
@l £% <@ Roofs » Cancel | OK I
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The Geometry and Positioning panel contains the Roof's
thickness, the Roof pane's pitch and the pivot line's elevation
values as well as the option to show the Roof on multiple
stories.

Wl Roof Default Settings x|

Fawvorites... | Default

- i% Geometry and Positioning
Lk

/.x 45,00 o
& f—
to Story 0 < \I 2700 /: 28
to Project i B
gp—| |27un / 199
Showor: | Current Stary Only -

» = Floor Plan
» B Section
P~ Model
P o Listing and Labeling
£2F D Roafs 3 | Cancel | 0K I

- The Roof pitch unit depends in the setting you choose in
the pop-up menu near the Roof Pitch edit field. You can
define the pitch in degrees, in percentages, or in the
amount of roof rise per 12 feet or 12 inches of horizontal
run. The roof pitch is typically positive, but it can also be a
negative value, in which case the resulting roof is
“reversed”: the side defined with the Eyeball cursor going
upward will instead go downward.

- The Roof pane's thickness can be set either vertically or
perpendicularly. If a composite structure is used in the
Section panel, these two fields cannot be modified, as the
Roof's thickness is then determined by that of the
Composite as defined in the Options menu.

In the Floor Plan panel, you can set the line type and pen
color that will represent the Roof's outline in the Floor Plan
and in Elevation and 3D views.

Il Roof Default Settings x|

Favaorites... Default

» @t Geometry and Positioning

- = Floor Plan

Solid Line >| N omlit |

b = Section
b Model

» b Listing and Labeling

£ @ Rools >| Cancel | oK I

The Section panel defines the fill pattern used to represent
cut Roof surfaces in Section/Elevation windows. Different pen
colors can be chosen for the outline of the cut surface, the
body hatch and the background of the hatch.

I} Roof Default Settings x|

Favarites Default

» @t Geometry and Positioning

» r— Floor Plan

hd % Section

S

v Use Ling & Fill Colors of Composite
¥ Use Background Colors of Composite

oof, conversion L4

b~ Model

» o Listing and Labeling

£% @ Rools bI Cancel | ok I

- Composites are available for Roofs. If you choose a
composite structure as the Roof's body hatch, the two
checkboxes below the pop-up control become active. You
can use them to override the line type and color setting
made here for the Section display and use the Composite's
own attributes as defined in Options/Composites.

The Model panel's most important controls define the
Materials used for displaying the different surfaces of the Roof
in 3D view. You can also define here the Roof edges' angles.
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W Roof Default Settings x|

Faworites... | Default
» @t Geometry and Positioning
» = Floor Plan
b = Section
't Hodel

A7 M RootTik 1 e

g | wood-Pine, shiny =r'

i [ Wood-Pine, shiny =m* € Custom

Cugtom Texture defined inthe 200indow, Reset Origin
P o Listing and Labeling

£2F D Roafs Dl Cancel | 0K I

- You can use three different materials for the Roof's
different surfaces or click the chain icon to use the last
selected material for all surfaces. Deselecting the chain
icon will restore the originally set materials to the roof's
surfaces.

- The Roof Edge Angle setting defines the base and fascia
boards of a roof. They can be set to be either vertical or
perpendicular to the elevation of the roof plane. The
Custom option is dimmed, unless the eave or the rake has
been set to a custom angle (see later). If the Castom radio
button is selected, you have the option of changing this
setting to vertical or perpendicular. Custom roof edges are
not defined in this dialog box.
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- The Reset Texture button is never active when drawing
new Roofs. It serves to restore the origin of the Texture if it
was modified in the 3D Window. See Aligning Textures in
3D in Chapter 5: Drafting and Editing Techniques.

The fifth panel is called Listing and Labeling and controls
the handling of the Roof in calculations.

Wl Roof Default Settings x|
Favorites... I Default
» @l G y and Pozitionil
» = Floor Plan
» = Section
r .~ Model
hd :B Listing and Labeling
1D: IHODF-UUT Link Properties:
[~ By Criteria
Matching Properties:
LLabe! Settings | ;I
l_ Individualhy Choose,. |
F
£% @ Foofs >| Carcel | ’TI

2

The controls of this panel are described in the Element
Identification, Listing and Labeling section earlier in this
chapter.

Drawing Roofs

When you are satisfied with the choices you made in the
Roof Settings dialog box, you can start drawing Roofs. New
Roofs can be created in either the Floor Plan or the 3D
Window, although some options differ or are restricted.

Graphisoft ArchiCAD User Guide

93



Chapter 4: Element Creation

Geometry

The Roof has six geometry methods in the Info Box, allowing
you to create both simple and complex roof shapes. The
options are: Polygon, Rectangle, Rotated rectangle, Polyroof,
Dome and Barrel-vaulted. Note that only four options are
visible a same time. The remaining options can be viewed by
clicking the small arrow at the bottom of some of the icons.

Default Settings EI Default Settings él @ﬂ
= o/=|a) Esls, R

Drawing a Simple Roof on the Floor Plan

Default Settings =

Ny |

Choose one of the first three Geometry Methods in the Info
Box (Polygon, Rectangle, Rotated Rectangle), then define
with two clicks the position of the pivot line. With the
Rectangle method, the roof will always be orthogonal.

In most cases, you will want the pivot line of the roof to
coincide with a wall Reference Line or a slab edge. The
change of the cursor form serves as a visual cue for accurate
placement.

After defining the pivot line, a cursor in the form of an
Eyeball will appear. Use this cursor to click on the side of the
pivot line where you want the roof plane to rise. You can then
draw the contour of the roof by clicking on each of the new
roof’s nodes.

Drawing a Simple Roof in 3D View

Choose one of the first three Geometry Methods in the Info
Box (Polygon, Rectangle, Rotated Rectangle), then enter the
roof plane by clicking any three points. ArchiCAD will
generate the Pivot Line for you.

Draw the contour of the roof. The Hammer cursor appears
when you return to the first node. Click to close the polygon.
ArchiCAD will then generate the Roof.

Drawing Complex Roofs

By choosing the Polyroof geometry method, you can create
equally sloped roofs on any polygonal or curved base. The
result will be a set of individual roof planes. With the
Autogroup function active, they will be automatically grouped
when created.

The process for drawing a Polyroof is the same on the Floor
Plan and in the 3D Window.

First, you draw a polygon of straight segments only. This
defines the pivot lines of the elements of the Polyroof. When
you are finished, the Polyroof Settings dialog box appears.
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Il PolyRoof Settings 21
Lewvels: IE

|z5000

¥y Roof Thickness

C / 109
lc )y Eave Overhang
C BE= k—*l\ 300

The final outline will be defined by the Eave Overhang value
which is added as an offset to the pivot line polygon.

Polyroofs can be made up of a maximum of four levels. The

inclination and maximum height of each segment can be
independently defined.

To create curved shapes with the Polyroof method, draw the
shapes with the 2D drawing tools, then use the Magic Wand
to define the pivot line polygon. Make sure that the Polyroof
Geometry Method is active when you do so. See also Using
the Magic Wand later in this chapter.

Note: ArchiCAD uses a crystal growth algorithm to calculate
the best solution for any particular polygon base. The height
defined in the settings dialog box is the maximum limit. If
the roof meets another roof plane before it reaches that
particular height, it will not go higher. If the roof has reached
the maximum level allowed, and the roof planes have not
met, a horizontal plane will be placed on top. Once the
structure is completed, its parts are individually editable.

Drawing Dome-Shaped Roofs

To create a Dome-shaped roof, select the Dome geometry
method in the Info Box. A Dome-Shaped Roof is a set of
individual roof planes. With the Autogroup function active,
they will be automatically grouped when created. The process
for drawing a Dome-shaped roof is the same on the Floor
Plan and in the 3D Window.

With the first click, you define the center of the arc; the
second click marks the beginning and the third, the end of the
outline. Double-clicking the beginning of the arc will create a
full circular dome.

Once you have defined the outline, the Dome Roof Settings
dialog box appears.

Height

to User Origin [T’
0

Horizental Segments
@ 7 " H

Wertical Segments ~ o=
@ .

#, Roof Thickness

/. |1QQ—
Cancel |

The edit field at top left in the dialog box contains the height
of the Dome Roof as measured from its centerpoint. This
value is set by default to the maximum allowed, i.e., the
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height of a semi-sphere structure. By entering a smaller
number, you can flatten your dome. The next edit field
contains the elevation of the dome’s base.

The number of strips and segments that make up the dome
can also be defined in this dialog box: they are limited to 90
and 360 respectively.

The roof thickness measured perpendicular to the roof’s
elevation can also be set, while the roof edge’s trimming is
controlled by the radio buttons on the right. The three options
available are perpendicular, vertical and horizontal trimming.
Once the dome is created, its parts can be edited as individual
pitched roofs, but not as a whole.

Drawing Barrel-Vaulted Roofs

Barrel-vaulted Roofs can be constructed in either Floor Plan
or 3D view, but it is done through different steps.

In 2D, a curve drawn on the Floor Plan is interpreted as the
cross-section of the Roof. Draw a series of arcs (or trace a
shape with the Magic Wand) and hit the OK or Cancel button
when finished.

When you have defined the curve, you will see a rubberband
boundary, whose ends are connected to those of the cross-
section curve. One of the sides of this boundary is the imaginary
“floor” and, at the same time, the side of the barrel roof.

With a first click, you define the starting point and the shape,
and with the second, the length of the barrel roof.

The Vaulted Roof Settings dialog box is displayed. You can set
here the elevation of the base point of the roof, its edge angle
and, if using a simple fill pattern, its thickness.

Il vaulted Roof Settings 2l x|

to Current Story 2 ». Roof Thickness

B3

2 1=

oK

i

Cancel

The resulting roof planes are individually editable. If
Autogroup is on, they are generated as a group. The curve
drawn in the Floor Plan is clearly visible in the 3D view of the
roof.

Note: ArchiCAD only allows the construction of curved
roofs that can be hit by vertical rainfall. This avoids the
construction of self-intersecting or reclinate roofs. This
also means that the same curve may be valid for the
generation of a roof from one angle of the boundary box,
and invalid from another angle. This is because the shape
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of the roof is determined not only by the curve that it is D Click on the second icon. The Symmetrical Vaulted Roof
constructed from, but also by the angle of the boundary dialog box appears. Enter the number of roof planes to
box that it is associated to. The start and end points of the create.

roof must be defined in such a way that the heavy line side 2) Draw the geometry of the roof by defining its height and
of the rubberband boundary does not intersect the original click.

cross-section curve.
There are three possible methods available for drawing a
Barrel-Vaulted Roof in 3D: rounded, symmetrical and
irregular.
Draw the first side of the outline rectangle of the roof at the
desired height. The pet palette appears. Defining the cross-
section is different for the three methods.

3) Extend the roof to the desired length and click to place the
To create a rounded roof: roof.

1) Click on the first icon.

2) Draw the geometry of the roof cross-section by defining its
height and click.

Note: This method creates roof planes of equal length in
cross-section.

To create an irregular roof:
1) Choose the third method from the pet palette and click.

roof.

2) Define the shape of the roof by clicking as many times as

_ you wish to create new planes. Double-click to finish
To create a symmetrical vaulted roof: creating roof planes.

S F
Cancel | ()8 |
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3) Extend the roof to the desired length and click to place the
roof.

Creating Roof Intersections

You may need to adjust simple roof panes to each other or to
modify some of the panes of a complex roof, for example to
accommodate a dormer.

Consider the two roof faces below:

AN

To have these two roof planes intersect:

1) Select the lower one on the Floor Plan, and Ctrl-click
(Windows) or Cmd-click (Mac) the ridge line of the other.

2) Now select the other roof plane and Ctrl-click (Windows)
or Cmd-click (Mac) the ridge line of the lower one.

3) The two faces have been adjusted to each other.

T T T

By

s
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When the two ridge lines meet on the Floor Plan, this means
that they are in fact intersected in 3D.

For more complex intersections, when more than two roof
planes meet (e.g., when a barrel vaulted roof meets a simple
pitched roof), additional nodes should be added to accommodate
the shape. However, the intersection process itself is similar.

ArchiCAD allows fascia and barge boards to be at unique
angles. For this reason, it is possible for two roofs to not be
properly joined, even though they meet on the Floor Plan.
You can create mortared joints at these intersections, or have
the roof planes connect with vertical ridges.

This is done by selecting all roof planes that you would like to
intersect, positioning the cursor at the common ridge and

keeping the mouse button down. Select the Roof Edge Angle
option in the pet palette that appears. This opens a dialog box.

Il Roof Edge Angl x|

& eical '
" Parpendicular "3:"
! Horizontal '
" Custom 'u.

ISU oo*

I~ &pply on &) Edges

Cancel
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The setting you make in this dialog box applies to all selected
roof planes that meet the common ridge line on the Floor Plan.

Holes in Roofs

You may need to make holes in Roofs. Select a Roof pane and
start drawing a new contour within its boundaries. The new
contour will be interpreted as a hole in the Roof.

Note: If you create a hole whose outline intersects the
host Roof’s contour or the outline of other holes in the
same polygon, ArchiCAD will display a warning message,
but the outline of the hole will still be created.

Adding Roof Level Lines

Choosing the Create Roof Level Lines command from the
Tools/Line Extras hierarchical menu will place lines on
selected roofs at the height values you specify in the
appearing dialog box.

You can define whether the level lines should be placed on
the top or bottom level(s) of the selected roof(s) by selecting
the appropriate radio button in the top part of the dialog box.

Il create Roof Level Li 2 x|
@ ~ OnTaop
% 0n Bottom
i to Story 0
s B
: to Praject Zera
[~ Omit Lines Dutside Roofs

I~ Group with Roof

]

Cancel |

In the fields in the middle, you can specify the height level
where you want the level lines to be placed. The height can
be relative to the Story’s own level or to the Project Zero.
When the Omit Lines Outside Roofs checkbox is enabled,
level lines that fall outside the floor plan polygon of the roof
they belong to will not be drawn. If the checkbox is disabled,

all resulting lines will be drawn. In this case, lines that fall
outside the roof polygon will be drawn to be of equal length
to the pivot line of the roof they belong to.

When the Group with Roof checkbox is activated, level lines
will be grouped with the roofs they belong to.

Note: This option is grayed if the Suspend Groups toggle
is active.

Roofs and Other Construction Elements

Roofs have the unique ability to trim either the top or the
bottom of Walls, Beams, Columns, Slabs, Doors, Windows
and Objects to fit the desired surface of Roofs. This trimming
is not done automatically: use the Trim to Roof command in
the Edit menu to determine which elements should be
affected. For the command to be available, at least one roof or
one element of the above types must be selected.

If walls, beams, columns, slabs and Library Parts are selected,
they will be trimmed to those roofs that are crossing them. If
one or more roofs are also selected together with these objects,
the elements will be cut only to those roofs that are selected
together with the objects. The objects are cut only if they are
partly or wholly under the roof. You must always define which
elements should be cut in the appearing dialog box.

W Trim to Roof 2=

" Trim Top

a0

€ Trim Base

Trim Element Types:

¥ walls, Columinz & Bearns
I Doors & Windows

I Slabs

I | Library Parts

Il SetWwall/Colurn Top to '*
highest Point '

Note: Original Height Settings will be lost

Cancel |
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If only roofs are selected, you will have to define what
elements you want to be cut by the roof by checking the
types in the dialog box. You then need to decide whether you
want to trim the top or the bottom of the elements and click
the Trim button.

Only intersecting elements can be trimmed to a roof. The roof
will only cut elements that are placed under or above its
polygon shape.

Trimming an element can either be temporary, for visual
display only, or definitive. A checkbox in the bottom part of
the Trim to Roof dialog box allows you to modify the height
or base elevation of the affected element. In the example
below, the Set Wall/Column Top to highest Point box was
first unchecked, then checked. The selection dots show that,
in the second case, the wall’s actual height has changed to the
highest point of the trimmed element.

Note that if you click Trim Base, the Set Wall/Column Top
to highest Point box changes to Set Wall/Column Base to
lowest Point. In this case, it’s the base elevation of the
element that changes.

The trim remains in effect even if you hide the Roof or the
trimmed elements, move them away from each other or even

delete the trimming Roof. This allows you to create special
gable shapes from those construction element types. In the
example below, the sloped wall was created by trimming
both its bottom and its top by two Roofs that had then been
removed. The selection dots in this front view show the
original elevation of the wall.

You can restore elements after a temporary trimming. If an
element has been trimmed to a roof, an additional button
appears at the bottom of that element’s Settings dialog box
(Model section) allowing you to undo the trimming. The only
exception is Slabs: their trimming can only be undone
through the Edit/Undo menu item just after the trimming has
been done.

Trimming Walls, Beams, Columns and Library Parts

You can cut quite complex shapes into walls, beams and
columns by trimming them to Roofs. The wall will always
follow the shape of the roof(s) above them, no matter how
many roof segments you have. However, you have to
remember that any roof can only make parallel cuts into the
walls (see example on the right).
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If you trim a wall with a roof that crosses the wall entirely, the
wall will be cut into two parts: one with a cutting at the end,
while the other will be a separate wall without any cut. This
second wall will start from the point where the roof ends.

There is one exception from this. If you have an opening that
would have points in both parts of the wall after the trim, the
wall will remain one piece.

Trimming Slabs

Slabs can also be trimmed by the lower or upper slope of
roofs with the help of this command. However, there is a big
difference between trimming slabs and trimming walls,
columns or Library Parts. While other elements can be partly
trimmed, slabs are always cut along the whole section line of

the roof and the slab, effectively removing the cut part of the
slab.

Trimming with a Remote Roof

You can also use remote roofs and even roofs on other stories
whose outline is shown on the given story for trimming
elements to the plane of that particular roof.

Just select the elements you intend to cut, then Ctrl-click
(Windows) or Cmd-click (Mac) an edge or a node of the roof
you want to cut them with. The reverse procedure will also
work: select the roof you want to cut with and Ctrl-click
(Windows) or Cmd-click (Mac) the individual elements you
want to be cut.

Note: The wall/beam/column is cut whether it is under a
roof or not. Be sure to set a sufficient height for the
original rectangular walls/beams/columns so that they are
cut correctly.
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Meshes

Definition

Meshes are surfaces of any form created by defining the
elevation of their characteristic points and interpolating
between them.

In the Floor Plan, only the outline and the ridges of the Mesh
are shown.

In 3D, depending on the construction method chosen in the
Info Box and the Mesh Settings dialog box, you will obtain
meshes created as superficies, meshes created with vertical
sides (skirt) and meshes created as solid bodies.

A mesh is created on the foundation of the basis Plane and
the ridges of the Mesh.

You draw the main contours of the mesh projected to the
basis plane. You can then raise the characteristic points of the
mesh’s superficies out of this plane.

There are two types of ridges in a mesh: user-defined and
generated ridges.

Ggheratdd Ridge

User-defined ridges are always visible as they are part of the
outline of the mesh.

If the polygons or nodes are at different elevations and the
Show All Ridges option is selected, ArchiCAD will show the
ridges generated through the connecting the mesh nodes.

Each of the ridges generated by ArchiCAD connect two nodes
at different heights that are not already connected by a user-
defined ridge. Therefore, they are not shown if nodes do not
differ in elevation.

Mesh Tool and Settings

The Mesh tool is located in the lower part of the construction
tools section of the Toolbox. Its settings dialog box contains
five panels: Geometry and Positioning, Floor Plan,
Section, Model and Listing and Labeling. At the bottom of
the dialog box, as for all tools, the current layer choice is
displayed in a pop-up menu.

1l Mesh Default Settings x|

B
= Favorites... Default
Oh

[t Geometiy and Positioning

»
,ﬁ » 1311 Floor Plan
@ » - Section
£, ==, Model
A ' » o Listing and Labeling
%] £Z D Meshes bI Cancel | oK I
74

The Geometry and Positioning panel contains the elevation
of the Mesh's basis plane, the depth of the mesh body or sides
below the basis plane, and the option to show the Roof on
multiple stories. You can also decide whether you will
construct a simple surface, a skirted surface or a solid body.

Il Mesh Default Sektings x|

Faworites... Default

- i% Geometry and Positioning
.

@“ f [1000
0 EEwE ) ID Show on:

” szj:rc:_q R l ID IEurrent Story Only j

#4351 Floor Plan
_~71 Seclion

&z, Model

- v |v |¥w

=p, Listing and Labeling

£ D Meshes 3 I

Carcel | ok I

&

In the Floor Plan panel, you can set the line type and pen
colors that will be used to represent the Mesh's outline in the
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Floor Plan and its contours in 3D and Elevation views. ArchiCAD
uses the same line type for user defined and generated ridges.
You can make a distinction between the two kinds of ridges by
setting their color in the Pen Color pop-up palette.

With the two Show Ridges radio buttons you can set whether
to show all ridges or only those that you have defined when
drawing the mesh.

Wl Mesh Default Settings x|

Faworites... | Detault

» @@t Geometry and Positioning

- @ Floor Plan

@ Solid Line » % l.||5z |
% W= ]
" Shaw User Defined Ridges
% Show &l Ridges
b _m Section
b =, Model
b = Listing and Labeling
£ @ Meshes 2 | Cancel | 0K I

The Section panel defines the fill pattern used to represent cut
Mesh surfaces in Section/Elevation windows. Different pen
colors can be chosen for the outline of the cut surface, the
body hatch and the background of the hatch. These settings
only apply to solid bodies, not to simple or skirted superficies.

Wl Mesh Default Settings x|

Faworites... | Default

» [@lt Geometry and Positioning
» I35 Floor Plan

hd % Section
] |
3
| # 7= 1|
W
b . Model
P =i Listing and Labeling
£% @ Meshes >| Cancel | 0K I

In the Model panel, you can assign materials to different sides
of the mesh block. Depending on the construction method
(simple surface, skirted surface, solid body), only some or all
controls will be available. You can use different materials for
the Mesh's different surfaces or click the chain icon to use the
last selected material for all surfaces. Deselecting the chain
icon will restore the originally set materials to the mesh
surfaces.

You can also control the appearance of the generated ridges
in the 3D model. If you choose All Ridges Smooth, only
user-defined ridges will appear in 3D view.

Il Mesh Default Settings =l

Favorites... I Default

» (@t Geometry and Positioning
» 3 Floor Plan

b - Sechon
e

% Model

@ . Misc-Grass
@ B HiscEarth b @

3 {* All Ridges Sharp

" User Defined Sharp

@ W HiscEath ' Al Ridges Smacth
Custom Texture defined in the 30 Windowr, Reset Origin

» o Listing and Labeling
£ D Meshes >| Cancel | oK I

The fifth panel is called Listing and Labeling and controls
the handling of the Mesh in calculations.
The controls of this panel are described in the Element

Identification, Listing and Labeling section earlier in this
chapter.
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Il Mesh Default Settings x|
Favorites... I Default
» @+ Geometry and Positioning
» 3 Floor Plan
»  _-7 Section
» &, Model
- ,.JE Ligting and Labeling
D IMesh-DD‘I Link Properties:
¥ By Criteria
" LabelMesh i )
Matching Properties:
Labe! Settings... | ;I
[ Individually Chaose...
f
£F <D Meshes >| Cancel | 0K I
4

Drawing Meshes

When you are satisfied with the choices you made in the
Mesh Settings dialog box, you can start drawing Meshes.
New Meshes can be created in either the Floor Plan or the 3D
Window.

Geometry

The Mesh has four geometry methods in the Info Box. You
can create Polygonal, Rectangular and Rotated Rectangular
shapes or a Regular Sloped Mesh.

E|

Default Settings £ |

The first three methods work the same as for other
construction tools, for example Walls or Slabs. See the
corresponding sections for details. Note that these geometry

methods only determine the outline of the mesh. The
elevation of the mesh points has to be determined manually.

Drawing a Polygonal or Rectangular Mesh

With the Polygon, Rectangle or Rotated Rectangle geometry
method, there are two phases in the drawing of a mesh.
First, draw a polygon at the elevation of the basis plane that
you defined previously in the Settings dialog box.

You can then edit the polygon after selecting it. Clicking the
borderline of the polygon with the Mesh tool active will open
the pet palette. By clicking one of its nodes, you can edit the
elevation of nodes if you choose the corresponding icon of
the pet palette.

This action opens the Mesh Point Height dialog box. You
can enter a new height value in the text field.

L esh ot veighe AR
Height: |E|
to Basiz Plane _)I
I~ apply toal
Cancel | OK I

- Checking the Apply to All box will set all Mesh points to
this new height.

- Changing the elevation of a single point will not affect the
elevation of the neighboring points.

- The arrow below the text field opens a pop-up menu in
which you can choose a reference level for the modified
height.
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Il Mesh Point Height

Height: |a?s

ta Basis Flane

« Basis Plane
Project Zera
1st Reference Level
2nd Reference Level

I~ Apply to Al

Cancel |

Drawing a Regular Sloped Mesh

The Regular Sloped Mesh method (the fourth in the Info Box)
helps you quickly create regular meshes with plane surfaces.
After defining the rectangle contour of the mesh, the Regular
Sloped Mesh dialog box opens automatically.

Il Regular Sloped Me: 2l x|

Drivisiores:
e =k

Mesh Comer Elevation:
ﬁ z1 IE
ﬁ z2 IU
=
0
coon |

In the first part of the dialog box, you can set the number of
divisions in either coordinate direction. You must then set the
elevation of three mesh corners; the fourth one is generated
automatically.

On confirming the settings, ArchiCAD will draw the mesh.

Adding New Points or Holes to the Mesh

With the Mesh tool active, select the Mesh that you wish to
add points to. Draw an open line or a closed polygon by

clicking twice at the last node or clicking the OK button in the
Control Box. The New Mesh Points dialog box then opens.
You can define here the new nodes as the points of a hole or
as an addition to the superficies.

If you draw outside of the contour of the first polygon, only
nodes within the contour will constitute the mesh.

You may continue developing your mesh later by adding new
nodes, polygons and editing elevations later as well. When
you add new points or create a hole in a mesh, ArchiCAD
offers several ways to define the relationship between the
newly created points and existing ones.

When you add points to the selected mesh, in the New Mesh
Points dialog box you can choose between adding new
points and creating a hole. Located below the two radio
buttons, the pop-up menu contains three choices that
produce different results.

I New Mesh Puints% 21|
& Add New Paints
" Create Hale

" Add New Paints
" Create Hole

Fit to szer Ridges M

- Mo Surface Fitting
x| Fito Al Ridges

Cancel |

- If you choose No Surface Fitting, the new points will be
added with the height value currently set in the Mesh
Settings dialog box. Intersected user-defined ridges will
keep their height. If you're creating a hole, the slopes of
the mesh will be connected to the bottom elevation of the
mesh.
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. .

- If you choose Fit to User Ridges, the new points will be
placed on the current surface of the Mesh, and only user-
defined ridges will keep their height. This method is
recommended for renderings.

;"/j/ —— j

e AT R

- If you choose Fit to All Ridges, the new points will be
placed on the current surface of the Mesh, and all ridges
will keep their height. This method is the most precise
one, but it may generate a rather large number of ridges.

In the latter two cases, if you wish to create a hole (for
instance, for accommodating a house plot), no slopes
connected to the bottom of the mesh will be created, allowing
you to place your building exactly into the excavated site.

Using the Magic Wand

The Magic Wand saves you work by finding and tracing a
polygon shape from among existing elements, and then
generating a new element based on the polygon. The Magic
Wand lets you create special shapes that are not available for
that particular tool type or would be tedious to construct
segment by segment. Using the Magic Wand is a universal
method for defining polygonal shapes using all tools and
methods that allow you to do so. Since it creates polygonal
shapes by nature, the Magic Wand will ignore geometry method
settings (such as Skewed Rectangle) for the current tool.

The Magic Wand works in both the Floor Plan and 3D
Window and recognizes the following element types: Wall,
Beam, Slab, Roof, Fill, Mesh, Line, Arc, Polyline, and Spline.
Magic Wand recognizes elements that are locked, displayed
from remote or Ghost stories, reserved by others or outside
your workspace.

How to Create an Element with the
Magic Wand

1) Select Desired Element Type. From the Toolbox, select
the new type of element you want to create.

2) Activate the Magic Wand. Click the Magic Wand icon in
the Control box (or, as a shortcut, press the Spacebar) to
make it appear.

- The Magic Wand has three different shapes for identifying
edges % | nodes % and empty space %% (including
surfaces).

3) Click the Magic Wand to find and trace a polygon

shape.

- If you click on an edge or node, the Magic Wand creates a
polygon by tracing that element and/or finding an element
chain: it runs along that edge and traces the element
chains whose endpoints fall within that edge.
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- If you click in empty space or on a surface, the Magic
Wand searches for and traces the closed geometric area
formed by the nearest elements (whether chained together
or merely intersecting), and generates the resulting

polygon.

- You can refine the Magic Wand function by selecting one
or more elements. In this case, the Magic Wand will only
take the selected elements into account when searching
for chained elements or a bounded area.

fox

0

4) The new elements are generated.

- The new elements are not linked to the originals and can
be manipulated independently.

- If the original shapes are superfluous, you can delete
them.

- If Offset or Multi-Offset has been activated, you can
complete the offset function after the Magic Wand has
created the new polygon.

- If you are creating a single Roof, you must draw a pivot
line and define the slope in addition to creating the
polygon with the Magic Wand.

All of the characteristics of the new elements are determined
by the current default settings of the corresponding tool. You
should always check that these are correct either before or
after using the Magic Wand, especially if the elements are
intended to have a specific relationship to each other, such as
a roof resting on a Wall.

Using the Magic Wand with the Pet
Palette

You can trace shapes for making holes in any polygonal
element and add or subtract shapes to a polygon by
combining the features of the Magic Wand with the pet
palette. See Modifying Element Sizes in Chapter 5: Drafting
and Editing Techniques.

Using the Magic Wand in 3D

In 3D, the Magic Wand feature works as in the Floor Plan, but
instead of using only the top view of the elements, each
element is considered the way it lies in space. When
searching for the contours of the new element, ArchiCAD will
only look at the elements that are actually intersected by the
clicked plane. The clicked plane is always the horizontal
plane through the clicked surface point or through the User
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Origin (e.g., when clicking inside polygon walls/beams into
space).
Note: If you create Walls by tracing the contour of a Roof
and define a height above the plane of the Roof, you will
be automatically prompted to trim the Walls to the Roof.

Bl Trim to Roof E 2%l
& Tim Top Vel
© TimBase Lr
Trim Element Types:

J# W, Columns & Beams

I~ Doors & Windows
I Slabs
I Library Parts

e

[~ EetWal/Cobumn Top o i

highest Paint ’
Note: Original Height Settings will be lost

Approximation of Curves

When creating curved Walls and polygon-type elements
based on Arcs, Circles and Splines, the approximation is
based on the state of the Magic Wand Settings dialog box
accessed from the Tools menu.

#ix
Tracing Method
u';*ut ' Deviation from Curves Giive preference to;
Less than 1 ' Linear Segments
" Best Match
iu"-\, " Segments Along Arcs
" Segments Along Circles
o0 Segment Length
i Cancel | ok I

With the two radio buttons on the right, you can choose
between two tracing methods.

- With Best Match, curved segments will follow as best as
possible the natural form of Circles, Arcs and Splines.

- With Prefer Linear Segments, only linear segments are used.

The four radio buttons on the left allow you to choose from a
set of options to approximate curves with linear segments.

- The first option allows you to define the maximum
deviation of the polygon from the original curved element.

- The two buttons in the middle allow you to define the
number of segments along an Arc or an entire Circle. In
the second case, arcs will be transformed into a number of
segments corresponding to the part of the circle they
represent.

- The fourth button allows you to make the transformation
with segments of uniform length.

Note: if you choose the Best Match method and real
curves cannot be created, ArchiCAD will try to
approximate curves in the hierarchical order represented
in this dialog box.
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Creating Element Duplicates

You will often need to create exact duplicates of a particular
element. ArchiCAD offers a large number of features that will
help you recover the settings of previously placed or defined
elements. While some of these features only work inside the
same project, you can also store and retrieve element settings
aCross projects.

Copy-Paste

The simplest way to create exact duplicates of elements is by
selecting, copying and pasting them. Construction elements
can only be copied and pasted on Floor Plans, while drawing
elements can be copied in the Floor Plan, Section/Elevation
and Detail Drawing windows. When copying construction
elements in the Section/Elevation window, you can only paste
the decomposed 2D elements of their current representation.
Copy-Paste works across stories and even projects.

The selection can be made with either the Arrow or the
Marquee tool.

When pasting Floor Plan elements, the elements keep their
original x-y position. Before choosing the final position of the
pasted elements, you can drag, rotate or mirror them.

- If the pasted elements cannot appear in the Window at the
current zoom level, a dialog box opens where you can
choose whether to paste the elements to the original
location or to the current view, and whether to zoom to
the pasted elements.

- When you are pasting with a multiple story marquee, an
alert appears asking you to identify the copied story to
merge to the current one.

Note: If you Cut/Copy and then Paste a selection
between stories at the same zoom level with no Panning
operations in between, the contents of the Clipboard are
pasted into the same position they were originally cut or
copied from. You can change stories in ArchiCAD between

Copy and Paste operations. This feature is very useful
when copying a selection from one story to another.

When pasting elements in another project, remember that
element attributes are identified by name.

- If the pasted elements refer to attributes that do not exist in
the target Project, the necessary attributes will be
appended.

- If the elements refer to attributes that do exist in the target
project but are different from those of the original project,
they will take on the attributes of the target project.

Drag, Rotate, Mirror a Copy

You can also create exact duplicates of an element inside the
same project by dragging one or several copies of the selected
element. The selection can be made with either the Arrow
tool or the Marquee tool.

- If you choose the Drag, Rotate or Mirror command in
the Edit menu and then start moving the selected element
while holding down the Ctrl (Windows) or Cmd (MacOS)
key, a copy of the selected element will be moved. Click to
place the copy.
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- If you choose the Drag or Rotate command in the Edit
menu while moving the selected elements, hold down
both the Ctrl (Cmd) and Alt keys to move several copies of
the selected element. Click to place single copies and
double-click the place the last copy. This function is not
available for Mirroring.

&

++

This feature works in both the Floor Plan and the 3D Window.
Note that, in the 3D Window, you can redefine the height of
the copies before placing them. In the Section/Elevation
window, the feature works on both additional drawing
elements and Doors and Windows (dragging only). In Detail
Drawings, you can use it on any drawing elements.

Hint: If you use this feature often, you can make the Drag
a Copy, Rotate a Copy and Mirror a Copy commands
appear in the Edit menu by checking the Show Element
Copy Transformation Commands in Edit Menu box
in Options/Preferences/Miscellaneous.

All the created elements will have exactly the same
dimensions and attributes.

Note: With the Arrow tool only, you can also use the pet
palette to create the transformed copies. Select the
elements, start moving them with the pet palette and press
the Ctrl or Cmd keys to place single copies and the Ctrl/Alt
or Cmd/Alt keys to place multiple copies.

Multiply

If you need to create a number of identical elements inside
the same project following a definite pattern, for example at
equal distances from each other, use the Multiply function in
the Edit menu.

This feature works in both the Floor Plan and the 3D Window.
Note that, in the 3D Window, you can redefine the height of
the copies before placing them. In the Section/Elevation
window, the feature works on both additional drawing
elements and Doors and Windows. In Detail Drawings, you
can use it on any drawing elements.

Multiply creates any number of exact copies of selected
elements on the current story using the following methods
and options:
- Drag the copies along a straight path with a reference line.
- Rotate the copies using an angle defined by a reference arc.
- Elevate (stack) the copies with a vertical displacement.

- Create a matrix of copies along two reference lines defined
by strokes.

- Elevate and drag or rotate (stagger-stack) the copies, using
both a reference line (or arc) and a vertical displacement.
This is useful for conditions such as linear or circular stair
risers or a sloping landscape’s contours (stagger-stacked
slabs).

Note: Rotated text blocks, labels, dimensions and fill
polygon area labels are always readable from the bottom
and the right side of the drawing.
To use the Multiply... command, set up the parameters in the
Multiply dialog box and apply them by setting a reference
line or arc. The specific steps are as follows:

A set of radio buttons specifies the type of Multiply operation
to perform.
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10l Multiply 2
Choose an action:
@ Drag " Flotate

" Elevate  Matrix

Mumber of copies:

Il

Wertical displacement:

' Increment « Distribute
5%3%% 52%%
i Sprfa_fi_q... la Disl_l!Eule -1
5389 Sash
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- Drag multiplies the copies along a straight path defined by
the reference line.

- Rotate multiplies the copies along an arc, using the angle
specified in the reference arc.

- Elevate stacks the copies with a vertical displacement.
Note that this option is grayed when working in a Section/
Elevation or Detail Drawing window.

- Matrix will place the copies of the selected element(s) to
a matrix defined by two perpendicular reference lines.
When choosing the Matrix option, you need to define the
number of copies for both the first and the second stroke
of the matrix. It also needs two parameters for the vertical
displacement.

In the lower half of the dialog box, the distribution options
determine how the start and endpoint of the reference line
will be interpreted.
-Increment spaces the copies by an incremental distance
equal to the length of the reference line or reference arc.
- Distribute spaces the copies evenly between the start and
endpoints of the reference line or reference arc.

- Distribute-1 will also space the copies evenly between
the starting point and the endpoint of the reference line or
arc, but the distance is divided by the Number of copies +
1 and no copy will be placed at the endpoint.

- Spread will place the copies of the multiplied element to
equal distance from each other along the reference line or
arc all the way until the reference is drawn. In this case,
instead of defining the number of copies, you set the
spacing in length or in degrees between two neighboring
copies.

Vertical displacement will define the value that is added to the
elevation of each subsequent copy of the multiplied object,
even during dragging, rotating or arraying the copies.

When multiplying the element(s) in the 3D window, the
vertical displacement must be defined with a reference vector,
not by a value in the dialog box. In this case, simply push a
radio button in the dialog box indicating whether you need
vertical displacement.

When you have defined your choices, click OK in the
Multiply dialog box and perform the operation by dragging
the cursor to the desired location according to the chosen
option.

Note: When multiplying Windows or Doors, do not forget
that ArchiCAD will place the copies of the openings into
the parent wall on the current story and not to the story
above or below it, even if you have defined an elevation
value that extends beyond that of the current story.
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Parameter Transfer

ArchiCAD allows you to pick the settings of one construction
element and pass them to another with two simple keyboard
shortcuts. This facilitates the modification of either the default
values in a settings dialog box, or the settings of existing
elements, without having to select Tools and open dialog
boxes. The feature is available:

- Both on the Floor Plan and the 3D Window for most
element types;
- In Section/Elevation and Detail Drawing windows for
drawing elements only.
When you press the Alt (Option) key, the cursor takes on the
Eyedropper shape.
The Eyedropper is:
# Full, when snapping to a Reference Line or axis node;
f Half full, when snapping to Hotspots and general nodes;

& Part full, part striped when snapping to a reference line
Or axis;

&' Striped, on top of an edge;
ﬁ Empty, when the cursor is in an empty workspace area
(visual feedback only).

Clicking with a full or striped Eyedropper will load the
settings of the given element into the corresponding tool type’s
settings dialog box and make them the new default settings for
that tool. The given tool becomes active, and, with the next
click, you can start drawing a clone of a clicked element.

To transfer a dialog box’s settings to an element, press the Alt
and Cmd keys (MacOS) or the Alt and Ctrl keys (Windows)
simultaneously while clicking on an element. The cursor
changes into a Syringe. The same rules (empty, striped, full,
etc.) apply as for the Eyedropper. Clicking an element will
apply the default values and attributes (Line Type, Pen Color,
Material, etc.) to that element.

P R

In the example below, the settings of the Wall on top have
been transferred to the Wall on bottom.

e B

Notes: In the case of overlapping elements of different
type, check in the Info Box to see which element has
been selected. The attributes of the element will also be
loaded into the Find & Select dialog box’s corresponding
fields, provided that the dialog box is currently open and
the appropriate button is active. The transferred attributes
will also be pre-selected when opening any of the
corresponding dialog boxes (Line Types, Pens & Colors,
Fill Types, Materials, Composites, Zone Categories).

Favorites

The Favorites feature allows you to save and easily recall
default tool settings. If you choose a stored Favorite, you can
create an element that has the same parameters and attributes
as the Favorite.

Favorites are saved with your Project file. You can also save
a separate Favorites file for reuse in other projects.

- If you close the current Project and create a new one,
stored favorites will remain at your disposal just like
materials, pen colors or line types.

- If you choose New and Reset, Favorites will be cleared.

- You can restore saved favorites by choosing the Load
Favorites command from the Favorite palette's pop-up
menu.

Note: When importing Favorites from another Project,
remember that element attributes are identified by name.
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- If the Favorites refer to attributes that do not exist in the
target Project, the necessary attributes will be missing.

- If the Favorites refer to attributes that do exist in the target
project but are different from those of the original project,
they will take on the attributes of the target project.

Favorites can be accessed from two locations:

- The Favorites floating palette that stores all saved favorite
settings regardless of the tool that created them. The
palette is hidden by default; choose Window/Floating
Palettes/Show Favorite Palette to display it. It remains
visible on top of the other Windows.

Favorites A
Type Hame Delete
Rename
Sawe Current Default Settings
Save Last Selection's.
Redefing with curent Default
Redefing with Last Selection

|  SaveFavorites
Load Favorites. ..

-
A See Info Box for Preview Favorite Preferences. .

=T

- The Favorites button in the top left corner of all Tool
Settings dialog boxes (except Camera). The dialog box
that opens will only list the favorite settings saved for that
tool.

LIl wall Selection Settings

A TR Il Apply Favorites 2
i-- Save Current Settings as Favarite |

Favorite Names:

The stored settings include:

- The element's attributes, including the line type, fill pattern
and pen color, as well as surface material choices;

- In the case of Library Parts, the name of the Library Part;

- All of the element's dimensions that can be entered in the
settings dialog boxes for the element, e.g., wall thickness
and height (but not length).

You can also customize the storing of Favorites for each tool
or parameter type by choosing Favorite Preferences from
the Favorite palette's pop-up menu.

In the Favorite Parameter Exclusion dialog box that appears,
check the names of the parameters that you DO NOT want to
store with Favorites.

Il Favorite Parameters Exclus =l

Checked Parameters Wil HOT be
saved with Favorites

@ Group by Toal
" Group by Paramater

- Clwall Masky
+ Colurnn b ask

Stary 0

H-[] Zone Mask

- [] Window/Door Mask
#-[] Object/Lamp Mask
H-[] Slab Mask

- [] Roof Mask

H-[] Mesh Mask.

+)-[] Section/E levation Mask
- [] Figure Mask

- ] Fill Mask,

] [ - -

Cancel |

2

Functions of the Favorites Palette

The Favorites palette lists the Names and Types of all stored
default settings. You can verify the actual settings in the Info
Box.

If no element is selected, clicking a name in the Favorites
palette will show the settings of the Favorite in the Info Box.
Double-clicking the name will also switch to the
corresponding tool in the Toolbox.
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If eligible elements (that is, ones that correspond to the type
of the Favorite) are included in the current selection, double-
clicking the name of the Favorite will apply its settings on the
selected elements.

You can sort Favorites by Name or Type: just click the
corresponding caption.

The arrow in the top right corner opens a pop-up menu with
a number of commands that allow you to work on Favorites.

Favorites A
Type Name Delate
Rename
Save Current Default Settings...
Save Last Selection's..
Redefine with cument D efault
Redsfine with Last S election

| SaveFavaites..
Load Favorites.

4 See Info Boxfor Preview Favarite Preferences. .

You can:

- Delete the selected Favorite (one at a time),

- Rename the selected Favorite (enter a new name in the
appearing Rename Favorite dialog box),

- If any tool is active in the Toolbox, choose Save Current
Default Settings to store these settings as a Favorite and
enter a name in the New Favorite dialog box that
appears. This item is inactive if the Arrow, Marquee or
Camera tool is selected in the Toolbox.

i Yew Fovorie Y

M arne:

Cancel

- If any element is selected, choose Save Last Selection to
store that element's current settings as a Favorite. If
nothing is selected, this command is inactive.

- If any tool is active in the Toolbox, choose Redefine with
Current Default to change the selected Favorite's

definition to the current default settings of that tool. This
item is inactive if the Arrow, Marquee or Camera tool is
selected in the Toolbox.

- If any element is selected, chose Redefine with Last
Selection to change the selected Favorite's definition to
the settings of that element.

- Export the whole set of Favorites in a separate file by
choosing Save Favorites. The file will be saved with the
.prf extension.

- Restore saved Favorites by choosing Load Favorites.
Note: When you have located the file to restore and
clicked OK in the directory dialog box, ArchiCAD will ask
you whether you wish to replace the current list of
Favorites with the one you are restoring or merge the two
sets of Favorites.

(Mlouestion X

& Do you want to replace or merge to current favorite list?

Merge | Feplace I

Cancel |

When merging the two sets, if any Favorites have identical
names, you will be prompted to skip or overwrite the
original definition.

(Mlouestion X

& Do you want to avenwrite the existing Favorite: A wall 7

Skip | Owenarite I

Skip &l |

- Define the exclusion of parameters by choosing Favorites
Preferences as seen in the introduction of this section.

Storing and Applying Favorites in Tool Settings

If you click the Favorites button on top of any tool's settings
dialog box, a dialog box appears listing only the Favorites
defined for that given tool.
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Wl apply Favorites x|
Sawe Current Settings az Favorite |
Favarite Mamnes:
T -l
E
Cancel | Apply I

You can either:

- Select a stored Favorite in this list and click the Apply
button to load that Favorite's settings in the tool's dialog
box, or

- Click the Save Current Settings as Favorite button on
top and create a new Favorite by naming it in the
appearing dialog box.

Note: Favorites are identified by their names. If you
attempt to use the name of an existing Favorite when
creating a new favorite (even if it belongs to another tool),
ArchiCAD will warn you about this.

Parametric Objects

Some types of construction elements are placed in ArchiCAD
as the instances of predefined elements residing in external
tiles named GDL Objects or Library Parts. GDL Objects are
stored in libraries of objects that can be used in many Projects.

GDL Objects comprise a 2D Symbol and a 3D description in
GDL (Geometric Description Language), as well as some
optional information such as an additional 2D description, a
user interface script or a component definition. To learn more
about Library Parts, see Chapter 7. Library Management,
Chapter 8: Working with GDL Objects and the Graphisoft GDL
Reference Manual.

When you insert a GDL Object, you are actually placing an
instance of the external file. You can freely configure the
placed instance within the parametric restrictions of the
Library Part without actually modifying the external file itself.

GDL Object Types

GDL Objects are directly placed using ArchiCAD tools.

Depending on their subtype, the tool that recognizes and

places them can be either the Object tool or a dedicated tool,

for example the Door, Window, Corner Window, Lamp, Stair

or Skylight tool.

Typically, you will follow these steps when placing a GDL

Object:

1) Select the corresponding tool in the Toolbox and open its
settings dialog box by double-clicking the tool's icon.

2) Browse for the appropriate element in the available library
folders.

3) Adjust the default settings default to suit your particular
situation or purpose and click OK to confirm.

4) Click at the desired location and place the customized
instance of the Library Part.
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Note that there are special constraints and considerations for
different types and subtypes of GDL Objects. See the detailed
descriptions of the different elements.

Warning: If you open a Project and the Status Report
palette informs you that library items are missing from the
Active Library, those items cannot be displayed on the
Worksheet, in the 3D Window or in the Bill of Materials.
See details in Chapter 7.

GDL Object Type Tool Settings

The settings dialog boxes of Library Part type elements are
more complex than those of the basic construction elements
presented in the previous section. They consist of two parts:
On the left, the browser area allows you to locate single
library parts corresponding to the active tool in the loaded
libraries. The right-hand side of the dialog box contains a
large number of unfoldable panels, similar to the ones
described for construction elements.

[l Object Default Settings x|
==N Load Other Object. o| v ravees | Dafault
G — Bl ~ @y Preview and Positioning
— -
- (23 [ArchiCAD Library]
[ Background Images 80 44 ] Offica Chairo1
[ Demo Libraw 80 1o Story 0
[ List Templates 20 %I 0

[} Obiect Library 60
[ Patches 80
[ Property Dista 80
[ Subtype Templates 80
[ Tertures 80
L..[3 Zones B0
70 Aarhi=A0 11 1

[iArchiCAD Libtay =

Baskground Demeo Library 80
Images 60

N

to Project Zero

.l |0

Show on; | Current Stary Only -

=i, Parameters

»
» == Custom Settings
» ] Floor Plan
» [pA Section
¢z Model
= _Listing and Labeling

=l &F <@ Fumitue & Equipment »

Cancel | o |
A

The browser area includes the libraries loaded with
ArchiCAD. The set of library folders cannot be modified here.
See details in Chapter 7.

You can unfold library folders by clicking the plus sign (or, in
MacOS, the purple arrow) next to their names in the panel on
the left. The panel on the right always shows the content of
the folder selected on the left. If you select an element (not a
folder) in the panel on the right, its settings appear in the
unfoldable panels on the right-hand side of the dialog box.

Wl object Default Settings x|
==N Load Other Dbject | 7] Favertes_ | Default

=1 Object Library 80 - §§ Preview and Positioning

- 1. BASICLIBRARY 80

-3 1.1 Fumishing 80 ] Armehait 02
. Appliances 80 J to Story 0
[0 Beds B0 Sy + ID—
) Cabinets and Shelves R
[Frais 20 | toProjectZen
[ Couches and Sofas 81 — [
[} Health and Recreatior O, B

[ Kitchen Cabinets 80

H i 74 Nifins AN _'_I
4 »
3
(I Chairs 80 = ﬁﬂg &5 »
3
3

= []_Floor Plan
& :I pA_Section
m » 3 Model

»

= Listing and Labeling

Showon: | Currert Stary Orly -

Custom Settings

Armchair 04 Armch air

|
l As
= = £ ® Funitue & Equipment v|

Cancel | |
4

- A pop-up control in the top left corner of the settings
dialog box allows you to arrange the browser area panels
vertically or horizontally.

- With the Load Other... button, you can load a library part
that is not located in an active library.

- Next to the navigation controls, three buttons representing
different icon sizes allow you to display the contents of the
browsed folder as large icons, as small icons or as a plain
alphabetical list that always shows the full names of the
elements.

116

Graphisoft ArchiCAD User Guide




Chapter 4: Element Creation

Dl Object Default Settings

Faverites.._|

x|

Default

D Chairs 80

ect Library 60 -]
1. BASIC LIBRARY £
£ 1.1 Fumishing 61
[ Appliances
[ Beds 80
i [ Cabinets an
- ke e
[ Couches ar
{1 Health and
[ Kitchen Cat
+[) Office 80
Lo Saritan e
L[ Tables 80
[0 1.2 Doors 80
() 1.3 Windows 80
) 1.4 Stucture B0
[ 1.5 Mechanical
() 1.6 2D Elements
2. VISUALIZATION !
3. MACRDS 80

4. ADD-OM LIBF\AF\‘v

I smeair0z

/i Amehairod

5 Bank

* Barstael

= Chairot

# chairoz

& chairaz

& Chair0d

T chairos

T chairos

& Dasign Chair01

{4 Design Chair02
Design Chair03

4l Design chairoa

1 pesian chairos

5 Design chairos

A vesign chairor

4 Design chairos

-

- i% Preview and Positioning
"

[

Armehair 02
1o Story 0
to Project Zero 2|

w0

Show or: | Current Story Orly -

s F

=

Custom Settings

Floor Plan

0

v [w v ¥
£
i

PA_Section

Model

D

L
i

Listing and Labeling

£ B Fumniture & Equipment 3

Cancel | ok |
A

By clicking the down-arrow in the center column of the
settings dialog box, you can hide the browser area. This way,
the dialog box takes up less space.

il object Default Settings

fect Libvam 80

| &% amchairat

Load Other Object. TJ\ Favoiites.
airs 50 vl e

- i% Preview and Positioning

] Armehair02

ol

The panels of the individual library part types are presented
in detail in the corresponding sections below.

Windows and Doors

The handling and behavior of Windows and Doors is quite

similar, therefore they will be described together.

Definition

In ArchiCAD, Windows and Doors simulate the look and
behavior of real-life Windows and Doors. Doors and
Windows cut real, see-through openings into the wall, so that
3D visualizations are more accurate ad lifelike. However, glass
panes are represented as solid shapes, allowing opaque
openings for standard elevations. The glass material lets light

in and you can look through the Windows and glass Doors in
PhotoRendered views.

On the Floor Plan, Windows and Doors are represented by
standard symbols. Depending on the scripting of the Library

Part, various amounts of details can be available at different
Floor Plan scales.

P B2 5 o

A 7 27,

In addition, a setting in Display Options (Options menu)
allows you to show Doors and Windows on the Floor Plan in
full or in outline only, to show or hide their dimensions, or, by
choosing the Reflected Ceiling option, to show the edge of
the door lintel in the same way as the sill of a window.

Window and Door Tool and Settings

The Window and Door tools are represented by a single
icon in the default shape of the Toolbox, together with the
Corner Window and Skylight tools. If you choose Options/
Customize/Palette Shapes and check the Extended
checkbox for the Toolbox, you can see all tools at the same
time.

[

= 2=
= o= | = il
Eﬁ!

Note: Additional icons represent special openings. In the
example above, the Corner Window tool also appears. See
the Placing a Corner Window section later.
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The Window and Door Settings dialog boxes are alike. As
seen in the section above, they comprise a browser area and a
number of unfoldable panels. This section deals only with the
unfoldable panels. (To see the browser area too, click the
arrow at the edge of the dialog box.)

| window Default Settings x|

4 Favorites.. | Default

Preview and Pozitioning

i)

b}
0

Parameters

v |rlwlw|r|vr|v|¥|¥|~
Ao P =

T @ﬁ..

il A

Custom Settings

Floor Plan

Section

Model

Reveal

Dil ion Marker
Marker Custom Settings

Listing and Labeling

[
T

Cancel |

There are ten panels in the Window and Door Settings dialog
box: Preview and Positioning, Parameters, Custom Settings,
Floor Plan, Section, Model, Reveal, Dimension Marker, Marker
Custom Settings and Listing and Labeling.

The Preview and Positioning panel includes, in addition to
the preview of the Window or Door that you will be placing,
simple navigation controls allowing you to go the previous
and next element in the active library set without having to
use the browser area and the controls needed to place the
Window or Door in its host Wall.

On the right-hand side of the panel, the Preview Area
displays the 2D symbol, the hidden line front view, the
hidden line axonometry, the 3D shaded axonometry, the
predefined preview picture or the optional information notes
of the selected Window or Door. Use the buttons next to the
Preview Area to choose a view.

Move the cursor inside the Preview Area and the cursor will
change to an arrow, allowing you to turn to the 2D Symbol or
3D View of your Library Part.

| window Default Settings x|

Fawarites Default

A4 @ Preview and Positioning

4« | »| [ Wi M Double Sash R
Empty Opening il

Anchor Paint:

e

-

a=g 120

Parameters

Custom Setlings
Floor Plan
Section

Model

Reveal

Di ion Marker

Marker Custom Settings

ES T

T

v (v (v v v v v v v

—h, Listing and Labeling

Cancel

By clicking the Empty Opening icon, you can clear the
current Library Part choice and create a simple hole-like
opening in the Wall. See Creating an Empty Opening later.

Both the Anchor Point choices and the Construction
Methods play a role in placing Library Part type Windows and
Doors. The Anchor Point setting decides whether you will
place the Window or Door by its centerpoint or one of its
corners, while the Construction Methods define the sill depth
and shape. The use of these options is illustrated in the
Placing a Window or a Door section.

The Sill Width field specifies an offset for the opening away
from the face of the wall in the direction you define by
clicking with the Eyeball cursor. (It has no effect if you
choose the edge positioning Construction Method.)

The Flip checkbox is only active when modifying the
opening side of a placed Door or Window while keeping the
frame in place.
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The second panel is called Parameters. It contains the
nominal dimensions of the opening as well as the set of
parameters defined in the Library Part.

| window Default Settings x|

b Favorites.. | Default

» g Preview and Positioni

¥ EB'= Parameters
=]

User Type Mevice . 1500
Fully Editable off |
20 Detail Level Detailed t 1500
3D Detail Level Detailed |@

[P Window Frame —

[ Sash Frame I 2400

[ 2D Representation

[* 3D Representation ::: 300

b Materials :
£ Detailed % lg—
20 Symbol Soale sensitn. 7 ¥

b 2'S Custom Settings

} o Floor Plan

b PA  Section

b [ Model

i Reveal

b e D on Marker

b B'S Marker Custom Settings

» b Listing and Labeling

Cancel |

The dimensions of the opening are defined in the four editable
fields on the right. The first two define the height and the
width of the opening, while the ones below define the height
of the header and the sill. These two values are linked: if you
change one, the other will be updated. If you change the
height of the opening, either the header or the sill will be
revised automatically, depending on how you set this option
in the Options/Preferences/Construction Elements dialog
box. The last field allows you to adjust the nominal sill height
to the desired level of the Slab connected to the host Wall.

Note that the physical size of Wall holes can be larger than
their nominal size, depending on local standards. See
Dislocated Openings later.

The parameter set listed on the left affects both the Floor Plan
and 3D representation of the Library Part. Different Windows
and Doors may have different sets of parameters. See Chapter
8: Working with GDL Objects and the Graphisoft GDL
Reference Guide for more details.

IWindow Default Settings 2=
P Favorites... | Default

» & Preview and Positioning
»

= Parameters

Custom Settings

Ri=
Sash Style Sash Frame Attributes Appearance
=1 | Frame Thidness o Sash Material
Ll +
1 3 Frame Width:
E Mullion Material
No Mullions  H-V Grid Panes Ho.
Mert, Upper: |3 S
Horiz. Upper 4
T | I
Louny Vart, Lower: 2
Horiz. Lower. 1
Mullions
Hotspots: [~
[
Back | Next
» of Floor Plan
(A, Section
P M Model
P .} Reveal
b 7 Di ion Marker
b B'= Marker Custom Settings
» b, Listing and Labeling

Cancel |

The Floor Plan panel contains choices for the outline of the
Window or Door. The Pen Color set here will be used in
Elevation and 3D views as well for the lines of the element.
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| window Default Settings X

4 F avorites. | Default

%) Preview and Positioning

5'= Parameters

5'S Custom Settings

4
4
4
M - Floor Plan

ﬁ Solid Lire

¥ Use Symbal Linetypes

| _9F m

Contours:

¥ Use Symbol Colors IE >|

[, Section

M Model

4l Reveal

| ion Marker

'S Marker Custom Settings

v v |w |w (v v

—m, Listing and Labeling

Cancel |

The Use Symbol Colors and Use Symbol Line Types
options allow you, when checked, to use the same pens and
line types for the opening that were used when its 2D symbol
was created. When they are unchecked, you can use any
single pen and line type for the 2D symbol of your item.

With automatic 2D wall framing, ArchiCAD will provide
default door and window framing details when you add
openings to your Project. You can switch automatic 2D wall
framing on or off around an opening on a Floor Plan by using
the Contours pop-up control. If you turn off automatic wall
framing, you can manually add any kind of reveal or inner or
outer sills to the 2D representation of your doors and
windows.

Note: To see these 2D manipulations reflected in the 3D
model, you must add true 3D elements to the incomplete
hole, or modify the GDL macro of the door or window in
question.

The Section panel contains choices for the contours and the
fill of the cut surfaces of the Window or Door.

E Window Default Settings x|

L] Favorites... Default

#'= Marker Custom Settings

» & Preview and Positioni
b B'= Parameters
¢ E'S Custom Settings
» o Floor Plan
A % Section
Rl .
Salid Fill r

“ B <9l iml
WV Use Symbal Section Attributes t' I80 ’_I
P M Model
» .} Reveal
b 7 Di 1on Marker
»
»

—h, Listing and Labeling

Cancel

The Use Symbol Attributes option allows you to use the
same pens and fill pattern for the opening that were used
when its 2D symbol was created.

In the Model panel, you define the Material choices for the
Window or Door.

In addition to the Surface Material options for the door or
window defined in the pop-up menu, several different
materials for individual parts of the door or window can be
specified in the GDL description using the additional
parameters of the opening. Checking the Use Object’s
Materials checkbox will ignore the set material and will
apply the same material that was used when creating the
Library Part.

See also Chapter 8: Working with GDL Objects for more
information about the GDL description.
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E window Default Settings 2l
Pl Favoites... | Default
hd Preview and Positioning
44 »|| W1 Casement I:
=t Empty Opening o i
aﬁg * il L] .
Anchor Paint 2]
bres d =% [0 =
P E'S Parameters
#  B'S Custom Settings
*» oy Floor Plan
b P4 Section
A Model
é [ wood-Pine 3

¥ Use Dbject's Materials

ﬁ " Same asWall Edae
@ % Same as Wall Side

=%+ Shaight Line
=% CurvedLine

Undo Roof Trim

‘wall Dpening M aterial:

In Curved \walls, Split by

Wiindovy s timmed by one or more roofs,

4 Reveal
nty D ion Marker
'S Marker Custom Settings

i Listing and Labeling

v v v |w

Cancel

The surface materials of the host Wall can be applied to the
opening in two ways.

- If you choose the Same as Wall Edge option, ArchiCAD
will apply the material of the wall's edge to the opening's
edges.

- If you choose the Same as Wall Side option, the external
and internal wall surface materials will be applied to the
opening's edges, with the reveal depth as the division line
between them.

For curved walls, the materials can change either along a
straight line or a curve.

The Reveal panel’s controls are only active if you have
chosen the Reveal construction method in the Preview and

Positioning panel.

E window Default Settings 21|

4 Faworites... I Default

hd Preview and Positioning

«|» I
2@&* Fiin

Anchor Paint:

g e

W1 Casement

’il
Empty Opening o H

2= Parameters

B'=  Custom Settings

oy Floor Plan
fA; Section
. Model

1§ Reveal

Section Floor Plan

»
»
3
»
»
-

Head Depth Jamb Depth Jamb Depth 2

% 1 |e0 [s0 [s0

SillfThreshald

» .5y Dimension Marker

Reveal Depth

% % ! [1z0

b B'S Marker Custom Sethings

»  op Listing and Labeling

Cancel

You can customize here the various elements of the reveal,
such as the Head Depth, Sill/Threshold Depth, left and right
Jamb Depth and Reveal Depth.
Note: For composite walls, ArchiCAD does not turn the
skin opposite the reveal inside the opening, if the reveal
depth is less than the remainder of the wall’s thickness.

The Dimension Marker panel features the customizable
Dimensioning options of the Window and Door tools. Note
that the display of the dimensions and the marker is set
universally for the entire project in Options/Display Options.
If the marker display is inactive there, you will not see the
preview of the dimension marker in this window either.
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| Window Default Settings 5'
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Dimension Markers are essentially parametric GDL Objects
permanently linked to the opening.

&

The illustration below shows the Basic marker and the
ArchiCAD 8.0 style marker.
-
Wind-002
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7 U, — Y7777

Sill $00

1 50
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The Marker Custom Settings panel contains options for the
Library Part type dimension marker. The panel is active only if

an eligible Marker has been selected in the Dimension Marker
panel.

The last panel is called Listing and Labeling and controls
the handling of Windows and Doors in calculations.

E Window Default Settings x|

4 Favorites | Default

Preview and Positioning

)

Parameters

Custom Setlings

Floor Plan

Section

Model

| Reveal

Di ion Marker
Marker Custom Seltings
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:g Listing and Labeling

1D: IWind-Dm Link Properties:

IV By Criteria

[~ Label Window ) )
Matching Properties:

LLabel Settings... | |‘H Window ;I
|

Choosz... |

[ Individually

Cancel |

The controls of this panel are described in the Element
Identification, Listing and Labeling section earlier in this
chapter.

4

Placing Windows or Doors

When you are satisfied with the choices made in the Window
or Door Settings dialog box, you can start placing openings.
Windows and Doors can only be inserted into Walls; they
cannot be placed independently in the project.

In the Floor Plan, you can place a Window or Door opening
at any Checkmark or Mercedes cursor position on a wall’s
outline. By turning On the Clean Wall & Beam
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Intersections mode from the Options menu, any point
where two or more Wall outlines meet becomes available as a
placement position for openings.

In 3D, you can place a Window or Door anywhere along the
length of the Wall. In Section/Elevation windows, you can
create new Windows or Doors only by duplicating existing
ones using the Multiply or Drag a Copy functions.

When the Door or Window tool is active and you place your
cursor on top of an eligible location in the Wall, the ghost
contour of the opening is shown and it follows the
movements of the cursor. You can switch this feature off in
Options/Preferences/Miscellaneous.

If you attempt to place a Window or Door near the end or top
of a Wall, where there is not enough room to accommodate it,
a dialog box will be displayed to warn you and give you the
option of discarding the opening. You can still opt to place
the Window or Door, but in this case you will obtain a
dislocated opening.

Geometry

The geometry of the Window or the Door is defined by the
information included in the Library Part. While some generic
elements allow a large amount of freedom in modifying the
size and shape of the Window or Door before or after placing
it in the project, more specific designs corresponding to real-
life manufacturer catalog items can only be placed as defined,
with restricted variation possibilities.

Creating a Simple Opening

To create a simple opening without placing a library part type
Door or Window, click the Empty Opening button in the
Preview and Positioning panel of the Door or Window

Settings dialog box, then go to the Parameters panel and enter
the height and width of the hole. Click along either side of an
existing wall.

You can obtain special 3D wall shapes by adding several
empty openings to it.

Placing a Window or a Door

If you wish to place a real Window or Door type object in a
Wall and have made your choices in the settings dialog box,
you need to decide on the construction and geometry method
(anchor point) used to place the opening. You can use the
choice made in the Window or Door Settings dialog box or
choose another method in the Info Box.

A single click is required to place and orient the opening:

- Windows: the click defines the external side of the
Window. Sill depth is always measured from this side.

4
Y,

- Doors: the click defines the swing direction of the door.
For doors without a German type reveal, sill depth will be
measured from this side. For doors with a German reveal,
sill depth will be measured from the opposite side.
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By selecting any of the three Door or Window Construction
Methods you can define how the default or selected Door/
Window will be positioned in the opening.

- The Edge method will place the Window or Door at either
edge of the opening in the wall. Clicking with the Eyeball
cursor decides which edge is chosen.

If this method is selected, the sill depth is automatically set to
Zero.

<3

ﬁ% ! E= | E

<4

- The Sill method will place the Window or Door within the
opening with a sill of the depth currently defined in the
Window/Door Settings dialog box at the selected side of
the opening. The Eyeball cursor will prompt you to choose
a side.

<4

e ————r—

<4

- The Reveal method creates a revealed opening according
to the values currently defined in the Window/Door
Settings dialog box. Use the Eyeball cursor to select the
side of the wall on which you want the reveal to be placed.

<4

@ N A

<3

Doors and Windows can be placed by their Anchor Points,
that is, either by their centers or their corners.

When placing a door or a window by its corner, the special
Double Eyeball cursor appears and, as you move the mouse,
it will flip the outline of the opening from one side (1) to the

other (2), prompting you to click (3) when you are satisfied
with the opening’s position. This works the same way at wall
corners.

Placing Corner Windows

Corner Windows can be placed at straight wall corners. Most
of the Windows of the standard ArchiCAD Library can be
placed at corners. The Corner Window Settings dialog box is
similar to the Door and Window Settings dialog boxes.
When you wish to place a Corner Window at a wall corner,
you can click anywhere on the wall: ArchiCAD will
automatically snap the window to the nearest corner of the
wall and create a mirrored copy of it on the adjoining wall.

The second window's parameters and properties are identical
to the first's. Their angle and position are automatically
adjusted.
- You can only place one pair of corner windows at any
given corner.
- The angle between the two walls cannot be equal to either
0 or 180 degrees.
- The placed windows can be stretched manually and
individually without breaking the link between the two
windows.
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Corner Windows turn into simple Windows if:

- You drag away, mirror or rotate any of the two placed
Windows.

- The angle between the two Walls is changed to 0 or 180
degrees.

- One of the Walls is elevated (since Windows are part of
the host Walls, the two Windows' elevations become
different).

- One of the connecting Walls is deleted or dragged away.
Skylights

Definition

Skylights are smart GDL Object type elements that can be
intelligently placed in Roof type elements. The Skylight Object
placed on top of a roof will be automatically inserted in the
roof and adjusted to the correct roof slope angle, at the
appropriate elevation, rotated to the correct angle (parallel
with the roof's reference line). A hole will be cut in the roof.

Note: The skylight must fit into a single roof plane.

Rz T 7 i
7

Skylight Objects are stored in the "Dormers and Skylights"
folder of the standard ArchiCAD library and can be activated
with the Skylight tool.

i’ lSkyIight Settings... ﬂﬂ
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The panels available in the Skylight Settings dialog box are
similar to those of the Window, Door, Object and Lamp tools.

Placing a Skylight

Skylights can be inserted into Roofs in either the Floor Plan or
in 3D view.

- In Floor Plan view, you place the skylight inside the
outline of the roof.

- In 3D view, click on the roof plane - ArchiCAD will detect
the location of the mouse-click and place the skylight on
the roof plane.

Skylights placed in Roofs behave quite similarly to windows
placed in walls. For instance, when moving the skylight, its
movements are restricted to the roof plane. If you modify the
roof plane, for example by changing its pitch, the skylight
object will follow suit.
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Objects and Lamps

Definition

Objects are predefined complex parametric elements that can
be freely placed in the project. Lamps are special Objects that
are used as light sources in the project.

The ArchiCAD Library includes a large number of predefined
Objects ranging from simple geometric shapes to complex
pieces of furniture. Manufacturer libraries representing real-
life products are also available from various sources including
CD-ROMs and the Internet.

See also the concepts underlying GDL Objects presented in
detail in Chapter 8: Working with GDL Objects. The creation
of GDL Objects is fully explained in the Graphisoft GDL
Reference Guide.

On the Floor Plan, Objects and Lamps are represented by a
2D Symbol while their 3D view is generated from the 3D
script that takes into account the parameter choices made by
the user.

]

R T T

Some 2D-only objects have special 2D Symbols especially
designed for use in the Section/Elevation window.

Object Tool and Settings

Similarly to the Door and Window tools, the Object and Lamp
tools are represented by a single icon in the Toolbox default
shape. The icon always shows the currently active one. Use
the small arrow at the bottom to flush out the other tool.

The Object and Lamp Settings dialog boxes are alike. As seen
in the Library Part Tool Settings section above, they comprise a
browser area and a number of unfoldable panels. The controls
of the browser area have been presented there. This section
only deals with the unfoldable panels. (To see the browser
area too, click the arrow at the edge of the dialog box.)

==, E Dbject Default Settings ﬂ
1 Favarites Default

» @i Preview and Positioni

Parameters

0% =B s

6

Custom 5ettings

Floor Plan

Section
Model
Listing and Labeling

o BDIOGD

Cancel | 0K I

Funiture & Equipment 3 I

»
3
3
»
3
3

=

REP: |2

N

There are seven panels in the Object and Lamp Settings dialog
box: Preview and Positioning, Parameters, Custom Settings,
Floor Plan, Section, Model and Listing and Labeling.

The Preview and Positioning panel includes, in addition to
the preview of the Object or Lamp that you will be placing,
simple navigation controls allowing you to go the previous
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and next element in the active library set without having to highlighted rectangle. It will act as the default positioning
use the browser area. You can also set the elevation of the handle and anchor point for the Object.
Object or Lamp as for the other construction elements and The other hotspots are displayed as an X. Click any of them to
decide whether to display it on other stories too. use as a positioning handle. This allows you to choose the
11 Obiect Default Settings: x| most appropriate handle for your purpose and facilitates swift
] [ s Detault and accurate object positioning.

hd Eg Preview and Positioning
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to Story 0 % 3 Ini y B
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Showi on [Current Story Oy | &

Y 5 Parameters The second panel is called Parameters. It contains the

b %= Custom Seltings dimensions of the Object as well as the set of parameters

: o Pon defined in the Library Part.

L_ir o . Il Object Default Settings x|
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£ @ Funiure & Equipment v el | [ ok ] ( _rawites. | befault
» @t Preview and Positioning
On the right-hand side of the panel, the Preview Area v [Fy FeemeEs
displays the 2D symbol, the hidden line front view, the
hidden line axonometry, the 3D shaded axonometry, the e - = Jsw
Y, ry, Bed Height 400

predefined preview picture or the optional information notes Lot D — :I et 2000 B
of the selected Object or Lamp. Use the buttons next to the £ Fill Badround Pen I otqier et [750
Preview Area to choose a view. e - oo L
Move the cursor inside the Preview Area and the cursor will ~ Materials Pow

e Frams Material [T s oweed | r

change to an arrow, allowing you to turn the 2D Symbol or
3D View of your Library Part.

2= Custom Settings

»

» ] Floor Plan
» Section
»
4

g Model
—m, Listing and Labeling

£ @ Fumiture & Equipment bI Cancel | ok I
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Activating the Chain icon to the right of the length and width
Objects can be positioned by their hotspots, defined in the 2D edit fields allows you to link the horizontal and vertical

symbol of the Library Part. One Hotspot is initially defined as parameters of your Objects and keep their original proportions.
the primary hotspot. This hotspot is marked with a
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You can also set a horizontal rotation angle. Below this field, a
checkbox can be used to place mirrored Library Parts or to
mirror them after placement. This option reflects the entire 3D
description of the Library Part across the Y-axis defined by the
Object Hotspot you entered in the Object Settings dialog box.

Some parameters related to Lamp type Library Parts are unique.

E Lamp Default Settings x|
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- You can set the light source’s color by double-clicking the
Color box, and choosing color in the standard Windows or
MacOS color editing dialog box.

- The brightness of the light can be set with the sliding
switch. Maximum brightness is at the right end.

- The switch next to the color box allows you to turn the
lamp on and off in PhotoRendering.

Note: Whether Lamps will be actually used in
PhotoRendering depends on the general setting made in
Options/PhotoRendering Settings/Effects.
The Custom Settings, Floor Plan, Section, Model and Listing
and Labeling panels of Objects and Lamps are quite similar to

those presented for the Window and Door type elements. See
their description there.
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Placing Objects and Lamps

When you have selected an Object or Lamp and adjusted its
settings in the Object Settings dialog box, you are ready to
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place it. You can place Objects in both the Floor Plan and the
3D Window.

It is also possible to place the 2D Symbol of Objects in a
Section/Elevation or a Detail Drawing window. Note that
many 2D only elements have specific 2D Symbols for use in
Floor Plan and Elevation view. Choose the appropriate view in
the Preview and Positioning panel before placing the Object.

When positioning the Object or Lamp, you can use numerical
input, gravitation, mouse constraints or the grids. This allows
you to fit fixtures or furniture to corners, specific positions, or
to each other with great accuracy.

Geometry

Unlike walls or other elements constructed on the fly, object
symbols have a predefined geometry and the cursor can only
snap to predefined Hotspots of the symbol. The cursor is not
sensitive to edges within symbols. Objects can be placed,
selected, and fitted to other elements by these hotspots. The
primary hotspot can be defined on the Preview and
Positioning panel of the Object Settings dialog box. Before
placing the Object or Lamp, make sure that you have selected
the appropriate hotspot.

When the Object or Lamp tool is active and you place your
cursor inside a construction window, the ghost bounding box
of the element is shown and it follows the movements of the
cursor. This also allows you to check the active hotspot used
for positioning the Object or Lamp. You can switch this
feature off in Options/Preferences/Miscellaneous.

D)% = [n|=a |

b

:[&
|

Four geometry methods are available in the Info Box for
placing Object and Lamp type Library Parts.

S

Default Settings ﬁl

- The Orthogonal method automatically places Library Parts
in alignment with the normal grid lines unless you specify a
rotation angle in the Settings dialog box before placement.

- To place a Rotated Library Part, first define a reference
point by clicking any point. Use the resulting rubberband
line to place the rotation vector. This rubberband line can
be constrained using any of the drafting modifiers or
enabled Mouse Constraint angles.

- The Diagonal input method works like the rectangle
geometry method used for polygonal elements.

- The Rotated diagonal input method works like the
rotated rectangle method used for walls, slabs, etc.

The last two methods let you define the A and B parameters of
the Object or Lamp graphically. Note that they are only available
if the GDL Object can be freely stretched; some Objects may
have fixed or proportionally set dimension parameters.

The result of this technique also depends on the active
hotspot. As a rule of thumb, if a hotspot at the corner of the
object is selected, you can define both the A and B parameters
graphically. If the hotspot is along a side of the object, you
can only define one of the parameters graphically and the
other parameter will be taken from the Settings dialog box.
When choosing a hotspot within the bounding box of the
symbol, none of the parameters can be set graphically and the
element will be placed as if using the simple orthogonal or
rotated methods.

Objects and Other Elements

Like other construction elements, Objects can be trimmed to
Roofs. See the Roofs section for details.

Graphisoft ArchiCAD User Guide

129



Chapter 4: Element Creation

Stairs

Definition

Stairs are a special subtype of Objects. ArchiCAD stairs are
created by StairMaker, an Add-On application smoothly
integrated with ArchiCAD. It lets you easily design and
construct all kinds of stairs required for ArchiCAD projects by
selecting from a set of predefined geometry types, or by

drawing the main geometry of the stair and editing parameters.

Note: To use StairMaker, it must be placed in ArchiCAD’s
Add-Ons folder that is located either in the same folder as
ArchiCAD, or in the System Folder (MacOS) or at the
location defined in the Windows Registry (Windows).

In most ways, Stairs behave similarly to Objects but they can
only be created and modified with the Stair tool.

On the Floor Plan, Stairs are displayed as 2D symbols using
standard architectural conventions. The way stairs are
typically displayed allows you to see both the bottom part of
the stairs going up and the top part of the stairs going down.
Stairs can be visible across multiple stories and the amount of
detail shown in the 2D symbol is scale-dependent. The
controls that handle the display of the 2D Symbol are in the

Preview and Positioning panel of the Stair Settings dialog box.

See their description in the next section.
Note: Slopes (or ramps) can also be created in ArchiCAD.
They too belong to the Stair subtype of Objects and share
most of the options available for Stairs.

You can create stairs in two ways:

- Standard types can be created by selecting a predefined
template and customizing it.

- Custom stairs can be created from a stair contour and a
line of travel designed with ArchiCAD's 2D drawing tools.
Note: In addition to the stairs created with StairMaker, the
Library may contain Stair objects for shapes and
geometries not available in StairMaker.

Geometry

The various stairs you can create are categorized into 18 stair

types.

Every time you create a new stair, a dialog box appears,
containing the 17 standard stair types you can create with
StairMaker. The last button represents the custom stair
designed with ArchiCAD’s drawing tools. The available stair
type previews correspond to the basic schemes in the
following illustration.

Straight Run HHHHHE  vrewen
with Landing %
Intermediate Landing T
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with Two Landings
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Winder at Both Ends

Z-Run
Winder at Both Ends

Circular

B
o

U-Return with Landing
and Winder starting with
Winder

C-Run
Adjustable Angles

Space Saver

U-Return with Landing
T and Winder starting with
T Landing

L-Run
with Landing

U-Return Custom Stair

Winder

You need to save different Stair Object files for Stairs of
different geometry. Since Stairs are typically specific to a
Project, it is recommended not to save them in a common
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library folder, but rather set up a folder for Project-specific
items and save your Stairs there.

Stair Tool and Settings

The Stair tool is located below the Object tool in the Toolbox.

Its settings dialog box includes the same panels as that of the
Object and Lamp tools: Preview and Positioning, Parameters,
Custom Settings, Floor Plan, Section, Model and Listing and
Labeling. See the Objects section above for details.
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The only difference is a small arrow located next to the
Preview area in the Preview and Positioning panel. Tt
opens a pop-up menu with two commands allowing you to
edit selected stairs and to create new ones.
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Stairs have two types of parameters:

- In StairMaker, you set the stair type, shape, structure,
railing and other parameters, as described later in this
section.

- In ArchiCAD, you set display parameters for the stair
symbol.
If you choose the 2D symbol in the Preview area, the Stair will
be displayed according to the state of the Story Sensitive
parameter.

W] Staightiunt | [resewt000 [a «|»]] Shaightrunt |
B =]
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to Project Zero ©
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If the Story Sensitive parameter is active, the stair will be
displayed as follows:

- Home story of the stair: lower part of the stair is displayed.

- First story above the home story: the upper part of the stair
or the whole stair is displayed.

- Stories below the home story: the contour line of the entire
flight with dashed lines is displayed.

- Any other story above: the entire flight of stairs is displayed.

o A

On home story On story directly above

‘ ]

LJJ

On stories below
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A
il

On further stories above

On the stair’s home story, you can also choose to show the
contour of the upper part of the stair by using the Dashed
Lines above Break parameter. On the first story above the
home story, you can show the entire flight of stairs by using
the No Break One Story Above parameter.

If the Story Sensitive master switch is OFF, the entire flight
of stairs will be displayed on all stories it is visible on, without
a break line.

The amount of detail displayed with the Stair depends on the
state of the parameters in the Scale Neutral Symbol group.

If the Scale Neutral Symbol master switch is ON, you can
use the four parameters below to set up the details as desired.
The Arrow UP/DOWN parameter is always effective if the line
of travel arrowhead is present.

- OFF: all arrows are directed upwards.
- ON: all arrows are directed away from the current story -
UP or DN will be added for better understanding.
The other three parameters are only effective if the master
switch is OFF, and turn on and off details of the symbol.
If the Scale Neutral Symbol master switch is OFF, the stair
will check the project scale.
- Scales from 1:50 or 1/4"=1'-0" and up: includes tread/riser
data, dashed lines for the nosing added
- Scales 1:200 and 1:100 or 1/16"=1'-0" and 1/8"=1'-0":
includes tread edges.
- Scales smaller than 1:200 or 1/16"=1'-0": outline of the
stair’s line of travel displayed with an arrowhead.

=7

The text size for the tread/riser data is always 2 mm, which is
acceptable for these scales.

M 1:50

Placing Standard Stairs

To design a new stair based on a standard type, activate the
Stair tool icon and choose the Create New Stair command
popped up with the arrow next to the preview area or choose
the File/GDL Objects/New With/StairMaker command.

Ll Stair Type Selection 7]

T SR | e

] | Rl | Btz

R

cancal |
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Choose whether to build a stair or a slope using the stair or
slope buttons. When you press the slope button the symbols
of those stair types whose geometry can be transformed into
slope will automatically turn into symbols of slope; all the
other buttons become gray.

Choose the required stair/slope type from the dialog box, and
click OK. A stair editing window appears on the screen for the
chosen stair type. The window's tab pages can be used to select
and set up the stair components, similarly to a setup wizard.
The editing windows of the various stair types are somewhat
different, but work similarly. The large buttons on the left
represent five tab pages allowing you to edit the stair
document. They give access, respectively, to the Geometry,
Structure, Tread, Railing and Listing settings. Any modification
you make on any of the tab pages also affects the other four.

When finished, save the new stair into an appropriate folder
by clicking the OK or the Save As... button.

Stair Geometry Parameters

The first tab page of the editing window contains preset
values for the available parameters and the floor plan symbol
of the preview area on the right.
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The parameters are separated in three sections: Geometry
Settings, Flight Settings and Tread Settings.

In the upper left part of the tab page, you will find editable
text fields for the Geometry Settings parameters.

This is the place where you can set up the main geometric
parameters of the stair: the story height, the horizontal bounding
parameters, the flight width, the length and the location of the
line of travel.

In the Flight Settings fields you can change the parameters
that define the flight: the number of risers, the form and the
number of the treads in the winder range (in the case of
certain stair types), the dimensions of the landings, the value
of the arrival offset, the closing angle of the flights, etc.

The geometry and the flight values affect the way the floor plan
symbol of the Stair is displayed in the preview area on the right.

In the lower part of the Flight Setting section StairMaker
allows you to add an optional top tread to the stair. It may
either have the same depth as the stair’s other treads, or you
can customize an extra tread depth.

Click the button on the right to add a top tread to the floor
level. A top tread is added to the stair at top floor level as
shown below.

Optional
Top Tread

=

If you leave the extra tread depth field’s value at zero, the top
tread at floor level will have the same depth as the other
treads. To change the top tread’s depth, enter a positive value.
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a2z A I

Tread Tread Exira Tread
Depth

Bottom right in the dialog box, Tread Settings are shown. By
setting these parameters, you can define the geometry of the

Treads or the angle of the Slope, based on the same geometry.

To the right of these fields, the longitudinal section of the stair
is shown, giving you instant feedback on your changes.

B fozer

~

All these parameters together define the design of the stair as
shown in the illustration below.

Run Length
Tread

Flight Width

Risers - 1

slab

Story Height

It is easier and more comfortable to climb the stairs if the sum of
twice the riser and the run (2*Riser + Run parameter) is within
the range of 60 to 63 cm, or 24 to 25 inches. To ensure this
condition, you can define a range of values for the (2*Riser) +
Run parameter in the Tread Settings section.

(Z*Riseri+Run = |0.600
{(Z*Riseri+Run < [0.650
(Z*Riseri+tRun= 0617

The last parameter is not editable. It only shows the current

value of the (2*Riser) + Run parameter.
Note: The Geometry parameters are defined in a very strict
hierarchy, which makes stair editing easy and intuitive.
Stair geometry definition is based on the (2*Riser) + Run
rule. Every time you modify a parameter, StairMaker
checks that the (2*Riser) + Run parameter is still in the
appropriate range. In addition to this hierarchy, you may
lock one or more parameters by clicking on the lock
button. Locked parameters will not be modified. If
parameters need changing, StairMaker will skip locked
parameters and look for the next value in the hierarchy. If
editing is not possible without changing a locked
parameter or if too many parameters are locked, an alert
will appear.

Usually, only the lower part of a stair should be displayed on

the floor plan on its home story. The upper part of the stair

should be displayed one story above. There is a double break

line on the 2D Symbol of the stair showing where the stair is

Vi
/4

All four endpoints of the two break lines can be dragged
along the stair outline while the lines remain parallel.
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7
Vil

If the whole stair should be displayed on the floor plan,
changing the break line will have no effect.

Some of the available stair types have one or two winders. In
the following example using the stair type called “U-Return
Winder”, we will see how winders are handled.

~ Geometry Selting:

S | eE—
Y ) ET
Sre 1 ) P

i~ Flight Settings

5 bl [e
39111 [ BT
Tread Settings
(2*RiserRun = [0.600
:m.imin 0120 [ZRiserpRon = [osen
(-‘% FJ'\;"E [2*RiserfRun = 0 A20
:’;’E & Joz=o -~
&Iw 0.000 7 sl [o-175

As you can see, a part of the stair is highlighted and all treads
in the highlighted area are skewed. The highlighted section is
the winder range for the stair. If the entire run is highlighted,
then all treads are skewed with respect to the line of travel.

Tread edges outside the winder range are perpendicular to the
line of travel. (For a comfortable stair, the winder range usually
includes at least the entire curved portion of the line of travel,
so that non-skewed treads are all in the straight run section.)
You can change the extent of the winder section with the

mouse. First move the pointer onto the stair (the pointer takes
a form that may remind you of a spreadsheet editor).

ZARN
AN

Press and hold the mouse button while moving it along the
stair. Some treads turn white as you make the winder section
shorter at the end. Release the mouse button, and StairMaker
will show the new outline of the stair. Make sure that you
define a winder section without overly skewed treads.

You can see that the treads shown in white are no longer
skewed. You can also change the skewed state of a single
tread by clicking. For example, to make the nose of the
bottom tread straight, simply click on the second tread. The
first tread turns white.

1

>

\_\1\

I S
The winder section is “fixed” on the middle tread of the curve,

i.e., you cannot shorten either end of the winder range
beyond this tread.
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If you shorten both ends of the winder range until the middle
tread, you will see something like the illustration below.

In StairMaker, the tread edges before the beginning and after
the end of the winder range are perpendicular to the line of
travel. These two edges define a line of travel segment and an
inside segment.

Two middle treads (if the n number

Winder Section  Middle Tread

of skewable treads is even)

Inside segment
Walking line segment

The inside segment is divided into treads as shown below:

Narrowest Tread Edge Dimension

|
s+2dM+2d
s+ 3d s+ 3d
s+4d s+ 4d

| Division of the ]
Inside

Enter the dimensions in the editable parameter text field in the
middle of the Flight Settings section. This value will be assigned
to the middle tread of the stair run (or to the two middle treads,
if the number of treads in the winder range is even).

As an alternative to the standard winder, you can create a radial
winder. When using this method, the edges of the treads in the
winder range meet in a single point. You can select this method
by clicking the Radial Winder button.

You can change the location of the centerpoint by clicking on
it. A dialog box will then prompt you to enter numeric values
for the offset.

Il Centerpoint S etting HE

ﬁ;ﬁ 0,200
i L

[[m |

The location and the offset are displayed with dashed lines.

If the corner is chamfered or filleted, the offset is still
measured from the imaginary corner.

The offset at custom angled stairs looks like this:

If you choose a U-Return Winder stair, StairMaker will
automatically set the radial winder midpoint to the midpoint
of the arced line of travel.

s+ 5d segment s+ 5d
s+ 6d s+ 6d
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If you choose a “Straight Run with winder at both ends,” you
can define the upper and lower extra length along the side of
the stair. The angles of the first and the last edge of the stair
depend on this offset.

Note: You cannot define radial winders for this stair type.

Stair types with winders let you chamfer or fillet the corners of the
run. To do this, move the pointer to a corner until it takes the form
of a perpendicular sign.

© r

Click on one of the stair’s corner points to open a dialog box
offering the three corner shapes available.

LIl Comner Setting [ 7] %]

I_ £+ Plain

£ © Chanfer

{7 C Filet

Cancel

The Plain corner is the “normal” corner shape. When you
start editing a new stair, all corners are plain.

Choose the Chamfer radio button from the dialog box.
Editable text fields appear where you can edit the chamfer
length. Enter a value and click OK.

LIl Comner Setting [ 2] %]
I_ = Plain
r_ £ Fille
Chamiar Langth [z 110
Maximum 1511 1718

Cancel

Now fillet the other corner.

Ll Corner Setting HE
I_ ' Plain
(7 © Charfer
{7 & Fiict
Fillet Radius 77
Maximum 1541 1118

Cancel

You can change the corner shape at any time. If you move the
pointer to a chamfered or filleted corner it will again show the
perpendicular sign.

Stair Structure Parameters

Click the second button on the left of the stair editing window
to work on the Structure Settings tab page of the Stair.
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The content of this tab page changes according to the
construction type of the stair.

In the Structure section, you can choose among five ways to

model the stair in 3D and edit the related parameters.

FFESS

The following 3D alternatives are offered:
- Solid Stair with Treads;
- Stair with Carriages;

- Stair with Stringers;
- Treads only;
- Solid Stair.

The following illustrations provide the explanation for the
various types.

Tread  Nosing Stair with Carriages
Tread  ——
Overhang w £
— Lo
Riser . 1 : ©
Camagei = |
Tread | Thickness' {———=3
Thickness
I o
| K\“\QW
OS¢
ot Top Tread at
Floor Level
Tread NOS‘; Stair with Stringers
Stringer Thickness
[
|
Riser
o I—
Thickness
Top Tread at
1 Floor Level
Stringer )?

Offset

‘%\

138

Graphisoft ArchiCAD User Guide



Chapter 4: Element Creation

Treads only
Tread  Nosing

Riser
0 )
Thickness:

Top Tread at
Floor Level

D

Solid Stair

Top Tread at
Floor Level

The upper and lower slabs should be set to exactly join the
Floor Plan Symbol within ArchiCAD, no matter which 3D
alternative is selected in StairMaker, and even if a top tread at
floor level is added to the stair.

} Stair }

Fset Feet

Note: When the stair construction is changed, the fields for
treads and nosing may change as well, according to the
current construction options.

The parameters of the stair’s structure change according to the
selected type. These changes will also appear in the stair
geometry tab page and in the parameters of the stair.

In the bottom left section of the window, you can customize

both the upper and lower structural and subfloor + finish
thicknesses.

f Subfloor + Finish
0.000 — Structural Thickness
----- KN . pd
0.300 s
N
i\
- o

Floor to floor
0.300

height

Subfloor + Finish
Structural Thickness |+0

StairMaker automatically adjusts the stair parameters to these
slab specifications. In the example below, the stair connects
to the top floor slab as shown on the left and to the lower

floor slab as shown on the right.

StairMaker automatically adjusts the stair height by referring to
the top elevation of the connecting bottom floor slab as zero.
If you use a separate slab for modeling the subfloor + finish in
ArchiCAD, you only need to enter the thickness of this slab in
the corresponding fields. When you place the stair in
ArchiCAD, the positioning height in the Object Settings dialog
box can be set to zero.

If you do not use any separate slab for subfloor + finish in
your design, set the subfloor + finish thickness to zero.

You can set up the landing thickness of those stairs that have
one or more landings in the editable text fields in the
Landing section of the Structure tab page.

The location of the intersection lines at the bottom of the
stairs depends on the thickness of the landings and the runs,
as well as on the geometry of the landing.
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StairMaker makes clean intersections at the bottom of the stair
between the runs and landings if you click the Clean
Intersections button at the bottom of the Landing section.
The following dialog box will appear:

Il Clean Up Bottom Surface HE

1= Adjust Landing Thickness to Stair Slab Thickness
" Adjust Stair Slab Thidness fo Landing Thickness

% Start Calculation from Downstais

(" Start Calculation fram Upstairs

Cancel I

StairMaker cleans up these intersections by changing the
thickness values of either the landing or the run. You can
select the desired option in the dialog box.

Using the other set of radio buttons, you can choose whether
the length of the landing is modified along the upper or the
lower run.

StairMaker recalculates the parameters with the new values,
and the 2D symbol of the stair will be updated.

One of the stair types has two landings. With this stair type,
your options affect the lower landing and StairMaker will
apply them automatically on the upper one.

On the left, the result in 3D. On the right, the clean
intersections of a U-Return stair with landing.

In the Attributes section of the Structure tab page, you can
define the Pen Color used for the Stair's contour and the
Materials of each of the Stair's sides in the 3D Window and
PhotoRendering.

Tread Parameters

Click the third button from the top on the left of the stair editing
window to open the Tread Settings tab page of the Stair.

% - Tread o
—_— -+ |o.0s0 %: t’ E T ]
| — 0 §
: 0.060
4 Dashed ~ Dashed 3
. Lines: - — - - _
+
-
@ﬂ % © Preship =B
Iy coon % I Pine sy R @
+ S Predhin =m0
-
|
4 [oooo

Notes: This option is not available when the stair structure
is set to Solid Stair or Solid Slope. The content of this tab
page changes according to the current stair Structure
settings.
In the Tread section of the tab page you can set up the exact
parameters of the stair’s tread:

- define the thickness of the tread,;
- define the nosing on the front and on the sides;
- define the thickness of the front of the risers.

In this Attributes section of the tab page, the Pen Color, Line
type and Material pop-ups allow you to define the 3D
appearance of the treads. You can assign different materials
for each side of the treads.

Railings

To set up the railings of the stair or the slope, click the fourth
button from the top on the left of the stair editing window.
The Railing Settings tab page will appear.
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Using the three buttons on the top of the tab page you can
define whether the railing settings should affect both sides of
the entire stair (All Stair-Rail mode), one side of the entire stair
(One Side mode), or a selected segment (One Segment
mode). Selection of the segments is indicated by a red line in
the preview area. The mode chosen here is also in effect
when setting the post (see below).

Clicking the first icon selects all the segments in the preview
of the stair. Parameter settings will affect the whole of the
stairs. A single railing type will be used for the whole stair
with the same offset and parameter value for each segment.
With regard to the offset value, the program automatically
ensures the integrity of the railing, which means that the
segments will intersect accordingly.

nnin

When switching to this mode from either of the other two
(One Side mode or One Segment mode) each flight inherits
the stair-rail and post settings of the lower starting flight’s first
left-hand segment.

After clicking the second icon, the left and right stair-rails can
be set independently. The left stair-rail is selected by default
as displayed in the preview of the stairs. To switch to the right
stair-rail, move the cursor to the other side of the stairs until it
takes the form of a stair-rail, then click it.

The settings displayed on the screen are always those relevant
to the selected railing and any changes in the values of the
parameters will only affect the selected railing. In this mode,
the program uses single railing types for both sides of the
stairs.

nn

When switching to this mode from All Stair-Rail mode, both
sides inherit the settings chosen in the previous mode. When
switching to this mode from One Segment mode, the whole
flight inherits the settings of the lower starting segment.

Clicking the third icon allows you to define a railing for each
flight (segment) independently. By default, the first segment
of the left railing is selected, as shown in the preview of the
stairs. To select another segment, simply click it.

Different offset values can be used for each segment. In this
case, the elements of the stair-rail belonging to different
segments will not fit each other automatically. Positive or
negative upper and lower overhang can be defined manually
for each railing segment.
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When switching to this mode from either of the other two (All
Stair-Rail mode or One Side mode), all stair-rails inherit the
previous settings. The overhang values of the stair-rails will be
identical to those calculated automatically in the previous mode.

In the preview area that displays the floor plan of the stairs,
each segment of the railing is represented by a line that shows
where the centerline of the railing lies. To switch off a railing,
first select it, then choose the No Railing option from the
Railing type pop-up. A thin line will indicate the place of the
stair-rail.

The types and parameters of the selected railing are set in the
Railing Setting section. The available railing types are listed
in the pop-up menu placed at the top of the dialog box. The
content of the pop-up window depends on the available
definitions. In the railing preview area (above the stair-rail
type pop-up) you can see the small image of the selected
railing type.

Postwith Balusters =l
Mo railing
Simple Wireframe
Simple Surface
Solid Frame
Solid Frame, Filled
Solid Frame with Balustrade
Farallel Bars

th Balusters

Postwith Panels
Simple Bar
Twisted

Wired

Wooden

The editable parameters under the pop-up window are
generally valid regardless of the railing type. They define the
position of the railing as related to the sideline of the stairs,
the height of the posts and the baluster as related to the stairs,
and the overhang values. In One Segment mode, the lower
and upper overhang relates to the current segment, while in
the other two modes they concern the lower overhang of the
bottom segment and the upper overhang of the top segment.
The parameters of the railing types are displayed in the list of
additional parameters.

The settings and placement of the posts of the railing are
defined in the Post Setting section. If the selected type does
not contain posts, this section will be dimmed.

Fost Setting

" no Posts _H(‘;:i I—D.DDD
& tlosestto: |

" on every Tread -ﬂ"':i [o.000
 number: |12 Egi IW
¥ Snap to Corner ::_L i »:—: [o.ooo

The position of the posts relative to the centerline of the stair-
rail can be defined with the radio buttons and the parameter
field. The rule according to which the posts are to be placed
along the selected segments of the railings is defined with the
radio buttons.

The placement of the posts can be defined by:

- setting up an approximate distance between the
neighboring posts (the posts are placed alongside the
flight or the segment at a given distance from one
another),

- placing a post on every tread (on landings, an
approximate distance will be used), or

- setting the number of the posts.

Using the Snap to Corner checkbox, the program
automatically places posts to the segment ends and places
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additional posts on the segments according to the rule
defined above.

The position of the posts placed automatically by the program
can be modified one by one by double clicking on the post
on the selected stair-rail segment. A dialog box appears,
where the position of the post can be set up numerically.

1Ll M odify location EHE

| [m
QI IB‘-SSBZ"

Cancel |

Some of the available railing types are illustrated below.

Listing Parameters

Click the fifth button on the left of the window to work on the
Listing Settings tab page of the Stair.

~General ~Railing
¥ Stair Type ¥ Raling Lenath on the Right
¥ Stair Name ¥ Raling Length on the Left
¥ Home Story

IV Layer
¥ Floor Height of the Stair
¥ FunLength

1~ Strutun i~ Tread:

v Type ¥ Mumber of Treads
¥ Yolume v Volume of Treads
V' Side Surface

IV Battom Surface
¥ Risers' Surface

IV Treads' Suface

¥ Surface of Treads

NN

¥ Valume of Risers

IV Surface of Risers

Each of the elements and properties (general, structure, railing
and treads) of the stair can be listed with the Calculate menu
commands. Stairs will be listed as library parts. The list can be
set up individually in ArchiCAD; however, if you wish to list a
part of the stair, be sure that the box beside it is checked.

For more information about listing features, refer to the
ArchiCAD reference guides.

Defining Slopes

Instead of creating a Stair, you can define a Slope just by
clicking the Slope button when the Stair Type Selection dialog
box appears. Only plain slopes are available, all the choices
with curved lines of travel are dimmed. A custom geometry
can be used for creating a slope only when the starting and
finishing edges of all flights are parallel with each other.

LUl Stair Type Selection (2] =]

1

Cancel I

When you have made your choice, click OK. The appearing
Slope editing window is quite similar to the Stair editing

Graphisoft ArchiCAD User Guide

143



Chapter 4: Element Creation

window, but irrelevant symbols and parameter fields are
dimmed and the others are transformed into slope setting
functions.

1L] Untitled 7 ]x]

[}
3
)

&
" g
[

W7 —
% = [
— e EE—
=) | E— o
T | X
ﬂ o | —
| [FlchtSetinge——————————————
g Bl EEE
= izl || |
(= /201 ) Co—
3 0.079 Tread Settings
™ il it = ,nssn—
— 0.030 | e o /
D —
| o | —

Check Stair | Save As
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In the Tread Settings section, a new element is the field where
the angle of the slope can be set.

In the Structure tab page, the available structure types for the
slopes correspond to the structure types for stairs.

B

FAR

Solid Slope

Creating Custom Stairs from Drawing
Elements

Standard Stair types work with fixed geometrical data. If you

cannot find the stair type you want among the predefined

templates that cover most of the common stair forms, you can

define the geometry of your Stair within your ArchiCAD

project.

1) Draw the exact contour of the stair with the Fill tool. The
fill that defines the stair cannot contain any holes.

2) Define the line of travel by using connected Lines and
Arcs inside the fill polygon. The segments of the line of
travel need to be connected properly, i.e., they cannot
cross each other or the sides of the fill. It has to be a
continuous chain of lines. Begin drawing the arcs and lines
from the starting edge of the stair to define the appropriate
direction of the line of travel.

Notes: The endpoints of the line of travel must snap
exactly to the sides of the fill polygon but cannot connect
adjacent edges or nodes of the fill polygon. Corners within
the line of travel define landings. If the connection of two
segments of the line of travel is not tangential, it will
define a landing.

3) Select the fill polygon and all segments of the line of travel
and choose the Create Stair Using Selection command
in the Tools menu in order to transform these floor plan
symbols into a stair object.

The Stair Type dialog box appears. StairMaker
automatically finds possible stair types for your draft. If
none of the predefined Stair Types match the sketch, you
can only define a Custom Stair.
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1] Stair Type Selection [ 2] %]
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Cancel |

Note: If the defined geometry cannot be interpreted by

StairMaker, you will receive a warning message describing

the problem. Make the necessary changes according to the

rules of the stair definition, and try again.

4) Select the required Stair type and click the OK button.
StairMaker then displays the stair editing window. The
following setting options are available for custom stair
geometry:

- story height;

- stair shape parameters;

- number of treads;

- inclination angle (parameters of the riser and the run).
Clicking the Check Stair button will detect any conflicts that
would prevent StairMaker from generating the stair.

When finished, click the OK button to automatically create
the stair at the location defined in ArchiCAD. You will also be

prompted at the same time to save your stair under the name
of your choice in the appearing Save as dialog.

Use the Cancel button to abort Stair definition. Even then,
you can name and save the Stair document without placing it
in ArchiCAD. In this case, the sketched fill, lines and arcs
remain selected, so if required they can be deleted.
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Adding Structural Elements and
Finishes

The next sections deal with special tools and features that
allow you to add GDL Object-based elements to specific parts
of your design in order to enhance them in 3D views and
Section/Elevation windows.

Adding Structural Elements with
RoofMaker

ArchiCAD includes an automated tool allowing you to add
structural elements to roofs. This tool is called RoofMaker and
can be accessed from the Extras menu. Technically,
RoofMaker is an ArchiCAD Add-On and is loaded with
ArchiCAD on startup.

RoofMaker adds parametric GDL Objects to selected roofs.
After placement, roof construction elements behave like
ordinary Objects and can be modified.

To place rafters, ridges or purlins (beams), a single roof
surface has to be selected. If multiple roof surfaces are
grouped, you must first ungroup them using the Ungroup
command in the Tools menu. You will then be able to select
roof surfaces individually.

Although the placement of roof construction elements using
RoofMaker works using other methods, we strongly
recommend setting the reference line of the roof to the upper
exterior edge of the wall beneath (as handled by ArchiCAD’s
Complex Roof Placement Method). The definition of
elements, with or without overhang, uses this reference line
as a basis.

We recommend setting the roof thickness equal to the general
cross-section height of the rafters. This way, you can use the
roof to cut elements that are standing upon the rafters (e.g.,
Posts).

To place a trimmer (blocking), a collar beam or a tie
beam, two corresponding rafters must be selected (opposite
rafters for a collar beam or a tie beam, and rafters in the same
roof surface for a trimmer).

After choosing the command for the placement of an object, a
dialog box opens in which certain parameters concerning the
object itself can be set. Surface materials and a layer can be
assigned to all elements. The current Pen Color set for the
Object is used by default. If you change the current Pen Color,
all the subsequently placed elements will have the new color.
The object is then placed with one or more clicks, or is placed
automatically, depending on the object type. See details
below.

Placing the Objects

Create a Rafter

When creating rafters, the bottom plane of the roof serves as a
reference plane. Rafters will be automatically placed on top of
it.

Select a reference roof surface on the floor plan. Choose
Create a Rafter from the Extras/RoofMaker menu.

A dialog box appears in which rafter parameters can be set.
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In addition to setting the height and width of the rafter’s cross
section and the type of eaves (vertical, perpendicular or
rectangular cut), you must define the width and the position
of a possible connecting element at the top (purlin, trimmer
or hip rafter); and the bottom (valley rafter or trimmer).

You can add a softit to the lower end of the rafter and set its
angle. Zero angle means the soffit is horizontal. The soffit will
have the same cross section as the rafter.

You can choose to view the outline of the rafter and the line
type for the axis in the Floor Plan. Normally, a roof plan only
shows the axis of any inclined element (rafters, hip rafters,
valley rafters); however, it is best to temporarily view 2D
outlines of the rafters for better control of the connections
between elements.

Clicking OK returns you to the floor plan with the reference
roof surface still selected. Click inside the selected roof
surface. (If you click outside, an error message appears.)

A rafter is placed with its axis going through the specified
point. By definition, rafters are perpendicular to the reference
line of the roof.

1

A profile parameter and a profile thickness parameter of the
rafter can be set after placement. The rafter may have a
rectangular (default) profile as well as I-beam, L-beam or C-
beam profiles.
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Create Multiple Rafters
Select a reference roof surface on the floor plan. Choose
Create Multiple Rafters from the Extras/RoofMaker menu. A
dialog box appears in which rafter parameters can be set.

llll Rafter Settings
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This dialog box is almost identical to the one used for creating
a single rafter. The placement method is defined by either a
maximal distance between the axes of the rafters (this is the
most common method), or the number of rafters to be placed
at an equal distance.

If you choose to define the placement giving a maximal
distance, the user-defined range might not allow the regular
placement of the objects. Therefore, there are further controls
that allow you to set where the necessary gap will be
introduced, either at the start, the middle or the end.

Clicking OK returns you to the floor plan with the reference
roof surface still selected. Click twice inside the selected roof
surface to define a placement line. (If you click outside, an
error message appears.)

Several rafters are placed along the placement line, with the
axis of the first rafter going through the point defined with the
first click, and the axis of the last rafter going through the
point defined with the second click. By definition, rafters are
perpendicular to the reference line of the roof.

Create a Hip or Valley Rafter

The hip rafter usually lies between two neighboring roof
polygons. Select the roof surface where the hip rafter
connects to a purlin instead of another hip rafter; other
methods may cause errors.

Choose Create a Hip Rafter or Valley Rafter from the
Extras/RoofMaker menu. A dialog box appears in which hip
rafter parameters can be set.
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In addition to setting the height and width of the cross section
of the rafter, and the type of eaves (vertical, perpendicular or
rectangular cut), you must also define the width of a possible
connecting element at the top. You can choose to view the
outline of the rafter in 2D as well as the line type for the axis.

Clicking OK returns you to the floor plan with the reference
roof surface still selected. Click along one of the edges of the
selected roof that is NOT parallel or perpendicular to the
reference line. (If you click elsewhere, an error message will
appear.)

A Hip or a Valley Rafter (or a Valley Rafter without Overhang)
is placed along the specified edge of the roof, depending on
the position of the edge to the roof’s reference line.

i Untitled 3D 7 All O] x]

@ ] | ey | o 17

Hip and Valley Rafters can also be placed with two roof
surfaces selected previously. It is then not necessary to click
afterwards to specify an edge; the object will be placed along
the common edge of the two surfaces. The difference
between the two methods lies in the shape of the resulting
objects; the top cut in the latter method makes the object
suitable for steeple type roofs.

Create a Purlin (or Beam)

Select a reference roof surface on the floor plan and choose
Create a Purlin from the Extras/RoofMaker menu. A dialog
box appears in which purlin parameters can be set.

Il Purlin Settings (%]
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By default, the purlin is placed under the reference plane
defined by the roof, since a purlin generally supports the
rafters from below. However, an elevation value can be set for
the purlin so that it can be higher or lower than the reference
plane. You can also set the values for the width and the height
of the cross-section.

The purlin can also be perpendicular to the rafters and be on
the top of them as well. If the purlin is placed on top, the
cross section height of the rafters has to be set.

Clicking OK returns you to the floor plan with the reference
roof surface still selected. Click either an edge of the selected
roof, or inside the roof polygon. (Clicking outside the
polygon produces an error message.)

If you click on an edge, a purlin is placed with its axis along
the edge. If the edge is not parallel to the reference line of the
roof, the endpoints of the axis of the purlin will be at different
heights - as indicated in the “Height difference” parameter of
the library part - and the purlin will be inclined.
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Clicking inside the roof polygon determines the position of
only one side of the purlin; an additional click is needed to
define the direction where the purlin extends. (For example if
you want to place a rafter in line with the interior side of a
wall, first you click to the interior side and then toward the
exterior.)

If you click inside the polygon, the axis of the beam will pass
through the clicked point parallel to the reference line of the
roof.

Create an Eaves Purlin (or Plate Beam)

Select a reference roof surface on the floor plan and choose
Create an Eaves Purlin from the Extras/RoofMaker menu. A
dialog box appears in which eaves purlin parameters can be
set.
Il Eaves Purlin Settings
L Wigdth:
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Cancel |
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This type of purlin is placed under the reference plane
defined by the roof, supporting the rafters from below.
However, an elevation value can be set for the eaves purlin so
that it can be higher or lower than the reference plane. You
can also set the values for the width and the height of the
Cross section.

Clicking OK returns you to the floor plan, with the reference
roof surface still selected. You need to click either one of the
edges of the selected roof, or inside the roof polygon. (If you
click outside the polygon, an error message appears.)

If you click on an edge, the purlin is placed inside the
polygon, with its side along the edge. If the edge is not
parallel to the reference line of the roof, the two endpoints of
the axis of the purlin will be at different heights, as indicated
in the “Height difference” parameter of the library part, and
the purlin will be inclined.

If you click inside the polygon, the axis of the purlin will pass
through the clicked point, parallel to the reference line of the
roof surface. An additional click is then needed to define the
direction where the plate beam extends. (For example, if you
want to place a rafter in line with the interior side of a wall,
first click on the interior edge of the wall and then toward the
exterior.)

There is an empty fill included in the 2D symbol of purlins
because purlins usually have to cover posts placed
underneath. These posts are generally displayed as a larger
circle to indicate that there is some kind of supporting
structure. You can use the Bring to Front and Send to Back
commands from the Tools menu to ensure the accurate
positioning of elements.

We recommend that you begin modelling the roof
construction with the purlins and continue with the hip
rafters/valley rafters before placing the rafters. This way you
can easily keep track of all the connecting elements. (When
placing ridges, you already know the thickness of the purlin;
when placing rafters you already know the thickness of
purlins, hip and valley rafters, etc.)

Create a Trimmer (or Blocking)

In order to place a trimmer, you must first select the two
rafters the trimmer is going to be placed between. The two
rafters have to be within the same roof polygon. (This also
means that they have the same pitch angle and they are both
perpendicular to the reference line of the roof.)

Choose Create a Trimmer from the Extras/RoofMaker menu.
A dialog box appears in which trimmer parameters can be set.
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it Trimmer Settings
Width:
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A trimmer is placed at the same height as the rafters. It can be
vertical or rotated to a position perpendicular to the pitch
angle of the roof. The 2D symbol also shows the current
position.

Clicking OK, you return to the floor plan with the two rafters
still selected. Click between the rafters. (If you click outside
them, an error message will appear.)

A trimmer is placed between the two rafters, the axis going
through the specified point. Trimmers are always parallel to
the reference line of the roof and thus perpendicular to the
rafters.

i Untitled 3D 7 ANl =1 E3
- b
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Create a Collar Beam

In order to place a collar beam you must first select two rafters
to place it between. The axes of the two rafters must be along
the same line and meet at the top, otherwise you will get an
error message.

Choose Create a Collar Beam from the Extras/RoofMaker
menu. A dialog box appears in which different parameters of
the collar beam can be set.

llll Collar Beam Settings
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A collar beam can be double- or single-sided. In addition to
the dimensions of the cross-section, an elevation value must
be set, calculated from the height of the insertion point of the
rafters (which is usually also the height of the reference line
of the roof). If the two rafters are not inserted at the same
height, the collar beam is placed relative to the higher one.
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Clicking OK returns you to the floor plan with the two rafters
still selected. If a double-sided collar beam has been selected,
it is placed automatically in the appropriate position. If a
single-sided collar beam is selected, click once more to
determine on which side of the rafters the collar beam will be
placed.

Create a Tie Beam

In order to place a tie beam, you must first select two rafters
to place it between. The axes of the two rafters must be along
the same line and meet at the top, otherwise you will get an
error message.

Choose Create a Tie Beam from the Extras/RoofMaker
menu. A dialog box appears in which different parameters of
the tie beam can be set.
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In addition to the dimensions of the cross section, an
elevation value must be set, calculated either from Project
Zero or the current story elevation.

Clicking OK returns you to the floor plan with the two rafters
still selected. The tie beam is placed automatically in the
appropriate position.

Using the Roof Wizard

The Roof Wizard allows you to create entire roof
constructions quickly and easily. You can place rafters,
purlins, trimmers, collar or tie beams in one step.

To begin, select all the roof surfaces in the project that you
wish to add structural elements to. Choose the Roof Wizard
command from the Extras/RoofMaker menu. The Roof
Wizard dialog box appears.

On the first tab page you can determine what the rafters
should look like.

LUl Roof Wizard Settings
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Apart from setting the general parameters of the rafters, such
as cross section parameters, the eaves type or the Floor Plan
visibility, you can also determine the placement of the rafters.

A standard and a minimal distance between rafters can be set.
Extra rafters can be added to the intersection of hip rafters or
to skylights.

A checkbox in the top left corner of all pages determines
whether this type of object should be created or be omitted
from this step.
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On the second tab page you can determine whether you want
to place collar beams or tie beams.

1Ll Roof Wizard Settings

In addition to setting the general parameters of the beams,
such as cross section parameters, you can also set the
elevation of the beams. For collar beams, set the elevation of
the top; for tie beams, set the elevation of the bottom.

Note: With the Roof Wizard, only double collar beams can
be created.
On the third tab page you can determine whether you want to
place hip rafter purlins or eaves purlins.

In addition to setting the general parameters of the purlins,
such as cross section parameters, you can also affect the
placement of the purlins.

You can also set the depth at which the eaves purlin cuts into
the rafter it supports. The eaves purlin is always placed on the
same level as the reference line of the corresponding roof
surface.

An eaves purlin is placed either below the opposing rafters
(supporting them), or between the rafters (supported by them).

On the fourth tab page you can determine whether you want
to place trimmers.

lll Roof Wizard Settings

Apart from setting the general parameters of the trimmer, such
as cross section parameters, you can also affect its placement.
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The trimmers can be either vertical or perpendicular to the
roof pitch angle.

On the fifth tab page you can determine what the hip and
valley rafters should be like.
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Apart from setting the general parameters of the rafters - like
cross section parameters, the eaves type or the Floor Plan
visibility - you can also affect the placement of the rafters.
Because of the different pitch angle of standard and hip or
valley rafters, the latter have to be lowered in order to get the
top of all rafters to the same elevation.

Clicking OK returns you to the floor plan. The roof
construction elements you have specified are placed
automatically in the appropriate position.

i Uniitied 3D / All HEE
FRG T T E
N NI f
L AR %; _‘
L™ IRRAIE
IRERAL I
B i 5
IEEEY; g S &
r [ .
ajaelalcoslsd o )

The placement of the rafters is optimized to meet the
specified requirements. The objects now behave as ordinary
Objects and can be modified as such.

The RoofMaker Toolbox

Choosing the last menu item of the RoofMaker hierarchical
menu will display the RoofMaker Toolbox. The Toolbox
contains shortcuts to all of the RoofMaker menu commands.

Adding Structural Elements with
TrussMaker

TrussMaker is a built-in tool allowing you to create girder and
truss objects for visualization purposes. It is accessed from the
Extras menu. Technically, TrussMaker is an ArchiCAD Add-On
and is loaded with ArchiCAD on startup.

Creating Trusses in the Floor Plan

Start by drawing the framework of the truss in the Floor Plan
window with the Line and Arc/Circle tools. Use different
pen colors for the different parts of the truss, as seen below.
Pen thicknesses have been exaggerated for clarity.

N

Create Truss...
Edit Truss...
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When you are satisfied with your design, select the lines - Hollow Section: click this button to construct rectangular
making up the truss and choose the Create Truss... or circular hollow trusses.
command from the TrussMaker hierarchical menu.

=

The TrussMaker Settings dialog box appears, allowing you to
choose a shape and define Options for Creating the truss. - Rolled Steel Profile: click this button to construct steel
trusses using a variety of profile options.

LIl TrussMaker Settings x|
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profile
The first tab page, Attributes, defines the appearance of the
R ﬂ truss in floor plan, section and 3D views. This tab page is
identical for all three construction types.
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Floar Plan & Model Attributes ————————————— = o Story 0
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wooden trusses. e

£ @ Furniture & Equipment ||
>
7
You can choose a pen color, a line type, a material and a layer
assignment for your truss. It is also possible to define a
vertical offset from the story or project zero level, and to set

the segmentation of any curves that you used to define the
outline of the truss.
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Note: The value you enter in the Resolution of arcs field is
relative to the complete circle, not the arc segment.
The Truss Profiles tab page has different choices according to
the construction type.
Because the different pen colors used to define the different
parts of the truss are interpreted separately, in this tab page
you can assign distinct parameters (e.g., thickness, diameter
or profile) to each part.

Attributes Truss Profiles | Steel Junctions I
Fen Wiidth Height Thickness Cross Section
+7y H o1 Joio | [oms ;

] 2!' 0.080 0.080 ooo

l
] 3!' 0.080 0.080 0.008
v 4l
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A black diamond next to the pen color icon indicates which
part of the truss you are defining options for. You can check
this in the preview area, where the given part appears thicker.

o8 1l
v 2[H]
v o[H]
v +[m]

To select a part to work on, either click its pen color icon or
its outline in the Truss Preview.

s o[
v 2[m]
v 3[@]
o 4[|

For the Timber Construction type, you can set the width
and the height of the elements. The right side of the dialog
box displays a preview of the cross section.

ot [
s 2 (]

In addition to the above, the Hollow Section type of truss
has a number of additional settings.

- You can choose between rectangular and circular elements
(but you cannot combine the two).

- Instead of width and height values, circular truss elements
are defined by their diameter and resolution.

- It is possible to customize the thickness of the different
parts of the truss.

Attributes Truss Profiles | Steel Junctions |
Fen Diameter  Resolution Thickness Cross Section
[ |

s 2 oo foefomo @
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For the Rolled Steel Profile construction type, an even wider
range of options is available:

Altributes Truss Profiles | Steel Junctions |

Fen Profiles Position wfidth Height Thickness Cross Section

oW L) Fe fe fm
ol L) Fe e (7
o8 EJE| Fe fw (T

The two pop-ups next to the pen color icon allow you to
choose among profiles and ways of positioning them.

156

Graphisoft ArchiCAD User Guide



Chapter 4: Element Creation

mi&AEIMLIEIﬁiI@

The third tab page of the TrussMaker Settings dialog box is
only available for the Rolled Steel Profile construction type.

Attributes | Truss Profiles

i~ Junction:

Steel Junctions |

i ﬁ Wwithout junction plates

‘with junction plates

i~ Geometr

i E+ Use center of gravity
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T L
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= F Don't use —fé

junction plate W L= IU.ZUU

i ’F Use junction plate W= 2100

“When joining two identical profiles:

The options offered in this dialog box allow you to use
customizable junction plates at the points where the truss
elements meet. If you choose not to use junction plates, the
corresponding options are grayed in the dialog box.

Junction Plat

W PR S I YT

= Don't use
junction plate W : L= IU_ZUU

i ’F Use junction plate W= 2100

“When joining two identical profiles:

In the Junction Plates section, T stands for the cross-section
value, L for the length of the junction plate from the
intersection point of the profile axis and M for the minimal
overlapping length of the profile and the junction plate.
Depending on the geometry (the angle between the profiles),
either L or M will be used to determine the actual junction
plate length - whichever results in a longer junction plate.
When you have finished customizing your truss, click the
Save... button at the bottom right of the dialog box. You will
then be prompted to name the new truss object and place it in
your active library.

The new truss appears on the Floor Plan on the baseline of
the contour. Go to the 3D Window to visualize it, and then
drag it into its final location.

Creating Trusses in Section/Elevation
Windows

You can also create a truss in a Section/Elevation window:
1) Draw a Roof on the Floor Plan and add a Section Line.

a/1 a/1

2) Open the Section/Elevation window corresponding to the
section line.

3) Fit the framework of the truss to the roof. Draw the outline
with lines as you would on the Floor Plan (see above).
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4) Select the framework's elements and choose Create
Truss... from the TrussMaker hierarchical menu.

5) Make the appropriate settings in the TrussMaker Settings
dialog box and save the object.

An alert will be displayed, informing you that the new truss
object has been created on the Floor Plan. The truss is placed
on the same line as the section line and will therefore appear
in the Section/Elevation window as an element that was cut
on its edge.

A1 A/1

A

6) Display the new truss with the roof in 3D or in another
Section window.

Editing Trusses

The framework drawn on the Floor Plan is not associated to
the truss after it has been created and placed (and can only be
used to create new trusses). Modifying this outline has no
effect on placed trusses.

TrussMaker offers you an additional method for editing
placed trusses.

Select a truss and choose the Edit Truss... command from
the TrussMaker menu or the TrussMaker palette.

An alert will appear, prompting you to create a new Section
window. Draw a simple section line with the Section/
Elevation tool, open the new Section/Elevation window
and then choose Continue Editing from the TrussMaker
menu or palette. The original framework will appear in the
window and you will be able to edit it.

Create Truss...

Continue editing

When you have finished making your changes, choose the
Create Truss... command again.

The TrussMaker Settings dialog box will appear, with the
same options as seen above. The only difference is that in
addition to the Save... button, a Save as... button appears.

Cancel | Save... |

- If you click Save..., TrussMaker will display a warning
telling you that you are about to save a library part under
an existing name. Clicking Overwrite will replace the
previous truss, while clicking Cancel will abort the whole
process.
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- If you click Save as..., a new truss object will be created.
TrussMaker will prompt you to name this object and find a
place for it in the library.

Adding Finishes

ArchiCAD includes built-in tools that allow you to enhance
exterior and interior views in the 3D Window and in Section/
Elevation views by adding parametric Objects based on the
original geometry of selected Wall, Roof, Slab and Zone type
elements. The objects recognize openings of any shape and
are updated if the geometry of the base element changes.

The corresponding commands, Accessories and Interior
Wizard, can be accessed from the Extras menu. Both
commands are based on Add-Ons that are loaded by default
on startup.

Accessories

Accessories enhance the modeling of Walls, Roofs and Slabs
in 3D and Section views. Each Accessory comprises two
elements: a command and the corresponding integrated
parametric objects. Each object has a number of required
parameters that are set by the command.

Using Roof/Slab/Wall Accessories

First, select an existing building element (wall, roof or slab)
on the Floor Plan, and then choose the appropriate command
from the Extras/Accessories hierarchical menu.

The Object Settings dialog box will then appear, prompting
you to select one of the Accessory objects. Set the object's
properties and parameters on the Parameters and Custom
Settings panel (the latter may provide additional information
that makes it easier to understand the parameters). Other
parameters will be set automatically when placing the object,
according to the related building elements.
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Click OK in the Object Settings dialog box to place the
Accessory Object. After placing it, you can select it and
modify its parameters at any time.

You can also place an Accessory Object without selecting a
corresponding building element.

- Select an Accessory Object and set its parameters in the
Object Settings dialog box.

- Draw a polyline on the Floor Plan. The selected Accessory
Object will be placed with the polyline geometry method.
Note: Accessory Objects placed on their own are not
associated to any element.

The Accessories commands update all parameter values of
the placed objects appropriately:

- When you delete an element, associated Accessory
Objects will also be deleted.

- When you modify an element, all parameter values will be
updated on the fly (wall geometry may change when
stretching connecting walls).

To simplify the procedure, you can save variations of the
Accessory Objects, using different names for customized
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default values. You can also create customized variations by
opening an object and saving a copy with a different name
(but keeping the first three characters and the underline
character), and then modifying the custom parameters and/or
scripts.

Roof Accessories

The Roof Accessories... command allows you to place the
Roof Surfacer object. It can model a roof surface with metal
sheets or with tiling. The metal sheets have two variations,
and there are four available types of tile.
Note: The surfacing is done tile by tile, and can add
considerable geometric detail (and, consequently,
rendering time) to each roof plane. Curved surfaces are
more demanding on the computer’s resources than planar
surfaces.

To simplify the operation, there are some restrictions on roof
geometry:
- The polygons (and subpolygons for the skylight holes)
cannot contain curved segments.

- The subpolygons cannot contain concave segments.

- The concave segments of the polygon must be separated
by at least one convex polygon segment.
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Slab Accessories
When choosing the Slab Accessories... command, you can
choose between two objects.

The Footing with Stem Wall object can model a concrete
footing with stem wall and sill plate.

Note: To simplify the operation, there are some
restrictions on the slab geometry. The slab perimeter
polygon cannot contain curved segments. If present, these
segments will be approximated with their chord.

The Floor Construction object can model layered floors.

The Custom Settings panel of this object allows you to make
settings for the 3D model and the Section representation.

— Accessory Object - Flooring — Flooring - Section Attributes

Thickness data Material Section Fill Type Background Colour  Fill Colour

10 | I LN

20 HcC. *

o | Lmc »

7 < ms. »

50 *—Es. » — =] 1.
Seclion Attributes | Back |
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Wall Accessories

With the Wall Accessories... command, you can place a
variety of objects adding details to your walls. The specific
objects are detailed in the following paragraphs, together with
their parameters.

The Molding and Paneling object can model interior details
on walls consisting of up to three selectable molding profiles,
and optional paneling (wainscot and wall panels) between
these moldings.

The object's custom parameters can be set in the Object
Settings dialog box, on either the Custom Settings or the
Parameters panel. Parameters are grouped according to
different criteria on the two panels.

The Custom Settings panel has two pages, one for the General
Settings, Geometry and Custom Angles and one for the
Materials and 2D Representation.
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The Battered Wall Modeling object can model battered
stone veneers and similar elements applied to the outside of a
wall, and can have a different thickness at the bottom and the
top. The object can extend beyond or end short of the bottom
and the top of the wall by a specified distance.
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The Canted Wall Modeling object is an exact replication of
the Wall it is derived from, except that it has a parametric
tilting angle.

— Accessory Object - Canted Wall

Use wall bot polygon [~
Use wall tap palygon [~

=
Custam begining ang\el[l oo ‘,' ‘
Custom end angle ID ] 1
Fill the: space r

|

e |
. o

= 2
Custom begining angle  Custom end angle

Floorplan Pen

Section Attributes I

On the Floor Plan, it also shows the outside boundaries of the
object, as well as the cross section at a given elevation (4 ft.
by default).
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The Stud Wall Framing object can be used to represent stud
framing within walls. It handles the properly added studs at
right angle corners and incoming wall joints. At the windows
and doors it adds double studs, cripples and jack studs as well
as parametric headers. The top header plate is broken or
extended to provide overlap at the joining walls.
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These objects have their property script set up to provide
LUMBER PACK calculation where the individual pieces are
listed with their nominal cross section sizes and their length is
rounded up - if necessary - to the next inch. The list also gives
an estimate on the overall board feet quantity.

Restrictions: Openings for Doors and Windows will have
horizontal edges perpendicular to the original wall plane.

Interior Wizard

The Interior Wizard command enhances the modeling of
3D Zones. It creates interior finish elements on the surface of
the 3D Zones defined by the user. You can edit the shape and
the material parameters of these elements using standard
ArchiCAD tools as well as parametric functionality. The
Interior Wizard recognizes wall openings and is updated if the
zone that it is connected to is updated or changed. The
Interior Wizard also relies on the objects stored in the
Accessories Library.

The Interior Wizard applies Accessory Objects to walls,
ceilings and floors of the selected room. First select the 3D
Zone on the Floor Plan. Then choose the Create Room
Accessories command from the Interior Wizard
hierarchical menu. A dialog box will then appear, prompting
you to select from the different types of Accessory objects.

After pressing any of the three buttons (Ceiling Accessory,
Wall Accessory, Floor Accessory), the Object Settings
dialog box will appear, allowing you to choose an object and
make the appropriate settings. The principle is the same as for
the Accessories commands.

When you have selected an object for all three types, the
Interior Wizard dialog box changes accordingly.

LIl Room Accessory

wios_wond_ceiing

‘whall Accessory |

wz_moldings_and_panels

Floor Accessomy |

wfz_floor_constiuction

Cancel | 0K |

When pressing OK, Interior Wizard places the Accessory
Objects on the surface of the 3D Zones. If the given room’s
Zone is changed or updated, use the Update Room
Accessories command from the Interior Wizard menu to
update the placed Accessory Objects.

To use the Gypsum Ceiling Object, construct a room, select it
and choose Extras/Interior Wizard. Click the Ceiling
Accessory button. In the Object Settings dialog box select
the Gypsum Ceiling object. Click OK to place the object.

View the created ceiling in 2D and 3D.

You can change the direction of the pattern by selecting a
special hotspot of the ceiling object in the Floor Plan view and
then moving it. Choose Display/Rebuild to update the view.
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You can also add a number of details to the placed ceiling,
including smoke detectors, lamps or diffuser grills, and
modify or delete single panels.

Make sure that the placed ceiling object is NOT selected.
Double-click the Object tool and select the Gypsum Ceiling
object again.

On the dialog box's User Interface tab page, change the

Usage Mode pop-up menu from Place Mode to Modify Mode.

— Accessory Dbject - Gypsum Ceiling -
- Place Mode =]
Modity Mode . Moy Mods

Resdit Mads =l

Usage Made

Accessory - Diffuser Gril

Diffuser Type [opoe 2| |12

Madiing the

loeation of the 250 I

selected panel
e

In the Accessory area, use the scrollbar to locate the item type
that you wish to insert. Select, for example, a smoke detector.

Accessory :  Detectar
Detector Type W _’I
Modifying the W
lncation of the Im— I:
selected panel
|

You can enter a value to offset the accessory from the ceiling
panel.

Click OK. Then, in Floor Plan view, click the location on the
ceiling where you wish to place the smoke detector.

Select the ceiling object, open the Object Settings dialog box
and change the Usage Mode to Reedit Mode. Click OK.

With the Alt key (Windows) or Options key (Mac) pressed,
choose Rebuild and Regenerate from the Display menu.

Go to the 3D Window to see that the smoke detector has now
been placed and integrated with the ceiling.
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Drawing Elements

Drawing elements are 2D only. They have various uses:

- Details that you did not wish to model fully with
construction tools.

- Positioning and drawing aids for the placement of
construction elements.

- Their outlines can be used to generate complex 3D shapes
using the Magic Wand tool.

- Decoration purposes or elaborating on details, especially
in the Section/Elevation windows or Detail Drawings.

The following types of 2D elements are available: Lines,
Polylines, Arcs, Circles, Ellipses, Splines, Fills, Text,
Figures and Hotspots.

The creation, display and behavior of the elements obeys
some common rules, but the specifics will be discussed in the
sections dedicated to the different element types.

Creation Steps

The typical steps in creating a drawing element are the
following:

1 Select the corresponding tool in the Toolbox and open its
settings dialog box by double-clicking the tool's icon.

2) Adjust the settings offered by default to suit your particular
situation or purpose, or click the Favorites button on top
of the palette to select a predefined element configuration.
Click OK to confirm the settings.

3) Choose a Geometry Method in the Info Box allowing you
to create plain, curved, chained, rotated or polygonal
variations of the elements, where applicable.

4) In the Floor Plan define the location or the length of the
drawing elements.

Element Display

The Floor Plan and Section/Elevation display of drawing
elements depends on the attribute choices made for them in

their dialog boxes. Attribute sets are managed by a number of
commands in the Options menu. For faster display or output,
the 2D appearance of some of the attributes can be modified
by the Display Options command, also located on the
Options menu.

You can change the attribute settings of the elements by
clicking the pop-up controls in the appropriate panels of the
element settings boxes and dragging the cursor to your new
choice. Attributes include Pen Colors and Line Types for most
element types and Fill Types for Fills only. See the
Construction Elements section for illustrations.

Straight Lines and Curves

Definition

Lines are one of the simplest drafting elements in ArchiCAD.
You can use them to create any 2D shape without utilizing
constraints.

The following straight and curved line elements can be
created in ArchiCAD.

- Single straight line segments using the Line tool.

- Circular arcs and full circles using the Arc/Circle tool.

- Elliptical arcs and full ellipses using the Arc/Circle tool.
- Natural splines and Bézier curves using the Spline tool.
- Freehand curves using the Spline tool.

- Series of chained straight and curved line segments using
the Line tool or the PolyLine tool.

The Drawing Lines and Curves section will show the
particulars of each technique.

Line Tools and Settings

In the Toolbox default shape, the Line, Arc/Circle,
Polyline and Spline tools are represented by a single icon.
Choose Options/Customize/Palette Shapes and check the
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Extended option for the Toolbox to show them all at the

same time.
NE 7z

=
152

Double-clicking any of the line type tools will open a dialog
box in which you can adjust the settings of the given tool.
This is a single panel dialog box with the Favorites button on
top and the Layer assignment pop-up at the bottom.

= Il Line Default Settings x|
O Fawaorites... | Default
@ ¥ Uz the same settings for Line/&ic/S pline/Poling tools
A, -r_-'_' General Settings
A
E Solid Line '| Y T am
7.9
|7 \ ™ Zone Boundary
i) )
o |+7+/|/' +f| —1|200 mm g B !
— —),l
?ﬂ £ @ Lines >| Cancel | 0K I

The available controls are identical for each of the line type
tools, with a few exceptions. Near the top of the dialog box, a
checkbox allows you to apply the settings made in the dialog
box of one line type tool to all others.

The top part of the General Settings defines the Line type and
the Pen Color of the line.

Below, activating the Zone Boundary checkbox allows lines
to delimit Zones when using the Automatic Recognition
method. See the description of Zones later.

For Splines only, there are two additional controls in this
section. This is where you can decide on drawing a natural
Spline or a Bézier curve and to create an open-ended or a
closed one.

[l Spline Default Settings x|
Favorites... Default

I~ Use the same settings for Line/&re/S pline/Polyling tools

)g,. General Settings

Solid Line >| 0@ am
lf‘_/‘\g Wg ™ Zone Boundar
[ e R E 16 m
>

£% @ Splines PI Cancel | ’TI

In the bottom part of the settings dialog box you can choose
whether to display Arrowheads on line segments that do not
define a closed shape. These Construction Methods are also
available in the Info Box. You can also set here the size and a
distinct Pen Color for the Arrowheads.

1212 AT

B B E +

- The No Arrows method produces a simple line segment
with no arrowheads.

- The Start Arrow method produces a line with the current
arrowhead style at the starting point of the line.

- The End Arrow method produces a line with the current
arrowhead style at the endpoint of the line.

- The Double Arrow method produces a line with the
current arrowhead style at both ends of the line.
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Below the Construction Methods, a pop-up control contains
the Arrowhead styles that are available for the different line
tools.

|: — || = | |-

> >~ B D
=,
The last arrowhead type is special, as it doubles the line with
arrows at both ends. Using a line like this, the cursor will snap
to the invisible axis line between the two visible lines. This
arrowhead is not available for Arcs and Splines.

Note that only Arcs and open Splines may retain arrowheads:
Circles, Ellipses and closed Splines are closed elements with
no starting point or endpoint to receive an Arrowhead, and
therefore do not support them.

- If you begin to draft an open element with Arrowheads
and decide to close it either while drafting or later, the
Arrowheads will simply disappear.

- If you later convert a closed element to an open one, for
example a Circle to an Arc, you can select it, open the
settings dialog box and add Arrowheads to it.

Drawing Lines

The four line type tools can produce single elements and
chains of elements in any combination of straight and curved
segments. The following sections give a short description of
all the possibilities.

Drawing a Single Straight Line Segment

To draw a single straight Line segment, choose the Line tool
in the Toolbox and the Single Line geometry method in the
Info Box. The Line segment is defined by its two endpoints. If
you have chosen to add Arrowheads to it, they will be placed
according to the Construction Method chosen in either the
Line Settings dialog box or the Info Box.
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Default Settings LI
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[~ Uniform Settings for Line
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Solid Line 3 | O
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Drawing Circular Arcs and Full Circles

To draw a circular arc or a full circle, choose the Arc/Circle
tool in the Toolbox and one of the Geometry Methods offered
by the first icon in the Info Box (Centerpoint, Three Points or
Tangent Point).

E|

Default Settings g

r— Uniform Settings for Line

The three methods are identical to those presented in the
Drawing Curved Walls section. See the Wall tool description
earlier.

Note: Unlike circular Walls, Circles can be fully closed.
You will obtain one element, not two half-circles.

Drawing Elliptical Arcs and Full Ellipses

To draw an elliptical arc or a full ellipse, choose the Arc/
Circle tool in the Toolbox and one of the Geometry Methods
offered by the second icon in the Info Box (Diagonal Ellipse,
Semi-Diagonal Ellipse, Ellipse Radii).
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A

Default Settings ﬁl
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Tools

The Diagonal Ellipse method creates an Ellipse constrained
into a rectangle.

The method stretches the ellipse of an invisible rectangle held
by the two points of its diagonal.
1) Click the starting point of the imaginary rectangle.
2) By stretching the imaginary diagonal, you get ellipses of
different sizes drawn into the invisible rectangle.
3) With the second click you choose the ellipse of the
appropriate size.

7

H

The Semi-Diagonal Ellipse method works in the same way
as the Diagonal method but here you define the imaginary
rectangle by its centerpoint and the endpoint of its semi-
diagonal.

&

The Ellipse Radii method defines an elliptical arc by the
major and another radius of an ellipse and the angle of the
arc.

1) Click the centerpoint of the ellipse.

2) Choose the orientation of the major radius, by clicking
again.

3) You get the rubberband line of the second radius, which
you can stretch to different sizes and angles. Notice the
accompanying ellipse that fits the length of the two radii. If
you stretch the minor radius too far away or right in line
with the major radius, you cannot draw the ellipse.
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4) In the final phase ArchiCAD holds the ellipse while you
define the side angle of the arc. First, you use a
rubberband line to define the side where the angle starts
from. Then you define a different side that closes the
angle, while ArchiCAD follows the angle with the Elliptical
Arc. Neither side of the angle remains visible when the
final arc is drawn.

Drawing Splines

To draw a natural Spline or a Bézier curve, choose the Spline
tool in the Toolbox and the first or the second Geometry
Method icon in the Info Box.

x

Default Settings il
A |
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Natural splines can be defined by placing nodes, which the
program automatically connects, thereby generating a smooth
custom curve. The angle of the tangent and the shape of the
spline generated with it is affected by each subsequent node
defined. You can conclude this operation either by double-
clicking on the last node, or by clicking the OK button in the
Control Box. Clicking OK always results in a closed spline.

[N

Bézier splines are somewhat more complex in nature, but
they allow more accurate reproduction of specific custom
shapes. Bézier splines are defined by nodes, just like natural
splines, but they also have editable tangent handles on each
side of these points. The shape of the Bézier spline is affected
by the direction of the tangent and the length of each tangent
handle.

When defining Bézier splines, click once to place a node, and
keep the mouse button depressed. By moving away from the
node in any direction, you are in effect defining the initial
tangent, and the length of the handle that defines the
curvature. If you release the mouse button, ArchiCAD will
assume that you wish to jump to the definition of the next
node with your next click. Keep the mouse button depressed,
and then define the next tangent and node as above. You can
conclude this operation either by double-clicking the last
node, by hitting the Enter key twice or by clicking the OK
button in the Control Box.

Simple clicking a handle without dragging the mouse will
define a sharp node within the Bézier spline.

You can edit Bézier splines by varying the length of each
handle separately. Note that there is only one angle

associated with both handles of a node, but the length of each
handle may be different. The longer the editing handle, the
smoother the curve will be at the control point.

You can pull out the handles from sharp nodes to turn them
into curved ones.

Note: A Bézier spline's editing handles are visible on the
Floor Plan if it is selected. If several Bézier splines are
selected at the same time, only the editing handles of the
spline last selected will be visible.

Editing Splines
When the Spline tool is selected in the Toolbox, you can
freely edit selected splines in the following ways:

- Click a spline with the Mercedes cursor to insert a node.

- Drag a node onto its neighbor to delete it.

- Drag a node to move it without changing its handles.
Notes: To reposition several nodes at the same time, use
the Marquee tool.

Drawing Freehand Curves

To draw a freehand curve, choose the Spline tool in the
Toolbox and the third Geometry Method icon in the Info Box.

This method is particularly useful to mark up documents.
When you start marking-up, ArchiCAD automatically activates
the Spline tool with the Freehand geometry method.

B | E|

- Markup Tools
Default Settings L

fla NI/\@(

Active Entry:

Mark-Up Entiy 3
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168

Graphisoft ArchiCAD User Guide



Chapter 4: Element Creation

The Freehand method always creates natural Splines.

Drawing a Series of Chained Segments

By combining the capabilities of the various line type tools,
you can create series of chained straight and curved line
segments using the PolyLine tool or the Chained geometry
method of the Line tool.

The difference between the two options is the result they
produce.

- If you draw the series of elements with the Line tool, each
segment remains an individual element, although they
may be grouped on creation.

- If you draw the series of elements with the PolyLine tool,
you obtain a single element.

°

M

°

/\/\

Otherwise, the creation process is the same. Activate the Line
tool or the PolyLine tool in the Toolbox. In addition to the
Single Line method available for the Line tool only (see
Drawing a Single Straight Line Segment above), there are
three identical methods.
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Default Settings A
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Default Settings EI
[= olo|

l_ Uniform Settings for Line
Taals

The Chained method produces a series of straight or curved
line segments joined at their endpoints. As you click to
complete one segment, you simultaneously begin the next
one. Click the Cancel button in the Control Box or double-
click the last endpoint to stop drawing. For an illustration of
the process, see the Drawing a Chain of Walls section earlier
in this chapter.

The Rectangle method produces four individual Line
segments (Line tool) or a single Rectangle (PolyLine tool),
defined by placing two opposing corner modes. With the
Rotated Rectangle method, you first define a rotation vector
for the rectangle's reference line. The rotation vector also
defines the length of the two segments parallel to it. By hitting
the Shift key once, you can unlock the length component
constraint and use only the rotation angle component of the
rotation vector.

- If you wish to decompose a PolyLine, select it and choose
the Explode command in the Tools menu. You will then
obtain a series of Lines and Arcs.

- Connected Lines and Arcs can be transformed into a
PolyLine if you select all connecting elements and choose
the Tools/Line Extras/Unify command.

Fills

Definition

You can mark different surfaces shown on your Floor Plans
and 2D representations with a wide range of ready-made or
customized fill patterns. 2D fills are especially useful in

section drawings or in detail drawing. Marking floor tiling or
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carpeting on Floor Plans and adding a graphic touch to
elevations are examples of utilizing the 2D Fill tool.

Fills can also serve to measure the area of polygons in your
Floor Plans. This feature produces a text element that is fully
associative and follows any changes in the associated fill
polygon. See the Adding Area Text section under Drawing
Fills.
Similarly to 3D construction elements, Fills can appear in
calculations with associated properties, descriptions and
components. The area of Fills can be subtracted from Zones.
Three types of fill representations are available in ArchiCAD
under Polygon Fills in the Display Options in the Options
menu.
- Solid Fill will display all Fills without any hatching lines or
motifs.
- Vector fills are composed of simple lines or line segments,
so they can be used for plotter output.
- Bitmap fills can be more intricate than vector fills, because
they are composed of pixels.
The two types of fills are associated with each other, so that
each bitmap fill pattern has a vector fill counterpart.

The orientation of the vectorized form of the fill pattern can
be defined as either linked to the Project Origin or to the Fill's
own origin. The setting can be made in the Fill Settings dialog
box. See the Vectorized Fill Orientation section under
Drawing Fills.

Fill Tool and Settings

The Fill tool is located in the bottom section of the Toolbox.
Double-clicking it opens the Fill Settings dialog box, which
has two panels: Floor Plan and Listing and Labeling.

—_—
(55 W Fill Default Settings x|
% Favaorites... | Default
r/f » gz General Settings
B

» ik Listing and Labeling

£ D Fik »|

Cancel | Ok I

The first panel controls the appearance of the Fill in the Floor
Plan. Note that these same options are applied when adding

a Fill in a Section/Elevation window or a Detail Drawing
window.

5
Favarites... I Default
v & General Settings
Ol gL
= Solid Line '| =¥ [ am
> F727) common brick L4 %9 I" 1m

¥ [ |
[~ Show Area Text
¥ Link to Project Origin
% ¢ Lirk To Fill Drigin
» =& Listing and Labeling
&£ | D Fils v Carcel | oK |

The first setting concerns the frame of the Fill. Choose the first
radio button to draw a Fill without an outline. If you wish to
have a framing line around the Fill's border, choose the
second radio button and then choose a Line Type in the pop-
up menu. In this case, the Pen Color control is also active and
you can choose a color for the outline.
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Below, you choose the fill pattern that will be used to display
the Fill. Only simple Fill types are available, Composite
structures do not appear in the pop-up control. The
availability of a pattern for the Fill tool is set in Options/Fill
Types. Note that you can choose a different color for the fill
pattern and its background, and both can differ from the color
of the outline.

For the fill background, you can also choose the transparent
option represented by a crossed circle at the end of the Pen
Color palette.

Note: You can choose a global color option for Fill
backgrounds in the whole project in Options/
Preferences/Miscellaneous to always use the given
window's background color, to show all Fills as
transparent or to use the settings made in this dialog box.

Ul Preferences ed b
I Mizscellaneous j << Previous | et 5 |

Fill Backgraund Calor: Usze Elements' Setting j

Use Drawing Background
All Transparent

V' Auto ID Increase
W Save in Mulilatform Format - ISl

A checkbox allows you to show an associative area text with
the Fill. See the Adding Area Text section under Drawing
Fills.

With the two radio buttons, you can link the vectorized
pattern of the chosen hatching to either the Project Origin or
the Fill's own origin, as discussed above in the Definition
section.

The second panel is called Listing and Labeling and
controls the handling of the Fill in calculations.

W Fill Default Settings x|
Favorites... I Default
» gz General Settings
- :@ Licting and Labeling
ID: IFiII-Dm Link Properties:
IV By Criteria
I~ Label Fill _ .
Matching Properties:
Labe( Settings... | ;I
l_ Subtract from Zones j
a % of Fill Area
[~ Individually Choose.. |
F
£2 D Fil DI Cancel | oK I
4

Most of the controls of this panel are described in the Element
Identification, Listing and Labeling section earlier in this
chapter.

If you check the Subtract from Zones box, you can subtract
the area of the Fill from the Zone it is in. Set the percentage of
the area to subtract from the measured zone area by typing
the desired value in the text field. See Zones later.

Drawing Fills

Geometry

Activate the Fill tool in the Toolbox and choose one of the
three Geometry Methods available for it in the Info Box.

|

Default Settings %l
&[E o

Drawing Fills with either the Polygon, the Rectangle or the
Rotated Rectangle method is similar to the process discussed
in the Drawing Walls section. See details there.
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Vectorized Fill Orientation

Before you actually start drawing the Fill, decide whether to
link the vectorized fill pattern to the Project Origin or the Fill's
own origin. You need to make this setting in the Fill Settings
dialog box.

If you choose to link the fill pattern to the Project Origin, the
pattern will start at the Origin and the part of the pattern that
falls within the Fill's boundary will be displayed.

If you choose to link the fill pattern to the element's own origin,
you first need to define this origin before actually starting to
draw the Fill. Your first click will determine the Fill's origin and
the second one the endpoint of the orientation vector.

This orientation vector can be displayed as a handle with the
vectorized Fill provided that you make this setting active in
Options/Display Options/Fill Handles. The handle does not
necessarily have to be located inside the Fill and can be used,
if shown, to select the entire Fill.

The fill pattern starts at the origin of the Fill element. By
selecting the Fill with the Fill tool active, you can modify the

orientation vector. Click the endpoint of the orientation vector
of the selected Fill and rotate it. If the Arrow tool is active, you
need to click the last icon on the appearing pet palette to
achieve the same result.

£

Note: Even in bitmap view, the handle remains visible, but
the bitmap pattern does not reflect in any other way the
rotated vectorized pattern.

After setting the optional rotation vector for the fill pattern
linked to the Fill's own origin, you can proceed.

Adding Area Text

If the Show Text Area checkbox has been marked in the Fill
Settings dialog box (described below), the Hammer cursor
will appear when you finish drawing the Fill with any of the
Geometry Methods, prompting you to position the text with a
click. The text block is created by calculating the area of the
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Fill. The text setting will be the same as the default values of
Dimension texts.

x

Selected: 1 Editable: 1
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Normal Supescript

B

£ Autolest: Irsert Autaliext.. |

[

[

~ {al Settings

[ Eovair s wstenn =] mifzon e [ Nm
ek X [oor

™ Revert to Automatic Position

o

To modify the font settings or even the content of the area
text, select the text only (not the Fill itself) and choose the last
command of the Edit menu which changes in this case to
Dimension Text Settings.

pop-up menus.

Il Preferences |
I Drimensions j << Previous | Mext 5> |
Standard Custom -

s ool 9] & [t

Area Calculation

BTG
‘V/ARS Sample: 0,12 m2

Unit: I meter j

Add... Clear |
Decimals: lﬁ ‘

Area value labels are always readable from the bottom or
from the right after a rotation or a mirroring.

Note: The visibility of the text block depends on the
current Text setting in Options/Display Options.

Text Blocks

Definition

With the dedicated Text tool, you can create multiline texts
with full scale font options, multiple styles and justification in
any direction. Text blocks can be created in the Floor Plan, in
Section/Elevations and in Detail Drawing windows.

Other tools can also create text as part of the element they
define, for example the area text of Fills, the internal
dimensions of Windows and Doors, Zone stamps, the text
part of Labels, the numbers and text in all types of
Dimensions. The options for all these texts are the same as
those of the Text tool detailed below. See also Dimensioning,
Zomnes and Labeling.

According to the choice made in Options/Display Options, all
text blocks can be framed with brackets at each corner
handle. This makes the text blocks easy to locate and edit,
while keeping the text readable. Another option (Greek) is
available for displaying a text block with the text illegible but
with uniform gray patterns substituted for the actual text.
Greek text can also be displayed with handles.

ArchiCAD
‘ ArchiCAD

ArchiCAD

ArchiCAD
ArchiCAD

ArchiCAD
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Notes: Text below 5 pt. (current screen size) will always
be Greek. Greek text above 48 pt. will be displayed as
normal. When editing text blocks, all Greek texts are
temporarily enlarged. The framing options only apply to
text blocks created with the Text and Label tools.

Text Tool and Settings

In the default shape of the dialog box, the Text tool and the
Label tool have been grouped in a single icon. Choose
Options/Customize/Palette Shapes and select the Extended
version of the Toolbox to see both tools at the same time.

.
== e
Elyen [~

[

Double-click the Text tool to open its settings dialog box.
This is a single panel dialog box with the Favorites and Layer
selection controls at the top and the bottom of the window

- Text size is defined in absolute values, so its on-screen size
will vary when you shift between different scales by
choosing Options/Floor Plan Scale.

- Ttalics used for TrueType fonts translates to a 75° slant if
the font is changed to a vector font.

- Leading can be set either relative to character size or in
absolute values.

- The Justification & Anchor Point settings will help you
place your text blocks in the most pleasing or practical
arrangement. The Anchor Point is especially useful when
you are editing text elements, since it will always remain
fixed even if you change font sizes or other text
characteristics.

- Some of the controls only appear if the plotter font has
been selected in the font selection pop-up menu.

- Text blocks are always readable from the bottom or from
the right even after a rotation or a mirroring.

o
. . e . o S
respectively. The controls in the Font and Positioning area o F
. . . T @
give you complete control over the orientation and %%, 23 s
typography of your text elements. R 3 & {QQ\“‘
o
i I Text Default Settings 2=l 6?0
==, -
F—— Favorites. .. I Default .
=8 S Sample Text Sample Text
; - IAU Font and Positioning Elock ) LBIDCk
[ I Courier Mew Westem j y I'r" | -l &
...... ()
Z2 | sy ¥ Bold Mt - & %Q:?%
e AL A
j==1 oo < Joor & e
e ™ Undeiline <,'_Jf§‘::0§- %
A Leading: & Single < Z
1142 g ¥
[T Eg
B " Double _ lﬁ:_} 5 &
- +
% " Custom: 0.00 il ictolhoi Hls
2
:: £% B Testblocks >| Cancel | oK I
&
174 Graphisoft ArchiCAD User Guide



Chapter 4: Element Creation

Placing Text Blocks

There are two types of text blocks in ArchiCAD: breaking and
non-breaking ones.

Creating a Breaking Text Block

To start a line of text, simply draw a rubberband rectangle by
clicking twice to define its corners with the Text tool on the
Worksheet. A one-line block with the defined width remains
on the screen, including a flashing text cursor indicating your
position in the text block.

click
+

| Start your text here!

click
_I_

New lines of text will be automatically started as soon as you
reach the predefined width of your text block. You can start a
new line at any time by hitting the Return key on your
keyboard. Click OK or hit the Enter key when you are
finished, or alternatively, click Cancel if you want to start all
over again.

Creating a Non-Breaking Text Block

Non-breaking text blocks are especially useful if you are not
sure in advance how long your text block’s lines will be.

To create a non-breaking text block, double-click on the
Worksheet with the Text tool active. You can immediately
start typing your text. You can type as many characters in the
same line as you wish.

Hitting Return will automatically start a new line. The width of
the text block will be determined by the width of the longest
line of the block.

Note: Stretching the Text block rectangle will cause it to
break up. You cannot turn a breaking Text block into a
non-breaking one. See also Stretching in Chapter 5:
Drafting and Editing Techniques.

Figures

Definition

Figures are image files embedded in the ArchiCAD project
file. They can be inserted in any of the 2D windows (Floor
Plan, Section/Elevation window, Detail Drawing). Figures are
placed and manipulated by the dedicated Figure tool.

Figures can be displayed either with or without handles or as
simple placeholders. This setting is global, that is, it affects all
placed Figures. The choice can be made in Options/Display
Options/Figures.

Note: Regardless of the import method, the images of
Figure type elements are embedded in the Project and can
make the file quite large. Use sizes and resolutions only as
needed to prevent overloading the Project.

Figure Tool and Settings

The Figure tool is located in the bottom section of the Toolbox.
Double-click it to open its settings dialog box. The dialog box
has two panels: Preview and Positioning and Image Format.

| 1l Figure Default Settings x|

[
B Favorites... | Detault
_*|

%
M

» Preview and Positioning
» i Image Format

Cancel | oK I

£ <@ [ ArchiCAD Layer >|

In the Preview and Positioning panel you can choose the
image file or the pasted image to insert as a Figure, define its
dimensions and the way it will be placed.
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W Figure Default Settings x|

Favarites. Default

A Preview and Positioning

Figure Size: Resolution:

Open. ID mmn ID,DD dpi
— —
Paste = L= T dni

™ Keep Proportiors

Restore Original Values

™ Insent Figure: Pisel by Pisel in Cunent Zoom

Anchor Point: ﬁ

Cancel | Ok I

[ Transparent

—

» i) Image Format

£% & [ AichiCAD Layer v|

You have two options for getting image files:
- Click the Open button to browse the directory system for
image files.
- Click the Paste button to use the contents of the

Clipboard. (If the Clipboard contains image information, it

will be used directly. If the contents is text, it will be first
converted to bitmap.)

Either way, the image will be displayed in the preview area

and all values will be relative to that opened or pasted image.

Below, the Name field displays by default the imported file’s
name or “Pasted Image no. x” if the Clipboard’s contents has
been used. You can rename the image as you wish; this has
no effect on the file’s real name.

g s e

Restore Original ¥ alues

™ Insert Figure Pixel by Fizel in Current Zoom

Anchor Paint ﬁ

In the right-hand side of the panel you can adjust the Figure
Placement parameters.

[~ Transparent
I F
izl with windous] @oc 0.00°

- Adjust inserted image size by typing new values in the
Figure Size fields. Use these fields to give accurate
dimensions to scanned site plans or measured layouts. The
Keep Proportions checkbox below allows you to fix
image proportions if appropriate.

Hint: Dimensions are often distorted when drawings or
images are scanned. Uncheck the Keep Proportions box
to unlink the dimensions and adjust figure width and
height independently if you want to make sure that
dimensions are correct. This is especially important when
inserting existing site plans, survey plans or layouts into
ArchiCAD Projects.

- If you wish to control the resolution of the inserted figure
rather than the image size, e.g., for specific print output
quality, use the Resolution fields.

- Use the Restore Original Values button to reset the
Placement Parameters to image default.

Note: Figure size and image resolution are
interdependent. By increasing image size, you decrease
resolution and vice versa.

- Check the Insert Figure Pixel by Pixel in Current
Zoom box to adapt the image to the current level of
magnification in the target window.

- The Transparent checkbox allows you to hide or show
elements below white pixels of the Figure according to the
current display order.

- Use the Mirror Figure checkbox to insert the figure
flipped horizontally.

- To automatically rotate the figure when inserting it into the
Project, type the desired angle in the field at the bottom
right of the panel.

- Position figures using the nine Anchor Point buttons.

In the Image Format panel, you define the storage format of
the image inside the project. In addition to the controls
displaying the file size and color depth of the image, you can
also save it in another format as an external file.
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Wl Figure Default Settings x|
Faworites... | Default

» Preview and Positioning
hd @ Image Format

Storage Format: IBltmap 'I
295 pivels B 173 K

[ ] True Calor - 32 bit
Save as... |

BT 198 pixels
£ @ [ ArchiCAD Layer >| Cancel | oK I
Placing Figures

When you have made your choices in the Figure Settings
dialog box, just click with the cursor to place the Figure. If the
result does not satisfy you (for example, the image is too
small or too large), choose the Undo command, open the
Figure Settings dialog box again, and adjust the size,
resolution or other settings before placing the Figure again.
You can also stretch the placed Figure, use the Shift key to
constrain the diagonal and keep the image's proportions.
Before you place the Figure, its ghost contour follows the
movements of your cursor showing its proportional size. The
ghost contour's anchor point is sensitive to element nodes
and edges. To make this option inactive, go to Options/
Preferences/Miscellaneous.

bl |« =) R[>

You can also place Figures in ArchiCAD directly, without
using the Figure tool, by pasting bitmaps originating either
from another ArchiCAD window (for example a
PhotoRendered Model picture) or another image-processing
software. The pasted element will be handled as a Figure by
ArchiCAD.

Note: Images imported by this method are always pasted
pixel by pixel in the current zoom.

Hotspots

Definition

Hotspots are simple points indicated by a small cross. Their
main role is to help position elements in 2D views. Hotspots
do not appear on printed and plotted outputs and can be
deleted when they are not needed any more.

The Hotspot Tool and Settings

The Hotspot tool is located in the bottom section of the
Toolbox. Double-clicking the icon opens a simple settings
dialog box in which you can set the Pen Color and the Layer
assignment of the Hotspot.

e

7 x
L Favorites... Default
T

S Color
N o

— W amm
% £% <@ Hot spots > Cancel | i I
Placing Hotspots

When you have made your Pen Color and Layer choice in the
settings dialog box, you are ready to place Hotspots. Just click
at the desired location.
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There is a number of situations when you may need to
continue construction starting exactly on a given point of an
element at a location where it has no hotspot or special point.
The solution is to generate hotspots that will allow you to
snap to this point.

There is no direct way to snap to remote intersection points of
elements. You can automatically generate Hotspots at
intersection points on the imaginary extensions of elements.

1) Select a line, edge or arc and place the cursor on top of
another (it becomes an Arrow with a Mercedes if the
Arrow tool is active, a simple Mercedes if another Tool is
active).

\
B

R

2) Command-click (Macintosh) or control-click (Windows) to
generate a section point.

\
.

Note: Cmd/Ctrl-clicking the edge of a Roof while another
one is selected will fit the clicked edge to the common ridge
(if any) of the two roof planes. With the Wall or Line tool
active, selected Walls or Lines will be extended to meet the
intersection point with the clicked edge.

To place a Hotspot at a remote Tangential point, select the
arc(s) and command-click (Macintosh) or control-click
(Windows) with the Checkmark cursor on any element
(hotspot or node).

Tangential hotspots will be generated on the imaginary
extensions of arcs or curved edges.

It is also possible to add Hotspots with a Cmd-click
(Macintosh)/Ctrl-click (Windows) to:

- A parallel projection of a wall, a line or the edge of a roof,
a fill or a slab from a selected hotspot.

b B % R K

v LT LT
| PR | s

- A perpendicular projection from any element hotspot
(Checkmark cursor location) or any empty space
(Crosshair cursor location) to a selected wall, slab, roof,
fill edge or line.

x e

ks
[ —
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Annotation Elements

In addition to the 3D construction elements that represent the
physical structure of the Virtual Building and the 2D drawing
elements used as positioning aids, details and decoration,
ArchiCAD offers different types of elements for labeling,
organizing and listing the components of the building.

- A large variety of associative Dimensions can be added
to construction elements and drawing elements in both the
Floor Plan and the Section/Elevation windows.

- Another associative feature is Labeling, allowing you to
link text information or a symbol to construction elements
and 2D Fills. Freestanding Labels are also available.

- Zones can be used to define three-dimensional units
inside the project, typically rooms or offices.

Dimensioning

Definition

ArchiCAD offers a large variety of dimensioning tools and
options for various uses and situations. Dimensions are fully
associative and can use various measurement units and
standards. Linear dimensions are accurately tagged to the
nodes and edges of project elements.

Dimensions can be placed in the Floor Plan, the Section/
Elevation and the Detail Drawing windows.

Dimensions are placed individually or in series on eligible
elements. You can also add automatic exterior or interior
linear dimensions to selected elements.

The various dimensioning types are Linear Dimensions,
Elevation Dimensions, Level Dimensions, Angle Dimensions
and Radial Dimensions.

Linear Dimensions are customized dimension lines. The
following terms are used to describe dimensioning operations:

- Reference points are nodes on ArchiCAD elements that
you have selected to be dimensioned.

& & & N

|7 A 1% 2

- Dimension points occur at the intersection of the
dimension line and the witness line according to the
previously defined reference points. They can be selected

as shown below.
7'-5" j/ .-_"

7 .
! 18'-9" ! 6’ !

- Dimension units are the basic components of the
dimension chain. A dimension unit connects two adjacent
dimension points and includes the written value of its
length. To select it you have to click the midpoint of the
line with the Checkmark Cursor.

=
\ |

- Dimension values are the text blocks containing the
length of the dimension unit. To select a dimension value
by itself, click on the lower left corner of the text.

- Dimension chains are the sum total of the connected
dimension units. You can select a dimension chain by
clicking at a “free spot” on the dimension line with the
Mercedes cursor.

7 Z/ 7 7

! 16'-9 e ‘ 6’ ‘ 7T-5" ‘
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- Associativity means that any dimension point you create
will adhere to its reference point until you delete one or
the other. For example, stretching the window in the wall
of the previous example causes the entire dimension chain
to be automatically updated as shown below.

V. i V)
o e

The following elements can be dimensioned by placing
reference points on them:

! 19'-9"

- Construction elements: Walls, Columns, Beams, Windows
and Doors (opening edges and midpoint only), Objects,
Lamps, Slabs, Roofs and Meshes.

- Drawing elements: Fills, all line type elements, Hotspots.

Note: If you place a reference point at an ineligible
location (or in empty space), the cursor shows a
rectangular reference point instead of the regular circular
one. This means that the reference point will be a static
one and will not follow suit when the dimensioned
elements are stretched or dragged.

3 981 ! 4 0139

g8 000

The appearance of the linear Dimensions depends on the Type
or Construction Method and the Geometry Method chosen in
either the Info Box or the Dimension Settings dialog box.
Details follow in the Placing Linear Dimensions section later.

A special case of the linear Dimension's type is Elevation
Dimensioning. It allows you to place height markers in
Section/Elevation Windows. It can also be used on the Floor
Plan, but it only measures the distance along the Floor Plan’s
Y-axis from the current Project/User Origin. This is not the
same as the element’s vertical height along the Z-axis, which
the Level Dimension tool measures on the Floor Plan.
Radial Dimensions display the value of the radius of a
curved element.

Level Dimensions are point-level elevation markers
common to architecture and site planning.

Associated Level Dimensions remain linked to the elements
they were placed on top of, even if they are no longer inside
the contour of these elements.

If a Level Dimension falls outside the contour of the element it is
associated to, its value changes according to the following rules:

. 4 .
A ZZ
. £ 000 |
1981 4019
% Z|
£ 000
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- With Slabs, there is no change: the value is the same as if
the Level Dimension were still inside the Slab’s contour.

- With Roofs, the value displayed is calculated by a projected
extension of the roof (that is, what the value would be).

- With Meshes, it is the Story’s height that will be displayed
(but the Level Dimension remains associated to the Mesh).

AN
() +2.00 % Ty +2.00
:I L 42.00 \\z\g} . :I b 42,00 \ =
0\ \ ERY™
T W\ JI X
P LY \\ \\ . ///i/\ N 'R,\\\ |
s _ AN T/ p 5 Qb
f ffﬂw ) \\ 0.00 f“ \; S\ /
t ! \ N\
X Yo AL AN
\\\ K/ / §I ﬁ g \ ks // §I ‘\\

Angle Dimensions display angle values between line and/or
linear element edge pairs as well as bent polygon edges. You
can choose between two Geometry Methods-acute and
obtuse angles-from either the Angular Dimension Settings
dialog box or the Info Box.

When you place angle dimensions using the Acute method,
only the quadrant of the space in which you click with the
Hammer cursor will be dimensioned.

The following examples, wherein we dimensioned the same
two edges of a general shape quadrangle, show the different
variations.

- o

o

-
@
=

When you place angle dimensions in the Obtuse method,
ArchiCAD will calculate the angle of the specified quadrant
together with the other two quadrants adjacent to the one that
was clicked. The Hammers on the arcs indicate points that,
when clicked, would give you the same result

Note: You cannot dimension 180 degrees. If you want to
mark it, use the Arc Tool with the Double Arrow method
and place the value as text on top of the half-circle.

Dimensioning Units

ArchiCAD supports the use of different Dimensioning
Standards. You can customize their use for the current
project in Options/Preferences/Dimensions.

This is particularly useful when working on several Projects
with differing levels of accuracy (construction details versus
site plans) or Projects being built in countries other than those
in which they are designed.

You can modify the accuracy of the different Dimensioning
tools, apply predefined standards such as US Builder or DIN,
or define your own customized settings.

Wl Preferences 2lx
I Dimensions j <« Previous | Nest > |
Standard Custom - M il
I_*E" ee| Gzt B |sarpe 0

Linear Dimension;

Unit: I millimeter j
Decimals: I il -

Extra Accuracy: 0ff -

¥ Don't Display Zero Wholes

I Rievert All Dimension Text o Automatic Position
I Revert All Custom Text ta Measuied Yalue

Cancel 0
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You can independently define the units for the different
dimensioning Tools in this dialog box: Linear, Angular, Radial,
Level and Elevation Dimensions, Window/Door Dimensions,
Sill height values and Fill Areas, and a sample gives you
feedback about the number format for the defined settings.
You can even independently define the number of decimals
you want to display for each Tool.

When using metric units, the Dimensions dialog box also
provides an option for suppressing zero values: 0.25 meters is
displayed as 25 and 1.25 meters is displayed as 1.25.

Imperial Unit Display

If you define feet and fractional inches for the unit of any
length type dimension, you have eight radio buttons to define
how you want dimensions to appear when either whole feet
or inches is zero.

B [y 5]+ [aidafe 77| sampte: 4 775"

Linear Dimensions

Unit: [feet &fractional inches i]
Fractions: 1/16 = [ Fractions in Small Type

Display of Zero Feet & Inches:
Q-1 304 O 1-0 344" J1-0" @034
& 1354 & 1-3/4" [ORN 344"

In each of the four pairs of radio buttons, click the option that
fits your dimension display standards.
Note: You cannot mix units for the same dimension type
in a Project. However, you can display two types with the
Secondary Dimensions command. See details later.

Dimensioning Tools and Settings

The Dimensioning tools are located around the middle of the
Toolbox. In Toolbox’s default appearance, ArchiCAD’s
various Dimensioning tools are merged into one pop-up icon
in the Toolbox. In order to see all Dimensioning tools at the
same time, choose Window/Floating Palettes/Palette
Shapes and choose the Extended option.

Double-click a Dimensioning tool and open its settings dialog
box. The various Dimensioning tools share many of their
options. The explanations below refer primarily to the linear
Dimension tool; controls specific to the other tools will be
presented additionally in detail.

Il pimension Default Settings: x|
»
Faworites... Default

» rall Type and Font
¥ _y1 Marker and Witness Line Dptions

F 2 Di ion Details

£% @ Dimensioning » |

Cancel | 0K I

The Dimension tool's setting dialog box includes three panels:
Type and Font, Marker and Witness Line Options and
Dimension Details. Note that some of the other dimensioning
tools have single-panel dialog boxes.

In the upper part of the Type and Font panel, you can choose
the Type or Construction Method of the various Dimension
tools as well as the style of the pointers or arrowheads.

Il Dimension Default Settings |
Favorites. Default

- [Au Type and Font

Dimension Type: -,
@ Cootl g O W

I™ Static Dimersion

I Courier Mew Westem j o . 2? I1 1.
125 :

M:t[z00 mn Ak P _I am
Witness Line: ;Im m
O Con c T Gt
» _yt Marker and Witness Line Options
b % Dimension Details
£ @ Dimensioning » Cancel | 0K I
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Using a pop-up menu, you can set the desired marker form.
The last marker type is special, as it results in a double
Dimension Line enclosing the values. With this marker, value
position settings are not effective.

By clicking the Static Dimension checkbox you can create

static dimensions that are not associated with any of the

elements in the Project.

Once a dimension has been made static, it cannot be made

associative again. If none of a dimension chain’s markers are

attached to construction nodes, the dimension chain will

become static. Static dimensions behave like other

dimensions in two ways:

D If rotated or mirrored, the value is always turned so that
you can read it from the bottom.

2) If the Dimension Unit is modified in Preferences, all
values will be updated.

If the Construction Method you have chosen is Elevation

Dimensioning, the panel changes accordingly to display the

options available for Elevation Dimensions.

il Dimension Default Settings x|
F avorites | Default

- [AU Type and Font

Dimengian Type:
Ol oottt Ty 0w

[ ¢ vd v f6ds
[~ al =~ =% =]

Dimenszian Origin:

I Froject Zero j ™ Static Dimension
ICDurierNewWeslem j L 12? 1 .
o 418 ’

M |2.00 mn [ — A7 T m
“ithess Line: J *© !
Cle—s Cle—u Ll
P _t Marker and Witness Line Options
P D ion D etails

£5 @ Dimensioning v Carcel | |

A marker series of Elevation Dimensions behaves as an
associative dimension chain. You can select and edit the
whole series by clicking on the invisible axis of the chain with
the Mercedes cursor while holding down the Shift key or
using the Arrow tool. Markers can be added or deleted from
the chain as in other types of linear dimension chains.
Individual markers in the chain cannot be edited.

For Elevation Dimensions only, you can choose the Reference
Levels defined in Options/Preferences/Working Units for
the placement of the dimensions.

For Radial Dimensions, three radio buttons allow you to
choose the label orientation. It can be either continuous with
the dimension line, always horizontal or always vertical. An
additional field allows you to define an optional prefix that
will appear before the value of the radius.

[l Radial Dimension Default Settings x|
Favarites... | Default

le Type and Font

Dimension Type: -,
e @) R -

Pointer Line & Text:

'8l f " AE o) :;J Prefir:
ICoulialNewWestem j ﬁ 2= 1.2? |1_ (L]
—-1.25-
1 el X L e = M am
A |
ﬁiﬁl Marker Size: 3,00 mm .
£% & Radidl Dimensioning >| Caneel | oK. I

Two Construction Methods, or types, are available:

- With centerpoint: When you select this type, and place a
radial dimension on the plan, the centerpoint of the arc
will automatically be marked by a crosshair.

- Without centerpoint: In this case, no centerpoint mark
will be placed at the centerpoint of the curve.
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For Level Dimensions, you can rotate the marker symbol by
entering a value in the rotation edit box. When you rotate a
marker symbol, the text will rotate with it, maintaining the
original relationship.

[l Level Dimension Default Settings x|
Favorites.. | Default
[AU Type and Font
&1 [mE o 9 o= ¢
s c
-"u.l -
L2 000
& [ Shatic Level
IEourlerNewWestam j C s 12! 1 1H
' +195
Mt |200 mm [ ¥ 1w
&5 @ Level Dimensioning v Carcel | oK |

The Level Dimension Text Frame option places a box
frame around the Level text for emphasis. The frame is
automatically sized to fit the text and cannot be
independently edited.

The Plus Sign Option places a plus or minus sign in front of
each level dimension text to indicate its position relative to
the zero level of the project.

In the Angle Dimension Settings dialog box, with the first
Numbering Orientation radio button active, the dimensioning
value will always be horizontal. With the second button
active, the dimensioning value is always in radial direction,
while the third one will be parallel to the tangent of the curve
next to it.

In the lower part of the Type and Font panel, you can choose
the type and size of the font to use for the dimensions as well
as the Pen Colors used for the different parts of the
dimensions (values, lines and markers). You can set different
types, sizes and Pen Colors for the different dimensioning
tools or even for selected individual dimension units of a
dimension chain.

I Courier New Western j :‘_ i 1 QE |1—£|
Mt[z0 m sk o A |

ﬁi‘l Marker Size: 200 mm

The Ttalic option appears in the dialog box if you use bitmap/
TrueType fonts. If you select vector fonts, the slant option
appears instead, allowing you to set the angle of the slant.
Italic used for bitmap/TrueType fonts translates to a 75° slant
if the font is changed to vector fonts.

On the Marker and Witness Line Options panel, you set
the size of the dimension marker and the format of the
witness lines.

Il Dimension Default Settings 5'
Favorites... Default

» tall Type and Font

- 7('1 Maiker and Witness Line Options

_IFI Marker Size: 1.00 mm
P_T* Dynamic ‘Witness Line Gap: ISUU— mm
o
W:I Custom Withess Line Length: IF i
y I Di ion Details
£ @ Dimensioning 4 I Cancel | ’TI

Witness lines can be applied to the entire dimension chain, to
selected dimension units or to individual dimension points.
You can also create dimensions without any witness lines or
with predetermined, short witness lines by clicking on the
appropriate radio buttons. Using the short witness line option,
the witness line length will automatically be fitted to the
marker (and thus implicitly to the appropriate text size). The
availability of the options depends on the Witness Line type
chosen in the Type and Font panel.
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The Dimension Details panel contains options for the

dimensioning of Windows and Doors and composite Walls.

x|
Fawvorites | Default

» tall Type and Font

P 1 Marker and Witness Line Dplions

- r.“&i Dimension Details

[ Detailed Window/Door Dimensions
™| Display taminal | ight

[~ Dimengion Care Only of Composite Walls

£% <@ Dimensioning » |

Cancel | 0K I

The Detailed Window/Doors Dimensions option adds the
opening’s height below the Dimension Line on any dimension
chain with reference points at both corners of an opening.
When this checkbox is checked, the second checkbox below
constrains dimensions to Nominal Height.

Note: This feature is in addition to the options available
through the Dimension Marker panel of the Door/
Window Settings dialog boxes and works for both
smaller and larger sizes for German type reveals.

Dimension Text Settings

The Dimension Text Settings is available when only the
value of a dimension element is selected. The name of the last
command of the Edit menu then changes to Dimension
Text Settings. You can also access the dialog box when
clicking the tool's icon in the Info Box. When one or more
dimension chains are selected, double-clicking the Text tool’s
icon in the Toolbox also opens this dialog box. See the
Manual Changes to Dimension Text section later.

Placing Dimensions

Linear Dimension Geometry

There are four Construction Methods, or types, available for
the Linear Dimension tool. These are available as icons in
both the Info Box and the Dimension Settings dialog box.

|

Default Seftings £ |

e

- With the Linear method, distances between two adjacent
Reference Points are measured and displayed.

- With the Cumulative method, the first Reference Point is
considered the zero point of the dimension chain. All
dimension values of the chain will give you the distance
between any Reference Point and the zero point.

- With the Base-line method, measuring the dimensioning
distances is the same as with the Cumulative method, but
only pointers are shown on the screen instead of whole
lines and the zero point is not marked.

- With the fourth icon, you create Elevation Dimensions. See
details below.

Below the Construction Methods, the Geometry Methods
available for linear Dimensions are shown.

- The Vertical method creates dimension chains that are
always vertical, regardless of the angle of the nodes or
element being dimensioned.

- The Horizontal method creates dimension chains that are
always horizontal, regardless of the angle of the nodes or
element being dimensioned.

- The Skew method creates dimension chains parallel to the
first two Dimension Location Markers placed, regardless of
the angle of any element(s) being dimensioned.
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- The fourth geometry method, Arc Length, allows you to
dimension curved elements.

Dimension Geometry settings refer to the entire dimension
chain, and cannot be set unit by unit. Once you complete the
chain, its geometry cannot be modified.

Placing Linear Dimensions
We will illustrate the placement of linear Dimensions with a
simple example.

1) Construct a wall with an empty hole (window) in it.

% Zi % 7

2) Select the Dimension tool. Mark the first Reference Point.
The Cancel button in the Control Box will then become
active.

3) Click on each endnode of the wall and window, then
double-click to close the dimension chain. Hitting the
Delete key once, or pressing the OK button in the
Control Box, will also display the Hammer cursor.

4) When the Hammer cursor appears, click at the location
you want the dimension chain to be positioned.

& o N

% Z % Z

R

5) The dimension chain will automatically be calculated and
displayed.

7 Z Z Z|

I
] [ [ I

- Once you mark the first Reference Point, the Cancel button
in the Control Box will become active, offering an
alternate way to cancel the dimensioning process.

- After you have marked your second Reference Point, the
OK key in the Control Box will also be activated,
indicating that you can create a valid dimension chain
from now on.

- You can revoke any marked Reference Point by clicking it
again.

The associativity of dimensioning requires a refined marking
procedure for the overlapping points of different elements.
To determine which overlapping node the Reference Point
will be assigned to, follow these steps.

1 It will be evident that you have arrived at an overlapping
element if the dimension markers are accompanied by
selection dots on one of the overlapping structural
elements.

2) If the selected element is correct, simply click on the next
node. Clicking the OK button will confirm the element
without activating the Hammer cursor.

3) If you want the dimension point to refer to another
overlapping element, successive clicks at the same node
will cycle the selection dots across them.

Note: In everyday use, just place the markers, regardless
of the selection dots. In most cases, you will not know
which of the overlapping elements will be modified later.

4) To accept this second structure, click on the next point or
complete the dimension. If you need yet another element,
click on the point again. Repeat these steps if you cannot
decide which element you want in the first cycle.

Note: You can check this later if you select a dimension
point. As long as you keep the mouse button pressed,
selection dots will be shown on the associated element.

Dimensioning Curved Elements

Click on a circular arc or a curved edge of a construction
element while the Arc Length Geometry Method is active in
the Info Box. ArchiCAD marks the end points of the arc or
the edge, respectively. This is the edge that arc length will be
measured on.
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You may click any other points you want to add to the
dimension chain.

Double-click anywhere in the workspace with the Empty
Pencil cursor or click the OK button in the Control Box to
finish selecting arc points for dimensioning. The Hammer
cursor appears, prompting you to place the dimension chain.
Click to place the dimension chain.

Editing methods of arc length dimension chains are similar to
those of linear dimension chains, as is the process of adding
or deleting dimension points.

Note: The Arc Length geometry method cannot be used

for elliptical arcs and splines.

Hint: For approximate dimensioning, turn elliptical arcs

and splines into a series of arcs using the Magic Wand
tool.

Placing Elevation Dimensions

When you choose the Elevation Dimensions method for the
linear Dimension tool, the placement options change
accordingly.

£

Default Settings i

Before placing an Elevation Dimension marker series, choose
Project Zero or Current User Origin in the Dimension
Settings dialog box or the Info to start your dimensioning
from the project zero or from the User Origin, respectively.
Alternatively, you can use one of the Reference Levels defined
in Options/Preferences/Working Units.

The Stored Origin option only appears for selected
Elevation Dimension chains and indicates that the User Origin
has been changed since the dimension chain was placed and
the dimension chain has not been updated.

Place individual markers by clicking the point you want to
dimension, then click OK in the Control Box. Use the
Hammer cursor to position the marker. Click multiple points
before clicking OK and using the Hammer cursor to place a
marker chain.

+E5.00

+4.00

+3.00

mr — #A 4200

mr A +1.00

Note: Hotlinked Modules placed in the Project may
contain Elevation Dimensions that refer to a User Origin.
In this case, the dimension values will be the same as in
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the source Project. Different rules apply if you move the
Elevation Dimensions in the host Project:

- If you select and move all elements related to an Elevation
Dimension without selecting the dimension chain itself,
the dimension chain will move with them. The origin of
the dimension values will keep its position, which means
that the numbers will change.

- If you select and move elements together with the
Elevation Dimension they relate to, and the dimension
chain has a custom origin, the origin will move with the
dimensions, which means that the numbers will keep their
values.

Dimensioning Wall Thickness

If you click on the Reference Line of a Wall perpendicular to
the direction of the dimension chain, both of its sides will be
marked.

When you complete the dimension chain, only those markers
which have been placed on walls perpendicular to the
dimension chain will be displayed.

If you start dimensioning with the Skew Geometry Method by
placing double markers on both sides of a wall, these markers
will define the chain angle to be perpendicular to this wall.

7\ & 77 7N & 7\

K d ki e

G

Editing a Dimension Chain
Dimensions can be dragged, rotated and mirrored, like any
other ArchiCAD element.
- If you edit all of the elements a dimension chain refers to,
the chain will be transformed along with the elements.
- If only some of the elements are edited, the Dimension

Line will keep its place and angle, and only the markers,
witness lines and values involved will change.

- If dimensioned elements are multiplied, you need to also
select the dimensions. The copies of the dimensions will
be associative to the copies of the elements.

Note: Units or points cannot be dragged, rotated or

mirrored away from the parent dimension chain.
You can insert any number of new dimension points into the
chain by selecting the chain and Command-clicking
(Macintosh) or Control-clicking (Windows) on the desired
new Reference Point. The new point can be located between
existing chain points or anywhere outside the dimension
chain.

7 7 % A

24'-2"

The result:

lat-ar

| 13'-5"
T

The existing dimension units will be divided into the
necessary number of units.

7 2] % AF'!

10" —gn 6

The result:
I o | |
1

The dimension chain becomes longer as needed. You cannot
insert points by selecting the dimension units directly. You
must select the chain.
Note: You can insert one node at a time into a single
dimension chain. When you insert a node, you have no
control over overlapping elements.
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If you select and delete a dimension point in the middle of a
chain, the adjoining two dimension units are merged.

delete
| e | e e |
T T 5 T
the result:
| e | Lo sn |

If the deleted point was at the end of the chain, the last unit
disappears and the chain becomes shorter.

delete
l__.-"' 10 -5 | 135" |
b T T
The result:
| N |

If you select and delete a dimension unit in the middle of a
dimension chain, the chain will be broken into two separate
parts.

delete

| s | e | v |

The result:

Finally, you can eliminate a complex dimension chain by
selecting and deleting it.

Separate dimension chains can be merged by selecting one of
the chains and Cmd-clicking (Macintosh) or Ctrl-clicking
(Windows) on the other one.

i 7 % A

| |

16' —o"

The result:

Lo _on . s |
I T

The second chain will be deleted and its Reference Points
added to, and dimensioned by, the first (selected) chain.

You can use this technique even with dimension chains that are
not parallel with one another and/or have no overlapping
parts at all.

12'-11"

12'-11" 51"
v v v
I |
W///////////////////////////////lf//,/
Z

7
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%
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Setting the Witness Line Length Manually
The length of custom and dynamic witness lines can manually
be set:

- for a single witness line;

- for both witness lines of a dimension unit;

- for all the witness lines in the chain.

To manually set the witness lines, select a dimension point,
Unit, or Chain while the Dimension tool is active. Grab the
hotspot or Reference Line of the selected part and drag the
gray distance indicator away from the dimension line.
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Point:

click

| 10" -9 [ X | 7 oG
T 1 T T

The result:

T T 1 1

Unit:

click

g
| 100 -90 ,\' | 7' -E"

The result:

| 100 -gr &
I %1

2 _gn

Chain:

click

S|

The result:

| 10" -g" | 5 | 7' -g" |
1 I I 1

Clicking at the desired length will cut (or stretch) the witness
lines involved.

Dynamic witness lines will never extend beyond the reference
node of the dimensioned element.
To manually set the nonexistent or short witness lines you

must first change them into one of the long types by resetting
them in the Dimension Settings dialog box.

Secondary Dimensions

The Secondary Dimensions hierarchical menu from the
Tools menu allows you to add metric unit equivalents to
dimension values displayed in feet and inches, and vice versa.
Choosing Convert Dimensions... will open a dialog box

where you can set the unit and the number of decimals of the
converted dimension value.

Convettto =
Decimals: 3 =

™ Dot Display Zero wholss

Cancel

Click OK and the additional values will appear in brackets,
always on the opposite side of the dimension line. The new
value will be placed as a text block, and can be edited as any
other text block.

v 6,510 N

N S |

L & 510 )
t ST +

I S |

- If nothing is selected on the Floor Plan, all placed
dimensions will be converted.

- If there are selected dimensions, only their values will be
converted.

Changes made to dimensioned elements do not automatically
update the converted dimensions.
n 5,076 N
f 211" 1

R R R g AR KR
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Choose the Refresh converted dimensions command from
the hierarchical menu to update both the value and the
location of the dimension. Again, this command will work on
either all dimensions (if nothing is selected) or selected ones.

. 5,076 o
7 167-8" *

b O ]

If you do not need equivalents any more, simply choose
Remove converted dimensions from the hierarchical
menu.

Automatic Exterior Dimensioning

You can add automatic associative linear Dimensions to
selected elements with the Automatic Dimensioning
command in the Tools menu. First, select a part of the
elements on the Floor Plan (or even the entire Floor Plan).
Choose the Exterior Dimensioning command. A dialog box
appears.

W Automatic Dimensioning 2

‘window/door dimensions:

€ Object center

(% Object endpaints

—

I8 RS

Distanoe between
dimenzion lines:

[~ Place dimensions on four sides

Cancel

In the first section you can set the way you wish to dimension
openings. Different architectural standards are possible. Either
the axis or the side edges of the opening are going to be
dimensioned.

In the next section, you can determine the placement of the
dimension lines. The distance between the dimension lines is
defined using the working units currently set in ArchiCAD.

You have the option to automatically place dimension lines
on all four sides of the bounding box of the selected
elements.

After clicking OK, it is necessary to define the direction of the
dimension lines. You can do this either by clicking the side
edge of any element, or, if the first click is made in an empty
area, by defining the direction with a second click.

When you have defined the direction of the dimension lines,
an additional click is needed to place the first dimension line
(the one nearest to the selected elements). If you choose to
place dimensions on all four sides, this distance also marks
the overall distance between the nearest dimension lines and
the bounding box of the selected elements.

8 172
3 375 . 4 797
90 3 185 190[» 4 417 190, | o
o | N
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o | 2
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Exterior Dimensioning takes into consideration walls and
openings. Up to four dimension lines are placed
automatically: the opening dimensions, the dimensioning of
the interior walls, the facade dimensions and the overall
dimension. If any of these dimension lines are unnecessary
(e.g., there are no openings, or the facade is straight), the
corresponding dimension line is discarded.
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Automatic Interior Dimensioning

The second command of the Automatic Dimensioning
hierarchical menu in the Tools menu allows you to add
associative interior dimensions to selected elements.

If you choose the Interior Dimensioning command, a
dialog box appears. It contains options for dimensioning
Columns and composite Walls.

Wl Automatic Dimensioning x|

r Column dimenszioning

' Objsct center
+

' Object endpoints
H—F

Wl dimenzioning

[~ Composits wall lapers too

Cancel

You then have to draw a line across the selected elements.
Walls, Columns, Beams, and Slab, Roof and Mesh edges
perpendicular to or crossing the drawn line will be
dimensioned. The line can consist of several segments.
Double-click to finish drawing the line. An additional click is
needed to determine the place of the dimension line. After
placing the dimensions, the crossing line disappears.

@
—

Drawing Radial Dimensions

Radial dimensions have two main parts: the Dimension Line
and the Label.

The Dimension Line is always placed in a radial direction and
the mark at its start always points toward the curved part. By
clicking on a point of the curved element you can start
drawing the Dimension Line either toward the centerpoint of
the curve or in the opposite direction. You cannot place a
radial dimension anywhere on the plan, as it always has to
originate from a curved element.

The Label is connected to the end of the Dimension Line. It
shows the value of the radius of the dimensioned curve. Its
orientation can be selected in the Radial Dimensioning
dialog box.

Note: Deleting the dimensioned element will also delete
any Radial Dimensions associated with it.

Drawing Level Dimensions

To place a level dimension in your Project, select the Level
Dimension tool from the Toolbox, then click anywhere on
the Worksheet. The elevation of the active story is
immediately displayed along with a standard elevation marker
as shown below.

You can place Level Dimensions on top of Slabs, Roofs or
Meshes, provided that the corresponding Gravity icon is
active in the Coordinate Box.

The following example shows Level Dimensions placed on a
rectangular Mesh’s four nodes and several randomly chosen
points.

+1.00 11 +2.00
Ses e s B =+
ﬂ +2_%_ +1.58
_é_ " +2.50
+oo T +3.00

Level Dimensions placed with Gravity On on top of Slabs,
Roofs or Meshes remain associated to them.

Both illustrations below contain two Level Dimensions placed
on the same Slab: one placed with Gravity On, the other with
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Gravity Off. When the Slab was elevated, the first Level
Dimension’s value changed.

+3.00

+0.00

Moving the Slab also moves the associated Level Dimension.
The Level Dimension that was placed with Gravity Off
remains in its place.

+3.00

20.00

When selecting an associative Level Dimension, keep the
mouse button depressed to temporarily display selection dots
on the element the Level Dimension is linked to.

When you release the mouse button, these selection dots will
disappear and only the Level Dimension will remain selected.

You can edit the elevation text separately as well as drag,
rotate, and otherwise modify the text independently of the
marker. The Level Dimension markers are individual
elements, and each one can be individually edited. They can

be dragged, rotated and mirrored, with or without copies, as
any other element.

If multiplied together with the reference slab, the copies of
the markers will be associated with the copies of the slabs. If
multiplied alone, the copies will be associative with the same
slab (or the story) as the original.

Drawing Angle Dimensions

You need to define exactly four reference points in order to
show angle values on the Floor Plan.

You can define these points in the following ways:

o—F &
- Click any existing line or edge (wall, slab, roof, mesh, filD).
This will immediately place two reference points on the
clicked line/edge.

- Click the hotspots of existing elements.

- Click anywhere on the plan (in this case, the angular
dimensions will not be associative).

19.3°{M
- Click an existing edge. This will immediately result in four
hotspots.
The four points you defined will determine two infinite lines
that ArchiCAD will use in the calculation of the angle.
Depending on which geometry method is selected in the Info
Box or in the Settings dialog box, and on where you click
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after the Hammer cursor appears, angle values are measured
differently and can be placed in different locations.

The two infinite lines divide the space into four quarters.
ArchiCAD will place the angle dimension in the quarter you
click after the Hammer cursor appears. The arc of the angle
dimension will pass through the point you click.

The angle dimension value, however, will automatically be
placed next to the middle of the dimensioning curve. It can
then be dragged to another location by the hotspot of the
dimension value.

Placing Angle Dimensions on Curves

Select the Angle Dimensioning tool in the Toolbox, then
click the bent polygon edge or circular you wish to
dimension. The two endpoints of the arc will be automatically
marked. Finally, place the dimension line with the Hammer
cursor

[N

Note: It is always the arc side of the angle that will be
dimensioned, regardless of the geometry method you
choose, or which side you click to.

Associative Dimensions in Sections/Elevations

Dimensions in the Section/Elevation Window are associative,
meaning that every dimension point you create adheres to its
reference point. For instance, when you stretch the Window
in the wall it will cause the entire dimension chain to be
automatically updated.

e 1.25 e 90/ 2.85 o 1.25 ¥ 1.42 ¥ 2.33 L

Elevation Dimensions and Angle Dimensions are also
associative.

+
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- When the Model type Section is unlinked (and turned into
a Drawing type Section), hotspots are generated on the
elements to mark the associated dimension points.

]

- When the Drawing type Section is updated from the
model, the dimensions associated to the hotspots will be
regenerated to reflect the changes to the model.

Manual Changes to Dimension Text

Dimension Text items are individually editable. Select a text
item by clicking on its node. You can change the position
and/or orientation of the text item using Edit commands (e.g.,
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Drag, Rotate). Click the Text icon in the Info Box to open
the Dimension Text Settings dialog box.

Ml Dimension Text Settings 21|

Selected: 1 Editable: 1

¥ 4 Content
[ra

' Measured Value ta Project Zera

[z53 I
 Custom Text:

[-258 I

Normal Superscript
 AutaText: Inzert AutaT ext -
v (all Settings
IVerdanaWaslem j MI|1 80 mm W |7 i |
I s & [0.o0r

™ Fievent to Automatic Position

Cancel |

Type custom text, maximum 25 characters, into the
corresponding field and add optional superscript, maximum
seven characters, if appropriate, or add an AutoText by
choosing from the pop-up menu.

 AutoText Insert AutaT et... B

to Project Zero
- IAU Settings ta 15t Reference Level
ta 2nd Reference Level
Verdana Westen 0 mm @ I? |

"Praject Zera"
[ iz

"1t Reference Level” oo

"2nd Reference Level"

You can reset the position of a selected custom text item by
checking the Revert to Automatic Position box at the
bottom of the dialog box. You can revert to the current value
of the text item by clicking the Measured Value radio button.

To undo changes of all modified dimension text items, open
the Dimensions... dialog box under Preferences in the
Options menu. Two checkboxes allow you to undo changes.

- Checking the first box will return any manually displaced
dimension text blocks to their original locations.

- Checking the second box will revoke any manual
modifications to dimensioning texts by replacing them
with their current values.

Zones

Definition

Zones are spatial units in your Project. Zones can be made up
of rooms, groups of rooms or even larger parts of a Project.

Zone Polygon and Stamp

Zones appear on the Floor Plan as fills and zone stamps
linked to the zone fills. The zone fill designates the zone
space in the Project, while the zone stamp contains textual
information about the zone, including its name, number, area,
and other optional parameters such as the material of the
subfloor, materials of the walls and surface of the walls (with
or without their openings), etc.

Zone stamps are intelligent parametric GDL Objects whose

look, contents and behavior can be fitted to local architectural
practice. They reside in the ArchiCAD Library.

If you place the Zone Stamp with one of the automatic
recognition methods, you will see a cross appear inside the
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Zone at the location that you first clicked to define the Zone's
area. This cross indicates the reference point of the Zone. The
cursor is sensitive to this point which is used as the starting
point of boundary recognition for subsequent updating actions.

W@ehouse 'Wéyehouse )
1 w1 -
A10,00 m2 A1 0,00 m2

In ArchiCAD, zones are grouped into categories. Zone
categories are defined according to similar usage or purpose,
e.g., public areas, laboratories and office space. Categories are
marked with different colors and zone stamp GDL Objects.

Some Zone categories are predefined in ArchiCAD and you
can define your own categories at will by using the Zone
Categories command in the Options menu.

Three options are available for displaying Zone polygons in
the Floor Plan in Options/Display Options: you can hide
Zone colors or display them on top or below the Fills. Note
that if the polygon that represents the Zone color is hidden,
you cannot edit its shape. Also in Options/Display Options,
you can choose to show or hide the Zone Stamps. Both of
these settings are global, you cannot choose them for single
Zones only.

Zone Polygons:

Zone Stamps:

Section Marker:

3D Zone Shape

In 3D, Zones appear as 3D spaces. The availability of zone
spaces makes the accurate analysis of both the geometric and
quantitative attributes of Zones possible. When the
surrounding and trimming elements define a complex
geometric shape, the corresponding zone space form that
matches its boundaries can be equally complex.

To view zone spaces in 3D, go to the Image menu, choose
Elements to Show in 3D and make sure the Zone icon is
selected in the dialog box.

Il Elements to Show in 3D 2x|

r Stories to Show in 30
& Al Stories
" From Story

Fw b

—Marquee Effect
Show elements: " Inzide Marques
& fuside Harques

¥ Trim Elemerits to Margues

— Element Types to Show in 30
Al Types ;I
Zone Tool

w/all Tool
B Column Toal

When Zone spaces are displayed in 3D, all construction
elements appear in Wireframe mode, regardless of the
currently active display mode. The same model in Wireframe
and Hidden Line view appears below.

When viewing the Shaded model, go to the 3D Window
Settings dialog box in the Image menu, and choose the
Contours: Draft option to view only the 3D Zones, without
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any of the construction elements. If you choose Contours:
Best, you will see the shaded Zone surrounded by the
construction elements in wireframe. Elements hidden by the
zone shape are not displayed at all.

off
Contours: |+ Draft
Best .

Zones spaces have a complex geometry depending on the
surrounding construction elements. The boundaries of zone
spaces can be walls, columns, slabs, beams, roofs, lines, arcs
and splines. Walls and columns, including freestanding ones,
are automatically identified.

"

Zone spaces can be trimmed to roofs, slabs and beams with
the Trim Zone... command in the Edit menu. 3D zone spaces
allow you to create complex solids for all sorts of generic
modelling purposes and massing studies. See Trimming the
Zowne shape under Defining Zones below.

Zone Calculation

ArchiCAD Projects can be evaluated according to the
information stored in the zones by creating a Zone List using

the commands of the Calculate/List Zones hierarchical menu.

See also the Area Calculation panel under Zone Settings, the
Calculating Zone Space section later and Chapter 10: Project
Data Calculation.

The Zone Tool and Settings

The Zone tool is located in the bottom section of the Toolbox.
Double-click it to open the Zone Settings dialog box. This
window has six panels: Name and Positioning, Zone Stamp,
Custom Settings, Model, Area Calculation and Listing and
Labeling.

I

: Il Zone Default Settings x|
Favorites.. | Default

Mame and Positioning

1P

Zone Stamp

1
o

Custom 5 ettings
Model

mh, Area C

—p, Listing and Labeling

=% @ Zones » |

Q n

- v v | ||

Cancel | Ok I

i i SN 1 S

The Name and Positioning panel contains the basic
information about the Zone, including its Category, Name and
Number, with several options for defining and positioning the
Zone polygon and stamp.

Il Zone Default Settings x|
Favorites... Default
- [b Mame and Positioning
Zone Category: B HNF 6 Medical Treatment O |
Zone Name: Iumce No Ium

Zone Height: [0
Zone Level: |0 D [k

Subfloar Thickness: | [ Zone Stamp Angle:

FEC e o

Zone Palygon
€ Gross 5 Het

= Zone Stamp

B*= Custom Sethings

o, Model
e, Area C.
=g, Listing and Labeling

£Z @ Zones 3

v |v (w (" |w

Cancel | Ok I
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A scrollable list allows you to choose a zone category. Zone
categories are defined by name, code, color and zone stamp,
together with a set of parameters. See the Zone Categories
section later.

The Zone Name and Number edit fields have to be
individually defined for every Zone and serve to identify the
Zone Stamp on the Floor Plan. When a Zone is defined and
the zone stamp is placed on the Floor Plan, several pieces of
additional geometric information (zone area, zone outline,
outline of holes, outline with walls, surrounding wall area,
etc.) are automatically calculated. These parameters can be
included in the Zone Stamp on the corresponding panel.

- The Zone Height is the height of the Zone body measured

from the Zone's bottom elevation.

- The Zone Level is the reference level of the Zone,
measured from the Story's elevation.

- The Subfloor Thickness is the elevation of the bottom of
the Zone body measured from the Zone Level.

You can choose between the display of gross or net polygon
shapes. These two radio buttons are only active if the zone is
defined by the reference line construction method (third icon
in the Info Box).
- If you choose the Net option, the zone polygon will not be
displayed beyond the inner edge of the boundary walls.
- Select the Gross radio button if you want the full zone
polygon displayed.
See the following figures for the difference both when the
Clean Wall & Beam Intersections (Options menu) is
turned on and off.

o
% F +
Liwving Room o Living Foom 7
03 i 05
A: 7,72 m2 A 7,72 mZ
i e

+ +

Liwving Room Liwving Room
05 05
A 7,72 mi A 7,72 mi

A pair of radio buttons control the rotation value of the Zone
Stamp. By default, the Horizontal button is active. Zone
Stamps are placed horizontally and keep their position even
after rotation of the Zone. The angle text field is grayed.

If you click the Rotated button, and then rotate the Zone, you
will see that the Zone Stamp's angle follows suit.
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The Zone Stamp panel includes a preview of the Zone

Stamp.

x|
Favarites, | Default

P [1, Mame and Positioning

¥ == Zone Stam
= P

Fane_Stamp_01 1 1m
IAriaI Arabic: j M1 IZ,UU ¥ Use Symbal Colare

TextFont 1

Show Zone Hame On

Show Zone No. On

Show Floaring an

Floor Type floor type>
Show Area On
Show Perimeter off

b Cailina Uninkd e

b B'S Custom Settings
b 2 Model
»
»

@, Area Calculation
=i Listing and Labeling

&% @ Zones >| Cancel | 0K I

Zone stamps are assigned to zone categories, which means
that by changing categories in the Name and Positioning
panel, the displayed preview may be replaced by a new one.

You can set the desired color for your zone in the pen number
edit box or you can use predefined stamp frame colors by
checking the Use Symbol Colors box.

You can set here the font type, size and color for the text part
of the Zone Stamp. Note that the preview shows the Stamp as
it will appear in the Floor Plan. If, for example the Greek
option has been enabled for all Text type elements in Display
Options, both the preview and the actual placed stamp will
display the text as gray, unreadable fields.

An unlimited variety of Zone Stamps can be scripted in GDL
and the contents of the parameter list may vary accordingly.

These parameters have an effect both on the appearance and
the contents of the zone stamp. The parameter list allows you
to switch on and off the display of parameters in the Zone
Stamp, as reflected in the preview.

Similarly to Windows, Doors and Objects, the Custom
Settings panel can contain additional graphic choices linked
to the active Zone Stamp. See examples in the Windows and
Doors section.

Note: Customization of the Zone Stamp parameters will be
lost if you change the Category of the Zone. In this case,
the parameters of the stamp will revert to the values stored
with the Zone Category attributes.
The Model panel controls the 3D appearance of Zones,
including Material choices and trimming options.

Il Zone Default Settings LI
Favorites... Default

[1, Mame and Positioni

= Zone Stamp

= Custom Settings

@ Model

é [ Misc-lce [3

4w =+

& Usze this Material on Al Zone Surfaces

€~ Inherit Boundary ' all and Trimming Element b aterials

Unde Top Trin

Zone is Timmed by one onmere Elements,

Wrida Battarm Tirim

P oh, AreaC
P - Listing and Labeling
£F @D Zones bl Cancel | -DK

You can choose a material for displaying the Zone in shaded
and PhotoRendered 3D views.
- By clicking the Use this Material... radio button, you
choose to display the 3D zone shape in the single material
you selected with the pop-up above.
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- If you click the Inherit Boundary Wall... radio button,
individual surface polygons will inherit the materials of the
corresponding surfaces of boundary walls and any
elements that you trimmed the Zone with.

Zone space trims can be undone by selecting the trimmed
zone space and pressing the Undo Top Trim or Undo
Bottom Trim button. See the Trimming Zones section below.
The Area Calculation panel allows you to check the
measured area of the Zone and refine the calculated values.

[l Zone Default Settings X
Favorites.. | Default

Mame and Pozitionil

Zone Stamp

Custom Settings
Model

Area Calculation

PR e R
i
1

S

Measured Met Area: Area Subtraction:
E 'lEl.ElUrnZ—
E me

- |0.00 m2
Remaining Area:
ID‘DD mz ™ FReduce by 0.00 H
Calculated Area:
Any changes will take effect
|U‘UU mz if zones are updated.

Measured Gross Area: 0,00 mz

P = Listing and Labeling

£ @ Zones 3 I

Cancel | ok I

The upper field, Measured Net Area, shows the net zone
area. This is the zone area within the boundary walls with
automatically recognized zones and the zone area within the
zone perimeter with manually drawn zones.

The right-hand section of the panel shows how low ceiling
areas, the areas occupied by Fills, freestanding Walls and
Columns within the zone area affect the calculation of the
total zone area.

- The space occupied by Walls and Columns that are not set
to act as zone boundaries in their own settings dialog
boxes can be partly or entirely subtracted from the zone
area.

- You can subtract from the total zone area a part of the
surface occupied by Fills as set in the Fill's own settings
dialog box.

- Tt is also possible to take into account only a part of attic or
other areas with ceiling heights below a certain value. See
Calculating Zone Space later.

The Remaining Area field displays the value obtained by
subtracting the Wall/Column, Fill and Low Ceiling reduction
values from the Measured Value.
The checkbox and percentage field next to this field allow
you to manually refine the calculated value. The last field near
the bottom of the panel displays the value you will see in
calculations.
Note: In order to activate the reduction defined in the
selected Zone’s Settings dialog box, you have to choose
Tools/Update Zones and refresh it.
The last panel is called Listing and Labeling and controls
the handling of the Zone in calculations.
The controls are the same as those used for construction
elements as discussed earlier in this chapter.
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il Zone Default Settings x|
F avarites, Default
*» [, Mame and Positioni
P p== Zone Stamp
P B'S Custom Settings
b, Model
P b, AreaC
7 :E Listing and Labeling
10 IHoom-UUT Link Properties:
M By Criteria
Matching Properties:
Itis a demo property with a veneven-veny d
I Individually Choose...
F
£ D Zores v Cancel | ok |
W

Zone Categories

Zones sharing the same function or purpose can be grouped
in categories. Zone Categories are defined by the command of
the same name in the Options menu and are handled as
ArchiCAD attributes.

Zone Categories are defined by the following elements:

- Category Code aids in the fast identification of the
categories, and in some countries this number can be set
according to the local standard. It can also appear in the
zone stamp.

- Zone Category Name describes the purpose or
functionality of the category. Note that each Zone can
have its own name and that it can be different from any of
the category names.

- Color helps to identify the zones belonging to the same
category on the Floor Plan.

- A Zone Stamp can be assigned to each zone category.
You can set default values for the parameters of each
category.

When you choose the Zone Categories command, a dialog
box is displayed, allowing you to create, modify or delete
zone categories.

lll Zone Categories ﬂ
T

Mew | Rename:. | Clear |

EHNF & Medical Treatment

Edit Selected Categorp

Zone_Stamp_01 3 | Calar: I
Parameter Default Walues
TextFont 1 =
Show Zone Mame On
ShowZone No. an “ZONE NAME>
Shaw Floaring On
Floor Tupe <floar type> "
Show Area On
Show Perimetar off
e it Uniis e [
caret_|

Predefined Zone Categories are displayed in the pop-up on
top of the dialog box. If you want to add a new category, click
on the New button and fill in the Name field.

I} Add New Zone Category x|

Category Code:
[&HNF

Zone Category Mame:

By double-clicking the Color box, you can assign any color to
the specified category. Select a zone stamp for the new
category by selecting a new GDL Object from the pop-up
menu.

You can delete or rename a zone category by selecting the
category in the category list and clicking the Clear or
Rename button respectively.

The default parameters of the zone stamp can be adjusted in
the parameter list of the stamp assigned to the current
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category. Some of these parameters (Zone Name, Zone
Number, Zone Level, Zone Height) are used in special fields
of the Zone Settings dialog box. The default values you
enter here will appear in the Zone Settings dialog box when
you select the given zone category.

See also the Graphisoft GDL Reference Guide for more
information about the creation and scripting of Zone Stamps.

Defining Zones

Geometry

There are two basic Zone definition methods represented by

three icons in the Info Box. You can either manually draw the
contour of a zone, or let ArchiCAD automatically recognize a

zone surrounded by bordering elements such as Walls, Lines,

Arcs, Splines and Columns.

|
Default Settings @I
ERNE

BHMNF 6 Medical Tre. ] '|

The Polygonal method is your best choice when your Zone’s
boundary is not clearly surrounded by elements. With this
method, you simply draw a polyline (as you would for any
other polygon) by clicking at every corner of the zone. Zones
created with this method cannot change their shape when
using the Update Zone command on them, and their area is
not modified by related constructions (enclosed elements).
See the Drawing Walls section above for illustration and
details.

Both automatic recognition methods, Inner Edge and
Reference Line, are based on the fact that most Zones are
surrounded by Walls and the only openings in them are Doors
and Windows. You can also activate the automatic recognition
by other element types such as Lines, Arcs and Splines with

the Zone Boundary checkbox in their settings dialog boxes
(Listing and Labeling panel). For Walls and Columns, the
Relation to Zones pop-up menu in the same panel lets you
set whether to use the element as a Zone Boundary or to
subtract its area from Zones.

- If you choose the Inner Edge method (second icon in the
Info Box), ArchiCAD will always define the zone area by
the inner edges of walls.

- If you choose the Reference Line method (third icon in
the Info Box), ArchiCAD considers the reference lines of
the walls as the boundaries of the zone. Note that even if
you constructed Walls with the reference line placed on
the internal edge, the Zone fill does not overlap the wall
symbol until you choose Bring to Front from the Tools
menu.

If the Zone has openings that are not Doors or Windows,
ArchiCAD will continue searching for boundaries outside the
spatial unit that you wished to identify as a Zone. In this case,
the result may not be what you expect (figure on right
below).

Public

In this case, you can:

- draw a line as a Zone Boundary, or

- use the Polygon method.
With standalone Zones, i.e., Zones that are not connected to
any other, automatic recognition may produce the desired
result even if the Zone is open. ArchiCAD will search around

the walls surrounding the Zone and when it fails to find one,
it automatically closes the Zone.
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Whichever Geometry Method you choose, the Hammer cursor
appears when you have finished defining the outline of the
Zone. Click with it to define the location of the Zone Stamp.
The Zone Stamp does not necessarily have to be placed inside
the Zone polygon.

Office
s
f: 943 m2
-+ +
Office
. A 1320 m2 ||

Trimming the Zone Shape

You can either select Roofs, Slabs and Beams and trim to them
the Zone they protrude into, or select a Zone and then choose
which element types to trim it to.

Il Trim Zone

& Trim Top @
£ Trim Base @

Trim 30 shape of Zone to:
¥ Roofs

[~ Slabs

[ Beams

Cancel |

You can choose between trimming the base or the top of zone
spaces. Check the corresponding boxes to define whether
you wish to trim the zone space(s) to roofs, slabs or beams. If
you select only one type of trimming element, e.g., roof, in
the Project, all the checkboxes are grayed. If two types are
selected, only the checkbox of the type not selected will be

grayed, and you can still choose between the selected types if
you wish.

Trim 3D shape of Zone to
I¥| Roife

= | ElahE
= Eeams

Trim 3D shape of Zone o
7| Eonfs

¥ Slahs

¥ Beams

The trim will be executed by clicking the Trim button in the
dialog box.

Zone space trims can be undone by selecting the trimmed
zone space and pressing the Undo Top Trim or Undo
Bottom Trim button in the Model panel of the Zone
Settings dialog box.

Note: You can also opt to undo the Trim when updating
modified Zones. See the Updating Zones section below.

Calculating Zone Space

In addition to the settings made in the Area Calculation panel
of the Zone Settings dialog box and the options chosen for
the construction elements included in the Zone's area, the
Zones screen in Options/Preferences contains controls for
defining the behavior of Related Constructions when
creating Zone Lists.

The top part of the dialog box concerns recesses cut in Walls
by Door and Window openings. When calculating Zone sizes,
it is possible to include or exclude recesses that are below a
certain depth and/or whose surfaces are smaller than a certain
value.
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IZnnas j << Previous | Mext »> |
Add wWall Recesses to Zones: |y vV ===
¥ 1t deeper than: m
[¥ 1t larger than: 010 m2

Y all & Colurn Subtiaction: Low Ceiling R eductian:

¥ = If lawar than:

It 1arger than: IDJD mz W 2000 ol
Subtract: I 100 * v [1000 ey
¥ B )

.
If larger than: Img mz 0
ST

o
Subtract: I]UU % P
ote: Subtract: Img %

Effactive on elements not excluded fram
the zone palygon

50 i

Cancel |

Check the boxes next to the Door and Window icons to add
recesses to zones.

Note: Wall recesses can only be added to the zone if the
Door/Window elements in the active Libraries include a
proper Parapet Wall Inset definition.

In the Wall & Column Subtraction area at bottom left, Walls
and Columns (or part of the surface they occupy) can be
included or excluded from the Zone’s size.

Remember that the relationship of Walls and Columns to
Zones can be defined in their own Settings dialog boxes; any
settings made in Preferences can only act on elements that
are not enabled for Zone Boundary recognition but are
enabled for reducing the Zone’s area.

Use the checkboxes next to the Wall and Column icons to
activate area reduction. Type the minimum value to be
considered for the area occupied by an element in the If
larger than text field. Then, in the Subtract text field, define
the percentage of the occupied area to be subtracted from the
measured area.

Located in the bottom right corner, the Low Ceiling
Reduction controls allow you to specify to what degree
reduced height spaces will be taken into account when
calculating Zone sizes.

Checking both boxes enables the customization of two
different height limits with different ratios. This allows you,
for example, to differentiate between limited usage areas and
unusable areas.

Updating Zones

When you modify your design, associative zones do not
automatically adjust themselves to the changes.

Using the Update Zones... command in the Tools menu will
adjust the Zones to your updated design and alert you about
any problematic Zones that might have been created. The
dialog box that appears also provides you with feedback on
how each Zone has changed.

Update Zones £ IQl Update Zones |
Results of the Last Update: Results of the Last Update:
Status  No. Hame Added m? Status Mo Name Added m? |
=l
v o0z Office 0.00
[
-
[” Keep Zone Stamp position if updated
[~ Keep Zone Stamp position if updated I™" Undo Top Trim if updated
I~ Undo Top Tiim if updated [~ Undo Bottom Trim if updated
™ unde Bottom Trim if updated I |
Zoon to Selectzd Zones | 4
Update Selected Zones I
fl £
Update All Zanes |
#
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The dialog box contains the following columns:

- Status: This is where ArchiCAD tells you if the Zone could
be updated, and if not, what the nature of the problem is.
The icons appearing in this field represent the following:

W All is well, ArchiCAD has successfully updated your
Zone.

& L: The Zone was created manually and cannot be
automatically adjusted.

/1 igh : The layer on which the Zone resides is locked.
Unlock the layer in the Layer Settings dialog box and
repeat the update process.

&l 4 The Zone is self-intersecting. Just as in the case of
polygons, you may have to adjust the Zone to have valid
geometry, or split it into two Zones. You can examine the
Zone by selecting it in the list, and pressing the Zoom to
Selected Zones button. Repeat the update process.

A 5 The reference point of the Zone is outside of its
boundary. Each automatic Zone has a reference point that
must lie inside the Zone. If you get this error message,
move the reference point inside the Zone and repeat the
update process.

& G'_E‘ : The Zone you are trying to update is not in your
workspace. This error can only occur if you are working in
a shared Project in Teamwork mode, and the Zone is
assigned to another team member. Ask the team member
to make the Zone available to you.

A1 +2+. The Zone you are trying to update cannot be
properly adjusted, because it has difficulty in finding all of
its edges. Use the Zoom to Selected Zones button to find
the Zone and repeat the update process.

- No.: This column contains the number that has been
assigned to the particular Zone.

- Name: This column contains the name of the Zone.

- Added m2: This column contains information on how the
Zone has changed. To change the display from the relative

change in square meters, choose a different unit from the
pop-up menu in the upper right portion of the dialog box.

m2

v Added m2
s ft
Added sqg ft
Added %
Corners
Added Corners

- You can keep the original position of zone stamps when
updating zones if you check the Keep Zone Stamp
position box.

- You can remove the 3D zone space trim by checking the
Undo Top Trim and/or Undo Bottom Trim boxes.

Note: If you leave the Undo Top and Bottom Trim
boxes unchecked, conflicts may arise in certain geometric
configurations.

Labels

Definition

Labels are text blocks or symbols optionally linked to
construction elements and 2D fills allowing you to identify or
comment elements or parts of your design.

Labels can be framed or unframed, with leader and
arrowhead. They can contain either custom text specification,
the element's ID or unique Internal ID or a symbol.
You can use Labels in two ways:
- Independent labels are manually placed in the Floor Plan
or in a Section/Elevation window.
- Associative labels can be assigned automatically before
the creation of an element or added to them later.

Label Symbols are special GDL Objects. They can be scripted
and/or graphically defined and can even include bitmaps.
They can display all kinds of element information on the
drawing, for example the skins of a composite Wall.
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Glass Block

You can create your own Label Symbols as you would any
other GDL Object by choosing the File/GDL Objects/New
Object... command. See Chapter 8: Working with GDL Objects
Jfor details.
Note: Text Labels and Symbol Labels containing text are
affected by the choice made for Text in Options/Display
Options. If you have selected the Greek option there, all
Labels with text in them will appear as gray, illegible blocks.

Label Tool and Settings

In the default shape of the dialog box, the Text and the Label
tools are grouped in a single icon. Flush out the Label tool, or
choose Options/Customize/Palette Shapes and select the
Extended version of the Toolbox to see both tools at the
same time.

Double-clicking the Label tool opens the Label Settings dialog
box which has six panels: Content and Preview, Text Style,
Pointer, Symbol Label, Custom Settings and Text Label.
Depending on the currently chosen Label type, some of these
panels will be inactive.

Label Settings

The Content and Preview panel defines the labeling options
for element classes and displays a preview of the selected
symbol label.

Il Label Default Settings x|

Favaorites... I Default
hd Content and Preview

‘wall Toal O
£ Column Toal 00O

@@ Beam Todl 00O

=== "Window Tool 00O

! gz Dooor T ol IO
Hly Object Tool 0O

@ Lamp Tool 10D O

[ Slab Tool [[o |

EI7 Ranf Tonl 1IN M
P iy Test Style
P ;2 v Pointer
» Symbol Label
b B'S Custom Setlings
¥ Text Label

£=2 @D Lahels DI Cancel | oK I

On the left, the element types eligible for labeling are listed.
You can set default labeling options for each element type. If
the Label (element type) on Creation box is checked in
the given tool's settings dialog box, these are the options that
will be offered by default.

You can choose the type of Label to use from a pop-up menu
on the right. The options are:

*‘_.2"‘ 3
AL A - Text. If you choose this option, ArchiCAD will place the
_Faroie | Defaul Default Text defined in the Text Label panel. If there is
-8 »  [ai] Content and Preview none, you will be prompted to write the text of the Label
: e ;:::lz:"'e when placing it.
» r Symbol Label - ID. If you choose this option, the Label will contain the ID
— b == Custom Settings of the associated element. Changing the ID field of the
—= Tost Label selected element will update the Label, too.
% EB B> Labos 8 Carcel | [ oK |
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- Internal ID. Fach ArchiCAD element has an internal
identifier that the user has no access to. If you choose this
option, the Label will contain this internal ID.

- Choose Other Label... followed by the names of the
available Label Symbols in the current Library. With the
Choose Other Label... command, you can use Labels that
are not currently loaded.

Below the pop-up, the preview area shows the Symbol Label
you have chosen from the Library. It does not contain any
associative elements.

The second panel is called Text Style. Depending on whether
you have selected a Text or Symbol type Label to place, its
controls are fully visible or dimmed.

Wl Label Default Settings =l
F aworites | Default

» [#1] Content and Preview

T AW Text Style

W

I Courier New ‘wWestern d

MT [200 wm | Bold
IS
I Underling

Leading: & Single
o112
" Double & 125
" Custom: 0,00 M C

rz 9 Pointer
Symbol Label

B'S Custom Settings
A= Text Label

4
4
4
»

Cancel | oK I

- If a Text type Label has been selected in the first panel,
you can fully configure its font type, size, alignment and
leading attributes and decide whether to draw a frame
with the Label.

£ B Labek v|

- If a Symbol type Label has been selected in the first panel,
you can only choose a font type and size as well as the
color of the text.

The third panel concerns the Pointer of the Label.

Il Label Default Settings LI
Favorites... Default

» [41] Content and Preview
P rayp TextStyle

hd K_lf Pointer

Solid Line >| A am|

(ol N el CE R AECE
stz mm >

» Symbol Label

Arawhead

b B'S Custom Settings
» Text Label

£ D Labels >|

Cancel | Ok I

You can define a straight or a curved pointer line, and choose
from three different pointer position options. The
Arrowhead's size can be set in points (imperial units) or mm
(metric units). Note that Symbol Labels can override the color
and Arrowhead settings made here, as shown on the next
panel.

The Symbol Label panel is only active if you have selected a
Symbol Label on the Content and Preview panel. It shows
options for the Symbol Label's size and other parameters.
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Il Label Default Settings x|
Favarites, | Default

»  [a1] Content and Pieview

P tay Test Style

¥ ¢y Pointer

- Symbol Label

Parameters

7 Text parameters - {1000

Fonttype Arial Miestern @
Fontsize 3 i I 1000
i Text distance 4000
L. Woking unit om

v Use symbal color
LI v Use symbal amow

L Brale sensithve text on

: % Extension line paramelers
i Extension line type single line

L. Fxdensinn line lennth AN

b B'E Custom Settings

3 Text Label

=2 D> Labels 3 I

Cancel | 0K I

Symbol Labels can have any number of parameters listed on
the left. On the right, you can set the size of the Label and its
placement angle. You can also choose to display the Symbol
Label with its own internal color and arrowhead or to use the
options chosen in the Pointer panel.

As for all other GDL Object type element, the Custom
Settings panel contains special options defined in the Symbol
Label's User Interface script. It is only active if you have
selected an appropriate Symbol Label in the Content and
Preview panel. See Windows and Doors for illustration and
details.

In the Text Label panel, you can enter a default text and
define the Label's orientation relative to the associated
element. This panel is only active if you have chosen a Text
type Label on the Content and Preview panel.

Il Label Default Settings x|

Favarites Default

[41] Content and Preview
1ap Text Style

1z ¥ Pointer

Symbol Label

%'S Custom Setlings

4
4
4
4
4
=

Text Label

Label orientation relative to
element:

Default Text
This element wias dravn by BA, =]

Cancel | Ok I

£=2 @D Lahels bl

Four orientation options are available for Text Labels:

- The Parallel method always places the Labels parallel to
the labeled elements.

]

- The Vertical method always places the Labels vertically.
The text can be read from bottom to top.

T
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- The Horizontal method always places the Labels width, simply click again at the end of the pointer with the
horizontally. Checkmark cursor. Type any length of text in the text box
and click OK in the Control Box to complete the label.

!
- The Custom method places the Labels at the angle you /

define in the edit field next to it.

y
%
%
|
%
|

Placing Associative Labels

M Associative Labels can be placed automatically on creation or
% added to selected elements at a later stage.
o o . . .
- Associative labels will be placed automatically with every

newly created element, if the Label (element type) on
creation box is checked in the given tool's settings dialog

] box's Listing and Labeling panel. Click the Label
. Settings button to choose options for the Label you wish
Placing Labels to place with the element to create.

- To add an Associative label to an element, select it and

Placing Independent Labels
open its settings dialog box. Go to the Listing and

Independgnt Labels can only l?e placed manua.lly. Click Labeling panel, activate the Label (element type)
anywhere in the workspace with the Crosshair cursor to start checkbox and click the Label Settings button to choose
drawing an independent label. Two additional mouse clicks options for the Label you wish to add to the selected
define the pointer. . element. You can also click the element with the Label tool
- If the label content is ID, Internal ID, Symbol or Default active to place the associative Label set by default for that
Text, the label is completed after the third mouse-click. element type.

K‘/ ﬁ default text
/

- If the label content is Text, draw a rubberband box after the
third mouse-click to define the width of the label text
column. If you do not want to predefine the text column
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Presentation Elements

Presentation elements are special element types. They define
the location of associated windows and views generated from
the Virtual Building model.

- Section and Detail Markers are placed to define the
location of associated Section/Elevation windows and
Detail Drawings.

- Cameras are used for setting up the 3D projection of the
model in perspective views and animations as well as VR
Objects and VR Scenes.

The chief purpose of the actual elements placed in the Floor
Plan (or, in the case of the Detail Marker, in Section, too), is to
set up the access point and configure the view displayed in
the corresponding window.

The section that follows presents both the elements
themselves and the special functionality available in the
resulting windows and views.

Sections and Elevations

Definition

In ArchiCAD, Sections and Elevations consist of two elements.
The Section Line created on the Floor Plan is used to generate
a Section/Elevation window showing the model from the
defined location.

The Section Line is defined with the Section/Elevation tool
located in the bottom section of the Toolbox. It places
standard section/elevation symbols on the Floor Plan
including optional breakpoints. The symbols may appear on
all stories of your Project or on a range of stories only.

On the Floor Plan, what you see is the Section Line itself with
Markers on both ends, an identifier and an optional dashed line
marking the depth of sections with limited horizontal range.

In Options/Display Options, Section depth can be displayed
or hidden on the Floor Plan. Section Marker display is also set

there. The two choices are Normal and Key Plan. In the latter
case, a simplified version of the Section Line with a uniform
dotted line and a single Marker is shown.

Section Depth

Detail Boundary

B/2 Q 77777777777777 A B B/2 L\\
B/3 A A B B/3 A
o S N N —4> s

N

The moment the Section Line is placed, a corresponding item
is generated in the Navigator palette's Project Map and a
command with the Section's name appears in the Window
menu's Sections/Elevations hierarchical menu. Double-
clicking the view in the Navigator or choosing the name of the
view in the hierarchical menu will open the corresponding
Section/Elevation window.

window  Extras  Help

Floating Palettes 3 ’E| e il

| Wiew Sete I

=-fB PlanFils -

=] IEI Stariez |T Floor Plan Chrl+2 =
Iﬁl i 3D Window  Ctri+d I
Sections/Elevations
ons - At [ Model
£ 441 Model) [y ) °del
£ 472 [Model _ 3D Picture = B2 fiGiit
1 A43 (Madel) _ i3 { Model
£ BA (Modsl - Element List - EBf1 {Model
31 Details - Component Lisk

The contents of the Section/Elevation window depend on
both the horizontal and vertical range you define for it. The
vertical range is defined in the current Working Units set in
Preferences. The horizontal range of the section can be of
three types:

- Infinite: All elements behind the Section Line will be
shown in the Section/Elevation window, provided that
they are not hidden by other elements.
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- Limited: Only the elements between the Section Line and
the limit will be shown in the Section/Elevation window.

- Zero Depth: Only elements actually cut by the Section Line
will be shown.

Each view you generate with the Section/Elevation tool
remains a part of your Project as long as its corresponding
Section Line is present. This also means that each view is
saved with the Project.

Section/Elevation Windows

There are two types of Sections/Elevations: dynamic Models
that are linked to the model and can be edited interactively
with the Floor Plan, and static Drawings that are unlinked,
editable drawings.

The contents of the Section/Elevation Window depends on
the settings chosen for the corresponding section line in the
Section/Elevation Settings dialog box (horizontal and
vertical range), not on what is currently selected on the Floor
Plan. Selections made on the Floor Plan do not affect the
Section/Elevation Windows in any way.

Selection made in a Section/Elevation Window is independent
from any other selection made in other Windows (Floor Plan,
3D Window, other Sections/Elevations).

You can save the contents of the Section/Elevation Window as
a separate file in a variety of formats.

Model Type Windows

Models are sections or elevations of the digital building. They
consist of construction elements and any change made in one
of the Section/Elevation Windows will automatically be
updated in the Floor Plan Window, and, when activated, in
any other Section/Elevation Window and the 3D Window.
The Model type Section/Elevation Windows are editable, but
no new construction elements can be created in them, with
the exception of duplicating existing Doors and Windows.
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Selection Settings E
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|
e e
g I i
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Note: Even by copying construction elements and pasting
them back you can only obtain plain, additional drawing
elements.
Changes made on construction elements in the 3D Window or
in other Section/Elevations Windows will appear when next
activating the Section/Elevation Window or on choosing
Display/Rebuild Model. The update process works on
construction elements only; additional 2D elements will
remain unchanged.
You can modify construction elements in their tool’s Settings
dialog boxes or in the Info Box.
Warning: Clearing a construction element in a Model
Window will also clear it from both the Floor Plan and the
3D model.

Drawing Type Windows

Models can be converted to simple Drawings by choosing
Display/Sections/Elevations/Unlink from Model. All
construction elements will then be converted to Lines and
Fills. You can add drawing elements to this Window by using
the 2D drafting Tools, by placing 2D objects and text blocks,
and even through copy-paste.
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Changes made on construction elements can be displayed in
the Drawing Window by choosing Display/Section-
Elevations/Rebuild from Model. In this case, additional
elements will remain unchanged, except for associative
Dimensions.
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Section/Elevation Tool and Settings

The Section/Elevation tool is located near the bottom of the
Toolbox. Double-clicking it opens the Section/Elevation
Settings which consists of seven panels: General, Floor Plan,
Marker, Marker Custom Settings, Cut Elements, Model Effects
and Distant Area Options. Some of the panels' settings
concern the Floor Plan appearance of the Section Line, while
others control the contents of the Section/Elevation window.

The first panel shows the General options. It contains the
identification of the Section/Elevation window, the horizontal
and vertical range of the view it displays and the accessibility
of the Section Line on different stories.

Bl Section/Elevation Default Settings x|

Favorites... | Default

¥ Y= General
¥

Reference ID: |4/4

Horizontal Range:

Hame:

Wertical Range:
i Infnite  Infinite

& i Limited  Limited
© u | ZeroDepth

L
Y —

¥ Marked Distant Area

Show Section Line on Stories, All j

Floor Plan
Marker

Marker Custom Setlings

i P e

Cut Elements
Model Effects
Distant Area Dplions

v v v v |¥v|>
m
o

@ B

=

Sections/Elevations 3 |

Cancel | 0K I

- The Reference ID can contain up to 31 characters in
length. Tt will appear on the Floor Plan with the orientation
arrowheads.

- The Name can contain up to 31 characters. This name will
then appear in the Navigator palette, the Window menu
and the title bar of the Section/Elevation window.

- The Marked Distant Area checkbox allows you to divide
the view displayed in the Section/Elevation Window into a
"closer" and "farther" area. The elements of the Distant
Area can be assigned different colors, hatches and effects
to indicate that they are at a longer distance from the
Section Line. See the Distant Area Options panel below.

If you have selected the Infinite radio button under Vertical
Range, the Show Section Line on Stories pop-up menu
allows you to choose between showing the section line on all
stories, or on the home story only.

=4

A [l section/Elevation Selection Settings x|
Al Favorites... Selected: 1 Editable: 1
— » %= General
% » it Floor Plan

a " P A Marker

"1 b = Marker Custom Settings
— El

o b . Cut
— »  #. Model Effects
I‘_"‘ » 2y Distant Area Oplions
% £ @ Seclions/Elevations 2 Cancel | 0K I
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If you have selected the Limited radio button and entered
height values, two additional options are active:

- The section line will appear on all stories that are entirely
in the vertical range defined in the height value fields;
- The section line will appear on all stories that are at least

partly included in the vertical range defined in the height
value fields.

The second panel shows the Floor Plan options, that is, the
appearance of the Section/Elevation symbol and its
components.

[l Section/Elevation Default Settings 5[
Favarites. | Default
P %> General
¥ i Floor Plan
i Dashed 2 | _l’ l_
Dense Dotted 3 | _|’ l—
= : 1w
Markers: V& @ alV
Section Line: ' Cortinuous
" Segmented iy
e
Lemath: ID,DD I ]
P A Marker
b 5'= Marker Custom Settings
» g CutEl
P & Model Effects
P 2 Distant Area Options
£F @ Sections/Elevations v Cancel | w |

- You can select different Pen Colors for the Section Line and
the ID and different Line Types for the Section Line and the
line that indicates the horizontal limitation (section depth).

- You can enable or disable the Markers at either or both
ends of the Section Line.

- By choosing the Segmented option, you can display parts
only of the Section Line. This allows you to display the

Markers or the end sections only of the Section Line. Note
that if both Markers are disabled, you cannot disable all of
the segments.
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The third panel shows the Marker options. It contains the
font and size settings of the marker text as well as the preview
and parameters of GDL Object-type markers.

lll Section/Eleyation Default Settings 5'

Favorites... Default

b % General
P 7t Floor Plan
¥ & Maker

Section Marker - 70 2 |

9 m|

j M1 |2,UD mm ¥ Use Symbal Colors

I Courier Mew Westem

llilil &2 [100
Warker Fill [ e

Twpe 70 1
Marker Text 1 Pen (default) BWro3sm A/ 4

4]

2= Marker Custom Settings
" Cut El

&5 Model Effects

sy Distant Area Dptions

v | v |v |w

£% @ Seclions/Elevalions 3

Cancel | 0K I
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If you choose a parametric marker from the pop-up menu on
top of the panel, the 2D Symbol and the parameters of the
corresponding GDL Object appear in the preview and list
fields respectively. The marker may include custom settings,

as seen in the next panel.

The Marker Custom Settings of parametric, GDL Object
type markers may include various options, mostly for the

arrowhead.

Il Section/Elevation Default Settings

Favarites... |

x|

Default

" General

;" Floor Plan

& Marker

v+~

=]

Marker Custom Settings

— Marker Types 70

LA A oo

» =, CutEl

b #s Model Effects

b =23 Distant Area Options

£% D Sections/Elevations

Cancel | ok I
v

The next panel controls the options for Cut Elements in the

Section/Elevation windows.

- You can either choose uniform Pen Colors for all cut

elements, or use their own settings.

- Uncut but visible elements inherit their respective Floor

Plan Pen Colors.

lll section;/Elevation Default Settings

Fawarites... |

S General

i Floor Plan

=

Marker Custom Settings

4
»
P A Marker
4
-

% Cut Elements

[+ Use Elements' Section Colors

x|
Default
T |
z

%

» . MWodel Effects

P 2y Distant Area Options

£% @ Sections/Elevations

d

Cancel | Ok I

The sixth panel shows the Model Effects. With the help of
these controls you can activate vectorial shadows and
vectorial 3D hatch patterns on model surfaces for Section/
Elevation views similar to model views in the 3D Window.

Il Section/Elevation Default Settings x|

Faworites... |

Detault

General

=i Floor Plan

Marker

Marker Custom Seltings

Cut EI t

Model Effects

™ Use One Pen for Al Elements " |7 i
I “ectorial 30 Hatching
Sun Azimuth
s In 3D Window o [e.00°
& Custom Q/u: Sun Altitude
|45.DD“
Shadow Polygons:
%/ % comman brick ’ . |2 1
M
LB =1
Mote: Shadow Polygons have no contours in Sections/Elevations.
» % Distant Area Options
£ @ Sections/Elevations 2 Cancel | 0K I
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With the first checkbox on top, you can decide to use a single
Pen Color for all of the element contours.

Vectorial 3D hatch patterns in Section/Elevation views can be
activated by checking the corresponding box. In this dialog
box there is no other control for vectorial 3D Hatching. The
vectorial 3D hatch can be set individually for each window.

See the following figures for differences between Section/
Elevation views with and without vectorial 3D hatches.

See also Vectorial 3D Hatching under Materials in Chapter O:
Project and Program Customization.

Vectorial sun shadows in Section/Elevation views are
activated by checking the corresponding box. Shadows work
independently of vectorial 3D Hatching patterns. Checking
the Vectorial Sun Shadows box activates all the controls of
the Model Effects panel.

You can set the position of the sun relative to the Section Line.

Alternatives include using the same sun position as in the 3D
Window and custom settings specific to each Section/
Elevation window.

- If you choose the As in 3D Window radio button, the
other controls are disabled.

- If you choose the Custom radio button, you can control
the sun position locally. Drag the sun with the cursor in
the graphical sun dial or type the desired value in the
corresponding field to set Sun Azimuth. Azimuth values
are limited so that the sun is always behind the section/
elevation line. Otherwise the visible side of the building
would be overshadowed.

Note: The sun position can be activated individually for
every Section/Elevation window.

In Section/Elevation views shadows have no contours;
however, the fill polygons are freely customizable. Choose the
fill type, fill pen and fill background pen using the
corresponding pop-up palettes.

Compare the following figure to the ones above for
differences between Section/Elevation views with and
without vectorial sun shadows.

See also the 3D Window Settings command's description in
Chapter 11: Menu Command Reference.

The seventh panel shows the Distant Area Options. This
panel is only active if you have checked the Marked Distant
Area box in the General panel. The controls are the same as
on the Model Effects panel, but you cannot set the Sun option
separately here.

1l section /Elevation Default Settings x|
Favorites... | Default
b S General
» 7t Floor Plan
P A Maker
» B= Marker Custom Settings
» % Cut Elements
¥ #: MWodel Effects
hd ﬁ. Distant Area Options
I Use One Pan far All Elements LAY |
I Wectarial 3D Hatching
I Vectorial Sun Shadows
Shadow Polygons:
W Z common brick ¢ . l”? |-|
. %
o |
Note: Shadow Polygans have no contours in Sections/Elevations.
£F @D Sections/Elavations , Cancal | ok |
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The Marked Distant Area is the "farther" area defined with the
control in the General panel. If you have chosen a Limited
horizontal range on the General panel, the secondary depth
line representing the Distant Area will be placed by default
halfway between the Section Line and the Depth Line.

Placing Section Lines

When you have made your choices in the Section/Elevation

Settings dialog box, follow these steps to place a section line

on the plan:

1) To start a section line, click with the mouse to begin
drawing a rubberband on the Floor Plan.

2) With the second click you can designate the direction of
the line and the length of the first segment. All the
segments of the Section Line will be parallel to this first
segment, although you may include perpendicular offsets
as you extend the line.

3) To finish drawing the section line, either click twice at its
endpoint or click the OK button in the Control Box.

4) By clicking with the Eyeball cursor you can set both the
orientation and the depth for limited sections.

5) The arrowheads and IDs are automatically placed after the
section line is completed.

Adjusting Section Lines

To manipulate a selected section line as a whole, you can use
the Arrow tool, the Marquee tool or any Edit menu
command. To change the length of a section line or the steps
of a staggered section, you need to select it and activate the
Section/Elevation tool. Then you can drag or stretch any of
the section’s line segments by its line or midpoint. For
staggered sections, if you drag a segment beyond the next
one, one step will be skipped. Note that this is a way of
making a staggered section more simple.

Breaking Section/Elevation Lines

You can break straight Section/Elevation lines and add new
segments to staggered sections.

Activate the Section/Elevation tool by clicking its icon in the
Toolbox. Select the section or elevation line you wish to edit by
holding down the Shift key and clicking on the line with the
Mercedes cursor or on one of its nodes with the Checkmark
cursor. (Reverse the procedure if you wish to select the element
using the Arrow Tool.) With T straight lines, click the midpoint
of the line. If you selected a staggered section, click the
midpoint of any segment you wish to break. The click will
break the line or the segment and the cursor will immediately
move half of it. Click again to define the position of the moving
segment. If you want to move the other half instead, simply
click on the original midpoint and pick up the other segment
with the Mercedes cursor. Click again to place the segment.

_IM3

Staggered sections can have a maximum of five section
segments.
Note: Breaks of a staggered section line can be eliminated
by pulling the break line out of the section range while the
section line is selected.

M3 _ _ _

| 4
T M3

Adjusting Section Depth and Distant Area Limit

You can change the depth of a selected section by
repositioning the limit line to include either fewer or more
objects. Make sure that the Selection/Elevation tool is active
and move the line by clicking it and dragging to the desired
position. Similarly, you can also move the secondary depth
line representing the Distant Area limit.
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Detail Drawings

Definition

In ArchiCAD, Details consist of two parts. The Detail Marker
created on the Floor Plan or a Section/Elevation window is
used to indicate details on these drawings. By placing a Detail
Marker, you can generate a Detail Drawing that either
duplicates the area around the Marker with 2D-only elements
or creates a brand new empty drawing. This means that an
optional detail boundary can be defined, allowing you to
copy elements automatically into the Detail Drawing.
There are four types of Detail Drawings:

- Project-based Floor Plan details;

- Project-based Section/Elevation details;

- Independent marked details;

- Independent unmarked details.
The Detail Marker is defined with the Detail tool located in
the bottom section of the Toolbox. It places standard detail
symbols on the Floor Plan or in the Section/Elevation
Window. As soon as a new Detail Drawing is generated by
placing a new Marker, a corresponding item appears in the
Project Map of the Navigator palette. Double-clicking the
view in the Navigator will open the corresponding Detail
Drawing. The names of opened Detail Drawings also appear
in the Window menu's Detail Drawings hierarchical menu.

Froject Map |Vieu\| Setsl

-4 Untitled
- & Stories
- [&] Sections/Elevations

|Window Extras Help

Floating Palettes 3 7 | e i
Floor Plan Chrl2
30 Window  CtrH3 |

Sections/Elevations 3 I

Detal Drawings

- 3D Picture

In the Options/Display Options menu, you can choose to
show or hide the Detail Boundary, that is, the framing line
that defines the area shown in the Detail Drawing window.

Detail Boundary:

Markup Items:

Detail Markers are always linked to Detail Drawings. A Detail
Drawing can be linked to more than one Marker.

Note that deleting the linked Drawing Marker does not delete
the Detail Drawing. It is still preserved in the Navigator
Project Map and can be accessed by double-clicking it there.
If you need to modify its settings, add a new Detail Marker
and link the drawing to it.

The Detail Drawing Window

A new Project-based Detail Drawing only contains drawing
primitives, that is, lines and fills. These originate from the
construction elements copied from the Floor Plan or Section/
Elevation.

All types of 2D information can be added to the Detail
Drawing: Lines, Fills, Hotspots, Text, Figures, Dimensions and
2D Symbols of Objects.

The contents of the Project-based Detail Drawing window can
be regenerated by choosing Display/Rebuild Detail Drawing.
Manually added data will be preserved, while the elements
originating from the Floor Plan or Section/Elevation window
will return to their original state.

Section Details reveal the elevation of the original
construction, which means the Elevation Dimensioning on
Details Drawings shows correct elevation values, unless you
displace drawing elements vertically.

Detail Tool and Settings

Double-clicking the Detail tool opens the Detail Settings
dialog box which has four panels: General, Marker, Marker
Custom Settings and Detail Boundary.
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The Marker panel contains controls for the Detail Marker's
2D Symbol. On the right, a preview area shows you how the
Marker will look when placed. Detail Markers are parametric
GDL Objects. If you have chosen a Marker in the pop-up on
top of the panel, any number of parameters can appear next
to the preview.

Parametric Markers can include additional options displayed
on the Marker Custom Settings panel. If using a marker
without additional options, this panel is not accessible. See the
Windows and Doors section for details.

The Detail Boundary panel includes a Line Type and Pen
Color setting for the frame of the Detail area.

Il Detail Default Settings x|
Favarites... | Default

=y, General
~Y Marker

2'S Marker Custom Setlings
_EH Detail Boundary

4
4
4
=

(2 Sofd Line »| 0 |
£F <@ Detail Markers bI Cancel |

The Detail Boundary can be hidden in Display Options, as
seen at the beginning of this section. However, the Detail
Boundary is never present on printouts. Printable frames are
available with the Detail Marker objects.

If you change a boundary of a detail, the markers linked to the
same detail drawing can be updated in the Navigator. For
updating markers, use the Update Detail Markers command in
the context menu of a Detail folder in the Navigator Project Map
or in the context menu of a Detail Clone in your View Sets.

Creating Details

In the Info Box, there are four options for drawing Detail
Markers.

&

Default Settings il
=3N=0E=a

When choosing the first icon, you can only place a Detail
Marker without defining a detail boundary. If you have
specified a Detail Drawing to attach before placing the
Marker, it will be linked to it. Clicking in the Floor Plan or the
Section/Elevation Window will place the Detail Marker with
the settings you made in the Detail Settings dialog box.

When choosing one of the other three icons, you will create a
Project-based detail by defining an area around the Detail
Marker. Provided that you have chosen the Create New Detail
Drawing Window option in the Detail Settings dialog box, the
Polygonal, Rectangular or Rotated Rectangular area you draw
will be copied into the new Drawing Detail window, together
with the 2D-only duplicates of any element that is inside that
area.
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Cameras
Definition

In addition to the default 3D views built into ArchiCAD, you
can place any number of Cameras in the Floor Plan for
generating perspective views in still image or animation (fly-
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through) format as well as Virtual Reality panoramic scenes, a
path for VR scenes and navigable VR object movies.
Note: You can find additional information on 3D related
functions in the 3D Image Setup and Navigator sections of
Chapter 3: Project Organization and Navigation and the
Image menu section of Chapter 11: Menu Command
Reference.
There are three types of Cameras available from either the
Camera Settings dialog box or the Info Box: Perspective
Cameras, VR Objects, and VR Scenes.

- Perspective Cameras are defined by a viewpoint, a target

point and an opening angle. They generate images directly
viewed in the 3D Window.

On the Floor Plan, all Cameras are shown with their target
points and the handles that can be used to manipulate
them. Only one camera is active at a time, as indicated by
the sun and view angle markers.

The Display Options of perspective Cameras can be set
with a pop-up menu in the Path Options dialog box
accessed from Camera Settings. You can hide the Cameras
altogether, show the Cameras with or without the Path line
and with or without the in-between frames. You can also
modify Cameras with the 3D Navigation palette and the
Navigator and Navigator Preview palettes.

- VR Objects are navigable objects taking advantage of
Apple’s QTVR technology. They are defined by a spherical
path along which the viewpoint can be positioned and
navigated. This viewpoint is represented by a view cone.
The navigable object can be viewed in Apple’s QTVR
Player application.

- Panoramic cameras define navigable VR Scenes using the
QTVR or RealSpace technology. You place one or a series
of cylindrical panoramas to be viewed in the
corresponding player application. For more information
on these technologies, see the More Information section of
Chapter 4: Element Creation in ArchiCAD Help.

Fangrama-6
Panerama-5

Panorama:’
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Only one type of Camera can be displayed at a time.
Switching to another type in the Info Box, the Camera Settings
palette or the Navigator palette automatically hides all the
Cameras of the other two types.

The Camera/VR Tool and Settings

The Camera icon is located at the bottom of the Toolbox.
Double-clicking it will open the Camera Settings dialog box.
The contents of this dialog box differ for the three types of
Cameras, but most of the settings are identical or similar.

This palette and the Floor Plan are simultaneously active, so
you can alter the settings, the camera locations and
orientations without repeatedly opening and closing the
window.

Perspective Cameras

When the perspective Camera type is active, the Camera
Settings dialog box allows you to make settings for the
default and selected Cameras, create and modify Fly-Through
paths, and set a number of other parameters.

A
B Camera |ﬁ VR Object |9 VR Scene |

Default

New% | Rename: | [Delete |

|0 Uniitied Path |

Camera: |o :’ Waithere: [0 frames

Smonth Fath at Cameras

Camera 2 o, TargetZ
®1 o |

o, Distance Azimuth

:_,\ [s000 o9 [z70,00°

Wiew Cone Roll Angle

,,.\"<'§|so,oo= & oo

0% Sun Aliuds 8 Bun Azimuth
Giee [as000 ..% [za0,00°

Path... Wles | -l

Sun...

Apply

Under the Camera type tabs, a number of controls allow you
to define and modify Fly-Through paths.

Every new Project has a default path named 00: Untitled
Path where the first cameras you place will reside. You can
rename this set at will.

If there is more than one Fly-Through path in your Project,
you can switch to any of them by using the path name pop-up
list or the Navigator palette.

You can start a new collection of 3D projections by clicking
the New... button. In the Add New Path dialog box you can
type a name for the new path. The checkbox option lets you
duplicate the current set when you define a new one. This
allows you to keep an original while modifying a copy under
a different name.

i} Add New Path x|

with name:

u ntitled Fath

™ 4dd Copy of Cunent Path

Cancel | oK I

You can change the name of an existing Fly-Through path by
selecting it in the path list pop-up menu and clicking the
Rename button. Type the new name in the dialog box and
click OK.

To delete the current set of projections, click the Delete
button. You will then be prompted to confirm this action. If
you do, the path name will be removed from the list and all
the cameras it contains will be deleted. If there is a single path
remaining, you cannot delete it.

The two numeric edit fields below the path name contain the
sequential number of the Camera inside the current path and
the number of time units (frames) during which the fly-
through motion will remain frozen (i.e., "Wait here") at the
given camera before moving on to the next one. You can
navigate among the cameras of the current Fly-Through path
by using the arrows beside the Camera number.
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Camera/¥R Settings
B Camens |@ VR Objest

Camera/¥R Settings
B Camens |@ VR Object

New. Renamn: New.. Renan
00 Untitled Path 00 Untitled Path
. Camera: [1 ji Wiait Camera: [2 :& iz
Smaoth Path at Smaooth Path &
Camera Z CameraZ
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Below these two fields, the Smooth Path at Cameras button
allows you to smooth the Bézier camera path at selected
Cameras on the Floor Plan. This will restore the tangent line
defining the path to its original condition if you have
previously modified it.

Camera/¥R Settings
M camens |@ WR Object |Q YR Scens |
Selected: 2 Editat
New.. | Rename Delete
|00 Uniited Path |

Camera: |o :I Waithere: [0 fram

Smoath Path at Cameras

CameraZ TargetZ

= ) S ¥ oo
.. <, Distanes # pzimuth 2
l ".“-: [zza0 o % [150,31° '

Using the six boxes in the middle section of the dialog box
you can enter parameter values numerically for viewpoint
height, viewing distance, view cone, azimuth, roll angle and
target height of the selected camera. Just below them, two
further edit boxes allow you to define the sun angle’s
parameters.

You can a choose a Pen color for the Camera in the bottom
right section of the dialog box. (To modify the color of the
path line, see Path Options below.)

The Path... button opens the Path Options dialog box. Here
you can define or modify the name of the current Path, set

Motion Controls and Display Options for it, and choose a Pen
Color for showing the path line on the Floor Plan.

20
Path Name: | Urtitled Path
r— hotion Controls Display Oplions
Camera Target: I Everpthing j
AR e
e M=

r~ Motion Resolution

Cameras on the path: 2

Inbetwesn frames: I'ID
Tatal frarmes: 11

Cancel |

The two Camera options define the shape of the camera path
during the Fly-Through animation as follows:

- Choose either Bézier or Polygon to control the method
used to create the path of the Camera. Bézier produces a
very smooth camera movement, while Polygon paths are
somewhat jumpier.

- Open or closed Camera motion controls whether a path
will be completed (closed) from the last defined keyframe
back to the first keyframe in the Path List.

The Target option defines the target point path shape during
the Fly-Through animation.

- If you choose Polygon, the target points of the in-
between frames will be placed on the straight line that
connects two consecutive target points. Choosing Smooth
will make the path of the target points rounded, but it will
always include the originally set target points in the
keyframes. (Smooth is available only if you have specified
Bézier for the camera motion.)

Hint: Use Polygon target motion if your camera moves a
lot but the target stands stills or moves just a little. This is
the case when you fly around a building but keep the
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same spot in sight. In other cases, try both methods to see
which one suits you better.

The following two pictures show you examples of different
Motion Control settings:

1]
-

+

R LT T R P——

- MOTION CONEIOIS oo

| comera: Target: ! Camera: Target:

i (@ Polygon ® Polygon (> Polugen " Polygon
) Bezier 1 Smoath | | @ Rezier @ Smooth
() Open (> 0pen

;@ Closed i @Closed

Motion Resolution: Each 3D Projection you add to the path
is considered a keyframe. ArchiCAD can interpolate between
keyframes to create In-between views which produce a
smoother animation.

Increasing the number of In-between frames increases the
smoothness of the apparent motion in the fly-through, but
these additional images require more time to create and more
disk capacity to store.

In the Display Options pop-up menu you can select from
among four choices which aspects of the current Path you
want to see on the Floor Plan.

If you choose Everything, the location of the in-between
frames will also be shown.

Note: Since Cameras cannot be assigned to Layers,
choosing None in Display Options here is the only way
you can hide them on the Floor Plan.

The Cameras and All radio buttons allow you to specify a
range of keyframe numbers to be displayed, or indicate that
all the frames in the Projection path should be displayed. This
setting will be used as a default in the Create Fly-Through
dialog box, so that only the visible part of the path will be
processed.

The Sun dialog box can be opened by clicking this button at
the bottom of the Camera Settings dialog box. See the Create
Sun Study command description (Image menu) in Chapter
11.

- To apply the settings made both to the Camera and the
Path, click the Apply button bottom right of the dialog
box. You do not need to close the dialog box to see your
changes appear.

- To apply the view defined by a Camera on the 3D model,
select the camera and activate the 3D Window.
Note: If multiple cameras are selected, the last selected
one will be applied.

VR Object Settings

Below the New, Rename and Delete buttons, you can find a
pop-up list containing the names of available VR Objects.
Each new Project has a default VR Object named 01 Untitled
Object whose name will be used for the first VR Camera you
place.

Using the edit boxes in the middle section of the Camera/VR
Settings dialog box, you can enter parameter values
numerically for object radius, center height, view cone,
number of parallels and meridians, start and end angles of
default or selected VR Objects.
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Camera/¥R Settings |
G VR Scene I
Default
Mew... | Fenarne | Delete |
|1 Urtitled Object |
@IR Radius
ISUDDD
@ CenterZ Wiew Cone
F [1700 Al\-{rx. [50,00°
Farallels Meridians
@ d @ |15

o Lowest View e Highest View
ey [0,00° éé}_ [a0,00°

|_ Sun moves with Wiewer

/o Sun Altitude /O: Sun Azimuth
ayee fzs.000 .= |za0,00°

7 Look Qutside
@fj % Look Inside ul?!
Sun... | Apply |

- The more parallels and meridians you define for the
object, the higher the resolution will be.

- With the Lowest View and Highest View values you can
define a full sphere, a hemisphere or a particular section of
a sphere for navigation.

- Checking the Sun Moves with Viewer checkbox will
always define the Sun’s position relative to the current
viewpoint.

- Two radio buttons near the bottom of the dialog box allow
you to define whether the viewing direction will point to
or away from the center of the object.

VR Scene Settings

Below the New, Rename and Delete buttons, you can find a
pop-up list containing the names of available VR Scenes. Each
new Project has a default VR Scene named 01 Untitled Scene
whose name will be used for the first series of VR Cameras
you place.

Camera,'¥R Settings x|
M Camera |@ WR Object
Default
Mew... | Rename | Delete |
02 Untitled Scens |

Panorarna name:

I Pariorama-1

Panoramic Camera Z

o 3 (R
/o Sun Altitude /O Sun Azimuth
Gyee [zs.000 .= [za0,00°

W[es o
Sun... | Apply |

You can use enter parameter values numerically for the
viewpoint height and the sun position for the selected
camera.

Note: Only the VR Cameras belonging to the Scene
currently selected in the dialog box will appear on the
Floor Plan.

Placing Cameras

Placing a Perspective Camera

When you have made your choices in the Camera Settings
dialog box, you are ready to place Cameras on the Floor Plan.
Your first click on the Floor Plan defines the location of the
Camera itself. Draw a rubberband line to set the view
direction, and click again to define the target’s horizontal
position. When the operation is completed, the sun icon
appears with default settings.
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Camera Settings and 3D Settings

Once applied to the 3D Window, the parameters of the
perspective defined by the camera will be copied into the 3D
Projection Settings dialog box and the Navigator and
Navigator preview palettes. However, modifying the view
there will be effective in the 3D Window only and will not
modify the Camera on the Floor Plan. To change the Camera,
you must edit it on the Floor Plan and activate the 3D Window
again when finished.
Defining perspectives in the 3D Projection Settings is useful
for:

- quickly switching to a perspective without having to

change windows, or

- showing Library Parts in perspective (you cannot define
Cameras when working with a Library Part).

See also 3D Image Setup in Chapter 3: Project Organization
and Navigation.

Defining Fly-Throughs

Placing several Cameras defines a Fly-Through path whose
parameters you can adjust in the Path Options dialog box
(opened from the Camera Settings dialog box or the Navigator
palette.)

Only one camera will be active at a time. This is the only
camera displayed with its sun and view angle markers. The
active camera is always the one that was last placed, unless
you select another one. Any cameras placed on the Floor Plan
will be attached to the current Fly-Through path after the
active camera.
Note: Collections of 3D parallel projections can also be
linked to create a Fly-Through, but these are handled
differently from perspectives. Only a single set of parallel
projections can exist, and you edit it in the 3D Projection
Settings/Parallel Projections dialog box, and not
through the Camera Settings. Also, since the viewpoint

distance is infinite for parallel projections, you cannot
display them on the Floor Plan Worksheet.
If the simple Camera is selected in the Camera Settings
dialog box, “Fly-Through” is added to the name of the Create
command in the Image menu.

The Create Fly-Through command creates a series of
normal or PhotoRendered 3D pictures defined by the parallel
projection set or the current camera path. You can either have
the resulting animation shown immediately on screen, or save
these pictures in the desired file format and show them in the
future using the PlayBack utility provided with ArchiCAD.
This utility makes it possible to view a movie of your Project
without having ArchiCAD installed or running.

In order to choose the Create Fly-Through command you
must have at least one Preset Parallel Projection or an
animation path with at least two Cameras.

The two main parts of the appearing dialog box allow you to
set the source and results of the Fly-Through.

Il Create Fly-Through 2=
— Source: ~ Result:
@ D iy . ) I QuickTime Movie j
" PhotoRendering Window
| True Color - 32 bit |

) Pre-zet Parallel Frojections I | Remove Redundant Lines

% Perspectives from Camera Path:

"00: Untitled Path™ ¥ Image Compression Set..
" Keyframes only ™| Dithering Rescale... |
& \With inbetween frames Frame rate; I‘]D
& Al Frames
= Frames from I ta |21
[~ Fiebuild Maded for Each Frame Show |
Uze if any Library Part is parametrized to change
with frame number. Cancel |

In the Source section, you can choose whether you want to
use ordinary 3D views of your Project with settings from the
3D Window Settings dialog box and the mode (Wireframe,
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etc.) selected in the Image menu, or to create PhotoRendered
images for the Fly-Through.

You can define the route of the Fly-Through either from the
Pre-set Parallel Projections or from the current Camera
Path.

By checking the Rebuild Model for Each Frame option you
can create additional animation effects, provided that you
have placed in your project any Library Parts whose
appearance changes with every frame. You can learn how to
achieve this by using the appropriate GDL Global variable.
See GDL Reference Manual.

See also Presets under 3D Image Setup in Chapter 3: Project
Organization and Navigation.

In the lower part of the Source section, you can decide
whether you want to use only the keyframes of the chosen
projection set, or the in-between frames as well, and specify
whether the Fly-Through should contain all frames from the
set, or only some of them.

Result: With the pull-down menus you can define the format
and the number of colors for the saved pictures.

Output formats include still pictures such as PICT (MacOS)
and BMP (Windows) as well as animations, for example
QuickTime Movie and Video for Windows (AVI). Additional
external formats may also be available.

In addition, you can:

- Remove Redundant Lines from Parallel Projections.

- Compress output files.

- Refine the views’ appearance using Dithering.
When using the QuickTime compression methods, check the
Image Compression box to make the movie file’s size smaller.
On the MacOS, Apple Animation is recommended.
Some output formats support image compression. Related
options can be defined in the dialog box that opens when you
click the Set... button.

— Compressor
- Quality

fe

Hl‘gh Eelsl

Llaasl Léw

— Motion

Frames per second: 10 B

v Key frame every 100 frames

[ Limit data rate to KBytes/sec
Optioneg... | ak. I Cancel |

Specify the compression method and colors with the pull-
down menus at the top of the dialog box.
- For some methods the color choices will be restricted to
Color or Grayscale.
- The Motion controls will be enabled or disabled
according to the choices available for the given method.
- The Options button is only active if the chosen method
offers additional possibilities. Some of these are shown
below.

™ Interlaced Number of figlds:  One & Twa
Filter Best - Fisld dominancs & Even € 0dd

™ Optimize for streaming
I™| RRE 2085 compatible ([ess eron coneoion]

Cancel |

By clicking the Rescale button, you can modify the scale of
the compressed images.

lll Compression Resc ﬂﬁl

Fiescaling Picture

Cancel

Seale: %
h: |T32 W | 461 pixels

Cancel |
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Click the Show button to have the Fly-Through processed
and immediately displayed on your screen. You can save the
resulting animation afterwards as described above.

Defining a VR Object and Creating a VR Object Movie

First, select VR Object in either the Camera Settings palette or
the Info Box. You will also see that “VR Object Movie” is
added to the Create... command name in the Image menu.

With a single click on the Floor Plan you can place a VR
Object camera with default parameters. Further clicks on the
Floor Plan will not create new cameras; you can only have
one camera active at a time.

If the VR Object is selected and you go to the 3D Window,
you can check its perspective elevation view from the
viewpoint indicated by the view cone. To modify the location
of the view cone, select it with the Camera tool active, drag its
node and position it onto another node of the object.

Choosing Create VR Object Movie will open a dialog box

where you can set a few options for creating a navigable

object.

The Source and Result areas offer the same choices as for the

Fly-Through, but output options are restricted to QTVR.
Note: Apple and Graphisoft recommend using the
Cinepack compression method.

Il Create ¥R Object 2=l
[aTvR 20 Engne =l
— Souce:
30 Window

{* PhaotoRendering ‘Windaw

™ Rebuild Model for Each Frame

Use if any Library Part is parametiized to change
with frame number.

- Result:

| Trus Color - 32 bit =l

¥ Image Compression
™ Dithering

Cancel | Save. |

Clicking Save... in the dialog box will prompt you to name
your navigable object file. All the 3D data you need will be
exported into this new format. You can view the result by
launching QTVR Player.

You may need to change the position of the VR Object. You
can be manipulate it using the cursor or the Drag, Mirror or
Rotate commands in the Edit menu. If the Camera tool is
active, you can reposition any of the selection nodes to
change the object’s 2D position. The sun and the camera can
be repositioned by their respective selection nodes.

Placing Panoramic Cameras for the VR Scene

The first click on the floor plan places a panoramic camera.
You draw a rubberband line, and the second click defines the
view direction. This camera will define your starting position
and view direction in the VR Scene. When the operation is
completed, the name of the panorama and the sun icon
appear with default settings.
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If you do not add more cameras to the current scene, you can
generate a single node QTVR Scene.

Placing several panoramic cameras defines a multi-node VR
Scene. One of the cameras will be active at a time. This is the
only camera displayed with its sun marker. The active camera
is always the one which was last placed, unless you select
another one. Each panoramic camera is assigned the name
Panorama-x (x is the camera’s sequence number) by default.
The name can be changed in the Panorama name field in
the middle section of the Camera Settings dialog window.

Each position has to be connected to at least one other,
otherwise a warning will prompt you to do so when you try to
generate the VR Scene using the Create VR Scene...
command in the Image menu. The connections will define
how you can change your position in the final VR Scene.

The connecting line between two positions can be drawn
when you place a panoramic camera or after some
unconnected cameras have already been placed. To place a
new camera connected to another one, always start drawing it
by clicking the center node of the camera you want it to be
connected to. The second click will define the position of the
new panoramic camera.

F. rama-10 Fanorama-10 rama-‘11

A i

You can insert a break in a connection line by pulling its
center node (defined by a circle) with the Checkmark cursor
while the Camera tool is active. This allows you to define a
connection that makes sense between two positions, for
instance on opposite sides of a wall. Instead of jumping
through the wall, you can then go to the next position
through a door, without having to place an extra Camera at
the opening.

Fanorama-10

szc_orama-ﬂ

g

Any connection can be cleared by selecting it by its center
node and deleting it.

Fanorama-10 Fagorama-11

Fanorama-10 Faporama-11

= i
Ly

The view direction and the sun position can be changed by
moving their nodes with the Checkmark cursor while the
Camera tool is selected.

Fagorama-10 Fagorama-10

G

To define another node as the initial node, just select it (with
the Camera Tool active) and drag the circle representing the
starting position on top of another node’s centerpoint.

If the VR Scene option is selected in the Camera Settings
dialog box, “VR Scene” is added to the Create... command
name.

Choosing the command will open a dialog box where you
can set a few options for creating panoramas or pictures that
you can then view in the appropriate player applications.
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21
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Set Image Compression. . |
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Cancel | Save..

With the View Cone, you can define the camera’s viewing
angle, within which you can create an initial zoom factor as
the default setting for the panoramic view. This initial zoom
factor cannot be greater than the View Cone.

Three options are available for creating VR panoramic scenes.
- Choosing Scene (default) will allow you to save all the
panoramas defined on the Floor Plan, together with a
control file containing the navigation data. To properly
view the scene in QTVR Player, you need to open this
control file.

- Choosing Panoramas will allow you to save the
panoramas defined on the Floor Plan without a control
file. You can view any of the panoramas in QTVR Player
individually, but you will not be able to navigate between
them.

- Choosing Pictures will allow you to save pictures of your
panoramas that you can then edit as bitmap images. These
files cannot be viewed in QTVR Player. After editing the
files (modifying the background, adding extra elements),
you must use Apple’s QTVR tools in order to manually
create a file viewable in QTVR Player.

You can also set the image height and length as well as the
Window size in QTVR Player (all measured in pixels).
Checking the Keep proportions box will ensure that your
image is not distorted.
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Polyroof Settings
~ dialog box 94
PolyWall Corners 75
PolyWalls 71
Pre-Sets
Adding the current Projection 44
projection ~ 44
Presentation Elements 210
Preset Zooms 17
Preview
~ of perspectives 42
Previous Zoom
~ command (Display menu) 18
Project Notes
~ window 16
Project Origin 27
resetting the ~ 28
Project Preview
~ Window 16

Project Zero Level

placing element on ~ 33
Projection Points

parallel and perpendicular ~ 178
Projection Types 43
Prompt Box 20

Purlins

placing ~ 149
Q
QTVR Player

~ application by Apple 220, 227
Quick Layers 23
QuickTime
compression methods 226
fly-throughs saved as ~ movies 226

R

Radial Dimensions 180
Construction Methods 183
drawing ~ 192
Label Orientation 183

Rafters
placing ~ 146

Rebuild
~ command (Display menu) 18

Rebuild All Models
~ command (Display menu) 19

Rebuild Model
~ command (Display menu) 18, 211

Rebuilding the 3D Window 18

Rectangle Walls 72

Redraw
~ command (Display menu) 18

Redrawing or Rebuilding a View 18

Reference Line
~ of Walls 74
moving a wall's ~ 76

Refreshing the screen 18

Relative Coordinate Values 28

Remote Intersections
Section points on ~ 178

Remote Roofs
Trimming Walls with ~ 101
Remote Tangential Points 178
Report Window 16
Reset
~ in 3D Navigation palette 50
Restoring a Wall/Column after Trim-
ming 100
Ridges
~ of meshes 102
Right-Angle Columns 80
Roof Accessories 160
Roof Edges
trimming ~ 96
Roof Level Lines
~ command (Tools/Line Extras) 99
Roof Wizard 152
RoofMaker 146
~ Toolbox 154
Roofs 91
3D Intersections 98
drawing ~ 93
drawing a Barrel-Vaulted ~ in 3D 97
drawing a simple ~ in 3D 94
holes in ~ 99
placing elements on ~ 33
trimming construction elements to ~ 99
Rotate
~a Copy 109
~ Zone Stamp 198
Rotated Columns 80
Rotated Rectangle Walls 72

S

Scale
~ & output 25
~ button 25
architectural ~ 25
Changing ~ 26
Drawing ~ 25
Output ~ 26
Scaled Elements 26
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Secondary Dimensions
~ command (Tools menu) 190
Section Depth
~ in Display Options 210
adjusting ~ 216
Section Lines
Adjusting ~ 216
displaying ~ on stories 212
placing ~ 216
Section Points
~ on remote intersections 178
Section/Elevation Settings 212
Section/Elevation tool 13

Section/Elevation Windows 13, 210, 211

Drawing type 211
Model type 211
naming ~ 212
types 13
Sections 210
Sections/Elevations 210
Associative Dimensions 194
breaking ~ lines 216
displaying Section Depth 210
Font & size 213
Section Pens 214
vectorial 3D hatches 215
vectorial sun shadows in ~ 215
Vertical Range 212
Selection
Element Types for 3D Imaging 47
Selections Palette 23
Set City

dialog box (Image/3D Projection Settings) 40

Set Home Zoom
~ command (Display menu) 18
Shading
~ command (Image menu) 48
Side Views 43
Sill 121, 124
Simple Openings 123
Single Walls 69
Skewed Grid
setting up a ~ 31

Skylights 125
placing ~ 125
Slab Accessories 160

Slabs
drawing ~ 89
holes in ~ 90

Integrating ~ with Walls 90
placing elements on ~ 33
scaling 26
trim to Roof 101
Slopes 143
Smooth Path at Cameras 222
Snap Grid 29, 30
Special Zoom 17
Splines
drawing ~ 167
editing ~ 168
freehand geometry method 168
StairMaker 130
Stairs 130
creating custom ~ 144
geometry 133
placing ~ 132
railings 140
structure 137
Status Report Palette 23
Stories
~ command (Options menu) 34
Adding ~ 35
definition 34
displaying a ghost ~ 36
List of ~ 38
Numbering 35
Removing ~ 35
Selection 35
Story Settings...
~ command (Options/Stories) 35
Straight Walls 69
Sun 44, 45
~ light parameters 45
Sun Moves with Viewer
~ for QTVR Objects 224

Sun Options

~ for Fly-Throughs 223
Surveyor’s unit 46
Symbol Colors 120
Symmetrical Vaulted Roofs 97

T

Target point 42
Text 174
Text Blocks 173
creating breaking ~ 175
creating non-breaking ~ 175
Justification & Anchor Point 174
placing ~ 175
scaling ~ 26
Text Settings
~ dialog box 174
Threshold 121
Tie Beams
placing ~ 152
Tool Settings Dialog Box 21
Toolbar 24
Toolbox 20
Top view
~ in perspective 43
axonometry 43
Tracing Elements in 3D 107
Tracing Method

~ for transforming curved elements 108

Trapezoid Walls 72
Trim to Roof
~ command (Edit menu) 99
Walls 100
Trim Zone
~ command (Edit menu) 197
Trimmers
placing ~ 150
Trimming Roof Edges 96
Trusses
creating ~ 154
TrussMaker 154
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v

Unlink Section/Elevation

~ command (Display menu) 14, 211
Unwrapped Columns 80
Update Zones...

~ command (Tools menu) 204
US Builder

dimension standard 181
User Origin

~ button 27

~in 3D 27

Creating a ~ 27

v

Valley Rafters
placing ~ 148
Vectorial 3D Hatching
~ in Sections/Elevations 215
Vectorial Hatches
~ & scaling 26
Vectorial Sun Shadows
~ in Sections/Elevations 215
Video for Windows
fly-through saved as ~ files 226
View Cone 42
~ for QTVR Scenes 229
Viewpoint 42
~ for Parallel Projections 44
Virtual Reality 220
VR Object Settings
~ dialog box 223
VR Objects 220, 227
defining ~ 227
Parameters 223
techniques 227
View Direction 224
VR Scene Settings
~ dialog box 224

VR Scenes 220
defining ~ 227
opening ~ in QTVR Player 229
panoramas 229
parameters 224
saving ~ as pictures 229

w

Wall & Column Subtraction
~ from Zone areas 204
Wall Accessories 161
Walls
~ & Columns 80
~ & Doors/Windows 77
~ & Roofs 77
~ & Slabs 77
connecting ~ with different hatches 74
definition 65
drawing ~ 68
drawing polygon ~ 72
geometry 68
intersections 74, 75
invert direction of ~ 77
modifying the structure of ~ 76
moving the reference line 76
scaling ~ 26
trim to Roof 100
Windows 117
Parameters 119
placing corner ~ 124
Wireframe
~ command (Image menu) 48
Witness Line
~ formats 184
Workplace
components of the ArchiCAD ~ 11
Wrapped Columns 81
Write Report
~ option in Preferences 16

z

Zone Categories 196
~ command (Options menu) 201
creating ~ 201
defining ~ 201
Zone Fill 195
Zone Lists
~window 15, 197
Zone Polygons
~ in Display Options 196
Zone Settings 197
Zone Shape
trimming the ~ 203
Zone Space
calculating ~ 203
Zone Stamps 195
~ in Display Options 196
default parameters 201
rotating ~ 198
Zones 195, 197
3D ~ spaces 196
Category Code 201
Category Name 201
Definition Methods 202
name and number 198
Parameters 198
Stamp Preview 199
updating zones 204
Zone Stamp 201
Zoom 16
~ in Navigator Preview 59
~ with wheelmouse 17
Zoom In
~ command (Display menu) 16
Zoom Level
~ button 18
Zoom Out
~ command (Display menu) 16
Zoom to Selection
~ command (Display menu) 17
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